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Safety Instructions

Be sure to read these instructions in order to operate the product safely. Follow these instructions to prevent
injury or harm to the operator of the product or others.

A\ WARNING

Denotes the risk of serious injury or death.

e Stop using the product in any case of unusual circumstances such as the presence of smoke or a strange
smell.

¢ Do not touch any exposed internal parts.

e Do not get the product wet. Do not insert foreign objects or liquids into the product.

¢ Do not touch the product connected to a power outlet during lightning storms. This may cause electric shock.

¢ Do not disassemble or modify the product.

* Do not expose the product to strong shocks or vibration.

e Use only power sources specified in this instruction manual for use with the product.

¢ Observe the following instructions when using a battery charger or AC adapter.

- Do not touch the battery charger or AC adapter connected to a power outlet during lightning storms.

- Do not use the product if the power plug is not fully inserted into the power outlet.

- Do not unplug the product by pulling the power cord.

- Do not plug in or unplug the product with wet hands.

- Do not place heavy objects on the power cord. Do not damage, break or modify the power cord.

- Do not leave the product connected to a power source for long periods of time.

- Do not expose the power plug and terminals to dirt or let them come into contact with metallic pins or other
metal objects.

- Do not charge batteries/battery packs at temperatures outside the range of O - 40 °C (32 - 104 °F).

e Observe the following instructions when using commercially available batteries or provided battery packs.

- Do not use leaking batteries/battery packs.
If a battery/battery pack leaks and the material contacts your skin or clothing, flush the exposed area
thoroughly with running water. In case of eye contact, flush thoroughly with copious amounts of clean
running water and seek immediate medical assistance.

- Use batteries/battery packs only with their specified product.

- Do not heat batteries/battery packs or expose them to fire.

- Do not charge batteries/battery packs using non-authorized battery chargers.

- Do not expose the terminals to dirt or let them come into contact with metallic pins or other metal objects.

- Keep batteries out of the reach of children.

- When disposing of batteries/battery packs, insulate the terminals with tape or other means.

¢ Do not shoot the sun directly or point a lens or a camera/camcorder with a lens attached at the sun. Even
when the sun does not appear on the screen or is behind the subject, the lens may concentrate the sunlight
and cause a malfunction or fire.

¢ Do not leave a lens or a camera/camcorder with a lens attached, exposed without the lens cap attached. The
lens may concentrate the light and cause fire.

e Do not leave the lens exposed without the lens cap attached.

e Do not wrap the product in cloth or other materials when in use or shortly after use when the product is still
warm in temperature.

e Do not allow the product to maintain contact with the same area of skin for extended periods of time during
use. This may result in low-temperature contact burns, including skin redness and blistering, even if the
product does not feel hot. The use of a tripod or similar equipment is recommended when using the product in
hot places and for people with circulation problems or less sensitive skin.

e Keep the product out of the reach of young children.

e A strap wrapped around a person’s neck may result in strangulation.

e Periodically remove any dust buildup from the power plug and power outlet using a dry cloth.

e Follow any indications to turn off the product in places where its use is forbidden. Not doing so may cause
other equipment to malfunction due to the effect of electromagnetic waves and even result in accidents.

¢ Before installing, be sure the surface is capable of supporting the total weight of the camera and connected
devices, and sufficiently reinforce the surface if necessary.




A\ cauTions
Follow the cautions below. Otherwise physical injury or property damage may result.

e Strap is intended for use on the body only. Hanging the strap with any product attached on a hook or other
object may damage the product. Also, do not shake the product or expose the product to strong impacts.
This may cause injury or damage to the product.

¢ Do not leave the product in places exposed to extremely high or low temperatures. The product may become
extremely hot/cold and cause burns or injury when touched.

¢ Only mount the product on a tripod that is sufficiently sturdy.

¢ Do not look at the screen for prolonged periods of time. This may induce symptoms similar to motion
sickness. In such a case, stop using the product immediately and rest for a while before resuming use.

-India only-

This product is not to be disposed of with your household waste. This product should be handed over to
a designated collection point. For more information regarding return and recycling of WEEE products,
please visit https://in.canon/en/consumer/web/e-waste or write to us at cipl.ewaste@canon.co.in

Also, this product including its components, consumables, parts and spares complies with the “E-Waste
(Management) Rules, 2022” and prohibits use of lead, mercury, hexavalent chromium, polybrominated
biphenyls or polybrominated diphenyl ethers in concentrations exceeding 0.1 % by weight and 0.01 %
by weight for Cadmium, except for the exemptions set in Schedule Il of the Rules.
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Introduction

About this Manual

Thank you for purchasing the Canon EOS C300 Mark lll / EOS C500 Mark Il. Please read this manual carefully
before you use the camera and retain it for future reference. Should the camera fail to operate correctly, refer to
Troubleshooting (11 221).

Conventions Used in this Manual

e @ IMPORTANT: Precautions related to the camera’s operation.
* (1)NOTES: Additional topics that complement the basic operating procedures.
¢ [11: Reference page number.
. (EOITD: Text that applies only to the model shown in the icon.
¢ The following terms are used in this manual.
- “Screen” refers to the LCD screen on the supplied LCD monitor.
- “LCD monitor” refers to the supplied LM-V2 LCD Monitor.
- “LCD attachment unit” refers to the supplied LA-V2 LCD Attachment Unit.
- “Camera grip” refers to the supplied GR-V1 Camera Grip.
- “Viewfinder” refers to the optional EVF-V50 OLED Electronic Viewfinder.
- “Battery pack” refers to a Canon BP-A30 Battery Pack (optional) or BP-AB0 Battery Pack (supplied).
- “Expansion unit” refers to the optional EU-V1 Expansion Unit 1, EU-V2 Expansion Unit 2, or EU-V3
Expansion Unit 3.
- “AC adapter” refers to a commercially available power adapter.
- “SD card” refers to an SD, SDHC or SDXC memory card.
- “Recording media” or “card” alone, not specified: refers collectively to CFexpress cards and SD cards.
- “CAMERA mode”: operating mode for making recordings (shooting mode).
“MEDIA mode”: operating mode for playing back and managing recordings (playback mode).
- “Access indicator”: when not specified, refers collectively to the SD CARD and CFexpress access
indicators.
- “RAW” refers to the data recorded using Cinema RAW Light. Unless otherwise stated, refers to data
recorded in the following main recording formats: RAW, RAW HQ, RAW ST or RAW LT.
- “Multi-Camera Control” refers to Canon Multi-Camera Control.
¢ Unless indicated otherwise, illustrations in the manual show the Canon EOS C500 Mark Il camera with a
Canon EF 50mm /1.4 USM lens attached.
¢ Photographs in the manual are simulated pictures taken with a still camera.
¢ Unless indicated otherwise, screenshots in the manual are from the EOS C500 Mark Il camera. Some
screenshots have been altered to make them easier to read. Furthermore, screenshots used are from a
product in development and may differ slightly from the actual screens due to product enhancement.
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Supplied Accessories

Supplied Accessories

The following accessories are supplied with the camera.

LM-V2 LCD Monitor LA-V2 LCD Attachment Unit Handle Unit GR-V1 Camera Grip*
(incl. grip attachment ring)

&

Microphone Holder BP-A60 Battery Pack CG-A20 Battery Charger CA-CP200 B Compact Power Adapter
(incl. M4 fixation bolts, x2) (incl. terminal cover) (for the CG-A20; incl. power cord)

’10\3\

n
Wiggno00lt

Expansion System Attachment Body Cap* UN-5 Unit Cable Hex socket head bolts
Bracket (0.64 cm, 1/4" x1, M3 x4)
and hex wrenches
(x3, for 0.64 cm, 1/4" / M4 / M3 bolts)

Ol

SS-1200 Shoulder Strap Thumb Rest Tape Measure Hook* Quick Guide

* Comes pre-attached to the camera.



Supplied Accessories

Before Using the Camera

e Before making important recordings for the first time, make test recordings using the video configuration(s) you
plan to use to check that the camera operates correctly. Should it fail to operate correctly, refer to
Troubleshooting ([ 221).

¢ Copyright notice: Unauthorized recording of copyrighted materials may infringe on the rights of copyright
owners and be contrary to copyright laws.

¢ Notes on privacy and publicity rights regarding the use of video: \When using the camera, exercise proper caution
in order to protect privacy and avoid any violation of publicity rights.

¢ About the LCD screen: The screen is produced using extremely high-precision manufacturing techniques, with
more than 99.99% of the pixels operating to specification. Very rarely, pixels may misfire or light up
permanently. This has no effect on the recorded image and does not constitute a malfunction.

@ rorTANT

e CFexpress cards can become hot due to the high operating temperature inside the camera. Removing a
CFexpress card immediately after using it for recording may cause burns or cause you to drop the card,
resulting in damage to the card.

¢ Observe the following precautions while an access indicator ([1 44, 45) is illuminated or flashing in red. Failing
to do so may result in permanent data loss.
- Do not turn off the camera and do not remove the battery or other power source.
- Do not open the card compartment cover.

11



Names of Parts

Names of Parts

Camera
12 8 9 10 11
ﬂ | [
MEDIA—CAMERA@
k@ OFFS
1 Tape measure hook and ¢ focal plane mark 9 @EIMED switch
2 MAGN. (magnification) button (11 87)/ Set to CAMERA to turn on the camera or to OFF
Assignable button Camera 1* to turn it off.
3 PEAKING button ([1] 87)/ 10 Built-in monaural microphone (1] 109)
Assignable button Camera 2* 11 Power indicator/Rear tally lamp (1] 51)
4 ND FILTER +/- buttons ([1] 76) 12 Control dial (1] 75, 78)
5 ZEBRA button ([J1] 98)/ 13 REC (start/stop recording) button (1] 51)
Assignable button Camera 3* 14 WB (white balance) button ([11 81)/
6 WFM (video scope) button ([11 114)/ Assignable button Camera 10*
Assignable button Camera 4* »-/11 (play/pause) button ([1] 145)
7 SELECT dial/SET button (11 34) 15 % (white balance adjustment) button (1 81)/
8 MEDIA button ([1] 143) Assignable button Camera 11*/
When the camera is on, press to toggle the INDEX button (11 144)/
camera between CAMERA mode (shooting) and M (stop) button ([J1 145)
MEDIA mode (playback).

* See Assignable Buttons ([11 129)

Locking the camera’s controls (key lock)

You can set the switch to & (key lock) to lock all the camera’s buttons and switches. This is useful in
preventing settings from being changed due to inadvertently pressing one of the buttons. Set the
switch back to CAMERA to reactivate the controls.

When the camera’s controls are locked, you can still operate the camera using an optional RC-V100 Remote
Controller or the Browser Remote application.
* In CAMERA mode, REC buttons are not locked by default but you can choose to lock them too (11 208).



Names of Parts
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& (illumination) button

Turns on/off the illumination of the buttons on the
camera’s left and back sides. This is convenient
for night time or black-out operation.

LUT button (1] 161)/

Assignable button Camera 5*

S&F (slow & fast motion recording) button

(1 120)/Assignable button Camera 8*
ISO/GAIN button ([ 74)/

Assignable button Camera 6*

S&F FPS (slow & fast shooting frame rate) button
(11 120)/Assignable button Camera 9*
SHUTTER (shutter speed mode) button ([ 73)/
Assignable button Camera 7*

* See Assignable Buttons (11 129)

13 14 15

7 Airintake vent ([1] 61)

8 Card compartment cover ([11 44, 45)

9 CFexpress card release buttons: for CFexpress
(left), CFexpress [B] (right), (11 44)

10 CFexpress card slots: for CFexpress (left),
CFexpress [B] (right), (11 44)

11 SD card slot ([11 45)

12 Card compartment cover switch

13 SD CARD access indicator ([11] 45)

14 SLOT SELECT (CFexpress card selection) button
(2 46, 144)

15 CFexpress card access indicators: for CFexpress
(Ieft), CFexpress (B] (right), (11 44)
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Names of Parts
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USB terminal 8 Camera grip attachment thread/Rosette ([1] 41)

For connecting the optional GP-E2 GPS Receiver.

Exhaust ventilation outlet ([1] 61)

Audio level switches for CH1 (top) and CH2
(bottom) (11 110)

System expansion terminal

¢ Focal plane mark

Alir intake vent ([1] 61)

Speaker ([1] 147)

Compliant with ARRI rosettes.

9 GRIP (camera grip connection) terminal (1] 41)

10 Audio level dials for CH1 (top) and CH2 (bottom)
(110

11 INPUT 1 (top) / INPUT 2 (bottom) switches
(audio source selection, [I] 109)

12 Cover for audio controls
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Names of Parts

Canon
EOS@
— @\
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U —

I

HI

EF lens mount

Front tally lamp (11 51)

VIDEO terminal ([11 29)

Lens mount fixation bolts

PUSH AUTO IRIS (momentary automatic aperture)
button (1 79)/

Assignable button Camera 14 ([1] 129)

EF-S lens mount index ([ 37)

EF lens mount index ([11 37)

Lens release button ([ 37)

EF lens lock pin

ONE-SHOT AF (focus automatically once) button
(T 89y

Assignable button Camera 15 ([J] 129)

10 EF lens contacts ([J1 37)

© 0 ~NO®

15
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Expansion unit connector
For connecting the optional EVF-V50 OLED
Electronic Viewfinder or expansion units.
Expansion unit connector cover
Power indicator/Rear tally lamp (11 51)
FUNC (main functions) button (1] 71)/
Assignable button Camera 12 ([J] 129)
Joystick ([11 34)
CANCEL button (11 34)
MENU button ([ 34, 129)
Screw holes for M4 bolts (7.5 mm (0.30 in.) deep,
x4)
Battery compartment ([J] 26)

0 MON. terminal ([J] 156, 157)

1 SDI OUT terminal ([I1 156)

Removing and attaching the terminal covers

12 TIME CODE terminal (11 102, 103)

13 REMOTE A terminal ([] 125)
For connecting the optional RC-V100 Remote
Controller or commercially available remote
controllers.

14 HDMI OUT terminal (11 156, 157)

15 MIC (microphone) terminal (1] 108)

16 () (headphone) terminal (11 112)

17 INPUT terminals (XLR): INPUT 1 (top), INPUT 2
(bottom) (11 105)

18 AUDIO STATUS (display the [d) Audio Setup]
status screens) button (1 215)/
Assignable button Camera 13 ([1] 129)

19 DC IN 12V terminal ([11 27)

20 BATTERY RELEASE button ([1] 26)

You can remove the covers of the camera’s terminals to access them more easily. To remove a terminal’s
cover, open the cover and gently pull it straight out. To attach back the terminal cover, insert the connecting

strip into the opening.

(i) NoTes

e |f the connecting strip is difficult to grasp, use a pair of tweezers or similar tool.



Names of Parts
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13 14 15
1 Tape measure hook 11 Sockets for tripod’s anti-rotation pin
Use the hook to accurately measure the distance (5 mm (0.20 in.) deep, x2)
from the focal plane. For tripods with 1/4"-20 mounting screws.
2 Screw holes for 1/4"-20 mounting screws 12 M4 screws for expansion unit connector cover
(9 mm (0.35in.) deep, x6) 13 Strap mounts
3 Top accessory mount with socket for 1/4"-20 Pass the ends of the supplied shoulder strap
mounting screws through the strap mounts and adjust the length of
(6.7 mm (0.26 in.) deep) the strap.

4 Accessory shoe with socket for 1/4"-20 mounting
screws (6.7 mm (0.26 in.) deep)/
Handle attachment unit ([J] 29)

5 Socket for the expansion system attachment
bracket

6 Screw hole for 3/8"-16 mounting screws
(10 mm (0.39 in.) deep)

7 TB-1 Tripod Base

8 Socket for tripod’s anti-rotation pin
(6.5 mm (0.22 in.) deep)

For tripods with 3/8"-16 mounting screws. 14 Expansion unit fixation screw holes (M4, x2)
9 Screw hole for tripods with 1/4"-20 mounting 15 Screw holes for tripod reinforcements and
screws (7 mm (0.28 in.) deep) accessories with 1/4"-20 mounting screws
10 Tripod base screws (7.5 mm (0.30 in.) deep, x3)
@ vroRTANT

¢ Do not use tripods and other accessories with mounting screws exceeding the depth of the screw holes on
the camera as this may damage the camera.

¢ Mounting the camera on a tripod using only one of the 1/4"-20 screw holes for tripod reinforcement may
damage the camera.
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Names of Parts

LM-V2 LCD Monitor

—

W

LCD panel with touch screen ([] 29, 31)
FUNC (main functions) button ([11 71)/
Assignable button LCD LM-V1/V2 1 (1] 129)
MENU button (11 34, 129)

Joystick (1] 34)

MIRROR (invert the displayed image) button
(32

6 CANCEL button ([11 34)
7 DISP (display) button ([11 53, 57)/
Assignable button LCD LM-V1/V2 2 ([1] 129)
8 LCD monitor’s position alignment mark A (11 29)
9 Screw holes for 1/4"-20 screws
(11.2 mm (0.44 in.) deep, x2)
10 VIDEO terminal (1] 29)



LA-V2 LCD Attachment Unit ([]] 29)

Names of Parts

LCD monitor fixation bolt

Base 1

Sockets for the microphone holder ([1] 42)
Cable clamp

Pivot A

Base 2 fixation bolt

OOk~ wWND =

Microphone Holder ([11] 42, 108)

7 PivotB

8 Base?

9 Locking knob

10 LCD monitor mount

11 LCD monitor’s position alignment mark A
12 Attachment mount

1 Microphone lock screw
2 Microphone holder
3 Microphone cable clamp

19
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Names of Parts

GR-V1 Camera Grip ([ 1 41)

At the time of purchase, the camera grip is pre-attached to the camera.

2
3
1 Control dial (1] 75, 78) 4 Joystick ([11 34)
2 REC (start/stop recording) button (11 51) 5 FOCUS GUIDE button ([I] 86)/
3 Grip belt Assignable button Camera Grip 1 (11 129)
Adjust the grip belt so that you can reach the REC 6 Rosette
button on the camera grip with your index finger Compliant with ARRI rosettes.

but still have a comfortable but secure grip. Locking screw
Grip attachment ring
Grip connection cable

0 Connection plug

- © 0~




Handle Unit ([1] 29)

w

1 2

ol

Screw holes for 1/4"-20 screws

(6 mm (0.24 in.) deep, x4)

Front accessory mount with socket for 1/4"-20
screws (8.8 mm (0.35 in.) deep)

Top accessory shoe

Through-holes (& 8.8 mm (0.35 in.), distance
center-to-center 35.5 mm (1.4 in.))

—_

(=]

Names of Parts

~
oo

Rear accessory mount with socket for 1/4"-20
screws (8.8 mm (0.35 in.) deep)

Locking knob

Rear mounting hole (through-hole)

Mounting base

21
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4K and Higher Resolutions: Workflow Overview

4K and Higher Resolutions: Workflow Overview

The following illustrates the typical workflow for 5.9K/4K recording with the camera. 5.9K recording is available
only with the EOS C500 Mark Il model.

Recording Post-production
4K recordin: - i
SO OUT / (2] g Fulldc;?:hty
HDMI OUT
terminal External —
output recorder
Primary clips
0 5.9K"/4K recording (RAW), ! [ xF-avC
4K recording (XF-AVC) . data

. N
CFexpress (1) Full-quality 0
card - data
Cinema
RAW Color
Development grading

@ Shooting

© 2K recording EDL o
(XF-AVC)
3D card ‘ ‘ NLE software
! only.

© Shoot in 5.9K/4K mode ([11 62).

© You can record 5.9K/4K RAW or 4K YCbCr 4:2:2 data on a CFexpress card in the camera, or record
4K data using an external recorder connected to the camera’s SDI OUT or HDMI OUT terminal
(M 156).
e Clips other than 5.9K/4K RAW need no further processing and can be color graded directly (step @).
© While recording 5.9K/4K primary clips, you can simultaneously record 2K proxy clips on an SD card.
¢ The file names of 2K proxy clips (XF-AVC) and 5.9K/4K clips are linked and identical for the most part
(M 59).
@ After recording, develop the 5.9K/4K RAW clips using the Cinema RAW Development software
(M 166) to generate full-quality data.
® You can also generate proxy data.

© You can use the 2K proxy clips recorded on the SD card or proxy files generated by Cinema RAW
Development on NLE software to edit the video offline and create an EDL.

@ Perform color grading based on the full-quality data.
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Color Grading with the ACES Workflow

You can perform color grading using ACES, the color encoding system defined by the Academy of Motion

Picture Arts and Sciences. This workflow allows you to perform on-set color grading* while continuing to shoot.

* Requires monitors compatible with ASC-CDL and 3D LUT color correction.

Post-production

RAW Input
>Develo ment-> Transform =>
Pl
Cinema RAW Color grading
CFexpress RAW Development (ACEScc/ACEScct)
card data > Input OpenEXR >
en
— Transform (iCES)
SDIOUT /
MON. / XF-AVC > Input >
HDMI OUT ﬁ Transform ASC-
terminal output | CDL ‘
CanonlLog?2/3
Cinema Gamut Output
Transform
¥
ACESproxy
Output
Inverse log ASC-CDL Transform

ACESproxy:

Color spaces:
ST2065-1:
ACEScc:
ACEScct:

Input Transform:

Output Transform:

ASC-CDL:

On-set Color Grading

ACESproxy video data that is output from the camera’s output terminals when performing

on-set color grading. Select the [ACESproxy] option for the LUT setting, depending on where

the video is to be output (1] 161).

129 e BT.709
APOQ primaries, linear floating-point encoding. IS BT.2020
AP1 primaries, log floating-point encoding. 1 PN T ﬁg‘:ma Gamut
AP1 primaries, log floating-point encoding. Differs 08 ' N AP
from ACEScc by adding a ‘toe’ to the encoding,
with a behavior resembling that of the Cineon 0.6
curve. >
Refers to the table used for converting color 041
information of the input device to ST2065-1 color 024

space. It can be downloaded from Canon’s

website. 01
Refers to the table used for mapping ST2065-1
color space information to the specific color
information scheme used by the display device. ' X
Refers to the list that contains color grading

adjustment data. This step requires equipment compatible with ASC-CDL.
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Preparations
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Preparing the Power Supply

You can power the camera using a battery pack or the DC IN 12V terminal. Even when a battery pack is
attached, if a power source is connected to the DC IN 12V terminal, the camera will not draw power from the
battery pack.

Using a Battery Pack

You can power the camera using the supplied BP-AB0 Battery Pack or the optional BP-A30 Battery Pack. Both
battery packs are compatible with Intelligent System so you can check the approximate remaining battery usage
time (in minutes) on the screen. For more accurate readings, when using a battery pack for the first time, charge
it fully and then use the camera until the battery pack is completely depleted.

Compact power adapter

Charging the Battery Pack
Charge battery packs using the supplied CG-A20 Battery
Charger and CA-CP200 B Compact Power Adapter. Before
charging, remove the terminal cover of the battery pack.
1 Connect the compact power adapter to the battery charger
and plug the power cord into a power outlet.
2 Attach the battery pack to the battery charger.
e Press lightly and slide the battery pack in the direction of the
arrow until it clicks.
e The CHARGE indicator starts flashing and also indicates the
battery pack’s approximate charge. The indicator will stay on ~ CHARGE
when charging has completed. indicator

Battery Charger

¥ ¥ approx. 0% to 49%: Flashes once every 2 seconds
K ¥k approx. 50% to 74%: Flashes twice every 2 seconds
KKKk approx. 75% to 99%: Flashes 3 times every 2 seconds

3 Disconnect the compact power adapter from the battery charger and unplug the power cord.
4 Remove the battery pack from the battery charger.

@ vrorTANT

e Do not connect to the battery charger any product that is not expressly recommended for use with this
camera.

¢ \When using the battery charger or compact power adapter, do not fix it permanently to one place as this may
cause a malfunction.

e To prevent equipment breakdowns and excessive heating, do not connect the supplied battery charger or
compact power adapter to voltage converters for overseas travels or special power sources such as those on
aircraft and ships, DC-AC inverters, etc.
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Preparing the Power Supply

(i) NoTES

¢ \We recommend charging the battery pack in temperatures between 10 °C and 30 °C (50 °F and 86 °F).
Outside the temperature range of 0 °C to 40 °C (32 °F to 104 °F), charging will not start.

If there is a malfunction with the battery charger, compact power adapter or battery pack, the charge indicator
will go out and charging will stop.

For handling precautions regarding the battery pack, refer to Safety Instructions (11 2), Battery Pack

(1 233).

For approximate charging times and usage times with a fully charged battery pack, refer to the Reference
Tables ([11 246).

Charged battery packs continue to discharge naturally. Therefore, charge them on the day of use, or the day
before, to ensure a full charge.

¢ \We recommend that you prepare battery packs to last 2 to 3 times longer than you think you might need.
Repeatedly charging and completely depleting a battery pack will eventually shorten its battery life. You can
check the battery life on the [ System Setup] status screen (I 216). Fully charging the battery pack and
then depleting it completely will give you a more accurate reading.

Attaching the Battery Pack 0)

1 Turn off the camera. a

2 Insert the battery pack all the way into the compartment
as shown in the illustration and press it gently toward the
left until it clicks.

CAMERA./.

Removing the Battery Pack
1 Turn off the camera.

2 Holding down the BATTERY RELEASE button (D), slide
the battery pack toward the right and then pull it out ().




Preparing the Power Supply

Checking the Remaining Battery Charge

You can check the approximate charge level on the battery pack itself. The remaining battery charge level

displayed on the recording/playback screen may not match the level shown on the status screen or the

indicators on the battery pack. When the camera is turned on, you can check the approximate remaining battery

usage time (in minutes) by looking at any recording/playback screen or the [§ System Setup] status screen 27

(0 216).

Press the CHECK button on the battery pack. An
indicator will light for approximately 3 seconds and show
the approximate remaining battery charge. > 0 ®® e e100%

0-25%

26-50%
51-75% Battery charge CHECK button
76-100% indicator

Using the DC IN 12V Terminal

When selecting commercially available AC adapters, make sure the external power source meets the following
specifications and all the safety standards of the country/region where it is used. Closely follow the
manufacturer’s instructions regarding the use and maintenance of AC adapters.

For information about the camera’s power consumption, refer to Specifications (11 242).

Power source Specifications

AC adapter

(DC IN 12V terminal) 4-pin XLR plug (female connector), 11.5Vto 20 V DC, 10 A (acceptable maximum load current)

1 Turn off the camera.

2 Connect the AC adapter’s 4-pin XLR connector to ——e=sn POWER
the camera’s DC IN 12V terminal.

@ vPoRTANT

e Make sure to turn off the camera before connecting or
disconnecting an external power source to/from the
camera’s DC IN 12V terminal.

Checking the Power Supply Levels

You can check the voltage level of an AC adapter on the screen ([J1 55). You can use the MENU > [ System
Setup] > [DC IN Warning (V)] setting to set a critical power level for the AC adapter. When the power input to the
camera reaches the predetermined level, the onscreen power indicator will change to red and an error message
will appear.



Preparing the Power Supply

(i) NoTES

¢ If the power supplied to the camera is at or below the level set for the power level warning (11 209), the
camera will not start recording. If the power supply’s voltage falls below the level necessary to operate the
28 camera while recording, recording will stop and the camera will turn off.



Preparing the Handle Unit and LCD Monitor

Preparing the Handle Unit and LCD Monitor

The LCD screen is necessary to complete the initial setup of the camera, so how to attach the supplied handle
and LCD monitor will be explained in this section. To learn more about using other optional and supplied
accessories, refer to Preparing Other Accessories (11 40) and to the Cinema EOS System Expansion User
Guide (PDF file), available for download from your local Canon website.

Attaching the Handle Unit

1 Slide the mounting base at the bottom of the handle unit into
the camera’s top accessory shoe and gently push it all the way
forward.

2 Tighten the locking knob to firmly secure the handle in place.

(i) NoTES

e The handle unit has 0.64 cm (1/4") sockets, giving you the option to
attach a variety of commercially available accessories.

e |f you plan to attach to the handle unit multiple heavy accessories
(optional or commercially available), reinforce the handle using a
0.64 cm, 1/4" hex socket head bolt (supplied) through the rear
mounting hole.

e |f necessary, use the supplied hex wrench for 0.64 cm, 1/4" screws to
tighten the locking knob and the rear reinforcement mounting bolt.

Attaching the LCD Monitor

Using the attachment unit, you can attach the LCD monitor to the handle unit or the camera itself.

Attaching the LCD Monitor to the Handle Unit
1 Turn off the camera.

2 On the LCD attachment unit, rotate the LCD monitor
mount in the direction of the locking knob to make the
LLCD monitor fixation bolt accessible.

3 Attach the LCD monitor to the LCD monitor mount.

e Alignthe A marks on the monitor and monitor mount. If
necessary, you can also mount the LCD monitor facing
the other way around.

e Tighten the LCD monitor fixation bolt using the supplied
hex wrench for 0.64 cm, 1/4" screws.

4 Attach the LCD attachment unit to the handle unit.
¢ Align the attachment mount on the LCD attachment unit to the handle unit’s front accessory mount.
e Tighten the locking knob firmly.

5 Rotate the LCD monitor 90 degrees toward the handle unit.

29
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Preparing the Handle Unit and LCD Monitor

6 Connect the LCD monitor to the camera’s VIDEO
terminal using the supplied UN-5 Unit Cable.
e Align the A marks on the cable’s plugs and
terminals.

7 Put the cable through the LCD attachment unit’s cable
clamp.

e |f necessary, adjust the position of the cable so that it
does not get in the picture or obstruct the view.

(i) NoTES

¢ Depending on the situation, the screws may become
loose. If necessary, use the supplied hex wrench for
0.64 cm, 1/4" screws to tighten them.

Attaching the LCD Monitor to the Camera

For this procedure, left and right directions are given as seen from the front of the camera (user facing the lens

mount).
1 Turn off the camera.
e |f the handle unit is attached to the camera, remove it.

2 On the LCD attachment unit, remove the base 2 fixation
bolt to separate base 1 from base 2.
e Use the supplied hex wrench for 0.64 cm, 1/4" screws.
3 Attach the LCD attachment unit’'s base 2 to the camera’s
top accessory mount so the pivots are on the right side.
® Use the same hex wrench and bolt to secure it firmly.
4 Rotate pivot B 90 degrees toward the back of the camera
(the side with the battery compartment) and rotate the
LCD monitor mount 180 degrees to the right.
5 Attach the LCD monitor to the LCD monitor mount.
¢ Align the A marks on the monitor and monitor mount.
¢ Tighten the LCD monitor fixation bolt using the
supplied hex wrench for 0.64 cm, 1/4" screws.

6 Rotate the LCD monitor 90 degrees right and then
90 degrees down so it is vertical and facing the back of
the camera.




Preparing the Handle Unit and LCD Monitor

7 Connect the LCD monitor to the camera’s VIDEO
terminal using the supplied UN-5 Unit Cable.
e Align the A marks on the cable’s plugs and
terminals.
e |f necessary, adjust the position of the cable so that it
does not get in the picture or obstruct the view.

(i) NoTES

¢ Depending on the situation, the screws may become
loose. If necessary, use the supplied hex wrench for
0.64 cm, 1/4" screws to tighten them.

Adjusting the LCD Monitor

The LCD attachment unit’s various pivots allow you to rotate the position of the LCD monitor in a number of
ways to match your shooting style. The following are suggested positions, assuming the user is behind the
camera and can see the LCD monitor and the subject.

LCD monitor mounted on the handle unit LCD monitor mounted on the camera

31
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Preparing the Handle Unit and LCD Monitor

(i) NoTES

¢ Based on the LCD monitor’s position, you can invert the image displayed on the screen. Repeatedly pressing
the MIRROR button will change the displayed image in the following order: Image inverted horizontally >
Image inverted vertically - Image inverted horizontally and vertically - Original image.

e You can adjust the brightness, contrast, color saturation, sharpness and luminance of the LCD screen with the
respective settings in the MENU > [[E=)) Monitoring Setup] menu ([11 201). These settings do not affect the
recorded video.

¢ In CAMERA mode, you can use the MENU > [(Z)) Monitoring Setup] > [B&W Image: VIDEO Term.] setting to
change the LCD monitor to black and white display. Even when the captured image is displayed in black and
white, onscreen displays and icons will be shown in color.

e You can use the MENU > [ System Setup] > [Touch Screen Response] setting to adjust the LCD monitor’s
response to touch input.

Removing the LCD Monitor and LCD Attachment Unit

1 Turn off the camera.

2 Disconnect the unit cable from the camera’s and
monitor’s VIDEO terminals.
¢ Pull back the metallic tip of the plug and then
disconnect the cable from the terminal.

3 Loosen the locking knob and remove the LCD
attachment unit and monitor.

@ vroRTANT

¢ Be careful not to drop the camera when attaching or
removing the LCD monitor.

(i) notes

e |f the LCD attachment unit’s locking knob was fastened
very tight, you may need to use the supplied hex wrench
for 0.64 cm, 1/4" screws to loosen it.




Date, Time and Language Settings

Date, Time and Language Settings

Setting the Date and Time
You will need to set the date and time on the camera before you can start using it. The [Date/Time] screen wiill
appear automatically when the camera’s clock is not set.

Date/Time

I
UTC-05:00 Jan .
i, 4

New York

1 Select the desired time zone and move to the next field.
e Joystick: Push the joystick up/down to make the selection and then press SET (press the joystick itself).
Dial: Turn the SELECT dial to make the selection and then press the SET button.
e You can also push the joystick left/right to move between the fields.
¢ The default time zone is [UTC-05:00] (New York) or [UTC+01:00] (Central Europe), depending on the
country/region of purchase. Time zones are based on Coordinated Universal Time (UTC).
2 Change the rest of the fields in the same way.

3 Select [Set] and then press SET.

(i) NoTES

e You can display the date/time with the MENU > [[Z)) Monitoring Setup] > [Custom Display 2] (CAMERA
mode) or [Custom Display] (MEDIA mode) > [Date/Time] setting.

¢ With the following settings, you can change the time zone, date and time also after the initial setup. You can
also change the date format and clock format (12 or 24 hours).
- MENU > [¥ System Setup] > [Time Zone], [Date/Time] and [Date Format]

¢ \When you do not use the camera for about 3 months, the built-in backup battery may be depleted completely
and the date and time setting may be lost. In such case, recharge the built-in backup battery (11 235) and set
the time zone, date and time again.

e Using the optional GP-E2 GPS Receiver, you can have the camera adjust settings automatically according to
the UTC date/time information received from the GPS signal (1] 209).

Changing the Language

The camera’s default language is English. You can change it to German, Spanish, French, Italian, Polish,
Portuguese, Russian, Ukrainian, Simplified Chinese, Korean or Japanese. Please note that some settings and
screens will be displayed in English, regardless of the language setting.

Refer to Selecting an Option from the Menu (11 34) for details on how to navigate the menu to complete this
procedure.

1 Select MENU > [¥ System Setup] > [Language &3 ].
2 Select the desired language and press the MENU button to close the menu.
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Using the Menus

Using the Menus

Many of the camera’s functions can be adjusted from the menu that opens after pressing the MENU button. In
CAMERA mode, you can also register frequently used menu settings in a customized menu (My Menu) for easy
34  access. For details about the available menu options and settings, refer to Menu Options (1 197).

)
MENU/—— MENU button
@ — Joystick
/— Joystick
..
CAN@- ——— CANCEL button
—— MENU button
CANCEL button
SET button
Press the SET button (in the manual,
SELECT dial/SET button “press SET”) to confirm a selection.
Joystick SELECT Qial
Turn the dial to move the orange
selection frame in the menu or to browse
quickly through a long list of options.
CANCEL button
Press to return to the previous menu/
Joystick/SET button submenu level or to stop some

When making a menu selection, push
the joystick to move the orange selection
frame in the menu. Then, press the MENU button

joystick itself (in the manual, “press SET”) Press the button to open the setup

to select the menu item indicated by the menus and then press again to close the
orange selection frame. menu after adjusting desired settings.

operations that are in progress.

Selecting an Option from the Menu

The following is a step-by-step explanation of how to select a typical option from the setup menus. Some menu
items may require additional steps. Such operations will be explained in the respective section of the manual.
For brevity's sake, references to menu settings throughout the manual will be abbreviated as follows:

MENU > [& System Setup] > [Language &3 ] > Desired option

1 Press the MENU button.
¢ The menu opens with the orange selection frame indicating the menu item that was selected the previous
time the menu was closed (unless the camera was turned off).
2 Push the joystick left/right or turn the SELECT dial to select the icon of the desired setup menu.
¢ In the example, the & icon, corresponding to the [System Setup] menu.

¢ |f one of the icons in the top row is not selected when you open the menu, first push the joystick up or press
the CANCEL button to move the orange selection frame to one of the icons.



Using the Menus

3 Press SET (press the SET button or press the joystick itself).
e You can also push the joystick down to move the cursor to the list of menu items.

4 Select the desired menu item ([Language &3], in the example) and then press SET.

e Joystick: Push the joystick up/down to select a menu item in the current page, or left/right to scroll through
the menu pages.
Dial: Turning the SELECT dial will scroll through all the menu items and all the menu pages consecutively.

5 Push the joystick up/down or turn the SELECT dial to select the desired setting option and then
press SET.
e The currently selected option is indicated with a b mark.
¢ \When many options are available, a scroll bar will appear on the right. Scroll up or down to see other
options.
e Press the CANCEL button instead to return to the menu page without changing the setting. In submenus,
you can also select [H] and press SET to return to the previous menu level.

6 Press the MENU button to close the menu.

(i) NoTES

¢ Unavailable items may appear grayed out.
¢ Pressing the MENU button at any time closes the menu.

» On some screens, the following icons may be displayed as a guide: (SET), MENU), GNCED . They refer, respectively,
to pressing the joystick or SET button, the MENU button and the CANCEL button.

¢ \When an optional RC-V100 Remote Controller is connected to the camera, you can use the remote
controller’'s up/down/left/right/SET buttons in the same way as the camera’s joystick. Pressing the SET button
is equivalent to pressing the joystick on the camera.

¢ You can check most of the current settings on the status screens (1] 211).

Using the Customized Menus (My Menu)

In CAMERA mode, you can register up to 6 frequently used menu settings under a My Menu page for easy
access. You can save up to 5 separate sets of My Menu settings so you can customize different options for
different shooting situations. Furthermore, if you set an assignable button to [My Menu] (11 129), you can press
the button to access your registered menu settings even faster and more easily.

Selecting a My Menu Set

Select MENU > [% My Menu] > Desired menu page.

e Each My Menu set corresponds to a separate menu page ([1] to [5]). Select the page of the My Menu set you
wish to use.

Adding Menu Settings
1 Select MENU > [ My Menu] > [Edit] > [Register].
e A screen will appear where you can select the menu setting you want to add.
e Press the CANCEL button to cancel the operation and return to the regular menu.
2 Select the menu setting you want to add.
3 Select [OK] twice.
e The menu setting you registered will now appear under the currently selected My Menu set.
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Using the Menus

Rearranging Menu Settings
1 Select MENU > [% My Menu] > [Edit] > [Move].
2 Select the menu setting you want to move.
e The & icon will appear next to the setting you selected to move.
3 Move the menu setting to the desired position and press SET.

Removing Menu Settings

1 Select MENU > [% My Menu] > [Edit] > [Deletel.
2 Select the menu setting you want to remove.

3 Select [OK] twice.

Resetting All the My Menu Sets

Reset all the menu settings registered to the currently selected My Menu set.
1 Select MENU > [% My Menu] > [Edit] > [Reset All].

2 Select [OK] twice.

Renaming My Menu Sets

You can give each of the 5 My Menu sets a more descriptive name to make them easier to identify.
1 Select MENU > [% My Menu] > [Edit] > [Rename].

2 Enter the desired name (8 characters long) using the keyboard screen (see the following sidebar).

Using the keyboard screen
1 Select a character and press SET to add it to the text.

e Select the arrows (1/1/+/—) to move the cursor and the
backspace character (€3) to delete the last character entered.

* Repeat this step as necessary to enter the desired text.
® Depending on the menu setting, not all characters may be
available. |_

2 After entering the desired text, select [OK] to confirm the text and
close the keyboard screen.

¢ Press the CANCEL button instead to close the screen without making any changes.

- Current character / Character limit
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Preparing the Lens

As much as possible, attach and remove the lens quickly and in a clean environment free of dust. Refer also to
the instruction manual of the lens used.

@ vrorTANT

¢ \When attaching/removing a lens, avoid direct sunlight or strong light sources. Also, be careful not to drop the
camera or lens.

(1) NoTES

¢ After removing a lens/When a lens is not attached to the camera:
- Do not touch the lens’s surfaces, the lens mount or any components inside the lens mount area.
- Place the body cap back on the lens mount and the dust caps on the lens. Clean any dust or dirt from the
body cap and dust caps before using them.

Attaching an EF Lens
1 Turn off the camera.

2 Remove the body cap from the camera and the dust
caps from the lens.

3 Attach the lens to the camera and turn the lens in the
direction of the arrow until it clicks in place.
e EF lenses: Align the red mark on the lens with the red EF
lens mount index mark on the camera.
e EF-S lenses: Align the white mark on the lens with the
white EF-S lens mount index mark on the camera.

Removing an EF Lens
1 Turn off the camera.

2 Hold down the lens release button and turn the lens all the
way in the direction of the arrow until it stops.

3 Remove the lens.

4 Place the body cap back on the lens mount and the dust
caps on the lens.

(1) NoTES

¢ Turning on the image stabilization function of an EF lens may reduce the effective usage time of the battery
pack. When image stabilization is not necessary, for example if the camera is fixed to a tripod, it is
recommended to turn it off.

¢ Depending on the lens used, you may experience one or more of the following limitations.
- The lens model name may be shortened when displayed on the screen.



38

Preparing the Lens

- You may not be able to focus manually when the focus mode switch is set to AF.
- You may not be able to use the focus preset function on super telephoto lenses.
- You may not be able to use the power zoom function on lenses with that function.

e This camera’s sensor is larger than the sensor size for which EF-S lenses are designed (APS-C). When using
EF-S lenses with this camera, you may notice peripheral illumination fall-off or vignetting.

* When using a compatible lens, you can use the MENU > [§ System Setup] > [Retract Lens] setting to retract
the lens automatically when the camera’s power is turned off with the focus mode set to AF.

¢ You can attach a B4 (broadcast) lens to the camera using the optional M0-4E or M0-4P B4 Mount Adapter. For details

refer to the Cinema EOS System Expansion User Guide.

- When using a B4 mount adapter, make sure to set MENU > [£% Recording/Media Setup] > [Sensor Mode]
to [Super 16mm (Cropped)] and MENU > ["™ Camera Setup] > [Mount Adapter] to [MO-4E] or [MO-4P].

- When alens’s 12-pin interface cable is connected to the LENS terminal of an optional EU-V2 Expansion Unit
2 or EU-V3 Expansion Unit 3 with a commercially available V-mount battery attached, you will be able to
zoom and use the push auto iris function from the camera.

- When using a B4 lens compatible with the L.C.A.C. (automatic lens chromatic aberration correction)
function, if the 12-pin interface cable is connected, the lens’s chromatic aberration can be corrected. In such
case, will appear on the left of the screen, next to the mount adapter’s icon.

Updating the Firmware of an EF Lens

You can update the lens firmware of the EF lens attached to the camera. For details about firmware updates for
EF lenses, visit your local Canon website.

1 Download the lens firmware update file from the Canon website and save it on an SD card. Insert the
SD card containing the lens firmware update into the camera ([11] 45).

2 Attach the lens you want to update and turn on the camera in CAMERA mode.
3 Select MENU > [¥ System Setup] > [Firmware] > [Lens].
e The current lens firmware version will appear on the screen.

e If the [Lens] option is grayed out, the attached lens may not support firmware updates or the SD card used
may not contain a valid lens firmware file. Check the lens and SD card and repeat the procedure from the
beginning.

4 Select [OK].
5 Select the lens firmware file (.LFU file).

6 Select [OK].
¢ The lens firmware will be updated. Once in progress, the lens firmware update cannot be canceled.

7 When the confirmation message appears, press SET.

@ vroRTANT
¢ Be sure to observe the following precautions while the lens firmware is being updated.
- Do not turn off the camera and do not remove the battery pack or other power source.
- Do not remove the lens.
- Do not operate any buttons or controls on the camera.
- Do not open the card compartment cover and do not remove the SD card.

(i) notes

¢ The lens firmware cannot be updated while pre-recording is activated.
e Power the camera using an AC adapter or a sufficiently charged battery pack.
¢ When using an optional EF extender, remove the extender before performing the procedure.
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In-Camera Lens Correction

Depending on the characteristics of the lens used, the corners of an image frame may be darker than the center
due to light fall-off (peripheral illumination drop), color shift/color fringing may be visible along high-contrast
edges in the image (chromatic aberration), or the image produced may not be as sharp at certain apertures (lens
diffraction). In CAMERA mode, you can apply a correction to compensate as necessary. To apply peripheral
illumination or chromatic aberration correction, correction data for the lens used is necessary. Automatic
chromatic aberration correction is available for broadcast lenses compatible with L.C.A.C.

Chromatic aberration and diffraction correction are not applied to RAW recordings but will be applied to proxy
clips recorded simultaneously with RAW clips.

1 Attach the lens you want to use and turn on the camera in CAMERA mode.

2 Select MENU > ["™ Camera Setup] > [Periph. lllum. Corr.], [Chromatic Aberr. Corr.] or [Diffraction

Correction].

e |f correction data is not available, [Periph. lllum. Corr.] or [Chromatic Aberr. Corr.] will appear grayed out. Visit
your local Canon website and check if there is correction data available for the lens you are using. If so,
download the necessary update package, update the camera’s firmware version and repeat the procedure
from the beginning.

3 Select [On].
* The camera will apply the correction for the attached lens to all future recordings.

(i) NoTES

¢ About in-camera lens correction data: The camera contains a register of correction data for compatible lenses
that were available at the time the camera went on sale. Correction data for future lenses will be made
available as part of the regular updates released for the camera’s firmware. For more details, visit your local
Canon website.
e Peripheral illumination/chromatic aberration correction cannot be applied in the following cases:
- When the appropriate correction data is not available for the lens attached.
- When using non-Canon lenses. Even if the corresponding menu setting is available (not grayed out), setting
it to [Off] is recommended.
¢ Diffraction correction cannot be applied when the camera cannot obtain the current aperture value of the lens.
e When peripheral illumination/diffraction correction is activated:
- Depending on the recording conditions, noise may appear in parts of the image.
- The level of correction will be lower for lenses that cannot provide distance information.
- The level of correction will be lower the higher the ISO speed/gain setting used.
- When using EF-S lenses, peripheral illumination fall-off may be more pronounced.
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Preparing Other Accessories

Preparing Other Accessories

Your camera is incredibly versatile and allows you to build the shooting configuration that best fits your needs
and shooting conditions. In addition to the supplied accessories, Canon offers a variety of optional accessories
that expand the functionality of the camera ([J] 237). For details about accessories compatible with this camera,
please download the Cinema EOS System Expansion User Guide (PDF file), available from your local Canon
website.

How to attach and adjust the LCD monitor and handle was already explained in a previous section ([11 29). This
section will cover other supplied accessories such as the camera grip and microphone holder.

Examples of Camera Configurations

LM-V2 LCD Monitor

&0
{

S
=7
> ) [ &Y
GR-V1 Camera — @@ 4—|
Grip Unit T peg

LA-V2 LCD Attachment Unit

@ Handle unit

Thumb rest

Microphone holder

Configuration with LCD monitor, Configuration with Light configuration with grip Minimal configuration
grip and handle LCD monitor and grip for hand-held shooting with thumb rest
@ PoRTANT

e Be careful not to drop the camera or accessories when attaching, removing or adjusting the various
accessories. Use a table or other stable surface to change the camera’s configuration.
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Removing and Attaching the Camera Grip

The camera grip comes originally attached to the camera. You can remove it and replace it with the thumb rest
when a minimal configuration is necessary.
41

Removing the Camera Grip
1 Turn off the camera.

2 Unscrew the camera grip’s locking screw and gently
detach the grip.
e The camera grip contains an internal connection cable
so be sure not to pull it too forcefully.
3 Remove the grip attachment ring and disconnect the
camera grip’s connection plug.

® You can attach the grip attachment ring to the
connection cable so that you do not lose it.

W

4 Screw the thumb rest onto the camera.

Attaching the Camera Grip

The camera grip can be attached in a number of positions
from 90° toward the lens to 60° toward the back at 6°
intervals.

1 Turn off the camera.

2 Unscrew the thumb rest and remove it from the camera.

3 Lay the camera on a flat, stable surface with the rosette
facing up.

4 Firmly insert the camera grip’s connection plug all the
way into the GRIP terminal on the camera.

e Make sure to insert the plug all the way in, until the
terminal is not visible.

e |f the plug is not correctly connected, all the controls
on the camera may be disabled ([I] 221).

5 Attach the grip attachment ring.
6 Return the camera to an upright position.

7 Attach the camera grip to the camera aligning it at the
desired angle and tighten the camera grip’s locking
Screw.

60° back 0° 90° forward
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Attaching the Microphone Holder
1 Attach the microphone holder to the LCD attachment unit.

2 Use a commercially available Phillips head (“crosshead”)
42 screwdriver to secure it firmly with the supplied M4 bolts.
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Preparing Recording Media

The camera records clips1 on CFexpress or SD cards? and photos on SD cards. The camera has two

CFexpress card slots and you can use two cards (in the manual, “CFexpress A” and “CFexpress B”) to record on

both simultaneously or to automatically switch to the other card when the card in use is full (1] 47). 43
Initialize cards ([J] 46) when you use them with this camera for the first time. —

1 “Primary clips” (generally speaking, deliverable files) are recorded on a CFexpress card. “Proxy clips” (smaller files, mainly
intended for offline editing) are recorded on the SD card.
2 The SD card is used also to save/read other files in addition to proxy files.

Compatible Recording Media

The following types of memory card can be used with this camera. For the latest information about recording
media tested for use with this camera, visit your local Canon website.

CFexpress cards
CFexpress cards compliant with CFexpress 2.0 Type B specifications.

However, it may not be possible to record on the card depending on the camera mode and bit rate used. For
details about CFexpress cards tested for use with this camera, visit your local Canon website.

SD cards'
SD card type: S>> §(g
SD cards SDHC cards SDXC cards
SD Speed Class®: CLASS@ CLASS@
UHS Speed Class® 3: w ]|
Speed Class U1 Speed Class U3

1" As of April 2020, the clip recording function has been tested using SD cards made by Panasonic, Toshiba and SanDisk.
2 UHS and SD Speed Class are standards that indicate the minimum guaranteed data transfer rate of SD cards.
Using an SD card rated UHS Speed Class U3 is recommended to record using slow motion recording.

@ vrorTANT

e CFexpress cards can become hot due to the high operating temperature inside the camera. Removing a
CFexpress card immediately after using it for recording may cause burns or cause you to drop the card,
resulting in damage to the card.

o After repeatedly recording, deleting and editing clips (if the memory is fragmented), you may notice slower
writing speeds to the card and recording may even stop. In such case, save your recordings and initialize the
card with the camera. Be sure to initialize cards especially before shooting important scenes.

¢ About CFexpress and SDXC cards: You can use CFexpress and SDXC cards with this camera but these types of
cards are initialized by the camera using the exFAT file system.

- When using exFAT-formatted cards with other devices (digital recorders, card readers, etc.), make sure that
the external device is compatible with exFAT. For more information on compatibility, contact the computer,
operating system or card manufacturer.

- If you use exFAT-formatted cards with a computer OS that is not exFAT-compatible, you may be prompted
to format the card. In such case, cancel the operation to prevent data loss.

(i) NoTES

e Proper operation cannot be guaranteed for all cards.
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Inserting a CFexpress Card

1 Slide the card compartment cover switch all the way in
the direction of the arrow.
e The card compartment cover will open to the left.

2 Insert the card straight, with the label facing the back of

the camera (the side with the battery compartment) all the
way into one of the CFexpress card slots.

* You can use two cards, one in each card slot.
3 Close the card compartment cover.

¢ Do not force the cover closed if the card is not correctly
inserted.

CFexpress card access indicators

e

©O)

CFexpress card
access indicators

CFex(;tZ:ggs {:ator ol
Red Accessing the card.
Green Recording/playback is possible and the CFexpress card is selected for recording/playback.
off A card is not inserted or the card slot is not currently selected.

If you set MENU > [¥ System Setup] > [CFexpress Access LED] to [Off], the CFexpress card access indicators

will not illuminate.

Removing a CFexpress Card

1 Wait until the CFexpress card access indicator is off or is
illuminated in green.

2 Slide the card compartment cover switch in the direction of
the arrow.
e The card compartment cover will open to the left.

3 Make sure the CFexpress card access indicator is off and
then push the CFexpress card release button.

4 Pull out the CFexpress card and close the card
compartment cover.
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Inserting and Removing an SD Card

1 Wait until the SD CARD access indicator is off or is
illuminated in green.

2 Slide the card compartment cover switch all the way in
the direction of the arrow.
e The card compartment cover will open to the left.

3 Insert the card straight, with the label facing the back
of the camera (the side with the battery compartment) SD CARD

all the way into the SD card slot until it clicks. indicator § f@ﬂﬁm\z
D <

* To remove the card, make sure the SD CARD indicator is
off and then push the card once to release it. When the >

—
card springs out, pull it all the way out. = w
q
4 Close the card compartment cover. D J@ll
\_

e Do not force the cover closed if the card is not correctly

inserted.

SD CARD

T

SD card access indicator

SD CARD indicator
Red

SD card status
Accessing the card.

Green

CAMERA mode: Proxy clip recording is activated and the card is ready for recording.
MEDIA mode: Playback from the card is possible.

Off

e Acard is not inserted in the camera or the card is write-protected.
e CAMERA mode only: A card is inserted but proxy clip recording is not activated.

If you set MENU > [¥ System Setup] > [SD Card Access LED] to [Off], the SD card access indicator will not

illuminate.

@ vPorTANT

e SD cards have front and back sides that are not interchangeable. Inserting a card facing the wrong direction
can cause a malfunction of the camera. Be sure to insert the card as shown in the illustration.
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Initializing Recording Media

Initialize cards when you use them with this camera for the first time. You can also initialize a card to permanently
delete all the recordings it contains.

1 Select MENU > [£% Recording/Media Setup] > [Initialize Media].
2 Select [CFexpress A], [CFexpress B] or [SD Card].

3 Select [OK].
e The card is initialized and all the data it contains is erased.

4 When the confirmation message appears, press SET.

@ vPoRTANT

e SD cards are initialized using the FAT12 / FAT16 file system, SDHC cards using the FAT32 file system, and
SDXC and CFexpress cards using the exFAT file system.

e |nitializing a card will permanently erase all data, including photos and protected custom picture files. Lost data
cannot be recovered. Make sure you save important recordings in advance.

¢ Depending on the card, initialization may take up to a few minutes.

(i) notes

e When relay recording is activated, while you keep recording on one CFexpress card, you can initialize another
CFexpress card in the other card slot.

¢ |f you set an assignable button to [Initialize Media] ([I] 129), you can press the button to open the [Initialize
Media] submenu.

Switching Between CFexpress Card Slots

The camera features two CFexpress card slots, CFexpress and CFexpress (B]. If both slots contain a card,
you can switch between them as necessary.

Press the SLOT SELECT button.

e The access indicator of the selected CFexpress card slot will
illuminate in green. On the screen, the CFexpress card selected is
indicated with a » mark next to the card icon.

¢ You cannot use the SLOT SELECT button to switch between
CFexpress card slots while recording or playing back.

® You can also perform this function remotely using Browser Remote
on a connected network device (1] 187, 191).
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Relay Recording and Double Slot Recording

In CAMERA mode, the camera features two convenient recording methods that can be used when both
CFexpress card slots contain a card: relay recording and double slot recording.

Relay Recording

This function allows you to continue recording on the other card without interruption when the card you are using
becomes full. Relay recording is available from CFexpress card slot A to CFexpress card slot B, and vice versa.
However, relay recording is disabled (the camera will not switch to the other card) when slow & fast motion
recording is activated.

Select MENU > [£% Recording/Media Setup] > [Relay Recording] > [On].
¢ Both CFexpress card icons will turn green.

Double Slot Recording

This function records the same clip simultaneously to both cards, which is a convenient way to make a backup
copy of your recordings while you record.
This function cannot be used together with relay recording or slow & fast motion recording.

Select MENU > [£% Recording/Media Setup] > [Double Slot Recording] > [On].
e [ appears at the top of the screen and both CFexpress card icons turn green.

(i) NoTES

e |f a card becomes full during double slot recording, recording on both cards will stop. On the other hand, if an
error occurs with one of the cards, recording will continue on the other card.

¢ \When using network functions, relay recording and double slot recording will be disabled while a connection
setting (SET file) is selected and the camera is connected to a network.

¢ Relay recording cannot be used when the main recording format is RAW HQ/RAW ST/RAW LT.

¢ You can select whether to use the same name or a different name for the file recorded to each media in
MENU > [E% Recording/Media Setup] > [Double Slot Recording].

Checking the Remaining Recording Time on a Card

In CAMERA mode, the display on the upper left of the screen shows the card icons and the remaining recording
time* (in minutes) on each card (11 54).

Onthe [£® Recording/Media Setup] status screen ([J1 217), you can check the total space, used space and
approximate remaining recording time* of each card. For the SD card only, the approximate remaining number of
photos and speed class will be displayed as well.

* Remaining recording times are approximate and calculated based on the current video configuration used.
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Recovering Clips

Some actions, such as suddenly turning off the camera or removing the card while data is being recorded, can
cause data errors in the recorded clip. In MEDIA mode, you may be able to recover clips with corrupted data
using the following procedure.

1 Set the camera to MEDIA mode and open the index screen with the clip you wish to recover
(13 143).

2 Select the desired clip (a clip with the 2 icon instead of a thumbnail image).

3 Press SET to open the clip menu and select [Recover Clip] > [OK].
e The camera will attempt to recover the corrupted data.

4 When the confirmation message appears, press SET.

(i) notes

¢ In the [RAW] index screen, recovered clips appear with a B> icon instead of the usual thumbnail.
¢ This procedure may delete clips shorter than 0.5 seconds in length.

® |n some cases, it may not be possible to recover the data. This is more likely when the file system is corrupted
or the card is physically damaged.

¢ Only clips recorded with this camera can be recovered. Photos cannot be recovered.
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Adjusting the Black Balance

In CAMERA mode, you can have the camera adjust the black balance automatically when ambient temperature
changes considerably or if there is a noticeable change in a true black video signal.

1 Attach the body cap to the lens mount and set the camera to CAMERA mode.

e |f alens was attached, turn off the camera and remove the lens. Place the body cap back on the lens mount
and turn on the camera.

2 Select MENU > ["™ Camera Setup] > [ABB] > [OK].
¢ The automatic black balance procedure will start. It may take about 1 minute depending on the frame rate.

3 When the confirmation message appears, press SET.

e [f the sensor is not completely shielded from light, [Error] will appear on the screen. Repeat the procedure
from the beginning.

(1) NoTES

¢ Adjusting the black balance is necessary in the following cases:
- When using the camera for the very first time or after a long period of not using it.
- After sudden or extreme changes in ambient temperature.
- After changing the sensor mode.
- After activating or deactivating slow & fast motion recording (including switching to another special recording
mode).
- After changing the shooting frame rate, when slow & fast motion recording is activated.
- After resetting the camera’s settings.
¢ During the adjustment of the black balance, you may notice some irregular displays appear on the screen. This
is not a malfunction.
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Recording Video and Photos

This section explains the basics of recording clips* and photos. For details on recording audio, refer to Recording
Audio ([1] 105).

* “Clip” refers to a single movie unit recorded with a single recording operation. You can also include metadata with the clip.

Recording

Power indicator/
rear tally lamp Front tally lamp

SD card access
indicator

a GO

CAMERA./

CFexpress card
access indicators

1 Set the switch to CAMERA.
e The camera turns on in CAMERA mode and enters record standby mode ([STBY]).
e The power indicator (rear tally lamp) will illuminate in green.
e The access indicators of card slots with a card inserted will illuminate momentarily in red. Then, the access
indicators of cards selected for recording will change to green.

2 Press the REC button to begin recording.

¢ Recording starts. The tally lamps illuminate in red (the rear tally lamp changes from green (power indicator) to
red) and the recording indicator at the top of the screen changes from [STBY] to [@ REC].

e The access indicator of cards used for recording will iluminate in red.

¢ You can use the REC button on the camera or the one on the camera grip.

¢ You can also perform this function remotely using Browser Remote on a connected network device (11 187,
191).

e For details about recording proxy clips, refer to Proxy Cljps (Simultaneous Recording) (11 69).

3 Press the REC button to stop recording.

e The clip is recorded and the camera enters record standby mode. The front tally lamp goes out and the rear
tally lamp changes from red to green (power indicator).
e The access indicator of cards selected for recording will change back to green.
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To take photos
In CAMERA mode, you can take photos using an assignable button. Photos are saved onto the SD card and
their size depends on the sensor mode ([ 62) in use. For details, refer to Specifications (11 241).
1 Set an assignable button to [Photo] (1] 129).
2 When the camera is in record standby mode, press the assignable button.
° ) appears at the top right of the screen and the photo is recorded on the SD card.
e The SD CARD access indicator will illuminate in red.

@ vPoRTANT

e Be sure to save your recordings regularly, especially after making important recordings. Canon shall not be
liable for any loss or corruption of data.

(i) NoTES

¢ You can use the review function (I 119) to play back part or all of the last clip recorded without having to
switch to MEDIA mode.

e |f you record using metadata settings, those settings will be recorded with the clip. For more details, refer to
Using Metadiata (11 117).

e |f the camera switches to the other CFexpress card while recording video due to the relay recording function
(11 47), the two parts (before/after the switch) will be recorded as separate clips.

e A single XF-AVC clip can be recorded continuously for up to 6 hours. At that point, a new clip will be created
automatically and recording will continue on a separate clip.

¢ If you set MENU > [¥ System Setup] > [Tally Lamp Settings] to other than [REC], the tally lamp lights when
the tally information for PGM is input.

¢ To record photos, make sure the SD card is not write-protected.

® Photos cannot be recorded in the following cases.
- While recording video.

When slow & fast motion recording is activated.

When the main clip is in RAW format and the resolution is set to [4192x3140 (4:3)] or [3768x3140 (6:5)].

- When pre-recording is activated.

While color bars are displayed.

While Browser Remote is activated.
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Onscreen Displays

Refer to this section for an explanation of the various screen displays that appear in CAMERA mode. You can

use the custom display function (11 203) to turn off individual onscreen displays if they are not required. The

menu item that controls each display is given in the following tables (1: indicates a menu item under [Custom 53
Display 1] and 2: indicates a menu item under [Custom Display 2]).

The position of some icons and onscreen displays may change depending on the display level settings. The
following screenshot and tables describe the onscreen displays at display level 1 with the [All Displays] setting

([57).

= 120/59.94P @0 2
DCINT7.0V

2022.7.22
A123C456 202207 22 -p————T———1+AE+0.25 PM 12:00
@ =B 15000K +20CC ND2stops B@F1.8 1S0800 1/60 CH1+3/CH2+4

AF frames
Depending on the focus function used you may see some of the following AF frames. You can also hide them
with the MENU > [[E) Monitoring Setup] > [Custom Display 1] > [Focus Mode] setting.

Continuous AF frame — in white/red ([Z1 90)
AF-Boosted MF frame — in white/yellow/red ([ 89)

Face AF: Main subject ([1] 92)

One-shot AF frame —

in white/green/red ([11 89) Face AF
ace AF:

Only one face detected or faces
other than the main subject

Tracking: Subject selection ([11 93)

Tracking: During tracking Focus frame with focus guide ([1] 86)
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Left side of the screen

Icon/Display Description Custom Display
0000 mm Approximate focal length of the lens. 1: [Focal Length]
(MF), Focus mode ((1 84). 1: [Focus Mode]
8 & Face AF (11 92).
B, 25+, 20, Digital tele-converter ([1] 95) 1: [Tele-converter]
(=) Image stabilization (1] 94). 1: [Digital Image
& Image stabilization disabled (the function is activated on the camera but turned off | Stabilization]
on the lens).
[R3\NY (in red) Lens error warning ([ 223). 1: [Lens]
[M0-4EMIMO-4P] B4 mount adapter. 1: [Mount Adapter]
o Available only when the optional MO-4E or MO-4P B4 Mount Adapter is
attached to the camera.
LCAC. Automatic chromatic aberration correction for a broadcast lens.
o Available only when the optional MO-4E or MO-4P B4 Mount Adapter is
attached to the camera.
[ 00 Custom picture file selected ([ 133). 1: [Custom Picture]
CL0G2), (C.LOG3), PQ), (HLG), [Gamma/Color Space] setting in the custom picture file (I 137).
([Wide DR), (NORM], (Std), [C.709],
(C.Gamut), (BT.2020], (BT:709
LOOK Look Files ([ 136)
= L Light metering mode ((Z] 80). 1: [Light Metering]
A viewing LUT has been applied to at least one display or output terminal 1: [LUT]
(3 161).
<;§> GPS signal: continuously on - satellite signal acquired; flashing - satellite signal not | 2: [GPS]
acquired.
o Displayed only when an optional GP-E2 GPS Receiver is connected to the
camera.
[ FAN | Fan operation: in white — normal ((I] 61); in red — fan warning (I3 223). 2: [Temperature/Fan]
8 Temperature warning (1] 61).
e When the camera internal temperature rises above a certain level, & will
appear in yellow. If the temperature rises further, B will appear in red.
(MEMO) User memo (1 117). 2: [User Memo]

Top of the screen

Icon/Display

Description

Recording media status, estimated remaining recording time and video format

(A, (B, / (BJ: CFexpress card (primary clips); (s2): SD card (proxy clips).

000 min The card’s status is indicated by the icon’s color: in green — can record; in yellow —
card almost full (5 minutes or less); in red — card almost full (less than 1 minute); in
white — reading the card.

o The CFexpress card selected for recording is indicated with a b mark.

(A], (B], (in red) END | Card is full.

3

, [B®, 5% (in red)

No card or cannot record on the card.

[RAW BIXF-AVC
m 8

Remote S FTP Pld 4

)

8o

=

Video format ([ 62).
Network connection status (1 183).

Custom Display
2: [Remaining Rec Time]

2: [Network Functions]
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Icon/Display Description Custom Display
D]} Double slot recording ([J1 47). 2: [Recording Mode]
Recording operation
STBY, @ REC Clip recording: record standby, recording.
S&F STBY, Slow & fast motion recording ([ 120): record standby, recording.
S&F @ REC
PRE STBY, Pre-recording ([0 122): record standby, recording.
PRE @ REC
REC#, STBY ® Recording command ([ 156, 157). 2: [Rec Command(EXT
EXT REC#, EXT STBY ® "EXT" is displayed when there is no recording media. REC)]
00.00P, 00.00i Frame rate ((1 63). 2: [Frame Rate]
When slow & fast motion recording is activated, the shooting frame rate is also
displayed (000/00.00P).
Gen. Genlock ([1 103). 2: [Genlock]
¢ Displayed only when an expansion unit is attached to the camera.
00:00:00.00 / 00:00:00:00 Time code ([I] 99). 2: [Time Code]
R, PFE Time code status ((Z1 100).
Power supply level indicator 2: [Remaining Battery]
— o - Remaining battery charge of a BP-A60 (supplied) or BP-A30 (optional) Battery Pack
o - 4 - and estimated remaining usage time (in minutes).
(in red) e When is displayed, replace the battery pack with a fully charged one.
000 min « Depending on the conditions of use, the actual battery charge level may not be
indicated accurately or may not match the levels shown on the [§ System
Setup] status screen or the indicators on the battery pack.
DC IN 00.0V Power supply voltage when using an AC adapter.
¢ When the voltage falls below the selected low-power warning level (11 209),
the voltage will be displayed in red.
— ] - Remaining battery charge of a commercially available V-mount battery.

o1 — {1 000%,
(=] 00.0V

e Displayed only when an optional EU-V2 Expansion Unit 2 or EU-V3 Expansion
Unit 3 is attached to the camera.

¢ Depending on the battery used, the battery charge level cannot be indicated as
a percentage. In that case, the voltage will be displayed instead.

¢ When the power level falls below the selected low-power warning level
(12 209), the percentage or voltage will be displayed in red.

Right side of the screen

Icon/Display

(Full) ((GNTAD only),
[Super35],

Description
Sensor mode ([] 62).

Custom Display
2: [Sensor Mode]

60(24)fps, 60(30)fps

Output Terminals Status (11 129).

2: [Output Terminals
Status]

0000x0000 Resolution ([ 62). 2: [Resolution/
00 bit, Color depth, color sampling, RAW mode (1] 62). Color Sampling]
YCC422 00 bit, * Displayed as “00 bit 4:3” when the resolution is set to [4192x3140 (4:3)], and

HQ / ST/ LT 12 bit as “00 bit 6:5” when set to [3768x3140 (6:5)].

((EIRNITAD only)

» Photo recorded on the SD card ([ 52). 2: [Photo]

» (in red) No SD card or cannot record photos on the SD card.

Return signal input state 2: [Genlock]
RET) Displaying return video _

¢ Displayed only when an optional EU-V3 Expansion Unit 3 is attached to the
camera.
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Icon/Display Description Custom Display
MO} MON. terminal disabled / HDMI OUT terminal active ([ 156). 2: [Output Terminals
Status]
(in red) Output onscreen displays (11 158). 2: [0SD Output]
(XD (in yellow) Magnification ([ 87). 1: [Magnification]

Y0, @9 (in yellow)

Peaking ([11 87).

1: [Peaking]

LIM

Audio limiter (00 111).

Audio level meter ([T 110).

2: [Audio Level Indicator]

00, (5

Headphone volume ([] 147).

Date/time

2: [Date/Time]

Bottom and center of the screen

Icon/Display
A001C001 to Z999D999

Description

Clip identification. Includes the camera index, reel number and clip number
components of the clip file name ([ 59).

Custom Display
2: [Reel/Clip Number]

00 00 00 00 User bit (1 101). 2: [User Bit]
4 Exposure bar (1] 80). 1: [Exposure Bar]
AE +0.00 AE shift (] 80). 1: [AE Shift]

o Key lock (11 12). 1: [Key Lock]
A/ B, 6z, 38, [4, | White balance (] 81). 1: [White Balance]
AWB

00000K +00 CC

ND 00 stops ND filter (11 76). 1: [ND Filter]

[, F00.0 / T00.0, closed Aperture value (1] 77). 1: [Iris]

ISO 000000, 00.0dB IS0 speed/Gain value ([ 74). 1: [ISO/Gain]
000.00°, 1/0000.00, 000.00Hz | Shutter speed ([11 72). 1: [Shutter]
CHO/CHO, Audio output channels ([1] 165). 2: [Monitor Channels]

CHO+CHO/CHO+CHO
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Selecting the Onscreen Display Level

You can press the DISP button to change the onscreen display level and control the amount of information
shown over the image. In CAMERA mode, you can customize each display level individually.

Press the DISP button to select the desired display level.

e Repeatedly pressing the DISP button will change the display level:
Display level 1 — Display level 2 — Display level 3.

Customizing Onscreen Display Levels

In CAMERA mode, you can change the information displayed at each display level. In most cases, icons are
displayed at a smaller size. Only the [All Displays] option of display level 1 uses a larger size for onscreen
displays.

Select MENU > [[E) Monitoring Setup] > [DISP Level 1], [DISP Level 2] or [DISP Level 3] > Desired option.

Options for display level 1
[All Displays]:  All onscreen displays at a larger size.
[All Displays (Periph. Border)):
All onscreen displays at a smaller size, more appropriate for use with the peripheral border

(1 58).

Options for display level 2
[Main Recording Displays]:
Only the onscreen displays most relevant for shooting.
[Only FUNC/MENUIL:
Usually no onscreen displays except for the recording
operation (REC/STBY). When the FUNC or MENU button
is pressed, the necessary information will be displayed
temporarily (for as long as you are changing the settings).

Exampl f “
[Main Recording Displays] option
Options for display level 3
[Only REC/STBY]:
No onscreen displays except for the recording operation (REC/STBY).
[No Displays]: No onscreen displays at all.
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Peripheral Border Display

You can apply the peripheral border display to all display levels in CAMERA mode. With the peripheral border
display, the camera’s image is reduced slightly so the onscreen displays are shown mostly around it and not on
top of it, partially hiding it.

Full-screen display Peripheral border display

Select MENU > [[Z) Monitoring Setup] > [Apply Peripheral Border] > Desired option.

Options
[DISP Level 1/2/3]:
Peripheral border display is always used.

[DISP Level 1/2]:
Peripheral border display is used for display levels 1 and 2.

[DISP Level 1], [Disp Level 2], [Disp Level 3]:
Peripheral border display is used for the respective display level.
[Off]: Full-screen display is always used.

Display Levels in MEDIA Mode

In MEDIA mode, the information displayed at each display level cannot be customized and the onscreen displays
during playback ([ 146) will change as follows.

Recordings Display level 1 Display level 2 Display level 3
) Joystick guide and playback Only playback information i
Clips information about the clip about the clip No onscreen displays
Photos Photo information No onscreen displays —

(i) NoTES

e Some onscreen displays, such as video scopes, onscreen markers and AF frames will be displayed
permanently even at display level 2. Turn them off with their respective function or select display level 3.

¢ \When the zebra pattern or false color display is activated, it will appear on the screen regardless of the
selected display level.
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Setting a Card’s Volume Label

In CAMERA mode, you can set the volume label for CFexpress cards and SDXC cards used for recording, in
order to make it easier to identify and organize them later.

1 Select MENU > [£% Recording/Media Setup] > [Volume Label] > [Canon] or [Canon + Metadata).
2 Initialize the card ([1] 46).
3 If necessary, set the clip file name’s metadata elements ([I1 59).

4 Record clips on the card.

e The card’s volume label changes when the first recording is made on a just initialized card. (For SDXC cards
only when the first proxy clip is recorded.)

Options

[Canon]: The volume label of CFexpress and SDXC cards will be “CANON” regardless of the clip file name
settings.

[Canon + Metadatal:
The volume label of CFexpress and SDXC cards will be “CANONX999” where “X” represents the
camera index and “999” represents the reel number set in the clip file name’s metadata settings.

Setting the Clip File Name

The camera allows you to change several settings that determine the clip file name of recorded clips. Personalize the
clip file name according to your preferences or organizational conventions to create files that are easier to identify
and organize. This function can only be used in CAMERA mode.

The basic file name structure is as follows.

A001C001_yymmddXX_CANON_01P

1 2 3 4 5 6 7
1 Camera index: One character (A to Z) that 5 Random component: 2 characters (numbers O to
identifies the camera used. 9 and capital letters A to Z) that change randomly
2 Reel number: 3 characters (001 to 999) that with each clip.
identify the card used. The number is assigned 6 User defined field: 5 characters (numbers 0 to 9
automatically but you can set the initial number. and capital letters A to Z) for any other
After you insert a new card (just purchased or identification purposes.
initialized), the number advances by one when the 7 Proxy clips only*: The camera will automatically
first recording is made. add the suffix “_Proxy” or “_P” to the file name of
3 Clip number: 4 characters (CO01 to D999). The proxy clips ([Z1 60). Additionally, when an SD or
clip number advances automatically with each SDHC card is used to record proxy clips, a
clip recorded (switching to D001 after C999), but stream number (01 to 99) will be added before
you can set the initial clip number and select the “_Proxy” or “P”. The stream number will advance
clip numbering method. every time the video (stream) file within the clip is
4 Recording date (set automatically by the camera). split and recording continues on a separate
stream file.

* Apart from this component, the file name of the primary clip (RAW or XF-AVC) and the proxy clip (XF-AVC) will be identical.
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Setting the Components of the Clip File Name

To set the camera index
1 Select MENU > [ £% Recording/Media Setup] > [Metadata] > [Camera Index].
2 Select the desired camera index and then select [Set].

To set the clip numbering method

Select MENU > [£% Recording/Media Setup] > [Metadata] > [Clip Numbering] > [Reset] or
[Continuous].

Options
[Reset]: The clip number will restart from 001 every time you insert a new card.

[Continuous]:  Clip numbers will start from the initial number set with [Clip Number] (following procedure) and
continue across multiple cards.

To set the reel number or initial clip number
The initial clip number can only be set when [Clip Numbering] is set to [Continuous].

1 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Reel Number] or [Clip Number] > [Change].
e To reset the reel/clip number to [001], select [Reset] instead.
2 Enter the reel/clip number using the data entry screen ([1] 60).

To set the user-defined field
1 Select MENU > [£® Recording/Media Setup] > [Metadata] > [User Defined] > [Change].
e To reset the user-defined field to [CANON], select [Reset] instead.
2 Enter the desired text string using the data entry screen ([11 60).
To set the file naming method for proxy clips
Select the string to be added automatically to the end of the file name for proxy clips.
Select MENU > [£% Recording/Media Setup] > [Metadata] > [Stream Number/Proxy] > [01_Proxy] or [_01P].

Using the data entry screen
1 Select the first character or digit and then press SET to move to the
next.

e You can also push the joystick left/right to move between the
fields.

e Change the rest of the characters/digits in the same way.

2 Select [Set] to confirm the text or value and close the data entry
screen.
¢ Press the CANCEL button instead to close the screen without
making any changes.
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Using the Fan

The camera uses a cooling fan to lower the camera’s internal temperature. In CAMERA mode, you can change
the fan’s operation mode and speed. In MEDIA mode, the fan runs at all times but you can select its speed.

Setting the Fan’s Operation in CAMERA Mode
1 Select MENU > [¥ System Setup] > [Fan Mode] > Desired option.

If you selected [Always On]
2 Select MENU > [¥ System Setup] > [Fan Speed (Always)] > Desired fan speed.

If you selected [Automatic]
2 Select MENU > [¥ System Setup] > [Fan Speed (STBY)] > Desired fan speed in record standby mode.
3 Select MENU > [ System Setup] > [Fan Speed (REC)] > Desired fan speed while recording.

¢ The [Maximum] option offers the maximum cooling effect but is available only for [Fan Speed (STBY)], as it is
noisier.

Options for [Fan Mode]

[Automatic]: The fan runs while the camera is not recording and is automatically turned off while the camera
is recording. However, if the internal temperature of the camera is too high (B8 appears in red),
the fan will be activated automatically (in that case, IEX will appear next to the E@ icon). When
the camera’s temperature has decreased sufficiently, the fan will be turned off. Use this setting
when you do not want the camera to pick up the fan’s operating sound.

[Always On]:  The fan runs at all times.

Setting the Fan Speed in MEDIA Mode
1 Select MENU > [§ System Setup] > [Fan Speed)].
2 Select the desired option.

@ vPorTANT
¢ While the fan is running, the exhaust vent will emit warm air.
® Be careful not to obstruct in any way the fan’s air vents ([J1 13, 14).

(i) NoTes

¢ Depending on the ambient temperature and other shooting conditions, the fan may not turn off even if you set
its operating mode to [Automatic].
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Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Video Configuration: Video Format, Sensor Mode, System
Frequency, Resolution and Frame Rate

In CAMERA mode, you can set the video configuration used for primary clips with the following procedures.
Select the video format, sensor mode, resolution (frame size), system frequency and frame rate settings that best
match your creative needs. Available options for some settings may change depending on previous selections
for other settings. See the tables following the procedures for a summary.

For details about the video configuration of proxy clips, refer to Proxy Cljps (Simultaneous Recording) (11 69).

Selecting the Sensor Mode

You can change the area of the imaging circle covered by the CMOS sensor to produce the recorded image.

1 Select MENU > [£® Recording/Media Setup] > [Sensor Mode].
2 Select the desired option.

Selecting the Main Recording Format

The camera can record primary clips in RAW* or XF-AVC format to a CFexpress card. RAW clips have to be
developed in post-production but give you more control and full-quality files that are best suited for HDR video.
XF-AVC clips deliver high-quality video due to efficient compression.

* Please note that the Cinema RAW Light data recorded by this camera is different from Cinema RAW data recorded by other
Cinema EOS cameras.

1 Select MENU > [ Recording/Media Setup] > [Main Rec Format].
2 Select the desired option.

Selecting the System Frequency

You can change the system frequency also in MEDIA mode if you want to play back clips from a card recorded
with a different system frequency setting.

1 Select MENU > [ Recording/Media Setup] > [System Frequency].

2 Select the desired option.
* The camera will reset and restart in the selected mode.

Selecting the Resolution and Color Sampling Settings

This setting is only available for XF-AVC clips. For RAW clips, the resolution is set automatically by the sensor
mode used and the color depth is determined by the selected frame rate.

1 Select MENU > [£% Recording/Media Setup] > [Resolution/Color Sampling].

2 Select the desired option.

e The resolution and color sampling settings (or color bit depth, for RAW clips) appear at the top right of the
screen.
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Selecting the Frame Rate

When shooting RAW clips, the frame rate will determine also the color depth. Refer to the following tables.
This procedure is not necessary when the system frequency is set to 24.00 Hz.

1 Select MENU > [£% Recording/Media Setup] > [Frame Rate].

2 Select the desired option.
¢ The selected frame rate will appear at the top of the screen.

Selecting the Bit Rate

This setting is only available for XF-AVC clips, depending on the resolution used. For RAW clips and when
MENU > [£%® Recording/Media Setup] > [Resolution/Color Sampling] is set to [1280x720 YCC422 10 bit], the
bit rate is determined automatically.

1 Select MENU > [£% Recording/Media Setup] > [Bit Rate].
2 Select the desired option.

Available Video Configuration Settings

RAW format settings

Main recording format: [RAW]

Main Color System frequency/Frame rate
Sensor mode  recording Resolution d:p:h Bit rate* 59.94 Hz
format 59.94P 29.97P 23.98P
5952x3140 10011 1 e bt _ _
X . S
12 bit P - ° °
10 bit o - -
(LK) 4192x3140 (4:3) - 1.48 Gbps
Full frame 12 bit - [ J o
3768x31406:5) L' 1336 bt _ _
X : . S
12 bit P - ° °
C300 Mk Il RAW
Super 35mm 10 bit [ ] - _
T 4096x2160 1 Gbps
Super 35mm 12 bit - o ([
(cropped)
Super 16mm 10 bit [ ] - _
2048x1080 250 Mbps
(cropped) 12 bit P - [ J ([




o4

Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Main
Sensor mode  recording
format

C500 Mk I
Full frame

C300 Mk Il RAW
Super 35mm

C500 Mk Il
Super 35mm
(cropped)

Super 16mm
(cropped)

System frequency/Frame rate

Resolution 3;')‘:; Bit rate* 50.00 Hz 24.00 Hz
50.00P 25.00P 24.00P
5052x3140 10011 1 e hd _ _
X, . S
12 bit P - ° °
4192x3140 (4:3) 1001 186 hd _ _
X . . S
12 bit P - ° °
10 bit ° - -
37683140 (6:5) " | 1.33Gbps
12 bit - ° °
10 bt ° - -
4096x2160 1 Gbps
12 bit - ° °
20481080 | % 250 mp hd _ _
X S
12 bit P - ° °

* The camera uses a variable bit rate (VBR).



Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Main recording format: [RAW HQ] / [RAW ST] / [RAW LT]

Sensor mode

Full frame

Main recording
format

RAW HQ

RAW ST

RAW LT

Resolution

5952x3140

RAW HQ

RAW ST

RAW LT

4192x3140 (4:3)

RAW HQ

RAW ST

RAW LT

3768x3140 (6:5)

Super 35mm
(cropped)

Super 16mm
(cropped)

RAW HQ

RAW ST

RAW LT

RAW HQ

RAW ST

RAW LT

4096x2160

2048x1080

Color depth

12 bit

System frequency/Frame rate/Bit rate*

59.94 Hz
59.94P 29.97P 23.98P
_ o o
2.12 Gbps 1.7 Gbps
o o o
2.09 Gbps 1.05 Gbps 835 Mbps
o [ J o
1.36 Gbps 679 Mbps 543 Mbps
_ o o
1.5 Gbps 1.2 Gbps
o [ J o
1.48 Gbps 737 Mbps 590 Mbps
o @ o
958 Mbps 479 Mbps 383 Mbps
_ @ o
1.35 Gbps 1.08 Gbps
o @ o
1.33 Gbps 663 Mbps 530 Mbps
(] @ (]
861 Mbps 431 Mbps 345 Mbps
(] @ (]
2.02 Gbps 1.01 Gbps 807 Mbps
(] @ (]
993 Mbps 497 Mbps 397 Mbps
o o o
645 Mbps 323 Mbps 258 Mbps
o o o
511 Mbps 256 Mbps 205 Mbps
o o o
252 Mbps 126 Mbps 101 Mbps
o [ J o
164 Mbps 82 Mbps 66 Mbps
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Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Sensor mode

Full frame

Main recording
format

RAW HQ

RAW ST

RAW LT

Resolution

5952x3140

RAW HQ

RAW ST

RAW LT

RAW HQ

RAW ST

RAW LT

4192x3140 (4:3)

3768x3140 (6:5)

Super 35mm
(cropped)

RAW HQ

RAW ST

RAW LT

4096x2160

Super 16mm
(cropped)

RAW HQ

RAW ST

RAW LT

2048x1080

Color depth

12 bit

System frequency/Frame rate/Bit rate*

50.00 Hz 24.00 Hz
50.00P 25.00P 24.00P
_ @ o

1.77 Gbps 1.7 Gbps
@ @ o
1.75 Gbps 871 Mbps 836 Mbps
@ @ o
1.14 Gbps 566 Mbps 544 Mbps
_ @ o
1.25 Gbps 1.2 Gbps
[ J o ( J
1.23 Gbps 615 Mbps 590 Mbps
([ J o ( J
799 Mbps 400 Mbps 384 Mbps
~ ° °
1.13 Gbps 1.08 Gbps
[ J [ ([ J
1.11 Gbps 553 Mbps 531 Mbps
[ J [ ] ( J
719 Mbps 360 Mbps 345 Mbps
[ J [ ] ([ J
1.69 Gbps 841 Mbps 807 Mbps
@ @ o
828 Mbps 414 Mbps 398 Mbps
@ @ o
538 Mbps 269 Mbps 259 Mbps
@ @ o
426 Mbps 213 Mbps 205 Mbps
@ @ o
210 Mbps 105 Mbps 101 Mbps
@ @ o
137 Mbps 69 Mbps 66 Mbps

* The camera uses a variable bit rate (VBR).



XF-AVC format settings

Sensor mode

C300 Mk Il
Super 35mm

C500 Mk I
Full frame,
Super 35mm
(cropped)

Super 16mm
(cropped)

Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Resolution/Color sampling

4096x2160

3840x2160

2048x1080,
1920x1080

1280x720

2048x1080,
1920x1080

1280x720

YCbCr 4:2:2,
10 bit

Bit rate*

810 Mbps,
Intra-frame

59.94P
([ ]

59.94i

59.94 Hz

System frequency/Frame rate

29.97P

23.98P

410 Mbps,
Intra-frame

260 Mbps,
Long GOP

160 Mbps,
Long GOP

810 Mbps,
Intra-frame

410 Mbps,
Intra-frame

260 Mbps,
Long GOP

160 Mbps,
Long GOP

310 Mbps,
Intra-frame

160 Mbps,
Intra-frame
50 Mbps,
Long GOP
24 Mbps,
Long GOP
310 Mbps,
Intra-frame
160 Mbps,
Intra-frame

50 Mbps,
Long GOP

24 Mbps,
Long GOP
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Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Sensor mode
4096x2160
C300 Mk Il
Super 35mm
C500 Mk I 3840x2160
Super 35mm
(cropped)
2048x1080,
1920x1080
1280x720
2048x1080,
Super 16mm 1920x1080
(cropped)
1280x720

Resolution/Color sampling

YCbCr 4:2:2,
10 it

Bit rate*

810 Mbps,
Intra-frame

50.00P
o

System frequency/Frame rate

50.00 Hz
50.00i

25.00P

24.00 Hz
24.00P

410 Mbps,
Intra-frame

260 Mbps,
Long GOP

160 Mbps,
Long GOP
810 Mbps,
Intra-frame
410 Mbps,
Intra-frame

260 Mbps,
Long GOP

160 Mbps,
Long GOP

310 Mbps,
Intra-frame

160 Mbps,
Intra-frame

50 Mbps,
Long GOP

24 Mbps,
Long GOP

310 Mbps,
Intra-frame

160 Mbps,
Intra-frame

50 Mbps,
Long GOP

24 Mbps,
Long GOP

* The camera uses a variable bit rate (VBR).
** Only when MENU > [ ] Recording/Media Setup] > [Resolution/Color Sampling] is set to [1920x1080 YCC422 10 bit].

(i) notes

e For details on the signal output from each terminal, refer to Video Outout Configuration (11 153).
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Proxy Clips (Simultaneous Recording)

In CAMERA mode, while recording a primary clip on a CFexpress card, you can simultaneously record the same
scene as a proxy clip (XF-AVC format) on the SD card. Because proxy clips have smaller files, they are suitable
for offline editing.

Video configuration of proxy clips

. . Proxy clips
Main recording format - - - 1
Format Resolution Color sampling Frame rate Bit rate
24 Mbps,
RAW 2048x1080 . . 35 Mbps
XF-AVC 2048x1080, YChCr 4:2:0, 8 bit ame as e 17 Mbps?,
5 primary clip
XF-AVC 1920x10807, 24 Mbps,
1280x7203 35 Mbps

1" Variable bit rate (VBR) set automatically depending on the video configuration of the primary clip.

2 Only when MENU > [ % Recording/Media Setup] > [Resolution/Color Sampling] is set to [3840x2160 YCC422 10 bit] or
[1920x1080 YCC422 10 bit].
Only when MENU > [£2 Recording/Media Setup] > [Resolution/Color Sampling] is set to [1280x720 YCC422 10 bit].

1 Select MENU > [£% Recording/Media Setup] > [Sub Rec Format] > [XF-AVC (SD Card)).
e The icon will appear in green at the top left of the screen.

2 Select MENU > [£% Recording/Media Setup] > [Sub Rec Color Conversion] > [Conform to Custom
Picture], [BT.709 (Wide DRY)], or [BT.709 (CMT 709)].

e |f you select [Conform to Custom Picture], the gamma curve and color space are determined to conform to
the gamma curve of Custom Picture. Furthermore, if you select [BT.709 (Wide DR)] or [BT.709 (CMT 709)],
they are converted as follows.

Gamma curve after conversion

Color space after conversion

Sub Rec Color Conversion BT.709 (Wide DR) BT.709 (CMT 709) BT.709 (Wide DR)  BT.709 (CMT 709)
BT.709 Normal BT.709 Normal BT.709 Normal
BT.709 Standard BT.709 Standard | BT.709 Standard
BT.709 Wide DR BT.709 Wide DR BT.709 Wide DR
Gamma curve of Canon 709 Canon 709 Canon 709 51700
Custom Picture | The gamma curve and color space after '
applying the Look File and after
conversion are [SDR BT.709] or [SDR SOR SDR
BT.2020].
Other BT.709 Wide DR CMT 709

e [f you select [BT.709 (Wide DR)] or [BT.709 (CMT 709)], proxy clips are recorded after converting the gamma
curve and color space. The value set for MENU > [[Z) Monitoring Setup] > [Gain for HDR — SDR Conv.]
(11 163) is applied to the proxy clips as well.

3 Press the REC button to start and stop recording.
e Proxy clips will be recorded on the SD card simultaneously with the primary clips recorded on the CFexpress

card.

(i) NoTes

e |f the recording of the primary clip stops during simultaneous recording, recording of the proxy clip will stop as

well.

e Simultaneous recording of proxy clips is not available when the main recording format is set to XF-AVC and

slow & fast motion recording is activated.
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Proxy Clips (Simultaneous Recording)

e |f there is no CFexpress card inserted in the camera, only the proxy clip will be recorded.

e SDHC cards are formatted using the FAT32 file system so, when recording proxy clips, the video (stream) file in
the clip will be split approximately every 4 GB. Playback with the camera will be seamless.
SDXC cards use the exFAT file system so the stream file in the clip will not be split.



Direct Setting Mode (FUNC Button)

Direct Setting Mode (FUNC Button)

In CAMERA mode, you can adjust main camera functions —shutter speed, ISO speed/gain, aperture and white

balance —using the FUNC button (direct setting mode). This section will explain the basic operation of the direct

setting mode. For specific details about the functions refer to the each function’s section: shutter speed ([11 72), 71

ISO speed/gain ([11 74), aperture (11 77), white balance ([J1 81). —

Using the Direct Setting Mode

1 Press the FUNC button.
e The onscreen display of the selected function will be
highlighted in orange.
e Press the FUNC button repeatedly or push the joystick left/
right to select a different function.
2 Push the joystick up/down or turn the SELECT dial to
select the desired value or white balance mode.
e The selected value/mode will be set and direct setting mode
will end.

e The onscreen display of the selected function will return to
normal.

(i) NoTEs

¢ The camera will automatically end the direct setting mode in the following cases.
- If no operation was performed for more than 6 seconds.
- If the menu or a status screen was opened.




Shutter Speed

Shutter Speed

In CAMERA mode, you can set the shutter speed according to the shooting conditions. For example, you may
want to set slower shutter speeds in darker environments. The camera offers the following modes.

You can also perform this function remotely using Browser Remote on a connected network device (11 187,
190).

[Speed]: Allows you to set the shutter speed (in fractions of a second). You can select the increment to use when
adjusting the shutter speed between 1/3-stop and 1/4-stop increments.

[Angle]: You can set the shutter angle to determine the shutter speed.

[Clear Scan]: Set the frequency in order to record CRT computer monitors without displaying black bands or
flicker on the screen.

[Slow]: You can set slower shutter speeds to obtain brighter recordings in places with insufficient lighting.
[Off]: The camera uses a standard shutter speed based on the frame rate.

Available shutter speeds
The individual setting options that can be selected will change depending on the frame rate used.

System frequency/Frame rate

Shutter speed mode 59.94 Hz 24.00 Hz 50.00 Hz
59.94P / 59.94i" 29.97P 23.98P 24.00P 50.00P/ 50.00i" 25.00P
1/3-stop 1/12 0 1/2000 (24 setting options in total)
(Speed]2 increments
.1/4'St0p 1/12 t0 1/2000 (31 setting options in total)
increments
[Angle]2 360.00°, 240.00°, 180.00°, 120.00°, 90.00°, 60.00°, 45.00°, 30.00°, 22.50°, 15.00°, 11.25°
9 Also angle values equivalent to the following shutter speeds: 1/120, 1/100, 1/60, 1/50, 1/40, 3/100, 1/30, 1/25.
[Clear Scan]? 23.98 Hz t0 250.38 Hz 24.00 Hz to 250.40 Hz
[Slow]® 1/15,1/30 115 112 112,1/25 112
[0ff] 1/60 1/30 1/24 1/50 1/25

1 59.94i and 50.00i are available only for XF-AVC primary clips.
2 When slow & fast motion recording or the [Run EVF at x2 Speed)] setting is activated, available setting options will vary depending
on the selected shooting frame rate. If [Run EVF at x2 Speed] is set to [On], the shutter speed lower limit will be equivalent to 1/x

seconds ("x" representing twice the value of the set frame rate).
3 Not available when slow & fast motion recording or the [Run EVF at x2 Speed] setting is activated.
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Changing the Shutter Speed Mode and Value
1 Select MENU > ["™ Camera Setup] > [Shutter Mode] > Desired shutter speed mode.

2 For [Speed] only: Select MENU > ["™ Camera Setup] > [Shutter Increment] >
[1/3 stop] or [1/4 stop].

3 Adjust the shutter speed, angle value or clear scan frequency using the direct setting mode ([ 71).

e After closing the menu, press the SHUTTER button to highlight
the shutter speed.

® The selected shutter speed will appear at the bottom of the : SHUTTER
screen.

Using slow shutter mode

When recording in dark surroundings, you can obtain a brighter picture by using slow shutter mode. You can
also use this mode when you wish to add certain effects to your recordings, such as blurring the background
during panning shots or recording a moving subject with an afterimage trail.

¢ Image quality may not be as good as when using faster shutter speeds in brighter surroundings.

(i) NoTes

¢ \When recording under artificial light sources such as fluorescent, mercury or halogen lamps, the screen may
flicker depending on the shutter speed. You may be able to avoid flicker by setting the shutter speed mode to
[Speed] and the shutter speed to a value matching the frequency of the local electrical system: 1/50* or 1/100
for 50 Hz systems, 1/60 or 1/120 for 60 Hz systems.
* May not be available depending on the frame rate.

¢ Closing down the aperture when recording under bright conditions may cause the picture to appear soft or out
of focus. The following measures may be effective in avoiding the loss of sharpness due to diffraction.
- Using a denser ND filter (11 76).
- Using a faster shutter speed.
- Applying diffraction correction ([J] 39). Results may vary depending on the lens used.

¢ \When the shutter speed mode is set to [Slow], bright red, green or blue dots may appear on the screen. In
such case, use a faster shutter speed or select a lower ISO speed or gain value ([1] 74).

¢ \When an optional RC-V100 Remote Controller is connected to the camera, you can change the shutter speed

mode with the remote controller's SHUTTER SELECT button and the shutter speed value with the remote
controller's SHUTTER A /W buttons.
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ISO Speed/Gain

ISO Speed/Gain

In CAMERA mode, you may want to adjust the brightness of the image according to the shooting conditions.
You can do so by changing the ISO speed or gain value to adjust the sensitivity of the sensor.

You can also perform this function remotely using Browser Remote on a connected network device (11 187,
190).

Available ISO speed and gain settings1

Main recorzdlng 1S0/Gain® Increment? Normal range Extended range®
format
[1stop] | 1608, 200, 400, 800, 1600, 3200, 6400, 12800, 25600 | 100, 51200, 102400
160, 200, 250, 320, 400, 500, 640, 800, 1000, 1250
ISO y y y y y ) ) ) ) )
=0l [1/3stop] | 1600, 2000, 2500, 3200, 4000, 5000, 6400, 8000, ;?gb;zghgggogbgggo?bz 100
10000, 12800, 16000, 20000, 25600 ’ ’ ‘
XF-AVC T
[ (grg;] 2 dB8, 0 dB 10 42 dB —6 B, —3 0B, 45 4B to 54 0B
[Gain] -
[Fine] —2 dB 0 42 dB 42.5 dB to 54 dB
(0.5 dB) :
[1stop] | 800, 1600, 3200, 6400, 12800, 25600 100, 200, 400, 51200, 102400
RAW 150] 800, 1000, 1250, 1600, 2000, 2500, 3200, 4000, 100, 125, 160, 200, 250, 320,
[1/3stop] | 5000, 6400, 8000, 10000, 12800, 16000, 20000, 400, 500, 640, 32000, 40000,
C500 Mk 25600 51200, 64000, 80000, 102400
RAW HQ
RAW ST ['\('grg;” 6 dB 0 9 dB, 45 dB to 54 dB
RAW LT [Gain] : 12 dBto 42 dB
[Fine] —2 dBto 11.5 B,
(0.5 dB) 42.5 dB t0 54 B

T The minimum sensitivity needed to obtain the recommended dynamic range depends on the gamma curve component of the
[Gamma/Color Space] setting in the custom picture file (1 137).
[Canon Log 2], [Canon Log 3], or [PQ]: ISO 800 / 12 dB gain
[HLG] or [BT.709 Wide DR]: ISO 400 / 6 dB gain
[BT.709 Normal] or [BT.709 Standard]: ISO 160 / -2 dB gain

2 MENU > [E% Recording/Media Setup] > [Main Rec Format] setting.

3 MENU > ["™ Camera Setup] > [ISO/Gain] setting.
MENU > ["™ Camera Setup] > [ISO Increment] or [Gain Increment] setting.

5 Sensitivity settings that are outside the recommended range but can still be used by setting MENU > [*™ Camera Setup)] >
[ISO/Gain Extended Range] to [On].

6 Available only when [ISO/Gain Extended Range] is set to [Off].
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Changing the ISO Speed or Gain Value
1 Select MENU > ["™ Camera Setup] > [ISO/Gain] > [ISQ] or [Gain].

2 Depending on your previous selection, select MENU > ["™ Camera Setup] > [ISO Increment] (ISO
speed) or [Gain Increment] (gain).

3 Select the desired option.

4 Adjust the ISO speed or gain value using the direct setting mode ([1] 71).
o After closing the menu, press the ISO/GAIN button to highlight
the ISO speed or gain value.

¢ The selected ISO speed/gain value will appear at the bottom of
the screen.

Using the Control Dial

You can also adjust the ISO speed or gain value using the control dial on the camera or the one on the camera
grip. You will need to set in advance the function of one of the control dials to [ISO/Gain]. You can select the
function assigned to each control dial independently.

1 Select MENU > [¥ System Setup] > [Camera Ctrl Dial
(control dial on the camera) or [Camera Grip Ctrl Dial] (control
dial on the camera grip) > [ISO/Gain].

Control dial

2 After closing the menu, turn the control dial assigned to [ISO/
Gain] to set the desired ISO speed or gain value.
¢ To select whether to change the ISO speed or the gain, perform
step 1 of the previous procedure (1] 75).

(i) NoTEs

¢ \When high ISO speeds or gain levels are set, the picture may flicker slightly.

¢ \When high ISO speeds or gain levels are set, bright red, green or blue dots may appear on the screen. In such
case, use a faster shutter speed ([ 72) or select a lower ISO speed or gain value.

¢ \When the ISO speed or gain level is changed, some noise may appear momentarily on the screen. Do not
adjust the ISO speed/gain level while recording.

e You can use the MENU > [ System Setup] > [Camera Cirl Dial Dir.] or [Camera Grip Ctrl Dial Dir.] setting to
change the direction of the adjustment when you turn the control dial on the camera or on the camera grip,
respectively.

¢ \When an optional RC-V100 Remote Controller is connected to the camera, you can adjust the I1ISO speed or
gain value with the remote controller’s ISO/GAIN A/ 'V buttons.
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ND Filter

ND Filter

In CAMERA mode, using the ND filter allows you to open up the aperture to obtain a shallower depth of field
even when recording in bright surroundings. You can also use the ND filter to avoid the soft focus caused by
diffraction when using small apertures. By default, you can select one of 3 density levels (up to 6 stops in 2-stop
intervals). If you enable the extended ND range, you can select one of 5 density levels (up to 10 stops in 2-stop
intervals).

You can also perform this function remotely using Browser Remote on a connected network device ([11 187,
190).

Press the ND FILTER + or - button to select the desired ND filter

setting.

¢ Repeatedly pressing ND FILTER + button will change the ND filter
setting in the following order: [ND 2 stops] — [ND 4 stops] = [ND 6
stops] = [ND 8 stops]* = [ND 10 stops]* — ND filter off. (The ND
FILTER - button cycles through the settings in reverse order.)

* The selected ND filter setting will appear at the bottom of the
screen.

* Only when MENU > ["™ Camera Setup] > [Extended ND Range] is set to [On].

(i) Nnotes

e If you set an assignable button to [ND +] or [ND -] ([ 129), you can press the button to change the ND filter
setting.
e Depending on the scene, the color may change slightly when turning the ND filter on/off. Setting a custom
white balance ([1 81) may be effective in such case.
e About the extended ND range: \When you switch to or from a density level in the extended range (8 or 10 stops),
you may notice one or both of the following circumstances.
- The focus may shift, affecting also the indication on the lens’s focus distance scale.
- Depending on the lens, the camera may not be able to focus at infinity focus.
e Changing the ND filter setting using the optional RC-V100 Remote Controller:
- When the remote controller is connected to the camera, you can use the remote controller’s ND button in
the same way as the camera’s ND FILTER + button.
- For settings between 2 and 8 stops, the corresponding ND filter indicator (1 to 4, respectively) will illuminate
in orange. When the ND filter is set to 10 stops, indicators 1 and 4 will both illuminate.




Aperture

Aperture

In CAMERA mode, you can affect the brightness of your recordings or change the depth of field by adjusting the
aperture. Depending on the lens used, the aperture value displayed may differ (F value or T value) and available
aperture values will vary as well. You can select the adjustment increment and even use the smallest iris
increment allowed by the lens.

When the optional SG-1 Shoulder Style Grip Unit is connected to the camera, you can also adjust the aperture
using the grip.

Manual aperture: Adjust the aperture value manually using the direct setting mode or the control dial on the
camera or on the camera grip; or remotely, using Browser Remote on a connected network device (1] 187,
190).

Push Auto Iris: Momentary automatic aperture. During manual aperture, press the PUSH AUTO IRIS button or
use Browser Remote to temporarily adjust the aperture automatically.

Automatic aperture: The camera adjusts the aperture automatically.

Required settings on EF Cinema lenses and broadcast lenses

To adjust the aperture from the camera, you will need to enable automatic adjustment using the controls on the
lens. Required settings vary depending on the lens. Refer to the following table and the instruction manual of the
lens used.

Lens ([ 247) Part used on the lens Setting for automatic adjustment
CN7x17 KAS S/E1, CN7x17 KAS S/P1,
CN8x15 IAS S/E1, CN8x15 IAS S/P1,
CN10x25 IAS S/E1, CN10x25 IAS S/P1, Iris operation change-over switch A
CN20x50 IAS H/E1, CN20x50 IAS H/P1,
compatible broadcast lenses
CN-E18-80mm T4.4 LIS KAS S,
CN-E70-200mm T4.4 L IS KAS S

(i) NoTES

e When the optional SG-1 Shoulder Style Grip Unit is connected to the camera: To adjust the aperture from the
camera, set the SG-1’s IRIS (aperture control) switch to the A position. For details refer to the Cinema EOS
System Expansion User Guide.

Iris auto/manual change-over switch A

Manual Aperture: Changing the Aperture Value

1 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Manual].

¢ This setting is available only when a lens compatible with automatic aperture is attached to the camera. For
non-compatible lenses, the aperture mode is automatically set to [Manual] and cannot be changed.

¢ When using a compatible EF Cinema/broadcast lens, enable automatic adjustment on the lens (11 77).
2 Select MENU > ["™ Camera Setup] > [Iris Increment] > [1/2 Stop] or [1/3 Stop].

* You can also set MENU > ["™ Camera Setup] > [Fine Increment] to [On] to use the smallest iris increment
allowed by the lens attached. Nevertheless, the aperture value displayed on the screen will be the closest
value in the selected increment scale.

3 Adjust the aperture value using the direct setting mode ([J1 71).

e The selected aperture value will appear at the bottom of the screen.
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Using the Control Dial

You can also adjust the lens’s aperture value using the control dial on the camera or the one on the camera grip.
By default, the function of both control dials is set to [Iris]. You can select the function assigned to each control
dial independently.

1 Select MENU > [¥ System Setup] > [Camera Ctrl Dial
(control dial on the camera) or [Camera Grip Ctrl Dial] (control
dial on the camera grip) > [Iris].

Control dial

2 After closing the menu, turn the control dial assigned to [Iris]
to adjust the aperture.

e The selected aperture value will appear at the bottom of the
screen.

(i) NOTES

¢ You can use the MENU > [¥ System Setup] > [Camera Ctrl Dial Dir.] or [Camera Grip Ctrl Dial Dir.] setting to
change the direction of the adjustment when you turn the control dial on the camera or on the camera grip,
respectively.

e If you set an assignable button to [Iris +] or [Iris =] (11 129), you can press the button to respectively open up
or close down the aperture.

e \When using an EF lens with no lens contacts or most EF Cinema lenses*, you cannot adjust the aperture using

the camera. Adjust the aperture using the lens.
* See the appendix for the list of EF Cinema lenses and broadcast lenses compatible with iris adjustment from the camera

(0 247).
¢ \When using an EF lens that can correct the aperture value according to the position of the zoom, you can use
the MENU > ["™ Camera Setup] > [Zoom-Iris Correction] setting to activate this correction.

¢ \When an optional RC-V100 Remote Controller is connected to the camera, you can adjust the aperture with
the remote controller’s IRIS dial. At default settings, turn the dial right to open up the aperture and left to close
the aperture.

e \When an EF Cinema lens is attached to the camera, the aperture value displayed on the screen will be a
T value. The aperture value (T value) displayed on the screen may differ from the indication on the lens’s
aperture scale.

¢ \When using an EF Cinema lens compatible with iris adjustment from the camera, when the iris is almost fully
closed, the aperture value (T value) will appear in gray on the screen.

¢ \When using an EF Cinema lens compatible with iris adjustment from the camera, when you change the
aperture value from a position of fully open or fully closed iris, multiple adjustment operations may be required
until the aperture changes.
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Momentary Automatic Aperture - Push Auto Iris

During manual aperture, you can press the PUSH AUTO IRIS button to have the camera temporarily take control
and adjust the aperture automatically for an optimal exposure.
This function is not available when slow & fast motion recording is activated.

1 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Manual]. 2

* When using a compatible EF Cinema/broadcast lens, enable AR

automatic adjustment on the lens (11 77).
2 Press and hold the PUSH AUTO IRIS button. x @&}
e The camera will automatically adjust the aperture to obtain
optimal exposure. As long as you hold the button pressed

down, B will appear on the screen next to the aperture value.
¢ \When you release the button, automatic aperture mode will end

and the [ icon will disappear. The selected aperture value will \ @

appear at the bottom of the screen.

(i) NoTeS

¢ You can use the MENU > ["™ Camera Setup] > [AE Response] setting to change how quickly the aperture
changes during automatic aperture mode. This setting has no effect when using an incompatible lens

(@ 247).

Automatic Aperture

When a compatible lens is attached to the camera, you can have the camera automatically adjust the aperture.
This function is not available when slow & fast motion recording is activated.

Select MENU > ["™ Camera Setup] > [Iris Mode] > [Automatic].
¢ When using a compatible EF Cinema/broadcast lens, enable automatic adjustment on the lens (11 77).

e The camera will automatically adjust the aperture to obtain optimal exposure. The selected aperture value will
appear at the bottom of the screen with an [ icon next to it.

(i) NoTes

e |f you set an assignable button to [Iris Mode] ([J] 129), you can press the button to toggle between the

[Automatic] and [Manual] settings when a compatible lens ([I1 247) is attached to the camera.

When MENU > [£2 Recording/Media Setup] > [Sensor Mode] is set to [Super 35mm] and a

broadcast lens is attached to the camera, the camera will not achieve optimal exposure.

o When MENU > [ £2 Recording/Media Setup] > [Sensor Mode] is set to [Full Frame] and an EF-S
lens or Super 35mm lens is attached to the camera, the camera will not achieve optimal exposure. Similarly,
when MENU > [ £2 Recording/Media Setup] > [Sensor Modg] is set to [Full Frame] or [Super 35mm
(Cropped)] and a broadcast lens is attached to the camera, the camera will not achieve optimal exposure
either.

¢ The aperture value may change in the following cases.

- While using the built-in extender or iris compensation function of an EF Cinema lens, when you switch from
automatic aperture to manual aperture.
- When the aperture controls on the lens are switched between automatic/manual mode.

¢ \When using EF Cinema lenses/broadcast lenses that let you adjust the aperture gain, if the aperture gain is set
too high, the aperture adjustment may not be stable (“aperture hunting”), depending on the shooting
conditions. In such case, reset the lens's aperture gain to its initial value.
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Exposure Compensation - AE Shift

Use AE shift to compensate the exposure that was set using automatic aperture, in order to darken or lighten the
image.

You can also perform this function remotely using Browser Remote on a connected network device (11 187,
190).

1 Select MENU > ["™ Camera Setup] > [AE Shift].

2 Select the desired option.
e You can select one of 17 AE shift levels from —2.0 to +2.0.

e The selected AE shift level will appear next to the exposure bar and the camera will attempt to adjust the
exposure accordingly.

(i) notes

¢ |f you set an assignable button to [AE Shift +] or [AE Shift -] (1] 129), you can press the button to adjust the
AE shift level.

The exposure bar

The W on top of the exposure bar indicates optimal exposure without any shift
(AE+0); the scale markings indicate the deviation from optimal exposure in |

1/2 EV increments. The indicator inside the exposure bar represents the current
exposure. When the difference between current and optimal exposure is larger |

than +£2 EV, the indicator will flash at the edge of the exposure bar. Optimal Current exposure
exposure will change depending on the light metering mode used.

Optimal exposure AE+0

Light Metering Mode

Select the light metering mode to match the recording conditions. Using the appropriate setting will help achieve
a more appropriate exposure level when adjusting the exposure manually or using an automatic aperture
function.

1 Select MENU > ["™ Camera Setup] > [Light Metering].

2 Select the desired option.
e The icon of the selected mode (Y or /a\, no icon for [Standard]) appears on the left of the screen.

Options

[Backlight]: Suitable when recording backlit scenes.

[Standard]: Averages the light metered from the entire screen, giving more weight to the subject in the center.
[Spotlight]: Use this option when recording a scene in which only a certain part of the picture is lit, for

example, when the subject is lit by a spotlight.

(i) Nnotes

e If you set an assignable button to [Backlight] or [Spotlight] (11 129), you can press the button to turn the
respective light metering mode on and off.
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White Balance

In CAMERA mode, the camera uses an electronic white balance process to calibrate the picture and produce
accurate colors under different lighting conditions. The camera offers the following ways to set the white
balance.

You can also perform this function remotely using Browser Remote on a connected network device ([11 187,
190).

Custom white balance: You can use a gray card or white object with no pattern to establish the white balance
and set it to one of two custom white balance positions, A or 1 B. When recording under fluorescent lights,
we recommend setting the custom white balance.

Preset white balance: Set the white balance to 8 (daylight) or #¢ (tungsten lamp). You can further adjust the
color temperature (K) value and the color compensation (CC) value, which adjusts the color along the green/
magenta gradation.

Color temperature: Allows you to set the color temperature between 2,000 K and 15,000 K, and further adjust
the color compensation (CC) value.

Auto white balance (AWB): The camera automatically adjusts the white balance to the optimal level.

(i) NoTES

¢ The [White Balance] and [Color Matrix Tuning] settings in the custom picture file (11 139) take precedence
over the white balance set with these procedures.

* You can use the MENU > ["™ Camera Setup] > [Shockless WB] setting to make the transition look smoother
when you change the white balance settings.

* You can use the MENU > ["®™ Camera Setup] > [C. Temp. Increment] setting to change the units for the color
temperature increment to [Mired] (5-mired increments) or [Kelvin] (100-kelvin increments). Even when [Mired] is
selected, the color temperature is converted to and displayed in kelvins. Changing this setting may change the
white balance setting.

¢ \When an optional RC-V100 Remote Controller is connected to the camera, you can adjust the white balance
with the remote controller's AWB button, A button, B button, PRESET button and =4 button.

e The color temperatures displayed on the screen are approximate. Use them only as a reference.

Custom White Balance

1 Press the WB button.
¢ The camera will enter the direct setting mode ([ 71) with the
white balance mode icon highlighted.
2 Select the 1A or 4B icon.

e Press SET to apply the stored custom white balance setting as
is. The rest of the procedure is not necessary. To set a new
custom white balance, continue the procedure.

3 Point the camera at a gray card or white object so that it fills
the whole screen.

¢ Use the same lighting conditions you plan to use when
recording.
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4 Press the = button.
* The o A or 4 B icon will flash quickly.
* Make sure the gray card or white object fills the screen until the procedure is completed.

¢ Once the icon stops flashing, the procedure is completed. The setting is retained even if you turn off the
camera.

e The color temperature and CC value registered by the camera will appear at the bottom of the screen next
to the oA or ®aBicon.

(i) notes

e Readjust the custom white balance if the light source or ND filter setting changes.

e \ery rarely and depending on the light source, x4 may keep flashing (it will change to a slow flashing). The
result will still be better than with auto white balance.

e After the camera registers a custom white balance the color temperature or CC value may appear in gray. This
indicates that the value registered exceeds the range of values that can be displayed but the white balance is
correctly calibrated and you can continue shooting.

Color Temperature/Preset White Balance

1 Press the WB button.

¢ The camera will enter the direct setting mode ([ 71) with the white balance
mode icon highlighted.

2 Select the 38 or 8¢ icon (preset white balance), or the [d icon (color
temperature setting).
e Press SET to apply the stored preset setting or color temperature as is. The
rest of the procedure is not necessary. To adjust the color temperature or CC
value, continue the procedure.

INDEX /0

WB 2]

3 Press the r® button.
* The camera will enter the direct setting mode with the color temperature
highlighted in orange. To adjust the CC value, push the joystick right.

4 Select the desired value.

e The selected color temperature and CC value will be set and will appear on the screen next to the white
balance icon.

Adjustment ranges

: . Adjustment range
White balance mode/setting .
Color temperature (K) Color compensation (CC) value
@¢ (daylight) 4,300 K to 8,000 K
— 510 +5
:,f\: (tungsten lamp) 2,700 Kt0 3,700 K

@ (color temperature) 2,000 K to 15,000 K —20to +20



Auto White Balance (AWB)

White Balance

The camera constantly adjusts the white balance automatically to achieve an appropriate level. The camera will

adjust the white balance if the light source changes.

1 Press the WB button.
¢ The camera will enter the direct setting mode ([1 71) with the white balance
mode icon highlighted.
2 Select the [ icon.

® The color temperature and CC value set automatically by the camera will
appear at the bottom of the screen next to the [[f icon.

(i) NoTes

e Custom white balance may provide better results in the following cases:
- Changing lighting conditions
- Close-ups
- Subjects in a single color (sky, sea or forest)
- Under mercury lamps and certain types of fluorescent and LED lights

* You can use the MENU > ["™ Camera Setup] > [AWB Response] setting to change how quickly the white

balance changes in auto white balance (AWB) mode.

e If you set an assignable button to [AWB Lock] ([1] 129), you can press the button to lock the current white
balance settings set automatically by the camera. To cancel the lock, press the button again (resume auto

white balance mode) or select a different white balance setting.
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Focus

In CAMERA mode, the camera offers the following ways to focus, depending on the lens used. The camera
incorporates Dual Pixel CMOS AF technology for advanced autofocus performance with compatible lenses.
Refer to the list of compatible lenses and functions that can be used ([I] 247).

You can also adjust the focus remotely using Browser Remote on a connected network device ([J1] 187, 189).

Manual focus: Turn the focus ring on the lens to adjust the focus. The camera offers several focus assistance
functions (11 85) to help you focus more accurately when using the manual focus.

One-shot AF*: You will be able to focus manually but still have the option to press the ONE-SHOT AF button to
let the camera focus automatically once on the subject inside the AF frame.

AF-Boosted MF*: Focus manually most of the way and let the camera finish focusing automatically.

Continuous AF*: The camera automatically keeps the subject inside the AF frame in focus at all times. You can
use the AF lock function ([T 91) to change the composition of the picture while keeping the focus on the
selected spot.

Face AF*: The camera automatically detects a person’s face, focuses on it and can track it if that person moves.
Tracking*: After you select a subject, the camera keeps focusing it and tracks the subject if it moves.
Note that some methods allow you to operate aspects of the focus by touching the LCD screen.

* Not available when a manual focus lens is attached to the camera.

Focusing methods and required settings

Focusing method Focus mode switch on an EF lens’ AF mode?
. MF _
Focus ring 3
Manual focus AF
[One Shot]
Browser Remote AF
ONE-SHOT AF button
One-shot AF AF [One Shot]
Browser Remote
Focus ring —
Camera (automatic)
AF-Boosted MF AF [AF-Boosted MF]

Browser Remote —

Camera (automatic)
Automatic

Continuous AF (camera or Browser Remote) AF [Continuous]

Face AF*/Tracking® Camera or Browser Remote AF -

1 For the necessary settings on compatible EF Cinema lenses and broadcast lenses, see the following table.
2 MENU > "™ Camera Setup] > [AF Mode].
Depending on the lens, the focus ring may be disabled when the focus mode switch is set to AF.
4 MENU > "™ Camera Setup] > [Face Detection].
5 To activate tracking, set an assignable button to [Tracking] and press the button.



Focus

Required settings on EF Cinema lenses and broadcast lenses

To adjust the focus from the camera, you will need to change the focus mode using the controls on the lens.
Required settings vary depending on the lens. Refer to the following table and the instruction manual of the lens
used.

Setting for automatic Setting for manual

Lens (11 247) Part used on the lens adjustment adjustment
CN7x17 KAS S/E1, CN7x17 KAS S/P1,
CN8x15 IAS S/E1, CN8x15 IAS S/P1, Focus operation
CN10x25 IAS S/E1, CN10x25 IAS S/P1, chan e-oﬁler knob SERVO MANU.
CN20x50 IAS H/E1, CN20x50 IAS H/P1, 9
compatible broadcast lenses
CN-E18-80mm T4.4 LIS KAS S, Autofocus/Manual Focus AF ME
CN-E70-200mm T4.4 L ISKAS S change-over switch

Manual Focus
Focus manually using the focus ring on the lens.

1 Select MENU > ["™ Camera Setup] > [AF Mode] > [One Shot].
e On an EF lens, you can set the lens’s focus mode switch to MF. On a compatible EF Cinema/broadcast lens,
you can enable manual adjustment on the lens.

2 Turn the focus ring to adjust the focus.

(1) NoTEs

¢ With some EF lenses, you may be able to operate the focus ring even when the focus mode switch is set to
AF.

e |f you operate the zoom after focusing, the focus on the subject may be lost.

e |f you focus manually and then leave the camera with the power turned on, the focus on the subject may be
lost after a while. This possible slight shift in focus is a result of the internal temperature rising in the camera
and lens. Check the focus before resuming shooting.

¢ \When adjusting the focus, be careful not to touch the front of the lens or moving parts on the lens except for
the focus ring.

¢ \When an optional RC-V100 Remote Controller is connected to the camera, you can adjust the focus with the
remote controller’s FOCUS dial. At default settings, turn the dial right to focus farther and left to focus nearer.

Using the Focus Assistance Functions

In order to focus more accurately, you can use the following focus assistance functions: Dual Pixel Focus Guide,
an onscreen guide that shows you if the selected subject is in focus; peaking, which creates a clearer contrast
by emphasizing the outlines of the subject; and magnification, which enlarges the image on the screen. You can
use peaking and the focus guide or peaking and magnification simultaneously for greater effect.
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Focus guide

The focus guide gives you an intuitive visual indication of the current focus distance and the direction and
amount of adjustment necessary to bring the selected subject into full focus. When used in combination with
face detection ([ 92), the guide will focus on the vicinity of the eyes of the person detected as the main
subject.

1 Set the focus mode switch on the lens to MF.
® On a compatible EF Cinema/broadcast lens, enable manual adjustment on the lens ([11 85).
¢ (MF) will appear on the left of the screen.

2 Press the FOCUS GUIDE button to display the focus guide.

¢ If you are not using the camera grip, you can set an assignable
button to [Focus Guide] (11 129).

¢ Alternatively, you can use the MENU > [ Assistance
Functions] > [Focus Guide] setting to turn the focus guide on
and off.

* You can use the MENU > [ Assistance Functions] > [Focus
Guide 2nd Frame] setting to display a second focus frame.
However, the second frame cannot be displayed if [Tele-
converter] is enabled.

3 Touch the point where you want to focus on the LCD screen to move the focus guide.

e You can also use the joystick or SELECT dial to move the focus guide’s frame. Press the CANCEL button to
return the focus guide’s frame to the center of the screen.

e When both focus guide frames are displayed, press SET to move the focus guide between the two focus
frames.

4 Adjust the focus manually as necessary.
e \When the focus guide turns green, the subject is correctly focused.

r o o o
L L L L

Focus farther Focus farther In focus Focus closer Focus closer Cannot determine
(large adjustment) (small adjustment) (in green) (small adjustment) (large adjustment) adjustment

(i) notes

¢ With subjects or in situations where autofocus may not work well ([T] 90), the focus guide may not work
correctly.

e The focus guide cannot be used in the following cases:
- While the focus is being adjusted automatically using one-shot AF, AF-Boosted MF or continuous AF.
- When the aperture value used is F13 or larger.
- When a manual focus lens is attached to the camera, except for compatible EF Cinema lenses ([ 247).

¢ \When the focus guide and face detection functions are used together, the focus guide may not focus the main
subject’s eyes correctly, depending on the direction in which the face is turned.
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Peaking
The camera offers two peaking levels.
1 Press the PEAKING button.

¢ The peaking icon (X8 or @®) appears on the left of the
screen and outlines (contour lines) in the image that are in
focus will be shown highlighted.

e Press the button again to turn off peaking.

e Alternatively, you can use one of the MENU > [ Assistance
Functions] > [Peaking:] settings to turn the peaking function on/
off separately on the respective terminal/output destination.

2 To change the peaking level, select MENU > [ Assistance
Functions] > [Peaking] > [Peaking 1] or [Peaking 2].

Magnification
1 Press the MAGN. button.
o (D appears on the left of the screen and the center of the screen* is magnified 2 times.
e The orange frame displayed on the top right of the screen (magnification frame) shows the approximate part
of the image shown magnified.
® Press set to change the magnification setting in the following order: 2x = 5x = 10x = 2x.
2 If necessary, use the joystick to move around the magnification frame and check other parts of the image.
e You can also drag your finger across the LCD screen to move the frame.
e Press the CANCEL button to return the magnification frame to the center position.

* Press the MAGN. button again to cancel the magnification.

* If one of the AF frames or a face detection frame is displayed on the screen, the area around the active frame will be magnified
instead.

(i) NoTes

¢ About Peaking/Magnification:

- You can use the MENU > [ Assistance Functions] > [Peaking 1] and [Peaking 2] settings to set the color,
gain and frequency of the two peaking levels independently of each other.

- You can use the MENU > [ Assistance Functions] > [Magn. Output] setting to select where to show the
magnified image (the LCD screen, an optional viewfinder or external monitors).

- The assistance functions will not affect your recordings.

- Magnification will be turned off if you change one of the following menu settings or if you turn slow & fast
motion recording on/off while the magnified image is displayed.
MENU > [£% Recording/Media Setup] > [Sensor Mode], [Main Rec Format], [Resolution/Color Sampling],
[Frame Rate]
MENU > ["™ Camera Setup] > [Digital Image Stabilization]

Peaking/magnification are not available while the color bars are displayed.

When MENU > [y Assistance Functions] > [B&W during Magn.] is set to [On], the screen is set to black and

white during magnification. The assistance functions will not affect your recordings.



88

Focus

Focus Position Guide

When a compatible lens (1] 247) is attached, you will be able to display the current focus position and the
preregistered focus positions. Depending on the lens, you may need to connect a 12-pin interface cable to the
LENS terminal of an optional EU-V2 Expansion Unit 2 or EU-V3 Expansion Unit 3.

For how to connect the lens and expansion unit, refer to the Cinema EOS System Expansion User Guide.

1 Select MENU > [ Assistance Functions] > [Focus Position Guide] > [Display] > [On].

The focus position guide dedicated screen appears.

e You can also set [Orientation] and [Sensitivity] of [Focus Position Guide] (11 204). [Sensitivity] is the level of
match (highlighting) between the current focus position and the registered focus positions, and the larger the
numeric value, the greater the match tolerance.

2 Set the focus position markers.

Select each of [Marker 1 Color] to [Marker 3 Color] and set the marker color.

3 Assign [Focus Position Marker 1] to [Focus Position Marker 3] to the assignable buttons ([1] 129).
4 Register the focus positions.

e |f you turn the lens’s focus ring, the current focus position appears. Press an assignable button at the
position you want to register. You can register up to three.

If you press and hold an assignable button, the registered focus position is cleared.

e |f the current focus position and a registered marker position match, a frame (highlighting) is displayed
around the screen.

(7 Current focus position
> P> : Registered focus positions

=

When normal When highlighting

(i) notes

e The screen display items are limited while the focus position guide is displayed. If you press the DISP button,
you can also change the DISP level from this screen (11 57).
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One-Shot AF

In this focus mode, you will focus manually in most situations but still have the option to have the camera focus
automatically only once on the subject inside the AF frame. You can change the size and position of the AF
frame.

1 Set the focus mode switch on the lens to AF.

e On a compatible EF Cinema/broadcast lens, enable automatic
adjustment on the lens ([1] 85).

. will appear on the left of the screen.

2 Select MENU > ["™ Camera Setup] > [AF Mode] >
[One Shot].

3 If necessary, change the size and position of the AF frame
(M 91).
4 Press and hold the ONE-SHOT AF button.

¢ A white AF frame will appear on the screen and the camera will focus automatically. When you are using
Face AF, the face detection frame around the face of the person who has been determined to be the main
subject will turn white.

¢ \When correct focus has been achieved, the AF frame turns green. If the camera cannot focus automatically,
the AF frame will turn red.

e The AF frame will disappear when you release the ONE-SHOT AF button.

(i) NoTes

e One-shot AF will not work in the following cases.
- When slow & fast motion recording is activated, if using certain lens models ([11 247).
- When Face AF is set to [Face Only] and a face has not been detected.

e \When the aperture value used is F13 or higher, Dual Pixel CMOS AF will not work and the camera will focus
using contrast-detection autofocus.

AF-Boosted MF

In this focus mode, you can focus manually most of the way and let the camera finish focusing automatically.
This is very convenient when you want to make certain that high-resolution clips (4K and higher) are in sharp
focus.

Additionally, with this mode, if the camera cannot evaluate how to adjust the focus, it will not perform unreliable
focus adjustments. This results in a more stable focusing operation overall than with continuous AF.

1 Set the focus mode switch on the lens to AF.
¢ On a compatible EF Cinema/broadcast lens, enable automatic adjustment on the lens ([1 85).
U will appear on the left of the screen.
2 Select MENU > ["™ Camera Setup] > [AF Mode] > [AF-Boosted MF].
¢ \When the focus is in the manual adjustment range, a yellow AF frame will appear on the screen.
3 If necessary, change the size and position of the AF frame ([1 91).
4 Turn the focus ring to adjust the focus.

e Focus manually to bring the subject closer into focus. When the focus enters the automatic adjustment
range, the focus frame will turn white and the camera will then finish focusing automatically.

¢ While the focus stays within the automatic adjustment range, the camera will keep the subject in focus
automatically.

* \When focusing nearer is not possible, the AF frame will turn red.
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Continuous AF

The camera will focus automatically on a subject inside the main area of the image (approximately 80% of the
screen’s length and height).

1 Set the focus mode switch on the lens to AF.
¢ On a compatible EF Cinema/broadcast lens, enable automatic adjustment on the lens ([1] 85).
. will appear on the left of the screen.

2 Select MENU > ["™ Camera Setup] > [AF Mode] > [Continuous].
e A white AF frame will appear on the screen.
¢ When you are using Face AF, a white detection frame will appear around the face of the person who has
been determined to be the main subject.
¢ When focusing nearer is not possible, the AF frame will turn red.

3 If necessary, change the size and position of the AF frame ([] 91).

(i) NoTES

About the autofocus (AF) functions:

¢ The point where the camera focuses may change slightly depending on shooting conditions, such as subject,
brightness and zoom position. Check the focus before resuming shooting.

¢ Autofocus may take longer in the following cases.

- When the frame rate set in the video configuration is 29.97P, 25.00P, 24.00P or 23.98P.
- With some EF lenses, the camera may take longer to focus automatically or may not be able to focus
correctly. Visit your local Canon website for the latest information.

¢ You can change the adjustment speed and responsiveness of the autofocus function with the following

settings. Visit your local Canon website for the latest information.

- MENU > ["™ Camera Setup] > [Apply AF Speed Limit] to select whether the selected AF speed is applied
at all times or only while recording.

- MENU > ["™ Camera Setup] > [AF Speed] to set the AF speed (the speed at which the focus is adjusted)
to one of 10 levels.

- MENU > "™ Camera Setup] > [AF Response] to set the responsiveness of the autofocus function to one
of 7 levels.

- While using continuous AF, you can hold the ONE-SHOT AF button pressed down to temporarily adjust the
focus using the maximum AF speed and AF response. This is helpful when you want to focus quickly after
focus was lost or to keep a subject in focus while you follow it.

Continuous AF will not work in the following cases.

- When using an EF lens that does not have a focus mode switch.

- While adjusting the focus using a remote controller connected to the REMOTE A terminal.

- When slow & fast motion recording is activated, if using certain lens models ([11 247).

e Autofocus may not work well on the following subjects or in the following cases. In such case, focus manually.

- Reflective surfaces - Through dirty or wet windows
- Subjects with low contrast or without vertical lines - Night scenes
- Fast moving subjects - Subjects with a repetitive pattern

- When using small apertures.

- When subjects at different distances appear in the picture.

- When an ISO speed or gain value in the extended range is selected ([T 74).

In the following cases, autofocus may not work as well as when the gamma curve component of the [Gamma/
Color Space] setting in the custom picture file (11 137) is set to [BT.709 Normal] or [BT.709 Standard].

- When the gamma curve component is set to an option other than [BT.709 Normal] or [BT.709 Standard)].

- When the main recording format is set to RAW.
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AF Lock

While using continuous AF or AF-Boosted MF, you can lock the focus on a certain subject and then move the

camera to change the composition. To use AF lock, you must set an assignable button to [AF Lock] in advance.

1 Set an assignable button to [AF Lock] ([11 129). 91

2 While the autofocus is active, press the assignable button. —

e The focus will be locked and and the AF frame will turn gray. When you are using Face AF, the face
detection frame around the main subject will turn gray.

e Press the assignable button again to cancel the AF lock.

(i) NoTES

e AF lock will be canceled automatically in the following cases:
- If the camera is turned off or the camera’s system frequency is changed.
- If the lens is removed or replaced.
- If MENU > "™ Camera Setup] > [AF Mode] is changed to [One Shot].
- When slow & fast motion recording is activated and the shooting frame rate used is other than 24P, 25P,
30P, 48P, 50P, 60P, 100P, or 120P.

Changing the AF Frame Size and Position

You can change the size and position of the AF frame that appears on the screen while using one of the
autofocus functions.

1 Select MENU > ["™ Camera Setup] > [AF Frame Position] > [Selectable] or [Center Framel].
2 Select MENU > ["™ Camera Setup] > [AF Frame Size] > [Large] or [Small].

Options for [AF Frame Position]

[Selectable]:  You can move the AF frame by touching the desired point on the LCD screen. You can also use
the joystick or SELECT dial. Press the CANCEL button to return the AF frame to the center of
the screen.

[Center Frame]: A fixed AF frame appears at the center of the screen.

Options for [AF Frame Size]
[Largel: Standard AF frame size.
[Small]: Smaller AF frame size (about 1/3 the standard size).

(i) NoTES

e \When [Tele-converter] is enabled, the [Small] AF frame’s position will be [Center Framel].
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Face Detection

When the face detection function is activated, the camera will detect people’s faces. When there are a number of
people in the picture, one person will be determined to be the main subject but you have the option to select a
different person as the main subject. The camera will keep tracking the main subject even when it moves.

You can use face detection with one of the autofocus functions to let the camera focus on the main subject
automatically (Face AF). You can also combine face detection with the focus guide ([I1 86) to help you focus on
the main subject manually.

1 Select MENU > ["™ Camera Setup] > [Face Detection] > [On].
¢ This is not available when slow & fast motion recording is activated and the shooting frame rate used is other
than 24P to 120P.

2 Select MENU > ["™ Camera Setup] > [Face AF] > [Face Priority] or [Face Only].
o @ (face priority) or @ (face-only AF) will appear on the left of the screen.

3 Point the camera at the subject.

e During continuous AF, the camera will keep focusing on the main subject’s face. During one-shot AF, the
camera will focus on the main subject’s face while you hold the ONE-SHOT AF button pressed down.

¢ All detected faces will have a face detection frame. The main subject will be indicated with a face detection
frame with small arrows.

Push the joystick left/right or turn the SELECT dial to select a different person as the main subject.

e During autofocus, a white frame will appear on the face of the main subject. During manual focus, the frame
will be gray or yellow*.

* [AF-Boosted MF] within manual adjustment range.

e [f you use face detection together with the tracking function (11 93), the camera will be able to track the
selected main subject more reliably. When you touch a subject on the LCD screen, tracking will be activated
and the face detection frame will change to a double frame ¢ J (tracking frame). This is better if you want to
track a subject when it is difficult to keep seeing their face.

Options
[Face Priority]: The camera focuses according to the AF mode currently selected.
[Face Only]: When a face is detected, the camera focuses according to the AF mode currently selected.

When there is no face detected, the camera locks the focus.

Face AF operation by AF mode

MENU > ["™ Camera Setup] > [Face AF]
MENU > ["™ Camera Setup] >

[AF Mode] and focus operation 725 i) [0 O]
Face detected  No face detected  Face detected  No face detected
[One Shot] while the ONE-SHOT AF button is not pressed Manual focus
[One Shot] while the ONE-SHOT AF button is held pressed down Focus on the
Focus on the Focus on the

subject inside Manual focus

[Continuous] (autofocus), detected face detected face

[AF-Boosted MF] within the automatic adjustment range the AF frame

[AF-Boosted MF] within the manual adjustment range

(vellow AF frame) Manual focus

(i) notes

® |n certain cases, faces may not be detected correctly. Typical examples include:
- Faces extremely small, large, dark or bright in relation to the overall picture.
- Faces that are turned to the side, at a diagonal, partially hidden or upside-down.
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¢ Face detection cannot be used in the following cases:

- When slow & fast motion recording is not activated and the shutter speed used is slower than 1/30
(59.94 Hz recordings), 1/25 (50.00 Hz recordings), or 1/24 (24.00 Hz recordings or 59.94 Hz recordings
with a 23.98P frame rate).

- When the second focus guide is active (MENU > [ Assistance Functions] > [Focus Guide] and [Focus
Guide 2nd Frame] are both set to [On]).

- When slow & fast motion recording is activated and the shooting frame rate used is other than 24P, 25P,
30P, 48P, 50P, 60P, 100P, or 120P.

- When a manual focus lens is attached to the camera.

- When [Tele-converter] is enabled.

e The camera may mistakenly detect the faces of non-human subjects. In such case, turn face detection off.

e If you set an assignable button to [Face Detection] (11 129), you can press the button to turn the function on
and off. If you set an assignable button to [Face AF], you can press the button to toggle between the face
detection options.

Tracking a Specific Subject

You can have the camera track other moving subjects that are not faces and also combine the tracking function
with one of the autofocus functions to let the camera focus on the desired subject automatically.
To use the tracking function, you will need to set an assignable button to [Tracking] in advance.

1 Set an assignable button to [Tracking] (11 129).

2 Press the assignable button.
¢ The subject selection mark »Z« will appear on the screen.
e Press the assignable button again or the CANCEL button to end the subject selection mode.
e This is not available when slow & fast motion recording is activated and the shooting frame rate used is other
than 24P to 120P.
3 Select the subject you want to track.

e Touch the desired subject on the LCD screen to start tracking it. You can also use the joystick or SELECT
dial to place the center of the »2« mark on the desired subject and then press SET.

e If the tracking failed, the »Z« mark will turn red momentarily. Select the subject again.

4 The »Z« mark changes to a double frame ¢ ] (tracking frame) and the camera will start tracking the
selected subject.
e During continuous AF, the camera will keep focusing on the selected subject. During one-shot AF, the
camera will focus on the selected subject while you hold the ONE-SHOT AF button pressed down.
e Press SET or the assignable button again to return to subject selection mode and select a different subject
to track. Press the CANCEL button to end the tracking function and return the camera to the focus mode
that was used previously.

(i) NoTES

e The camera may start tracking the incorrect subject if there is another subject in the picture with similar color/
pattern characteristics. In that case, select the desired subject again.
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Image Stabilization

Image Stabilization

In CAMERA mode, you can use the image stabilizer to compensate for camera shake and achieve steadier
shots. The image stabilizer is more effective at wider angles and the effect is reduced the more you approach the
telephoto end.

The camera’s image stabilization is not available for RAW clips.

1 Select MENU > ["™ Camera Setup] > [Digital Image Stabilization] > [On].

* \When using lenses not compatible with camera-lens communication, perform step 2 to enter the lens’s focal
length manually. With compatible lenses, skip to step 3.

* Image stabilization is activated and & appears on the left of the screen.

2 Select MENU > "™ Camera Setup] > [Lens Focal Length] and enter the lens’s focal length using the
data entry screen ([]] 60).
* The image stabilization is adjusted according to the focal length entered.

3 When using an anamorphic lens, select MENU > ["™ Camera Setup] > [Anamorphic Corr.] >
Squeeze factor to use to correct the image stabilization.

e If you selected [Lens Squeeze Factor], the anamorphic correction will be applied according to the squeeze
factor specified with the MENU > [£% Recording/Media Setup] > [Metadata] > [Lens Squeeze] setting.

(i) Nnotes

e [f the IS function is turned off on an EF lens, the camera’s image stabilization function is deactivated too and
the & icon will flash on the left of the screen.

e Even if the IS function is turned off on a B4 broadcast lens, it will not affect the camera’s image stabilization
function.

e Depending on the subject and shooting conditions, subject blur may be more prominent (the subject may be
momentarily blurred) due to the use of image stabilization.

e \When using TS-E lenses and fisheye lenses, turning off the camera’s image stabilization is recommended.

¢ \When the camera is expected to be stable, for example when it is mounted on a tripod, turning off the
camera’s image stabilization is recommended.

e |f the degree of camera shake is too high, the image stabilizer may not be able to compensate fully.

¢ The camera’s image stabilization will not function when using super telephoto lenses with a focal length
exceeding 1000 mm.



Zoom

Zoom

In CAMERA mode, you can use the camera to zoom when an EF Cinema/broadcast lens compatible with zoom
operation ([11 247) or an EF lens integrated with an optional PZ-E1 Power Zoom Adapter is attached to the
camera.

You can also zoom remotely using Browser Remote on a connected network device ([1] 187, 189).
Additionally, you can select the digital tele-converter from the menu and move the focal length to the telephoto
range (except when recording in RAW format).

Required settings on EF Cinema lenses and broadcast lenses

To operate the zoom from the camera, you will need to enable automatic adjustment using the controls on the
lens. Required settings vary depending on the lens. Refer to the following table and the instruction manual of the
lens used.

Lens ([1] 247) Part used on the lens Setting for automatic adjustment
CN7x17 KAS S/E1, CN7x17 KAS S/P1,
CN8x15 IAS S/E1, CN8x15 IAS S/P1, .
CN10x25 1AS S/E1, CN10X25 IAS S/P1, Zoom operation change-over knob SERVO
CN20x50 IAS H/E1, CN20x50 IAS H/P1
CN-E18-80mm T4.4 LIS KAS S, .
CN-E70-200mm T4.4 L IS KAS S Zoom change-over switch SERVO
EF-S 18-135mm F3.5-5.6 IS USM* Zoom mode switch PZ (Power Zoom)

* When using the optional PZ-E1 Power Zoom Adapter, make the required setting on the PZ-E1, not the lens.

1 Enable automatic zoom adjustment on the lens.
2 Select MENU > ["™ Camera Setup] > [Camera Grip Zoom] > [On].

3 Select MENU > ["™ Camera Setup] > [Camera Grip Zoom Speed] > Desired zoom speed.
e Zoom speeds are constant; [1] being the slowest and [16] the fastest.

4 After closing the menu, use the joystick on the camera grip to zoom.
e Push the joystick up to zoom in (telephoto) and push it down to zoom out (wide-angle).

(i) NoTES

¢ \When an optional RC-V100 Remote Controller is connected to the camera and the lens is correctly set, you
can zoom with the remote controller’s ZOOM dial.

¢ \When using slow zoom speeds, it may take longer for the lens to start moving.

Using the digital tele-converter:

The focal length is multiplied by the selected factor when you select MENU > ["™ Camera Setup] >
[Tele-converter] > desired option.
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Onscreen Markers, Zebra Patterns and False Color

Onscreen Markers, Zebra Patterns and False Color

In CAMERA mode, using onscreen markers allows you to make sure your subject is correctly framed and is
within the appropriate safe area. Zebra patterns help you identify areas that are overexposed. The false color
overlay allows you to check if the exposure is correct. You can display the assistance overlays independently on
the LCD screen, an optional viewfinder or external monitors. The assistance overlays will not affect your
recordings.

Displaying Onscreen Markers

The camera offers several onscreen markers. You can display multiple onscreen markers simultaneously and
select their color individually.

[Center Marker]: Displays a small marker that indicates the center of the screen. You can select the shape of the
center marker.

[Horizontal Marker]: Displays a horizontal line to help you compose level shots.
[Grid Marker]: Displays a grid that allows you to frame your shots correctly (horizontally and vertically).

[Aspect Marker]: Indicates various aspect ratios by displaying border lines or by masking the image outside the
selected aspect ratio. Available options include standard aspect ratios ([4:3], [1.66:1], etc.), a vertical aspect ratio
[9:16], and [Custom], a free aspect ratio set by the user.

[Safe Area Marker]: Displays a margin from the edges of the image to indicate the action safe area, text safe
area, etc. You can select the core area used as the basis for calculating the safe area and a percentage, relative
to the side length or area.

[User Marker 1], [User Marker 2]: Displays up to two rectangular frames whose size and position you can set

freely and independently of each other.

1 To display the markers overlay on individual video outputs, select MENU > [ Assistance
Functions] > [Markers: VIDEO Term.] (LCD screen), [Markers: EVF-V50] (optional viewfinder),
[Markers: MON./HDMI] or [Markers: SDI OUT] (external monitors) > [On].

e [f the respective setting is set to [Off], onscreen markers will not be displayed on the corresponding video
outputs even if individual markers are configured.

Safe area 88%
by side length

®___ Horizontal
marker

Aspect guide 4:3

User marker  Center marker Grid
(100, 250) ([Cross 1] type)

2 Select the marker(s) you wish to display and configure them with the following procedures.
e You can display multiple markers simultaneously.
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Center Marker / Horizontal Marker / Grid Marker

1 Select MENU > [ Assistance Functions] > [Center Marker], [Horizontal Marker] or [Grid Marker] > Desired
marker color.
e Select [Off] to turn off the marker.

2 For [Center Marker] only: Select MENU > [ Assistance Functions] > [Center Marker Type] > Desired marker
shape.

Aspect Marker

1 Select MENU > [ Assistance Functions] > [Aspect Marker] > Desired marker color or transparency of the
masked area.
e Select [Off] to turn off the marker.

2 Select MENU > [ Assistance Functions] > [Marker Aspect Ratio] > Desired option.

e |f you selected one of the preset aspect ratios, the rest of the procedure is not necessary. If you selected
[Custom], perform step 3 to specify the aspect ratio.

3 For [Custom] only: Select MENU > [ Assistance Functions] > [Marker Custom Asp. Ratio] and enter the
aspect ratio using the data entry screen (11 60).

Safe Area Marker

If an aspect marker is not selected, the safe area will be calculated as a percentage of the whole image and you
can only select the percentage. To calculate the safe area as a percentage of an aspect ratio marker, select an
aspect marker in advance (previous procedure).

1 Select MENU > [ Assistance Functions] > [Safe Area Marker] > Desired marker color.
e Select [Off] to turn off the marker.

2 Only when an aspect marker is already activated: Select MENU > [ Assistance Functions] > [Basis for
Marker Safe Area] > [Whole Picture] or [Selected Aspect Marker].

3 Select MENU > [ Assistance Functions] > [Marker Safe Area %] > Desired percentage.

e You can select the margin as a percentage of the total frame area [(Area)] or as a percentage of the width/
height [(Side Length)].

User Markers

1 Select MENU > [ Assistance Functions] > [User Marker 1] or [User Marker 2] > Desired marker color.
e Select [Off] to turn off the marker.

2 Select MENU > [ Assistance Functions] > [User Marker 1 Size] or [User Marker 2 Size] and enter the width
[W] and height [H] using the data entry screen (11 60).

3 Select MENU > [ Assistance Functions] > [User Marker 1 Position] or [User Marker 2 Position] and enter
the [X] and [Y] coordinates using the data entry screen ([1] 60).
e |f necessary, repeat the procedure from the beginning to display both user markers.

(i) NoTEs

e After activating the onscreen markers you can set MENU > [[Z) Monitoring Setup] > [DISP Level 2] to [Only
FUNC/MENU] and then select display level 2 to turn off all other onscreen displays, leaving only the markers
(57).

e |f you set an assignable button to [Markers: All], [Markers: VIDEO Term.], [Markers: EVF-V50], [Markers: MON./
HDMI] or [Markers: SDI OUT] (1] 129), you can press the button to turn the markers on and off on all
monitoring devices, the supplied LCD screen, an optional viewfinder or external monitors, respectively.
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Displaying Zebra Patterns

The camera has a zebra pattern function that shows black and white diagonal stripes over

areas that are overexposed. There are two types of zebra patterns and you can display both \ /
simultaneously. Zebra 1 lets you identify areas within a certain range (+5% of a specified level \
from 5% to 95%) while zebra 2 lets you identify areas that exceed a specified level (from 0%  Zebral  Zebra2
t0 100%).

1 Select MENU > [ Assistance Functions] > [Zebra] >
[Zebra 1], [Zebra 2] or [Zebra 1+2] (both zebra patterns).

2 Select MENU > [T& Assistance Functions] > [Zebra 1 Level]
or [Zebra 2 Level] > Desired option.

3 Press the ZEBRA button to activate the selected zebra
pattern on all monitoring devices at once.
¢ Alternatively, you can press an assignable button set to
[Zebra: All], [Zebra: VIDEO Term.], [Zebra: EVF-V50] or [Zebra:
MON./HDMI] (11 129), to turn the zebra pattern overlay on and off on all monitoring devices, the supplied
LCD screen, an optional viewfinder or external monitors, respectively.

Displaying False Color

In this display mode 6 colors are overlaid on a black & white version of the image to identify potentially
problematic exposure areas.

To display the false color overlay on individual video outputs, select MENU > [y Assistance
Functions] > [False Color: VIDEO Term.] (LCD screen), [False Color: EVF-V50] (optional viewfinder) or
[False Color: MON./HDMI] (external monitors) > [On].

e Alternatively, you can press an assignable button (1] 129) set to one of the above options, or to [False Color:
All] to turn the false color overlay on and off on all monitoring devices at once.

(i) Nnotes

* You can use the MENU > [ Assistance Functions] > [False Color Index] setting to check an index of the
colors used in the false color overlay.
Color Meaning
Red White clipping
Yellow | Just below white clipping
Pink | One stop over 18% gray
Green | 18% gray (medium gray)

Blue | Just above black clipping

Purple | Black clipping

e The false color overlay will not be output while color bars are displayed.
¢ When the Look File registered to the custom picture file is active, the color displayed might not be that of the
correct brightness level.
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Setting the Time Code

In CAMERA mode, the camera generates a time code signal and records it with the recorded clips. The time
code signal can be output from the SDI OUT terminal, MON. terminal, TIME CODE terminal ((11 103) or HDMI
OUT terminal. In MEDIA mode, the time code embedded in the clip being played back is output from the SDI
OUT terminal or MON. terminal.

Depending on the frame rate used, you may be able to select between a drop frame an non-drop frame time
code signal (11 100). The default mode varies depending on the country/region of purchase and, though the
time code display style is different for DF and NDF, in this section the NDF display style is used for simplicity’s
sake.

Selecting the Time Code Mode

In CAMERA mode you can select the camera’s time code mode.

Select MENU > [¥ System Setup] > [Time Code Mode] > [Preset] or [Regen.].
Options

[Preset]: The time code starts from an initial value you can select in advance. The default initial time code
is 00:00:00:00.
See the following procedures to select the time code running mode and set the initial time code.
[Regen.]: The camera will read the selected card and the time code will continue from the last time code

recorded on the card. The time code runs only while recording so clips recorded consecutively
on the same card will have continuous time codes.

Setting the Time Code Running Mode

If you set the time code mode to [Preset], you can select the time code running mode.
Select MENU > [¥ System Setup] > [Time Code Run] > [Rec Run] or [Free Run].
Options

[Rec Run]: The time code runs only while recording so clips recorded consecutively on the same card will
have continuous time codes.
[Free Run]: The time code starts running the moment you confirm the selection and keeps running

regardless of the camera’s operation.

Setting the Time Code’s Initial Value

If you set the time code mode to [Preset], you can set the initial value of the time code.

1 Select MENU > [¥ System Setup] > [Set Time Code] > [Change].

* The time code setting screen appears with an orange selection frame indicating the hours.

e To reset the time code to [00:00:00:00], select [Reset] instead. If the running mode is set to [Free Run], the
time code will be reset the moment you confirm the selection and keep running continuously from
00:00:00:00.

2 Enter the initial time code using the data entry screen ([1] 60).

e |f the running mode is set to [Free Run], the time code will start running from the selected time code the
moment you confirm the selection.
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Selecting Drop or Non-Drop Frame

When the frame rate is set to 59.94P, 59.94i or 29.97P, you can select between a drop frame (DF) or non-drop
frame (NDF) time code, depending on how you plan to use your recordings.

With all other frame rates, the time code is set to non-drop frame (NDF) and cannot be changed.

Select MENU > [¥ System Setup] > [Time Code DF/NDF] > [DF] or [NDF].

¢ The time code display will change depending on the setting. When you select [DF], the time code will appear
as [00:00:00.00]; when you select [NDF], it will appear as [00:00:00:00].

About the time code display
An icon may appear next to the time code depending on the operation. Refer to the following table.
Icon Description
R The time code mode is set to [Regen.].
P The time code mode is set to [Preset] and the running mode is set to [Rec Run].
F The time code mode is set to [Preset] and the running mode is set to [Free Run].
E The time code signal is coming from an external source.

No icon | Time code during clip playback.

(i) NOTES

¢ About the time code output:

- In CAMERA mode, the embedded time code signal is output from the SDI OUT terminal and MON. terminal.
With the MENU > [£% Recording/Media Setup] > [HDMI Time Code] setting you can output the time code
signal also from the HDMI OUT terminal ((11 157).

- In MEDIA mode, the time code and user bit recorded with the clip are output from the SDI OUT terminal and
MON. terminal.

e The frames value of the time code runs from O to 23 (frame rate set to 23.98P or 24.00P), from 0 to 24 (frame
rate set to 25.00P, 50.00i or 50.00P), or from 0 to 29 (all other frame rates).

However, if MENU > [ System Setup] > [MON./HDMI Scan Mode] is set to [PsF (Forced 1080i)] or if MENU
> [ System Setup] > [MON. Output Resolution] or [HDMI Max Res.] is set to [1280x720], even when the
frame rate is set to 23.98P or 24.00P, the frames value of the time code output from the MON. terminal and
HDMI OUT terminal will be converted so it runs from O to 29.

When slow & fast motion recording is activated, you cannot select the [Free Run] running mode. Conversely,
when pre-recording is activated, [Free Run] is set automatically and cannot be changed.

When slow & fast motion recording is activated, the time code signal will not be output from any of the
terminals.

When you mix drop frame and non-drop frame time codes, there might be a discontinuity in the time code at
the point where the recording starts.

¢ \When you are using the [Free Run] running mode, the time code will continue running as long as the built-in
backup battery has some charge left, even if you disconnect all other power sources.

If you set an assignable button to [Time Code] (1 129), you can press the button to open the

[ System Setup] menu page with the time code settings.




Setting the User Bit

Setting the User Bit

In CAMERA mode, you can set a user bit composed of the date or the time of recording or an identification code
consisting of 8 characters in the hexadecimal system. There are sixteen possible characters: the numbers 0 to 9

and the letters Ato F.
The user bit is recorded with clips and can be output from the SDI OUT terminal, MON. terminal, TIME CODE

terminal or HDMI OUT terminal. It can be used freely to categorize and manage recordings or to keep additional
information about them.

To set an hexadecimal code
1 Select MENU > [¥ System Setup] > [User Bit Type] > [Setting] > [Changel.
¢ To reset the user bit to [00 00 00 00], select [Reset] instead.

2 Enter the user bit using the data entry screen ([1] 60).
e Press the CANCEL button to close the screen without making any changes.

To use the recording date/time
Select MENU > [¥ System Setup] > [User Bit Type] > [Date] or [Time].
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Synchronizing with an External Device

In CAMERA mode, you can use the camera’s TIME CODE terminal to synchronize this camera’s time code to an
external signal. Using the same external time code signal with multiple cameras allows you to set up a multi-
camera recording. You can also output the time code signal from this camera to other cameras. You can output
the time code signal from the SDI OUT terminal or MON. terminal to an editing device (while recording or during
playback), so the editor can create video with the same time code.

Additionally, when the optional EU-V1 Expansion Unit 1 or EU-V2 Expansion Unit 2 is attached to the camera,
you can use the EU-V1 or EU-V2's G-LOCK/SYNC OUT terminal to synchronize this camera’s video signal to a
reference signal* from an external video device (Genlock synchronization) or to send out the camera’s video
signal as a synchronization reference signal®.

* As reference video signal (input signal) for Genlock synchronization, you can use an analog blackburst or tri-level HD signal. The
reference video output signal will be a tri-level HD signal.

Connecting an External Device

When synchronizing a time code signal, connect the external device to the TIME CODE terminal on the camera.
When synchronizing with a reference video signal, connect the external device to the G-LOCK/SYNC OUT
terminal on an optional EU-V1 or EU-V2 attached to the camera. Be sure to set either terminal to input or output
in advance.

Connection diagram

TIME CODE terminal j
)

TC

EU-V2 Expansion
Unit 2 (optional)

>

G-LOCK/SYNC OUT terminal J

s BNC cable (commercially available)

Time Code Signal Input

An external SMPTE-standard LTC timing signal received from the TIME CODE terminal can be recorded as the
time code. The user bit of the external timing signal can also be recorded with clips. Before connecting the
device, set the TIME CODE terminal to input with the procedure below and make sure the time code running
mode is set to [Free Run] (11 99).

1 Select MENU > [ System Setup] > [TC In/Out] > [In].

2 To record the external time code signal’s user bit, select also MENU > [¥ System Setup] > [User Bit
Recording Mode] > [Externall].



Synchronizing with an External Device

(i) NoTes

¢ Synchronize the camera’s time code with an external time code signal that matches the camera’s system
frequency. Use a 24-frame time code signal when the frame rate is set to 23.98P or 24.00P, a 25-frame time
code signal when it is set to 25.00P, 50.00i or 50.00P and a 30-frame time code signal for other frame rates.

¢ When a suitable external time code signal is received, the camera’s own time code will be synchronized to it
and the synchronization will be maintained even if you disconnect the cable from the TIME CODE terminal.

¢ |f the external time code signal is incorrect or there is no input signal, the internal time code set in the camera
will be recorded instead.

¢ \When an external time code signal is received, the DF/NDF selection will follow the external time code signal’s
settings.

e |f an external time code signal is input while pre-recording is activated, there might be a discontinuity in the
time code of the pre-recorded clip.

¢ Performing any of the following actions while the cable is not connected will cause the synchronization to be
disrupted; the correct time code will be restored once you reconnect the cable.
- Turning the camera on/off
- Switching to MEDIA mode
- Changing the video configuration

Time Code Signal Output

The time code signal output from the TIME CODE terminal will be a SMPTE-standard LTC timing signal. The user
bit will also be output.

Select MENU > [¥ System Setup] > [TC In/Out] > [Out].

(i) NoTes

¢ About the user bit output: In CAMERA mode, the user bit set by the user (1] 101) will be output. In MEDIA
mode, the user bit is not output from the TIME CODE terminal.

¢ The time code and user bit will not be output when slow & fast motion recording is activated.

Reference Video Signal Input (Genlock Synchronization)

When a reference sync signal (analog blackburst or tri-level signal) is input through the optional EU-V1’s or
EU-V2’s G-LOCK/SYNC OUT terminal, the phases of the camera's V and H sync will automatically be
synchronized to it. The phase difference between the external Genlock signal and the camera is initially set to 0.
The H phase can be adjusted within the range of approximately +0.4 H.

1 Select MENU > [¥ System Setup] > [G-LOCK/SYNC Term.] > [Genlock Input].

2 Select MENU > [¥ System Setup] > [Genlock Adjustment] > [Change].
e To reset the adjustment value to [000], select [Reset] instead.

3 Enter the H-phase adjustment value using the data entry screen (1] 60).

(i) NoTES

¢ \When a suitable Genlock signal is input, the Genlock synchronization stabilizes after approximately
10 seconds.

¢ \When a suitable Genlock signal is detected, the icon will flash at the top right of the screen. When the
camera locks on the external Genlock signal, the icon will stay on.
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e |f the external Genlock signal is incorrect, the synchronization may not be stable. In such case, the recorded
time code may be incorrect.

Reference Video Signal Output

After changing the function of the optional EU-V1’s or EU-V2's G-LOCK/SYNC OUT terminal, you can use the
camera’s video signal as a reference sync signal (tri-level HD signal) to synchronize an external device to this
camera. The reference signal’s configuration is determined by the video output configuration of the SDI OUT
terminal and other menu settings.

1 Select MENU > [¥ System Setup] > [G-LOCK/SYNC Term.] > [HD Sync Output].
2 If necessary, select MENU > [¥ System Setup] > [SYNC Scan Mode] > [P] or [PsF].



Recording Audio

Recording Audio

The camera features 4-channel linear PCM audio recording and playback. The sampling frequency is 48 kHz and
the audio sampling bit depth is 24 bit. You can record audio using the INPUT terminals (commercially available
analog microphones, analog line-in audio sources, AES/EBU digital audio sources), the MIC terminal

(commercially available microphones) or the built-in monaural microphone*.

The audio signal will be output with the video signal from the SDI OUT terminal, MON. terminal and HDMI OUT

terminal. You can record the audio signal on an external recorder.

* Only for recording voice memos while shooting.

Audio Settings and Recorded Audio Channels

Which audio inputs are recorded to which audio channels is determined by a combination of menu settings and
audio-related controls on the camera. Refer to the illustration below and the table on the next page.

)
INPUT 1

INPUT 1/ INPUT 2 switches —
(audio source selection)

AES/EBU
LINE.
MIC

MIC.
+48V

INPUT 2

AES/EBU
LINE:
MIC:

MIC.
+48V

—
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Menu settings

Audio source
selection switches

Recorded audio channels/audio sources

[CH1/CH2]'  [CH3/CH4]'  [CH2Input]®  INPUT1 INPUT 2 CH1 CH2 CH3 CH4
106 AES/EBU INPQT 1 termlnal INPQT 2 termmal
- (digital audio) (digital audio)
- AES/EBU
LINE, MIC, INPUT 1 terminal _ INPUT 2
MIC+48V (digital audio) terminal
AES/EBU INPUT 1 _ INPQT 2 tern'!lnal
[INPUT terminal (digital audio)
. [INPUT 2]
Terminals] LINE, MIC, INPUT 1 INPUT 2 INPUT 1 INPUT 2
LINE, MIC, MIC+48V terminal terminal terminal terminal
MIC+48V i
AES/EBU INPUT 1 INPUT 1 INPPT. 2 tern'!lnal
INPUT 1] terminal terminal (digital audio)
LINE, MIC, INPUT 1 INPUT 1 INPUT 1 INPUT 2
MIC+48V terminal terminal terminal terminal
INPUT 1 terminal MIC terminal | MIC terminal
- AES/EBU - (digital audio) L ®)
INPUT 1 MIC terminal | MIC terminal
[INPUT e AESEBU | torminal B It ®)
Terminals] Terminal [INPUT 2] : ;
erminal] LINE, MIC, LINE, MIC, INPUT 1 INPUT 2 MIC terminal | MIC terminal
MIC+48V MIC+48V terminal terminal L (R)
INPUT 1 INPUT 1 MIC terminal | MIC terminal
(INPUT 1] B terminal terminal L ®)
INPUT 1 terminal Built-in Built-in
- AES/EBU - - ) microphone | microphone
(digital audio)
(mono) (mono)
Built-in Built-in
AES/EBU INPU.T ! - microphone | microphone
M | terminal (mono) (mono)
[ (IJVrI]iac;"a [(INPUT 2] Built-i Built-i
LINE, MIC, | LINE MIC, | INPUT 1 INPUT 2 micf; ;gne mic‘:(') ;]'Sne
MIC+48V | MIC+48V | terminal terminal P P
(mono) (mono)
INPUT 1 INPUT 1 Built-in Built-in
[INPUT 1] - : ) microphone | microphone
terminal terminal
(mono) (mono)
MIC terminal | MIC terminal INPUT 2 terminal
B AES/EBU L ®) (digital audio)
[INPUT MIC terminal | MIC terminal INPUT 2
Terminals] AES/EBU LINE, MIC, L (R) terminal
VG LINE, MIC, MIC+48V | MIC terminal | MIC terminal |  INPUT 1 INPUT 2
. MIC+48V L (R) terminal terminal
Terminal]
[MIC MIC terminal | MIC terminal | MIC terminal | MIC terminal
Terminal] L) (R) L) (R)
[Monaural - B - MIC terminal | MIC terminal ‘BU|It-|n .Bu"t-m
) microphone | microphone
Mic] L) (R)
(mono) (mono)




Menu settings

Audio source
selection switches

Recording Audio

Recorded audio channels/audio sources

[CH1/CH2]! [CH3/CH4]'  [CH2 Input]? INPUT 1 INPUT 2 CH1 CH2 CH3 CH4
Built-in Built-in INPUT 2 terminal
- AES/EBU microphone | microphone -, )
(digital audio)
(mono) (mono)
Built-in Built-in
[INF_’UT - AES/EBU microphone | microphone - INPU_T 2
Terminals] terminal
LINE, MIC, (mono) (mono)
MIC+48V ilt-i ilt-i
[Monaural LINE, MIC, mi'z;’;'tr:gne miﬁ:&'th'gne INPUT 1 INPUT 2
Mic] MIC-+48V P ? terminal terminal
(mono) (mono)
IMIC Built-in BUIIN 1\ terminal | MIC terminal
. microphone | microphone
Terminal] (L) (R)
(mono) (mono)
Built-in Built-in Built-in Built-in
[Monaural ) ) . .
) microphone | microphone | microphone | microphone
Mic]
(mono) (mono) (mono) (mono)

T MENU > [M) Audio Setup] > [Audio Input Selection] > [CH1/CH2] and [CH3/CH4] settings.
2 MENU > [ Audio Setup] > [CH2 Input] setting.

Using the optional EU-V2 Expansion Unit 2
When an optional EU-V2 Expansion Unit 2 with a commercially available V-mount battery is attached to the
camera, you can use the EU-V2’s INPUT terminals to record an analog audio source (INPUT 3 terminal to CH3
and INPUT 4 terminal to CH4). The analog audio source (LINE, MIC or MIC+48V) is determined by the audio
source selection switches on the EU-V2.

Audio source
selection switches
on the camera

Menu settings Recorded audio channels/audio sources

[CH1/CH2]'  [CH3/CH4]"2  [CH2 Input]® INPUT 1 INPUT 2 CH1 CH2 CH3 CH4
INPUT 1 terminal INPUT 3 INPUT 4
- AES/EBU - (digital audio) terminal terminal
INPUT 1 INPUT 3 INPUT 4
T[INP_UTI INPUT 2] AES/EBU terminal - terminal terminal
erminals
(Camera)]’* LINE, MIC, INPUT 1 INPUT 2 INPUT 3 INPUT 4
[INPUT MIC+48V LINE, MIC, terminal terminal terminal terminal
Terminals INPUT 1] MIC+48V INPUT 1 INPUT 1 INPUT 3 INPUT 4
(Exp. Unit)] terminal terminal terminal terminal
[MIC MIC terminal | MIC terminal INPUT 3 INPUT 4
Terminal] L R) terminal terminal
[Monaural - - - Built-in Built-in INPUT 3 INPUT 4
. microphone | microphone ; .
Mic] terminal terminal
(mono) (mono)

T MENU > [M) Audio Setup] > [Audio Input Selection] > [CH1/CH2] and [CH3/CH4] settings.
For combinations of settings that do not use the [INPUT Terminals (Exp. Unit)] option, the recorded audio channels are the same
as in the previous table.

3 MENU > [M) Audio Setup] > [CH2 Input] setting.

4 When the EU-V2 with a V-mount battery is attached to the camera, the option to use the INPUT terminals on the camera
appears as [INPUT Terminals (Camera)] instead of [INPUT Terminals].

107



108

Recording Audio

(i) NoTES

e |f the V-mount battery is removed while using the EU-V2’s INPUT 3/
INPUT 4 terminals, the audio inputs recorded on CH3/CH4 will
change automatically to INPUT 1 and INPUT 2, respectively.

® You can press the AUDIO STATUS button to display only the
[P Audio Setup] status screens. On these status screens ([11 215)
you can check the input source selected for each audio channel and
other audio-related settings.

¢ When you display the [§) Audio Setup] status screens using the
AUDIO STATUS button, you can press SET to open directly the
[d) Audio Setup] menu page.

Connecting an External Microphone or External Audio Input Source to the Camera

To each of the INPUT terminals you can attach commercially available microphones, digital audio sources (AES/
EBU), or analog line in sources with an XLR connector. To the MIC terminal you can attach commercially
available condenser microphones with a & 3.5 mm stereo mini plug.

Using the supplied microphone holder, you can fix external microphones with a diameter of 19 mm to 20 mm.

Follow the procedure below to connect a microphone (refer also to the following illustration). To connect an
external device to the camera, plug the device’s cable into the desired INPUT terminal (@).

1 Loosen the microphone lock screw (D), open the
microphone holder and insert the microphone ((2).

2 Tighten the lock screw and put the microphone cable
through the cable clamp under the microphone holder

®).

3 Plug the microphone cable into the desired INPUT
terminal (@) or the MIC terminal ().

@ wPorTANT

¢ Do not connect or disconnect microphones and other audio
devices from any INPUT terminal when the corresponding
INPUT (audio source selection) switch is set to the
MIC+48V position. This may damage the camera and/or device.

Microphone lock screw

INPUT 1 terminal
INPUT 2 terminal
MIC terminal

|
.
2 OlllE
=

Z

y B

v




Recording Audio

Setting the Audio Input Type for the INPUT 1/INPUT 2 Terminals

Using the INPUT 1/INPUT 2 terminals, you can record audio independently from a microphone or audio input

source.

Set the INPUT 1 or INPUT 2 switch to AES/EBU (digital audio), o S yrenes

LINE (analog audio device) or MIC (analog microphone).

e When a terminal’s INPUT (audio source selection) switch is set to
AES/EBU, the audio recording level for that input cannot be
adjusted.

¢ When using the INPUT terminals to record to only one channel,
use the INPUT 1 terminal.

@ vroRTANT
¢ Using an analog microphone that requires phantom power
- Be sure to connect/disconnect the microphone with the camera
turned off or when the respective INPUT switch is set to the MIC
position. Only after the microphone is connected, set the switch to MIC+48V.
- The same applies also to INPUT terminals on an optional EU-V2 Expansion Unit 2 attached to the camera.
¢ To connect a microphone or other audio device that is not compatible with phantom power to an INPUT
terminal, make sure the respective INPUT (audio source selection) switch is set to a position that matches the
device (AES/EBU, LINE or MIC). Setting the switch to MIC+48V may damage the audio device.

Selecting the Audio Input Source for Audio Channels

In CAMERA mode, you can select the audio input source that will be recorded on CH1/CH2 or CH3/CH4,
independently for each pair of audio channels. For details refer to the Audio Settings and Recorded Audio
Channels table (11 105).

1 Select MENU > [)) Audio Setup] > [Audio Input Selection] > [CH1/CH2] or [CH3/CH4].

2 Select [INPUT Terminals] (external microphone or audio device), [MIC Terminal] (external
microphone) or [Monaural Mic] (built-in microphone).

¢ \When an optional EU-V2 Expansion Unit 2 with a commercially available V-mount battery is attached to the
camera, the [INPUT Terminals] option changes to [INPUT Terminals (Camera)] and you have an additional
option [INPUT Terminals (Exp. Unit)] (only for [CH3/CH4]) to record audio from the INPUT terminals on the
EU-V2.

About the monaural microphone
The monaural microphone allows you to add comments while shooting, Monaural
which can be synchronized to the audio and video during editing. The audio microphone
recording level of the monaural microphone is adjusted automatically and
cannot be changed.
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Recording the Same Analog Audio Input to Two Channels

By default, when using analog audio sources (line in or microphone) connected to the INPUT terminals, each
audio input is recorded to a separate audio channel (INPUT 1 to CH1 and INPUT 2 to CH2).

If necessary (for example, as an audio backup recording), you can record the same analog audio source
connected to the INPUT 1 terminal to both audio channels, CH1 and CH2. In that case, you can adjust the audio
recording levels of each channel independently of each other.

Select MENU > [) Audio Setup] > [CH2 Input] > [INPUT 2] or [INPUT 1].

Options
[INPUT 2 Records audio to each channel separately. Audio input into INPUT 1 is recorded to CH1, while
audio input into INPUT 2 is recorded to CH2.

[INPUT 1]: Audio input into INPUT 1 is recorded to both channels. Audio input into INPUT 2 will not be
recorded.

Adjusting the Audio Recording Level

In CAMERA mode, you can adjust the audio recording level of analog audio inputs (INPUT terminals or MIC
terminal). You can select automatic or manual audio level adjustment, and adjust each audio channel separately
or adjust CH1/CH2 or CH3/CH4 together (when the audio level adjustment of the audio channels is linked,
111).

The audio recording level of digital audio inputs and the built-in monaural microphone cannot be adjusted.

Automatic Audio Level Adjustment for CH1, CH2 or CH1/CH2

Set the audio level switch of the desired channel to A (automatic) to CH1/CH?2 audio level switches
let the camera automatically adjust that channel’s audio level.

Manual Audio Level Adjustment for CH1, CH2 or CH1/CH2
You can set the audio level manually from —oco to +18 dB.

1 Set the audio level switch of the desired channel to M (manual). CH1/CH2 audio level switches

2 Turn the corresponding audio level dial to adjust the audio level.
)

e For reference, the O corresponds to —oco, 5 corresponds to se
0 dB, and 10 corresponds to +18 dB. cﬁlf@DM
e As a guideline, adjust the audio recording level so that the audio f’
level meter on the screen will go to the right of the —18 dB mark 9
(one mark right of the —20 dB mark) only occasionally. .o
e Closing the protective cover will prevent the audio controls from A@DM
being changed inadvertently. CHzf’
©
N

CH1/CH2 audio level dials



Recording Audio

Audio Level Adjustment for CH3, CH4 or CH3/CH4

1 Select MENU > [) Audio Setup] > [Audio Rec Level CH3], [Audio Rec Level CH4] or [Audio Rec Level
CH3/CH4] > [Automatic] or [Manual].

e |f you selected [Automatic], the rest of the procedure is not necessary. If you selected [Manual], continue the
procedure to set the audio recording level.
2 Select MENU > [)) Audio Setup] > [CH3 Level], [CH4 Level] or [CH3/CH4 Level] > Desired audio level.
e For reference, 0 corresponds to —oo, 50 corresponds to 0 dB, and 100 corresponds to +18 dB.

¢ As a guideline, adjust the audio recording level so that the audio level meter on the screen will go to the right
of the =18 dB mark (one mark right of the —20 dB mark) only occasionally.

Automatic Level Control (ALC): Linking the audio level adjustment of CH1/CH2 or CH3/CH4

e When both CH1 and CH2, or CH3 and CH4, are set to the MIC terminal or INPUT terminals and to the
same type of analog audio source (external line input or external microphone), you can use the MENU >
[) Audio Setup] > [CH1/CH2 ALC Link] or [CH3/CH4 ALC Link] setting to link the audio level adjustment
of both channels.

e When CH1 and CH2 are linked, you can use the CH1 audio level switch and dial to affect both CH1 and
CH2. When CH3 and CH4 are linked, you can use the [Audio Rec Level CH3/CH4] and [CH3/CH4 Level]
settings to affect both CH3 and CH4.

Audio peak limiter
e If at least one of the channels is set to the INPUT terminals, an analog audio source and manual audio level
adjustment, you can activate the audio limiter to lessen audio distortions. When MENU > [M) Audio Setup]

> [INPUT Limiter] is set to [On], the audio limiter will limit the amplitude of audio input signals when they start
to distort.

(i) NoTes

¢ We recommend using headphones when adjusting the audio level. If the input level is too high, audio may
become distorted even if the audio level indicator shows an appropriate level.

e If you set an assignable button to [Audio Level Indicator] (11 129), you can press the button to turn the
onscreen audio level indicator on and off.

Advanced Audio Input Settings

In CAMERA mode, you can adjust various settings that affect the audio input depending on the terminal and
audio source used.

Microphone Sensitivity (INPUT Terminals)

You can select the external microphone’s sensitivity. The setting is applied when one of the audio channels in the
[d) Audio Setup] status screen is set to [INPUTx MIC] or [INPUTx MIC+48] (where “x” indicates the number of
the corresponding INPUT terminal (1 to 4)).

Select MENU > [ M) Audio Setup] > [INPUT 1 Mic Trimming] to [INPUT 4 Mic Trimming] > Desired
sensitivity level.

e You can select one of 5 sensitivity levels from —12 dB to +12 dB.

111



112

Recording Audio

Microphone Attenuator (INPUT Terminals)

You can activate the external microphone’s attenuator (20 dB). The setting is applied when one of the audio
channels in the [$)) Audio Setup] status screen is set to [INPUTx MIC] or [INPUTx MIC+48] (where “x” indicates
the number of the corresponding INPUT terminal (1 to 4)).

Select MENU > [) Audio Setup] > [INPUT 1 Mic Att.] to [INPUT 4 Mic Att.] > [On].

Microphone Attenuator (MIC Terminal)

You can activate the external microphone’s attenuator (20 dB). The setting is applied when one of the audio
channels in the [ Audio Setup] status screen is set to [MIC L] or [MIC R].

Select MENU > [ ) Audio Setup] > [MIC Att.] > [On].

Low-Cut Filter (MIC Terminal)

You can activate the low-cut filter, for example to reduce the sound of wind in the background when recording
outdoors. The setting is applied when one of the audio channels in the [) Audio Setup] status screen is set to
[MIC L] or [MIC R].

Select MENU > [ M) Audio Setup] > [MIC Low Cut] > [On].

¢ \When you activate the low-cut filter, some low-frequency sounds may be suppressed along with the sound of
wind. Selecting [Off] is recommended when recording in surroundings unaffected by wind or if you want to
record low-frequency sounds.

Plug-in Power (MIC Terminal)
You can supply plug-in power to an external microphone connected to the MIC terminal.

Select MENU > [ M) Audio Setup] > [MIC Power] > [On].

e Connecting an external microphone that does not require power supply when [MIC Power] is set to [On], may
damage the microphone.

Monitoring the Audio with Headphones

Connect headphones with a @ 3.5 mm stereo mini-plug to the ()
(headphone) terminal to monitor the recorded audio.

(i) NoTes

* You can adjust the headphone volume with the MENU > [)) Audio Setup]
> [Headphone Volume] setting. If you set an assignable button to
[Headphones +] or [Headphones -] ([1] 129), you can press the button to

adjust the headphone volume without using the menu. () (headphone)
terminal




Colors Bars/Audio Reference Signal

Colors Bars/Audio Reference Signal

In CAMERA mode, you can have the camera generate color bars and a 1 kHz audio reference signal and output
them from the following terminals. Color bars are not available when the main recording format is set to RAW.

) : MON. terminal/ (") (headphone) . NP

VIDEO terminal SDI OUT terminal HDMI OUT terminal terminal Optional viewfinder
Color bars ‘ (] ‘ o ‘ @ ‘ - ‘ o
Audio reference signal ‘ - ‘ ® ‘ ° ‘ o ‘ -

* Only when an optional viewfinder compatible with the camera is connected.

Color Bars
The camera offers SMPTE, EBU and ARIB color bars.

1 Select MENU > ["™ Camera Setup] > [Color Bar Type] > Desired option.

2 Select MENU > ["™ Camera Setup] > [Color Bars] > [On].
e The selected color bars appear on the screen and will be recorded when you press the REC button.
e Turning off the camera or changing the operating mode to MEDIA mode will deactivate the color bars.

(i) NoTEs

¢ While color bars are displayed, the magnification function (1 87) cannot be used.

. Color bars cannot be displayed when the sensor mode is set to [Super 35mm] and slow & fast
motion recording is activated with a shooting frame rate higher than 60.

e Color bars cannot be output when the gamma curve component of the [Gamma/Color Space] setting in the
custom picture file ([J1 137) is set to an option other than [BT.709 Wide DR], [BT.709 Normal], [BT.709
Standard] or [Canon 709].

e |f you set an assignable button to [Color Bars] (11 129), you can press the button to turn the color bars on/off.

Audio Reference Signal
The camera can output a 1 kHz audio reference signal with the color bars.

Select MENU > [ M) Audio Setup] > [1 kHz Tone] > Desired option.
¢ You can select one of three audio levels (-12 dB, —18 dB, —20 dB), or [Off] to turn off the signal.

¢ The reference signal will be output at the selected level when you display the color bars, and will be recorded
when you press the REC button.
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Video Scopes

The camera can display a simplified waveform monitor or a vectorscope to check your recordings. The selected
video scope is displayed on the screen and can be output to other monitoring devices as well.

Displaying a Video Scope

Choose between a waveform monitor or a vectorscope. You can also change opacity, position and waveform
monitor size settings.

1 Select MENU > [ Assistance Functions] >
[WFM Function] > [Waveform Monitor] or [Vectorscope].

2 Press the WFM button.

o Alternatively, you can use one of the MENU > [ Assistance
Functions] > [WFM:] settings to turn the video scope on/off
separately on the desired video output.

e By default, the video scope will appear on the right of the screen.
Using the MENU > [ Assistance Functions] > [Waveform
Settings] or [Vectorscope Settings] > [Position] settings, you can select where to display it (left or right side).

3 If needed, select MENU > [& Assistance Functions] > [WFM Opacity Level] > Desired option.
* The smaller the percentage the more transparent the onscreen displays.

Configuring the Waveform Monitor
1 Select MENU > [ Assistance Functions] > [WFM Function] > [Waveform Monitor].

2 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Type] > Desired option.
¢ If you selected an option other than [Select Ling], skip to step 5.

3 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Select Line].

4 Enter the Y coordinate of the line you want to display using the data entry screen ([1 60).
¢ The available range of lines that can be selected depends on the vertical component of the resolution used.
For 3140: 0 to 3138 (in 2-line increments)
For 2160: 0 to 2158 (in 2-line increments)
For 1080: 0 to 1079 (in 1-line increments)
For 720: 0 to 719 (in 1-line increments)

5 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Vertical Scale for HDR] > [IRE]
or [PQ/HLG].
e Select the Y axis (luminance) scale used when displaying the waveform monitor of an HDR (high dynamic
range) image (PQ or HLG standard defined by ITU-R BT.2100).
6 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Gain] > [1x] or [2X].

e [f you selected [1x], the rest of the procedure is not necessary. If you selected [2x], the display range of the
waveform monitor’s Y axis will be reduced by half. Continue the procedure to select the minimum luminance
value (in %) shown on the Y axis.

7 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Y Position] > Desired option.
8 If needed, touch the waveform monitor on the screen to change its display size (only for VIDEO
terminal/optional viewfinder).

 You can also select MENU > [ Assistance Functions] > [Waveform Settings] > [Size: VIDEO Term./EVF-
V50] > Desired option.



Video Scopes

Options for [Type]

[Line]: Sets the waveform monitor to line display mode.

[Line+Spot]:  The waveform of the area in the red frame is displayed in red on top of the [Line] mode
waveform.

[Select Line]:  The selected horizontal line (in red) will be displayed along with its waveform.

[RGB]: Shows 3 side-by-side waveforms in an RGB parade.

[YPbPY]: Shows 3 side-by-side waveforms in a YPbPr parade.

Options for [Vertical Scale for HDR]
[IRE]: Displays the video scope in IRE units.

[PQ/HLGI: For HDR-PQ images, displays the video scope in nits (cd/m?) (including when the gamma curve
after applying the Look File is set to [PQ]). For such images, the narrow range’s (video range)
waveform monitor is displayed.

For HDR-HLG images, the Y axis shows a relative-index value between 0.0 and 1.0. (including
when the gamma curve after applying the Look File is set to [HLG]).

Configuring the Vectorscope
1 Select MENU > [ Assistance Functions] > [WFM Function] > [Vectorscope].
2 Select MENU > [ Assistance Functions] > [Vectorscope Settings] > [Type] > [Normal] or [Spot].

3 Touch the onscreen vectorscope to switch its magnification rate between [1x] and [2x].
* You can also select MENU > [ Assistance Functions] > [Vectorscope Settings] > [Gain] > Desired option.

Options for [Type]

[Normal]: Displays the usual vectorscope.

[Spot]: The color signal of the area in the red frame is displayed in red on top of the [Normal] mode
waveform.

(i) NoTes

¢ The waveform monitor will not be affected even if a LUT is applied to the image, the range is changed or
anamorphic desqueeze is used on the selected video output or screen.

¢ If the [Knee] settings in the custom picture file (] 138) were changed, a horizontal line will appear on the
waveform monitor indicating the luminance (Y) level* corresponding to the knee point.
* When a Look File registered to the custom picture file is active, the displayed luminance may not be at the correct level.

¢ \When the waveform monitor’'s Y axis is set to display in IRE units, a level of 10 bit 64 maps to O IRE and 10 bit
940 maps to 100 IRE, regardless of the custom picture settings.
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Adding Marks to Clips in CAMERA Mode

Adding Marks to Clips in CAMERA Mode

In CAMERA mode, only when the main recording format is set to XF-AVC, you can add marks to primary clips to
set them apart. While recording, you can add shot marks (H) to flag an important shot or frame. After recording
a clip, you can add an OK mark ([ld) or check mark ([) to help you identify particular clips.

You can add and delete marks also in MEDIA mode (11 150, 150).

Adding a Shot Mark while Recording

To add a shot mark to a clip while recording, you must set an assignable button to [Add Shot Mark] in advance.
When pre-recording is activated, you cannot add a shot mark before the REC button is pressed to start
recording the clip.

1 Set an assignable button to [Add Shot Mark] ([1] 129).

2 While you are recording, press the assignable button at the beginning of the shot you wish to mark.
e [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.

(i) noTes

¢ Up to 100 shot marks can be added to a single clip.

e There may be up to a 0.5 second delay from when you press the button to when the camera adds the shot
mark.

¢ When a clip contains a shot mark, B will appear next to the clip’s thumbnail in the playback index screen.

Adding an [l Mark or [ Mark to the Last Clip Recorded

After recording an important clip, you can add to it a mark to set it apart. [l marks can also be used to protect
important clips, as clips with an [l mark cannot be deleted with the camera.

To add an [ mark or [ mark in CAMERA mode, you must set an assignable button to [Add [l Mark] or
[Add M Mark] in advance.

1 Set an assignable button to [Add [l Mark] or [Add [4 Mark] (11 129).

2 After recording a clip, press the assignable button.
o [[MAMark] or [Mark] will appear briefly and the selected clip mark will be added to the clip.

(i) NoTES

¢ Aclip cannot have both an [ mark and a [ mark at the same time.

¢ When a clip has an [l mark or P4 mark, the respective icon will appear next to the clip's thumbnail in the
playback index screen.



Using Metadata

Using Metadata

In CAMERA mode, when the main recording format is set to XF-AVC, the camera automatically adds metadata
to the recorded clips. You can use Canon XF Ultility to check and search for specific metadata. You can also
create and transfer a user memo remotely using Browser Remote on a connected network device (11 187,
192).

Metadata components

Entering content Checking content
Metadata = .
Camera Canon XF Utility Browser Remote Canon XF Utility

User Memo: clip title, creator, location and description. - o' @ @

GPS information: altitude, latitude and longitude. 2 o [ ) o
Information about the recording: scene and take. o ]
Information about camera settings: shutter speed, ISO 4 Py
speed/gain value, etc.

Unique Material Identifiers (UMID): country, organization o _ _ _

and user codes based on the SMPTE standard. (12 200)

1 User memo files need to be created using the software and saved on an SD card in advance.

2 Only when an optional GP-E2 GPS Receiver is connected to the camera. While recording, GPS information is recorded
automatically by the camera.

3 GPS information can only be added to clips already recorded.

4 Recording data is logged automatically by the camera.

Setting a User Memo Created with Canon XF Utility

Before you can add a user memo, you must first install Canon XF Utility ([J] 166). Next, create the user memo
and then save it to an SD card. Once you insert the SD card in the camera and select the user memo, it will be
added to clips you record.

1 Use Canon XF Utility to save a user memo to an SD card.
e For details, refer to Managing User Memo Profiles in the Canon XF Utility Instruction Manual.

2 Insert the SD card into the camera’s SD card slot.
3 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Setting] > [SD Card].

4 Select MENU > [£% Recording/Media Setup] > [Metadata] > [User Memo] > Desired user memo file.

e The [ED icon appears on the left of the screen. (In CAMERA mode, only when [[Z) Monitoring Setup] >
[Custom Display 2] > [User Memo] is set to [On].)

e Select [Off] to record clips without a user memo.

(i) NoTes

e After you set a user memo, do not remove the SD card while you are recording. If the SD card is removed, the
user memo will not be added to the clip.

¢ You must set the user memo before you start recording for it to be added to the clips. You cannot change the user
memo already added to a clip using the camera but you can do so with Canon XF Utility.
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Entering Slate Information About the Recording
You can enter scene and take information to help identify the recording later on.
Select MENU > [ £% Recording/Media Setup] > [Metadata] > [Scene] or [Take] > [Change].

118 o Enter the desired text using the keyboard screen (1 36).
¢ To clear the scene/take information, select [Reset] instead.



Reviewing a Recording

Reviewing a Recording

If you set an assignable button to [Review Recording] in advance, you can review all or part of the last clip
recorded even with the camera set to CAMERA mode.

1 Set an assignable button to [Review Recording] (11 129).
2 Select MENU > [¥ System Setup] > [Review Recording] > [Entire Clip] or [Last 4 sec].

3 After you finish recording a clip, press the assignable button.

¢ The last clip that was recorded is played back for the selected duration. [ REVIEW] appears at the top of
the screen.

¢ While the clip is reviewed, there will be no sound from the built-in speaker but the audio will be output from
the () (headphone) terminal, MON. or HDMI OUT terminal and SDI OUT terminal.

* You can use the joystick to jump back/forward within the clip ([J1 147).
e Press the CANCEL button to stop reviewing the clip and return to record standby mode.
e After the clip finishes playing back, the camera returns to record standby mode.

Options
[Entire Clip]: Allows you to review the entire clip.
[Last 4 sec]:  Allows you to review just the last 4 seconds of the clip.

(i) NoTes

e |f the camera switched cards during a recording, the camera will play back the clip on the card most recently
recorded on.
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Special Recording Modes

In CAMERA mode, the camera features the following special recording modes (not available when the main
recording format is [RAW HQ], [RAW ST] or [RAW LT]).

Slow & fast motion recording: This mode allows you to change the shooting frame rate to achieve a slow motion
or fast motion effect during playback.

120

Pre-recording: The camera will start recording a few seconds before you press the REC button. This is especially
useful when it is difficult to predict when to start recording.

Slow & Fast Motion Recording

The camera can record using a progressive frame rate (shooting frame rate) that is different from the playback
frame rate. Recording a clip with a shooting frame rate higher than the [Frame Rate] setting will result in a slow
motion effect during playback. Conversely, a lower shooting frame rate will result in a fast motion effect.

Sound is not recorded when slow & fast motion recording is activated. The maximum recording time of a single
clip is the equivalent of approximately 6 hours of playback time.

When the main recording format is [RAW], you can record proxy clips simultaneously with slow & fast motion
clips (1 69). XF-AVC proxy clips will have the same shooting and playback frame rates as the primary RAW
clips.

(EINITAD Available shooting frame rates (Main recording format: RAW)

Sensor mode Resolution Available range
[Super 35mm] \ 4096x2160 ) -
[Super 16mm (Cropped)] ‘ 2048x1080 o o
Frame Rate Shooting frame rate (fps)
59.94P 15, 30, 44, 48, 52, 56, 60, 90, 120 150, 180
15, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48,52, 56, | 150, 180
2997p 60, 90, 120
23.98P, 12, 16, 18, 20, 22, 24, 26, 28, 30, 32, 36, 40, 44, 144,168, 180
24.00P 48, 52, 56, 60, 72, 96, 120
50.00P 15, 25, 34, 38, 42, 46, 50, 54, 58, 60, 75, 100, 120 | 125, 150, 175, 180
95.00P 15,17, 19, 21, 23, 25, 26, 28, 30, 34, 38, 42, 46, 125, 150, 175, 180
50, 54, 58, 60, 75, 100, 120

Available shooting frame rates (Main recording format: XF-AVC)

Sensor mode Resolution Available range
[Super 35mm] 4096x2160,
3840x2160, PY _
2048x1080,
1920x1080
[Super 16mm (Cropped)] 2048x1080, ° P
1920x1080
Frame Rate Shooting frame rate (fps)
59.94P 15, 30, 44, 48, 52, 56, 60, 90, 120 150, 180
15, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52,56, | 150, 180
2997p 60, 90, 120
23.98P, 12,16, 18, 20, 22, 24, 26, 28, 30, 32, 36, 40, 44, 144,168, 180
24.00P 48, 52, 56, 60, 72, 96, 120
50.00P 15, 25, 34, 38, 42, 46, 50, 54, 58, 60, 75, 100, 120 | 125, 150, 175, 180




Sensor mode Resolution

25.00P

Special Recording Modes

Available range

15,17,19, 21, 23, 25, 26, 28, 30, 34, 38, 42, 46,
50, 54, 58, 60, 75, 100, 120

125, 150, 175, 180

(@I Available shooting frame rates (Main

recording format: RAW)

Sensor mode Resolution Available range
[Full Frame] 5952x3140,
4192x3140 (4:3), o -
3768x3140 (6:5)
[Super 35mm (Cropped)] 4096x2160 [ J -
[Super 16mm (Cropped)] 2048x1080 @ @
Frame Rate Shooting frame rate (fps)
59.94P 15, 30, 44, 48, 52, 56, 60 90, 120
29.97P 15, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 60 | 90, 120
23.98P, 12,16, 18, 20, 22, 24, 26, 28, 30, 32, 36, 40, 44, 72,96, 120
24.00P 48, 52, 56, 60
50.00P 15, 25, 34, 38, 42, 46, 50, 54, 58, 60 75,100, 120
25.00P 15,17,19, 21, 23, 25, 26, 28, 30, 34, 38, 42,46, | 75,100, 120
50, 54, 58, 60
Available shooting frame rates (Main recording format: XF-AVC)
Sensor mode Resolution Available range
[Full Frame], 4096x2160, 3840x2160, ° _
[Super 35mm (Cropped)] 2048x1080, 1920x1080
[Super 16mm (Cropped)] 2048x1080, 1920x1080 [ J [ J
Frame Rate Shooting frame rate (fps)
59.94P 15, 30, 44, 48, 52, 56, 60 90, 120
29.97P 15, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 60 | 90, 120
23.98P, 12,16, 18, 20, 22, 24, 26, 28, 30, 32, 36, 40, 44, 72,96, 120
24.00P 48, 52, 56, 60
50.00P 15, 25, 34, 38, 42, 46, 50, 54, 58, 60 75,100, 120
25.00P 15,17,19, 21, 23, 25, 26, 28, 30, 34, 38, 42, 46, 75,100, 120

50, 54, 58, 60

1 Press the S&F button.

e Slow & fast motion recording is activated. [S&F STBY] appears at the top of the screen and the shooting
frame rate appears next to the frame rate setting (the playback frame rate).
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Special Recording Modes

2 Press the S&F FPS button and select the desired shooting frame rate using the joystick or SELECT
dial.

e Alternatively, you can set MENU > [£% Recording/Media Setup] > [Recording Mode] to [Slow & Fast
Motion] to activate slow & fast motion recording and use the MENU > [£% Recording/Media Setup] >
122 [Slow & Fast Frame Rate] setting to set the shooting frame rate.

S&F

S&F FPS

Shooting frame rate (fps)
([Slow & Fast Frame Rate] setting)

60 /23.98P 00:00:50:07P

[Frame Rate] setting (playback frame rate)

3 Press the REC button to begin recording.
e The tally lamps illuminate in red (the rear tally lamp changes from green (power indicator) to red).
¢ [S&F STBY] changes to [S&F @ REC] while recording.

4 Press the REC button again to stop recording.
e The clip is recorded at the selected frame rate.
e The front tally lamp goes out and the rear tally lamp changes from red to green (power indicator) and
[S&F @ REC] changes back to [S&F STBY].
5 To end the special recording mode, press the S&F button again.
* You can also set MENU > [£% Recording/Media Setup] > [Recording Mode] to [Normal Recording].

(i) notes

e The shooting frame rate cannot be changed while recording.
e The time code signal will not be output from any terminal.

¢ |f you change the system frequency, slow & fast motion recording will be canceled and the shooting frame rate
will be reset to its default value.

e About the time code when slow & fast motion recording is activated:
- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode.
- If the time code running mode was set to [Free Run], the time code running mode will be changed
automatically to [Rec Run] when slow & fast motion recording is activated.
- When the special recording mode is turned off, the time code running mode will return to its previous setting.

Pre-recording

When pre-recording is activated, the camera starts recording continuously onto a temporary memory (3 or

5 seconds (@EITAD only)) so when you press the REC button, the clip will contain also a few seconds of video
and audio recorded before you pressed the button.

Pre-recording is available only for XF-AVC primary clips.

1 Select MENU > [ Recording/Media Setup] > [Recording Mode] > [Pre-Recording].
¢ [PRE STBY] appears at the top of the screen.

2 When selecting a pre-recording time, select [3 sec] or [5 sec] in MENU > [ £ Recording/
Media Setup] > [Pre-Recording Time].

3 Press the REC button to begin recording.
e The tally lamps illuminate in red (the rear tally lamp changes from green (power indicator) to red).



Special Recording Modes

¢ [PRE STBY] changes to [PRE @ REC] while recording.
4 Press the REC button again to stop recording.
¢ The clip is recorded. The recorded clip will include a few seconds of video and audio recorded before the
REC button was pressed. 123
¢ The front tally lamp goes out and the rear tally lamp changes from red to green (power indicator) and —_—
[PRE @ REC] changes back to [PRE STBY].

5 To end the special recording mode, select MENU > [ Recording/Media Setup] > [Recording
Mode] > [Normal Recording].

(i) NoTES

¢ Pre-recording will be canceled if the main recording format or recording mode is changed.
e About the time code when pre-recording is activated:
- The time code of the clip will start a few seconds before the REC button was pressed.
- The time code will be recorded with the running mode set to [Free Run].
- If the time code mode was set to [Regen.], or to [Preset] with [Rec Run] running mode, the time code
running mode will be changed automatically to [Free Run] when pre-recording is activated.

- When the special recording mode is turned off, the time code running mode will return to its previous
setting.
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Using Anamorphic Lenses

You can attach an anamorphic lens to the camera and set the anamorphic desqueeze ratio used to display the
image from the camera on monitoring devices while shooting or during playback.

1 To apply the anamorphic desqueeze to individual video outputs, select MENU > [[Z) Monitoring
Setup] > [Anamorphic: VIDEO Term.] (LCD screen), [Anamorphic: EVF-V50] (optional viewfinder) or
[Anamorphic: MON./HDMI] (external monitors) > [On].

2 Select MENU > [[Z) Monitoring Setup] > [Anamorphic Desqueeze] > [Lens Squeeze Factor], [x2.0],
[x1.8] or [x1.3].
e You can select a fixed desqueeze factor of x2.0, x1.8 or x1.3. If you selected [Lens Squeeze Factor], the
anamorphic correction will be applied according to the factor specified with the MENU > [ £% Recording/
Media Setup] > [Metadata] > [Lens Squeeze] setting.

3 If necessary, select MENU > [[Z) Monitoring Setup] > [Desqueeze for S&F] > [Reduced Display] or
[Off].
¢ When slow & fast motion recording is activated, the desqueezed image can only be displayed windowboxed
(IReduced Display]). You can select [Off] to display the image without correction.

(i) notes

e You can record the lens’s squeeze factor in the clip’s metadata with the MENU > [ 2% Recording/Media
Setup] > [Metadata] > [Lens Squeeze] setting.

¢ In CAMERA mode during normal recording mode, if [Anamorphic: MON./HDMI] is set to [On] when the HDMI
OUT terminal’s resolution is set to [4096x2160 / 3840x2160] and the frame rate is set to 59.94P or 50.00P, the
video output from the HDMI OUT terminal will be a 1920x1080 image.

e The image displayed during photo playback and the camera’s live view image in the Browser Remote
application will not be desqueezed.



Using the Optional RC-V100 Remote Controller

Using the Optional RC-V100 Remote Controller

You can connect the optional RC-V100 Remote Controller to the camera’s REMOTE A terminal in order to
control the camera (including advanced recording functions) from a distance. The remote controller lets you turn

the camera on, navigate the menus and remotely control the aperture and shutter speed, change picture-related
settings like the knee and sharpness, and more.

Furthermore, when the RC-V100 is connected to the REMOTE B terminal using an expansion unit and RR-10/

RR-100 8-pin remote cable (optional), the self-illuminating buttons of the RC-V100 can all illuminate, and also the
camera can accept multiple operations from the RC-V100 simultaneously.
For details on how to connect and use the remote controller, refer to its instruction manual.

EU-V1 Expansion
Unit 1 (optional)

REMOTEA  REMOTE B

REMOTE A

Remote cable
(supplied with the RC-V100)

RR-10 or RR-100 8-pin Remote Cable (optional)

1 Turn off the camera and connect the optional RC-V100 Remote Controller to the camera.

2 Turn on the camera in CAMERA mode.

3 Select MENU > [¥ System Setup] > [REMOTE Term.] > [RC-V100 (REMOTE A)] or [RC-V100
(REMOTE B)].

Options

[RC-V100 (REMOTE A)]:

Select this option to use the optional RC-V100 connected to the camera with the RC-V100’s
remote cable.

[RC-V100 (REMOTE B)):
Select this option to use the RC-V100 connected to an expansion unit with an 8-pin remote
cable (all optionals).

[Standard]: Select this option to use commercially available remote controls.

[Standard + RC-V100]:
Select this option to use a commercially available remote control (connected to the REMOTE A
terminal) simultaneously with an optional RC-V100 (connected to the REMOTE B terminal). Note

that with this connection, you will not be able to turn the camera on/off using the CAMERA
POWER button on the RC-V100.

(i) NoTES

e The AGC button, AUTO KNEE button and AF button on the remote controller will have no effect on the camera.

e The AUTO IRIS button on the remote controller can operate the camera only when a compatible EF lens
([0 247) is attached to the camera.

e The ZOOM dial on the remote controller can operate the lens only when a compatible EF Cinema/broadcast
lens ([ 247) is attached to the camera.
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Displaying Live Video

If you connect an optional EU-V3 Expansion Unit 3 to the camera, inputting and outputting return signals and
superimposing tally information will be possible, allowing you to build a system to display live video. The
resolution of signals that can be input to the RET IN terminal is 1920x1080. For how to connect the camera and
EU-V3 Expansion Unit 3, refer to the Cinema EOS System Expansion User Guide.

Example of live video system

SDI OUT terminal
D Video output

MON. terminal / HDMI OUT terminal
Monitor output

Display

RET IN terminal
Return signal input

Ol LT &

~—
Remote Camera
Controller

Ethernet RC-IP100/RC-IP1000

Tally information* and

camera control input

(XC Protocol) Tally terminal Switcher

Tally information

* When using the RC-IP100, the only supported tally input is .
“PGM”. input

Inputting and Outputting Return Signals
1 Select the terminal for output in MENU > [¥ System Setup] > one of the [RET Output:] options.
2 Assign [RET] to an assignable button ([J] 129).

3 Press the assignable button to display or hide the return video.

e [f you assign [RET (While Pressed)] to an assignable button, the return video can be displayed while the
button is held pressed down.

e The return video can be displayed while the RET button on the lens or the demand attached to lens is held
pressed down.

(i) NoTES

¢ For how to enable and disable the RET button, check the functions of your lens or demand.
¢ \When suitable return signals are input, the synchronization stabilizes after approximately 10 seconds.

¢ \When suitable return signals are detected, the icon will flash at the top right of the screen. When the
camera locks on the external signal, the icon will stay on.

Inputting and Outputting Tally Information

You can display tally information input via XC protocol on the screen (Tally OSD). In addition, the tally information
can be output from the DC OUT 12V 2A terminal of the EU-V3.



Displaying Live Video

1 Select MENU > [[=) Monitoring Setup] > one of the [Tally OSD:] settings > [On].
e Confirm and/or change the screen for tally OSD display and the output destination.

2 Select MENU > [[= Monitoring Setup] > [Tally OSD Settings] > Desired option.

Tally OSD Settings List

[Tally OSD Settings] Tally Input State Recording Status (REC) Tally 0SD Lamp Color
PGM Red
[Tally In (PGM/PVW)] PYW — Green
PGM + PVW Amber
[REC] — '
Recording Red
PGM Red
[REC/Tally In (PGM/PVW)]
PYW Record Standby Mode Green
PGM + PVW Amber

3 Select MENU > [[Z) Monitoring Setup] > [Tally OSD Position] > Desired option.

(i) NoTES

e Recorded video/still images are not affected.

¢ \When you select [Frame] while the focus position guide is displayed, the tally OSD is displayed at the top.

Top

Bottom
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Customization

Assignable Buttons

The camera offers a number of assignable buttons to which you can assign various function. Assign often-used
functions to the buttons you find most convenient to personalize the camera to your needs and preferences.
You can find 15 assignable buttons on the camera’s body, 2 assignable buttons on the LCD monitor and one
assignable button on the camera grip. You can also use assignable buttons found on optional accessories’ and
applicationsz.

1 LM-V1 LCD Monitor, EU-V2 Expansion Unit 2, EU-V3 Expansion Unit 3, EVF-V70 OLED Electronic Viewfinder, SG-1 Shoulder

Style Grip Unit, RC-V100 Remote Controller, RC-IP100/RC-IP1000 Remote Camera Controller
Remote Camera Control Application, Multi-Camera Control

On the
( ) camera grip

©

=
m
=
c

Cle

O
>
=
[a)
a
m

O

©

. INDEX/H

1 Press the MENU button and, while holding it pressed down, press the assignable button whose
function you wish to change.
e A list of available functions appears with the current function assigned to the button highlighted.
e You can also select the appropriate menu setting from the various pages of the MENU > [ Assignable
Buttons] menu.
2 Select the desired function.
e The selected function will be assigned to the selected button.
e |f you selected one of the preset functions, the rest of the procedure is not necessary. If you selected [User
Setting], continue the procedure to register a menu setting.
3 Navigate the menus as necessary and select the menu setting you want to register.
¢ The selected menu setting will be assigned to the selected button. User-selected settings will be indicated
with a icon in the [@ Assignable Buttons] menu.

4 Press the assignable button to use the assigned function as described in the following table.
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Assignable Buttons

(i) NoTES

¢ You can check the [ Assignable Buttons] status screens ([11 214) to see what functions are currently
assigned to each button.

e You can reset only the functions assigned to the assignable buttons, without affecting other camera settings,
with the MENU > [ System Setup] > [Reset] > [Assignable Buttons] function. All the assignable buttons will
return to their default function.

¢ \When you select [Enable] in MENU > [&@ Assignable Buttons] > [Link to Camera], the functions assigned to
assignable buttons 1-4 on the camera can also be assigned to assignable buttons 1-4 of the RC-V100,
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RC-IP100/RC-IP1000, Remote Camera Control Application, and Multi-Camera Control.

Assignable functions

Functions can be set separately in CAMERA mode and MEDIA mode. Refer to the following table for assignable
functions and available modes.

. o CAMERA  MEDIA
Function name Description mode mode A
[One-Shot AF] The camera focuses automatically one time only (one-shot AF function). [ ) - 89
[AF Lock]1 Locks the focus during continuous AF. [ J - 91
[Face AF] Toggles the [Face AF] setting between [Face Priority] and [Face Only]. @ - 92
[Face Detection] Turns the face detection function on/off. @ - 92
[Tracking] Turns the tracking function on/off. @ - 93
[Focus Guide] Turns the focus guide on/off. @ - 86
Focus Position Marker1’ _ . "
Focus Position Marker2! ;Zgrlkséfsrs [Marker 1 Color] to [Marker 3 Color] set in MENU as the focus position PY _ 88
Focus Position Marker3' '
. Turns peaking on/off on all monitoring devices, except on those connected to the
[Peaking: Al SDI OUT terminal.
[Peaking: All(+SDI OUT)] | Turns peaking on/off on all monitoring devices.
[Peaking: VIDEO Term.], ® - 87
[Peaking: EVF-V50], Turns peaking on/off only on the LCD monitor, an optional viewfinder or external
[Peaking: MON./HDMI], monitors, respectively.
[Peaking: SDI OUT]
[Magnification] Turns magnification on/off.
[Magn.: VIDEO Term.], Selects the output terminal for the magnified display and turns magpnification PY _ 87
[Magn.: EVF-V50], on/off only on the LCD monitor, an optional viewfinder or external monitors,
[Magn.: MON./HDMI] respectively.
Cycles through the digital tele-converter options in the following order:
[Tele-converter] X1.5 - x2.0 > x2.5 - x3.0 ->0ff. o %
[Push Auto Irs] The camera automatically adjusts the aperture only while the button is held ° _ 79
pressed down.
[Iris Mode] Switches the aperture adjustment mode between automatic and manual. [ ) - 27
[Iris +], [Iris -] Opens up/closes the aperture, respectively. [ ) -
IND +], ND ] Cycles throggh ND filter settlr]gs in increasing (higher density) or decreasing PY _ 76
(lower density) order, respectively.
[AE Shift +], [AE Shift—] | Compensates the exposure making the image brighter/darker, respectively. [ J - 80
[Backlight], [Spotlight] Iggséi; 52; light metering mode between [Standard] and [Backlight]/[Spotlight], PY _ 80




Assignable Buttons

. o CAMERA  MEDIA
Function name Description mode mode (A
[Zebra: All] Turns zebra patterns on/off on all monitoring devices.
[Zebra: VIDEO Term., Turns zebra patterns on/off only on the LCD monitor, an optional viewfinder or ® - 98
[Zebra: EVF-V50)], external monitors, respectivel
[Zebra: MON./HDMI] » TeSpectively.
[WEM: All} Turns the selected video scope on/off on all monitoring devices.
mﬁm \E/iITfSSTOe]rm‘]‘ Turns the selected video scope on/off only on the LCD monitor, an optional ® [ ] 114
[WFM: MON./HDMI] viewfinder or external monitors, respectively.
[LUT: All] Turns on/off the application of the selected LUT to all monitoring devices.
[LUT: VIDEO Term.],
[LUT: EVF-V50], Turns on/off the application of the selected LUT only to the LCD monitor, an PY P 161
[LUT: SDI OUT], optional viewfinder, video output from the SDI OUT terminal, or external monitors
[LUT: MON.], connected to the MON. or HDMI OUT terminal, respectively.
[LUT: HDMI]
[False Color: All] Turns the false color overlay on/off on all monitoring devices.
[False Color: VIDEO
Term.], Turns the false color overlay on/off only on the LCD monitor, an optional Py _ 98
[False Color: EVF-V50], viewfinder or external monitors, respectively.
[False Color: MON./HDMI]
[False Color Index] Displays/hides the false color index screen.
[White Balance] Enters the dlre.ct setting mode with the white balance mode highlighted and °® _ 81
ready to be adjusted.
[Set White Balance] Starts the white balance calibration for a custom white balance setting. @ - 81
[AWB Lock]1 While using auto white balance (AWB), locks the current white balance settings. @ - 83
(AR AwB],
[e®a Set A], [ Set B],
[¢¢ Daylight], Changes the white balance mode/setting to the respective option. o - 81
[$¢ Tungsten],
[ L4 Kelvin]
Opens the [ Monitoring Setup] menu page with the settings for adjusting the
[LCD LM-V1 Setup], optional LM-V1 LCD Monitor, supplied LM-V2 LCD Monitor, optional EVF-V50
[LCD LM-V2 Setup], OLED Electronic Viewfinder or optional EVF-V70 OLED Electronic Viewfinder,
. o o 201
[EVF-V50 Setup], respectively.
[EVF-V70 Setup] Options for optional accessories are available only when the accessory is
attached to the camera.
[OSD OQutput: All] Turns the camera’s onscreen displays on/off on all monitoring devices.
D :
[0SD Output Turns the camera’s onscreen displays on/off on external monitors connected to [ ] [ ] 158
MON./HDMI, the MON. or HDMI OUT terminal or SDI OUT terminal, respectivel
[0SD Output: SDI OUT] : » TESpectively.
[OSD Opacity: All] Changes the transparency level of onscreen displays on all monitoring devices.
[0SD Opacity: VIDEO
Term.],
[OSD Opacity: EVF-V50], | Changes the transparency level of onscreen displays only on the LCD monitor, an o [ ] 159
[OSD Opacity: optional viewfinder or external monitors, respectively.
MON./HDMI],
[OSD Opacity: SDI OUT]
[DISP] E:ftzges the onscreen display level, replicating the function of the camera’s DISP °® ° 57
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Assignable Buttons

. o CAMERA  MEDIA
Function name Description mode mode A
[Markers: All] Turns onscreen markers on/off on all monitoring devices. @ -
[Markers: VIDEO Term.],
[Markers: EVF-V50], Turns onscreen markers on/off only on the LCD monitor, an optional viewfinder or PY _ 96
[Markers: MON./HDMI], | external monitors, respectively.
[Markers: SDI OUT]
[Color Bars] Turns color bars on/off. [ J - 113
[IP Streaming] Turns the IP streaming function on/off. @ - 185
[Photo]! Records a photo. ) - 52
[Review Recording]' Plays back the last clip recorded in CAMERA mode. @ - 119
[Time Code] Opens the [§ System Setup] menu page with the time code settings. @ - 99
[Add Shot Mark]' Adds a shot mark to the clip. [ ) o 116,
[Add [ Mark], _ 150,
[Add 1 Mark] Adds an [ or [ mark to the clip. [ ) o 150
[Headphones +], Increases/reduces the headphone volume, respectively. @ o 147
[Headphones -]
- - A -
[Monitor Channels] Svyltc.hes the audio channels output from the {) (headphone) terminal and the PY ° 165
built-in speaker.
[Audio Level Indicator] Turns the audio level meter on/off. @ o 110
[FUNC] Enters the direct setting mode, replicating the function of the camera’s FUNC P _ 71
button.
[Slow & Fast Motion] Turns slow & fast motion recording on/off.
(Slow & Fast Frame Rate] Whep slow & fast mot|pn recording is activated, highlights the shooting frame
rate in order to adjust it.
[Output: 60 <
1,2 ) ) ) ) [ J - -
60 (24) fps] Turns on/off making output terminal/screen video equivalent to 24 fps (or 30 fps)
[Output: 60 < when the frame rate is 59.94P or 59.94i. °
60 (30) fps]" 2 - B
. Enters the direct setting mode with the aperture value highlighted and ready to
[Iris] . [ J - 77
be adjusted.
(Shutter] En.ters the direct setting mode with the shutter speed highlighted and ready to be PY _ 73
adjusted.
(1S0/Gain] Enters the direFt setting mode with the ISO speed or gain value highlighted and °® _ 75
ready to be adjusted.
[Status]' Displays the status screens. [ ) o 211
: ) - _
[Audio Status] Displays the [ ) Audio Setup] status screens. You can press SET to open the PY ° 9215
[d) Audio Setup] menu.
[Custom Picture] Opens the [[®@& Custom Picture] menu. @ - 133
[My Menu] Opens the [ Y& My Menu] customized menu. @ - 35
[Initialize Media] Opens the [Initialize Media] submenu. [ J o 46
[CAMERA < MEDIA] Switches between CAMERA mode and MEDIA mode. @ @ -
[RETJ1 Displays/hides the return video. @ - 126
[RET (While Pressed)]' Displays the return video while the button is held pressed down. @ - 126
(OB User Setting]‘ Customizable slot. Assign to the button any menu setting you would like to °® Py _

register.

! Function can be used only by assigning it to a button.
2 Not available when slow & fast motion recording is activated.
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Custom Picture Settings

The camera lets you change many settings (1 137) that control various aspects of the image produced. As a
set, all these settings are treated as a single custom picture file. After adjusting the desired settings to your
preference, you can save up to 20 custom picture files (in the camera or on an SD card), and load them later to
apply exactly the same settings ([11] 135). You can also save the custom picture file as part of the metadata
recorded with XF-AVC clips (1] 135).

Custom picture settings have no effect on RAW recordings.

(i) NoTES

e Custom picture files are exclusively compatible for use only with the same camera model (between C300 Mark
lIl cameras or between C500 Mark Il cameras).

Selecting Custom Picture Files

In CAMERA mode, select a custom picture file to apply its settings to your recordings or to edit, rename, protect,
or transfer it.

1 Select MENU > [[@d Custom Picture] > [Select File].
e \When an optional RC-V100 Remote Controller is connected to the camera, you can press the remote
controller's CUSTOM PICT. button to open the [[@d Custom Picture] menu.
2 Select the desired file.

e Select one of the custom picture files saved in the camera (C1 to C20). To use the settings of a custom
picture file saved on an SD card, copy the file to the camera in advance ([J] 135).

¢ \When you close the menu, the selected custom picture file’s settings will be applied. and the number of
the selected custom picture file, as well as the icons of the [Gamma/Color Space] setting in use will appear
on the left of the screen.

Preset Picture Settings

The following settings are saved to custom picture files C1 to C20 as preset custom picture settings. Custom
picture files C1 to C9 are protected by default and need to be unprotected before they can be edited.

Preset custom picture

file [Gamma/Color Space]* [Color Matrix]  [Look File]

Characteristics

[BT.709 Wide DR /

C1: [BT.709 Wide DR] BT.709]

C2: [Canon Log 2] [Canon Log 2/

C.Gamut]
. [Canon Log 3/ [Neutral]
(C3: [Canon Log 3] C.Gamu]
C4: [PQ] [PQ / BT.2020]
C5: [HLG] [HLG / BT.2020]
) [BT.709 Standard / )
(C6: [BT.709 Standard] BT.709] [Video]

These settings produce a wide dynamic range and are
appropriate for playback on BT.709 compliant monitors.
These settings use Canon Log 2 gamma and require post-
production processing. They achieve superior gradation in the
shadows (dark areas of the image).

These settings use Canon Log 3 gamma and require post-
production processing. They keep the [Canon Log] gamma
characteristics while expanding its dynamic range.

These settings use a high dynamic range gamma curve
compliant with the PQ standard defined by ITU-R BT.2100.

These settings use a high dynamic range gamma curve
compliant with the HLG standard defined by ITU-R BT.2100.
These settings are appropriate for playback on BT.709 compliant
monitors, and use a gamma curve that meets ITU-R BT.709
standards.
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Preset custom picture

file [Gamma/Color Space]* [Color Matrix] [Look File] Characteristics

(BT.709 Wide DR/ Reproduces the image quality and look of an EOS

C7: [EOS Standard] [Neutral] On interchangeable lens DSLR camera with its picture style set to
134 BT.709] [Standard].
) Reproduces the image quality and look of an EOS
(8: [EOS Neutral] [BT]?; \;\gg? DR/ [Neutral] On interchangeable lens DSLR camera with its picture style set to
' [Neutral].

These settings produce a look appropriate also for use without
post processing, featuring high contrast while ensuring a wide

C9: [Canon 709] [Canon 703 /BT.709] (Neutral] - dynamic range optimized for playback on BT.709 compliant

monitors.
C10: [User10] to [BT.709 Wide DR / Neutral _ These settings use a gamma curve with a very wide dynamic
C20: [User20] BT.709] range, optimized for playback on BT.709 compliant monitors.

* MENU > [[®@ Custom Picture] > [Edit File] > [Gamma/Color Space] setting.

(i) NoTES

¢ About the logarithmic gamma curves (Canon Log settings)
These gamma curves require post-production processing. They were designed to make the most of the
imaging sensor characteristics in order to obtain impressive levels of dynamic range.
- In CAMERA mode, you can apply a LUT to the supplied LCD screen, an optional viewfinder or video output
from the various terminals to use gamma curve settings more suitable for viewing on a monitor screen.
- There are also other LUTs available that can be applied for processing in post-production. For the latest
information on available LUTs, please visit your local Canon website.
e About changing custom picture related settings using the optional RC-V100 Remote Controller
- When an optional RC-V100 Remote Controller is connected to the camera, you can press the remote
controller's CUSTOM PICT. button to open the [[@d Custom Picture] menu.
- If a protected custom picture file is selected on the camera, custom picture related settings cannot be
changed using the remote controller.
- Adjusting custom picture related settings using the remote controller will change the settings registered
under the currently selected custom picture file. If you want to keep an important custom picture file, copy it
in advance to an SD card or select in advance a custom picture file you do not mind changing.

Renaming Custom Picture Files
1 Select a custom picture file ([J] 133).

2 Select MENU > [[@ Custom Picture] > [Edit File] > [Rename] > [Input].
¢ Enter the desired file name (up to 16 characters) using the keyboard screen ([1] 36).

Protecting Custom Picture Files

Protecting a custom picture file prevents its settings from being accidentally changed.
1 Select a custom picture file (1] 133).

2 Select MENU > [[d@d Custom Picture] > [Edit File] > [Protect] > [Protect].

o [ox] will appear next to the file name.
¢ To remove the protection, select [Unprotect] instead.
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Resetting Custom Picture Files
1 Select a custom picture file ([I] 133).
2 Select MENU > [[@d Custom Picture] > [Edit File] > [Reset].

3 Select a preset custom picture setting and then select [OK].
® The custom picture file will be reset to the selected values.

Editing a Custom Picture File’s Settings
1 Select a custom picture file ([(J] 133).
2 Select MENU > [[@ Custom Picture] > [Edit File].
3 Select a setting you wish to change and select the desired option.
» Refer to Available Custom Picture Settings (11 137) for details on the various settings.

¢ Repeat step 3 for other settings as necessary.
* \When you close the menu, the new custom picture settings will be applied.

Copying Custom Picture Files

You can copy custom picture files between the camera and SD card. Insert in advance into the camera the card
where you want to save your custom picture files or the card that contains the custom picture file you want to
load.

Copying a File from the Camera to an SD Card
1 Select a custom picture file (1] 133).
2 Select MENU > [[@d Custom Picture] > [Save File] > [Save to SD Card].

3 Select the destination file on the card and then select [OK].

e Select an existing custom picture file to overwrite it or [New File] to save the settings as a new custom
picture file on the card.

4 When the confirmation message appears, press SET.

Replacing a File in the Camera with a File on an SD Card

1 Select the custom picture file that you wish to replace ([J1 133).

2 Select MENU > [[@d Custom Picture] > [Save File] > [Load from SD Card].

3 Select the file with the settings that you want to replicate and then select [OK].
e The file in the camera will be overwritten by the one on the card.

4 When the confirmation message appears, press SET.

Embedding the Custom Picture File in Clips

When you record in XF-AVC format after having set custom picture settings, you can have the custom picture file
embedded in the metadata and saved along with the clips.

Select MENU > [ % Recording/Media Setup] > [Metadata] > [Add File] > [On].
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Look Files
You can register LUT files created with Blackmagic Design’s DaVinci Resolve as Look Files in the custom picture

file. Using a Look File allows you to adjust the video quality of the recorded video. These adjustments apply also
to proxy clips, photos, and screen/output terminals.

1 Insert the SD card with the desired Look File (.cube format, located in the root directory of the SD
card) into the camera’s SD card slot.

2 Select a custom picture file. (] 133)
3 Select MENU > [[@d Custom Picture] > [Edit File] > [Gamma/Color Space] > Desired option.

4 Select MENU > [[@ Custom Picture] > [Edit File] > [Look File Setup] > [Register].
e The Look Files in the SD card will be displayed.

5 Select the desired Look File.
6 Select the [Gamma/Color Space] setting to use after the Look File is applied.

7 Select [OK] twice.
e The selected Look File will be loaded and registered to the custom picture file.
¢ Then, the image quality adjustments set in the Look File will be applied, and will appear on the screen.

¢ When you disable the image quality adjustments set in the Look File, select MENU > [[@@ Custom Picture]
> [Edit File] > [Look File] > [Off].

(i) notes

About Look files
- The camera supports LUT files (3D LUT/.cube format) in 17 grid or 33 grid format created with Blackmagic
Design’s DaVinci Resolve.
- LUT files with input ranges outside the 0 to 1 range in the header (“LUT_3D_INPUT_RANGE”) are not
supported.
- LUT files which include values outside of the 0 to 1 range in the data area are not supported.
- LUT files 2 MB and larger, as well as files with a name containing over 65 characters are not supported.
- Only the following characters can be used in the file name:
Numbers 0 to 9, upper/lower case letters a to z, underscore (_), hyphen (-), period (.) and a single byte
space.
e Save a Look File to the root directory of the SD card.
e |f the correct input/output gamma curve and color space conversion are not selected, video will not be output
correctly.
A Look File cannot be used if the [Gamma/Color Space], [HLG Color] or [Over 100%] settings are changed
after registering it.
When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to either
[BT.709 Normal], [BT.709 Standard] or [BT.709 Wide DR], super-white (video signal above 100%) and super-
black (video signal below 0%) levels of brightness will be clipped. When the video signal contains super-white
brightness levels, select MENU > [[@d Custom Picture] > [Edit File] > [Other Functions] > [Over 100%)] >
[Press] and then activate the Look File to apply it to a signal compressed to 100%.
When playing RAW clips, the Look File registered when the clip was recorded will only be applied to the
thumbnail and not the clip itself.

Deleting a Look File
You can delete Look Files registered in custom picture files.

1 Select a custom picture file (11 133).
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2 Select MENU > [[@d Custom Picture] > [Edit File] > [Look File Setup] > [Delete] > [OK].

® The Look File will be deleted and the image quality adjustments will be reversed to the original settings of the
selected custom picture file.
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Available Custom Picture Settings

Menu items Options / Additional information

[Gamma/Color Space] [Canon Log 2 / C.Gamut], [Canon Log 3 / C.Gamut], [Canon Log 3 / BT.2020],
[Canon Log 3/ BT.709], [PQ / BT.2020], [HLG / BT.2020], [BT.709 Wide DR / BT.2020],
[BT.709 Wide DR / BT.709], [BT.709 Normal / BT.2020], [BT.709 Normal / BT.709],
[BT.709 Standard / BT.709], [Canon 709 / BT.709]

Combination of gamma curve and color space settings that affects the overall look and color space of
the image.

Gamma curve

- prrooNormal/ - [Canon Log 2]: Logarithmic gamma curve that obtains a richer color gradation in the dark areas of
BT.709 Wide DR the image. Requires image processing in post-production.

. ngon 700 [Canon Log 3]: Logarithmic gamma curve that keeps the characteristics of the [Canon Log] setting
while expanding its dynamic range. Requires image processing in post-production.

Input [PQ]: HDR (high dynamic range) gamma curve compliant with the PQ standard defined by ITU-R
BT.2100.

[HLG]: HDR (high dynamic range) gamma curve compliant with the HLG standard defined by ITU-R
BT.2100.

[BT.709 Wide DR]: Gamma curve with a very wide dynamic range. Optimized for playback on BT.709
compliant monitors. Equivalent to the [Wide DR] setting in previous camera models.

[BT.709 Normal]: Gamma curve that produces darker dark areas and reduced contrast in the

"""" gzggﬂ tggg highlights, compared to the ITU-R BT.709 standard. Optimized for playback on BT.709 compliant

—PQ monitors. Equivalent to the [Normal 1] setting in previous camera models.

[BT.709 Standard]: Gamma curve that meets ITU-R BT.709 standards, for playback on BT.709
compliant monitors. Equivalent to the [Normal 3] setting in previous camera models.

[Canon 709]: Gamma curve appropriate also for use without post processing, featuring high contrast
while ensuring a wide dynamic range. Use this when outputting to a BT.709 compliant monitor.

Output

Output

Input

Color space

[C.Gamut]: Color space developed by Canon based on the specific characteristics of the camera’s
imaging sensor. It covers a wider color gamut than that of BT.2020. Use this setting with
workflows that require ACES2065-1 color space.

[BT.2020]: Color space that meets ITU-R BT.2020 standards, which defines parameters for ultra-
high-definition television (4K/8K).

[BT.709]: Standard color space that is compatible with SRGB specifications.

[Color Matrix] [Neutral], [Production Camera], [Video]

The color matrix affects the overall color tonality of the image.

[Neutral]: Reproduces neutral colors.

[Production Camera]: Reproduces colors more suitable for motion picture production.

[Video]: Reproduces the colors of an EOS C300/EQS C500 camera with no custom picture settings
applied.

[Look File] [On], [Off]
Image quality adjustments set in the Look File will be applied.

[Look File Setup]
[Register] Registers a Look File to a custom picture file.
[Delete] Deletes a Look File registered to a custom picture file.
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[Black Gamma]
[Level]

Menu items Options / Additional information
[HLG Color] [BT.2100], [Vivid]
Changes the quality of color reproduction when using the hybrid log gamma (HLG). This setting is
138 only available when [Gamrpa/CoIor Space] issetto [HLG / BT.2(.)'20]..
[BT.2100]: Color reproduction according to ITU-R BT.2100 specifications.
[Vivid]: More saturated color reproduction according to the ‘Traditional Colour' approach in ITU-R
BT.2390.
[Black]
[Master Pedestal] —-50 to +50 (+0)
Increases or decreases the black level. Higher settings will make dark areas brighter but decrease
contrast. This setting is not available when the gamma curve component of the [Gamma/Color
Space] setting is set to one of the [Canon Log 2] or [Canon Log 3] options.
[Master Black Red], —-50 to +50 (x0)
[Master Black Green], These settings correct the color cast in blacks. These settings are not available when the gamma
[Master Black Blue] curve component of the [Gamma/Color Space] setting is set to one of the [Canon Log 2] or [Canon

Log 3] options.

-50 10 +50 (+0)

[Range], [Point]

[Point]

Output

,,,,,

~20 t0 +50 (+0)

These settings control the lower part of the gamma curve (dark areas of the image). These settings
are only available when the gamma curve component of the [Gamma/Color Space] setting is set to
one of the [BT.709 Normal] or [BT.709 Standard] options.

[Level]: Raises or lowers the lower part of the gamma curve.

[Range]: Selects the adjustment range from the selected [Point].

[Point]: Determines the shape of the lower part of the gamma curve.

[Low Key Saturation]

[Activate] [On], [Off]
Set this setting to [On] to enable the adjustment of color saturation in dark areas with the [Level]
setting.

[Level] -50 to +50 (x0)
Specifies how saturated colors are in dark areas.

[Knee]

[Activate] [On], [Off]
Set this setting to [On] to enable the adjustment of the knee point with the following settings. These
settings are only available when the gamma curve component of the [Gamma/Color Space] setting is
set to one of the [BT.709 Normal] or [BT.709 Standard] options.

[Slope] -35 to +50 (+0)

[Point] 50 to 109 (95)




Menu items

[Saturation]
[Slope]

Output

Input

Custom Picture Settings

Options / Additional information
-10to +10 (x0)

These settings control the upper part of the gamma curve (highlights of the image). By compressing
the highlights, you can prevent parts of the image from being overexposed.

[Slope]: Determines the slope of the gamma curve above the knee point.

[Point]: Sets the knee point of the gamma curve.

Point]
(Pomnt [Saturation]: Adjusts the color saturation in the highlights.
g
3
Input

[Sharpness]

[Level] —10 to +50 (x0)

Sets the sharpness level of the video output signal and the recorded signal.
[Detail Frequency] -8 to +8 (x0)

Sets the center frequency of horizontal sharpness. Setting higher values increases the frequency,
which, in turn, increases the sharpness.

[Coring Level]

-30 to +50 (x0)

Sets the level of correction of artifacts caused by high sharpness levels (coring). Higher values
prevent sharpness from being applied to minute details, resulting in less noise.

[Limit]

[Noise Reduction]

-50 to +50 (x0)
Restricts how much sharpness is applied.

[Spatial Filter]

[Frame Correlation]

[Off], 1t0 12

[Off], 1to 12 (1)

Reduces noise by applying a soft focus-like effect on the entire picture. When set to a value other
than [Off], afterimages are not produced but the whole image will have a softer look.

[0ff], 110 3
Reduces noise elements by comparing the current image to the previous one (field). When set to a

value other than [0ff], the perceived resolution will not be affected but an afterimage may appear for
moving subjects.

[Skin Detail]
[Effect Level] [0ff], [Low], [Middle], [High]
[Hue] -16 to +16 (=0)
[Chroma], [Area], [Y Level] 0to 31 (16)

The camera applies a softening filter to areas in the picture with skin tones to give a more pleasant
appearance. By changing these settings, you can determine what areas will be detected as skin
tones. A zebra pattern will appear on the screen over areas of the image that are detected as having
skin tones.

[Effect Level]: Adjusts the level of the filter.

[Hue]: Adjusts the hue for detection of skin tones.

[Chroma]: Adjusts the color saturation for detection of skin tones.

[Area]: Adjusts the color range for detection of skin tones.

[Y Level]: Adjusts the brightness for detection of skin tones.

[Color Matrix Tuning]
[Gain]

50 t0 +50 (+0)
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Menu items

[Phase]

Options / Additional information
—18 to +18 (x0)

These settings adjust the color intensity ([Gain]) and color phase ([Phase]) of the color matrix,
affecting the color tones of the whole image.

[R-G], [R-B], [G-R], [G-B],

-50 to +50 (x0)

[B-RI, [B-G] Each matrix changes the tint of the picture along the color gradations detailed below, affecting the
color tones of the whole image.
[R-G]: cyan/green and red/magenta; [R-B]: cyan/blue and red/yellow;
[G-R]: magenta/red and green/cyan; [G-B]: magenta/blue and green/yellow;
[B-R]: yellow/red and blue/cyan; [B-G]: yellow/green and blue/magenta.
[White Balance]

[R Gain], [G Gain], [B Gain]

-50 to +50 (+0)

These settings adjust the amount of white balance throughout the whole image by changing the
intensity of red tones ([R Gain]), green tones ([G Gain]), and blue tones ([B Gain]).

[Color Correction]

[Select Area]

[Off], [Area A], [Area B], [Area A&B]

The camera detects areas with certain color characteristics (color phase, chroma, area and Y level)
and corrects them when recording. You can set the color correction for up to two different areas

(A and B) and apply the color correction to either one ([Area A] or [Area B]) or both of them ([Area
A&BY)).

While color correction is activated, parts of the image that are not detected as having the
characteristics specified for area A or B will appear colorless on the optional viewfinder or external
monitors connected to the SDI OUT, MON. or HDMI OUT terminals (except when adjusting the
[Revision Level]/[Revision Phase] settings).

[Area A Setting Phase],
[Area B Setting Phase]

0to 31 (0)
These settings determine the color phase of the area to be corrected (A or B, respectively).

[Area A Setting Chroma],
[Area A Setting Area],
[Area A Setting Y Level],
[Area B Setting Chroma],
[Area B Setting Area],
[Area B Setting Y Level]

[Area A Revision Level],
[Area B Revision Level]

[Area A Revision Phase],
[Area B Revision Phase]

[Other Functions]

010 31 (16)

These settings determine the following color characteristics of the area to be corrected (A or B,
respectively).

[Area A Setting Chromal], [Area B Setting Chroma]: Color saturation.

[Area A Setting Area], [Area B Setting Area]: Color range.

[Area A Setting Y Level], [Area B Setting Y Level]: Brightness.

-50 to +50 (x0)

These settings adjust the amount of correction applied to the color saturation in the corrected area
(A or B, respectively).

-1810 +18 (+0)

These settings adjust the amount of correction applied to the color phase in the corrected area
(A or B, respectively).

[Over 100%)]

[Through], [Press], [Clip]

Determines how the camera handles video signals exceeding 100%. This setting is not available
when the gamma curve component of the [Gamma/Color Space] setting is set to one of the
[Canon Log 2], [Canon Log 3], [PQ], [HLG] or [Canon 709] options.

[Through]: Leave the signal unchanged.

[Press]: Compress a signal of up to 108% down to 100% levels.

[Clip]: Clip the signal at 100%.

(i) NoTES

¢ Depending on other menu settings, you may not be able to obtain the desired image effect even after
changing the custom picture settings.



Custom Picture Settings

¢ \When an optional RC-V100 Remote Controller is connected to the camera, the following custom picture
settings can be changed using the buttons and dials on the remote controller.
[Black] > [Master Pedestal], [Master Black Red], [Master Black Blug]
- [Black Gamma] > [Level]
[Kneg] > [Slope], [Point] (only when [Knee] > [Activate] is set to [On]) 141
[Sharpness] > [Level]
- [White Balance] > [R Gain], [B Gain]
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Saving and Loading Menu Settings

Saving and Loading Menu Settings

After you adjust settings in the various menus, you can save those settings in the camera or on an SD card. You
can load those settings at a later date or on another camera of the same model so that you can use that camera
in the same way.

Saving Menu Settings
1 Select MENU > [¥ System Setup] > [Transfer Menu/[€d] > [Save].

2 Select [To Camera] or [To SD Card] and then select [OK].

e The camera’s menu settings will be saved to the selected destination. If menu settings were previously
saved, the old file will be overwritten by the current menu settings.

3 When the confirmation message appears, press SET.

Loading Menu Settings
1 Select MENU > [¥ System Setup] > [Transfer Menu/[€d] > [Load].

2 Select [From Camera] or [From SD Card] and then select [OK].

e The camera’s menu settings will be replaced by the settings in the previously saved file. Then, the screen will
turn black momentarily and the camera will restart.

(i) NoTES

¢ The following menu settings are not saved with this operation.

- MENU > "™ Camera Setup] > [Color Bars]

- MENU > [[@d Custom Picture] > [Edit File] > [Look File Setup] (only when saved using the [To Camera]
setting)

- Look Files used with MENU > [[@d Custom Picture] > [Select File] > [EOS Standard] or [EOS Neutral]
(only when saved using the [To Camera] setting)*

- MENU > [£® Recording/Media Setup] > [Metadata] > [User Memo]

- MENU > [[Z) Monitoring Setup] > [User LUT 1] to [User LUT 4]

- MENU > [ Assistance Functions] > [Magnification], [Magn. Output], [False Color Index]

- MENU > [& Assistance Functions] > [Waveform Settings] > [Size: VIDEO Term./EVF-V50]

- The root certificate for secure FTP transfers
* When loading settings with custom picture files set to [EOS Standard] or [EOS Neutral] using the [From Camera] setting, select
MENU > [Edit File] > [Reset] > [EOS Standard] or [EOS Neutral] to set a Look File again.

¢ \When menu settings are loaded with this operation, even protected custom picture files in the camera will be
replaced.
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Playback

This section explains how to play back clips and photos with the camera. For details on playing back recordings
using an external monitor, refer to Connecting to an External Monitor or Recorder (11 156).

Clip Index Screen
1 Set the switch to CAMERA.

2 Press the MEDIA button (1] 12).

e The camera is set to MEDIA mode and the clip thumbnails will
appear in the index screen.

(i) NoTES

e |f the card contains XF-AVC clips recorded at a system frequency

\4
7
MEDIA — CAMERA /
other than the one currently used by the camera, you will not be »

able to play back the clips and the clip thumbnails will not appear in the index screen. To play back such clips,
change the camera’s system frequency ([11 62) to match the recordings on the card.

¢ You can switch between CAMERA mode and MEDIA mode using an assignable button (1] 129).
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Key lock ([T 12)
Shot mark! (01 150)
[ mark/M mark' (0 150)
Orange selection frame
Clip identification (camera index, reel number and
clip number) (11 59)
Recording date and time
FTP transfer ([J] 184)
8 Recording media
/ [B. CFexpress card (the one currently
selected appears in white)
SD card
9 Index screen currently displayed ([1] 144)

[ NGV O

~ O

T XF-AVC clips only.

10 Clip thumbnail

11 Clip number / Total number of clips

12 Recording date (month and day only) and time

13 Clip’s start time code

14 Clip duration

15 Custom picture file embedded’ (1] 135)

16 Slow & fast motion recording (11 120)

17 Color sampling1 and resolution ([T 62)
For RAW clips, the RAW mode (RAW/HQ/ST/LT)
appears instead of the color sampling.

18 Frame rate? (1] 63)

2 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.

Switching CFexpress Cards

If both card slots contain a card, press the SLOT SELECT button to

play back recordings from the other card.

Switching Index Screens

The clip index screen that appears when you switch to MEDIA mode
depends on the current recording settings. Change the index screen
to play back primary clips recorded in a different format, proxy clips or

photos.
1 Press the INDEX button.

e Press the button when an index screen is displayed to open the

index screen selection menu.
2 Select the desired index screen.
® The selected index screen appears.

K
\ SELECT©

INDEX /i

e Select [Cancel] to return to the previous index screen.

Options
[RAW Index]:
[XF-AVC Index]:

Primary clips (RAW format) recorded on the selected CFexpress card.

Primary clips (XF-AVC format) recorded on the selected CFexpress card.

[XF-AVC Proxy Index]:

Proxy clips (XF-AVC format) recorded on the SD card.

[Photo Index]:  Photos recorded on the SD card.
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Playing Back Recordings
1 In the index screen, select the thumbnail of the desired recording and
then press the /1l button.

¢ Clips: Playback will start from the selected clip until the last clip in the index
screen.

¢ Photos: The selected photo will be displayed.

2 Use the joystick and buttons on the camera to control the playback.
e Clips: Press the /1l button or press SET to pause/resume playback. You
can also use the onscreen joystick guide (11 147). Press the Il button to
stop playback and return to the index screen.

¢ Photos: Push the joystick left/right to view other photos. Press the Il button O @
to return to the index screen.

Custom picture settings of RAW clips during playback
RAW clips are played back using the following custom picture settings.

e [Gamma/Color Space]: Same setting used for recording

e [Color Matrix]: [Neutral]

e Contour lines are de-emphasized in a way similar to setting [Sharpness] > [Level] to —10.
e Other settings are set to [Off].

(i) NoTES

¢ The following image files may not be displayed correctly.
- Images not recorded with this camera.
- Images edited on a computer.
- Images whose file names have been changed.
¢ You can press the DISP button repeatedly to change the level of onscreen displays (11 58).
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Onscreen Displays During Clip Playback
You can press the DISP button on the LCD monitor to change the information displayed during playback

([ 58).

180.00°
F1.4

150200

2122 23

1 Keylock (11 12)

Fan operation ([1] 61) and temperature warning
([ 223)

LUT (3 161)

Shutter speed! (O 72)
Joystick guide (1] 147)
FTP transfer ([J] 184)
Recording media

/ (B. CFexpress card
SD card

8 Playback operation

N

~NOo O~ W

P PLAY Playback
1l PAUSE Playback pause
/1 Frame reverse/Frame advance

F FWD x5 P Fast playback

<4« FREV x5* Fast reverse playback
* Approximate playback speed: x5 / x15 / x60

00 00 00 00

9101112
59.94P [€3 {1 09125(5)2"1“? 1 3
3840 2271/25 1 4
YCC4ZZX‘|OI)H 1 5
@t
- 17
18
19
— 20

24 25

9 Frame rate? ({11 63)

10 Custom picture file embedded?® (1] 135)
11 @ mark/M mark® (11 150)

12 Time code (11 99)

13 Power supply level (11 55)

14 Clip number / Total number of clips

15 Resolution ([1] 62)

16 Color Sampling3 and color bit depth ([T 62)
17 Video format (1] 62)

18 Output onscreen displays (11 158)

19 Headphone volume (11 147)

20 Audio level meter®

21 Aperture value' (0 77)

22 1SO speed/Gain' (0 74)

23 User bit (0 101)

24 Recording date and time®

25 Audio output channels (1] 165)

T Only when [(Z]) Monitoring Setup] > [Custom Display] > [Camera Data] is set to [On].
2 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.

3 XF-AVC clips only. (EIITAD For RAW clips recorded with a main recording format other than [RAW], the RAW mode (HQ/ST/LT)

is displayed.

Only when [[E]) Monitoring Setup] > [Custom Display] > [Audio Level Indicator] is set to [On].
5 Only when [[=] Monitoring Setup] > [Custom Display] > [Date/Time] is set to [On].
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Clip Playback Controls

The following playback types are available using the joystick and onscreen joystick guide. You can press the
DISP button to show/hide the joystick guide.

Playback type Operation 147

During playback, push the joystick up or down.

1
Fast playback Repeat to increase the playback speed to approximately 5x = 15x = 60x the normal speedz.

Frame advance/reverse During playback pause, push the joystick up or down.

Skip to the beginning of the next During playback, push the joystick right.

clip

Skip to the beginning of the . N

current clip During playback, push the joystick left.

SKip to the previous clip During playback, push the joystick left twice.

" You may notice some anomalies (blocky video artifacts, banding, etc.) in the playback picture.
2The speed indicated on the screen is approximate.

(i) NoTES

e There is no audio during any of the playback types listed in the previous table.
e You can press the B/1l button during fast playback to return to playback at normal speed.

Adjusting the Volume

You can use headphones or the built-in speaker to listen to the audio during
normal playback. When you connect headphones to the () (headphone)
terminal, the speaker will be muted. The audio signal will also be output from the
SDI OUT terminal, MON. terminal and HDMI OUT terminal.

1 Select MENU > [M) Audio Setup] > [Headphone Volume] or [Speaker
Volumel].

2 Select the desired level. A

%/ (headphone)
(i) NoTES

terminal
e For details on changing the audio channel, refer to Audio Outout (11 165).

e If you set an assignable button to [Headphones +] or [Headphones —] (11 129), you can press the button to
adjust the headphone volume without using the menu.
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Clip/Photo Operations

You can perform various operations on the clip selected in the index screen using the clip menu. Available
options will depend on the type of recording selected.

Clip/Photo Menu Operations

1 Select the desired recording.

2 Press SET.

e The clip/photo menu will be displayed. Available functions will differ depending on the recording.

3 Select a menu item.

Clip menu options

Menu item Description Index screen
[RAW]  [XF-AVC]  [XF-AVCProxy]  [Photo]
[Play] Starts playback. (] @ o o
[Display Clip Info] Displays the clip information screen ([ 149). (] @ o o
{ggfegnm';a&'grﬁ; Adds or deletes an [ mark (C10 150, 150). - ° - -
{ggfeta&frﬁ; Adds or deletes a @ mark (I 150, 150). - ° - -
[Del. All Shot Marks] Deletes all the shot marks from a clip (11 151). - @ - -
[Recover Clip]2 Recovers a clip (1] 48). o o o -
[Delete Clip] Deletes a clip (11 151). o o ([ J -
[Delete User Memo] ?EIS[:Z ':h)e user memo and GPS information of a clip _ P S _
[FTP Transfer] Transfers a clip using the FTP protocol ([ 184). - o o -
[Stop] Ends photo playback. - - - o
[Delete] Delete photos (11 151). - - - o

Vi the clip already contains an [l or mark, the option to delete the mark will appear in the menu.
2 Appears only when a clip requires recovery. In such case, only [Cancel], [Recover Clip] and [Delete Clip] will appear in the menu.

(i) NoTES

¢ To perform operations on XF-AVC proxy clips or photos recorded on an SD card, make sure the card is not

write-protected.



Displaying Clip Information

1 Select the desired clip in the clip index screen.

Clip/Photo Operations

2 Press SET (clip menu) and select [Display Clip Info].

e The [Clip Info] screen will appear.

e Push the joystick left/right to check the information on other clips. Press the CANCEL button to return to the

index screen.

L —10
1 12120 11
Nov. 3,2019 9:20 AM 12
A001C033_191103VG_CANON 13

. Intra 810 Mbps 3840x2160
2—am & S&F REC r 14
3 : 15
i Start 00:07:26:28 16
. End 00:07:30:26 17

4 A Duration 00:00:03:29
Prev. 1 8

5

O Lens & (AR K [@ Data 1/3 ’|9

1 Keylock (1] 12) 11 Clip file name ([11 59)
2 Thumbnail of the selected clip 12 Compression, bit rate and resolution ([ 62)
3 Clip geotagged with GPS information 13 Frame rate! (11 63)
4 Thumbnail of the previous clip 14 Shot mark (1 150) and [ mark / P4 mark?
5 Thumbnail of the next clip (1 150)
6 FTP transfer (0 184) 15 Custom picture file embedded? (1] 135)
7 Recording media 16 Color sampling2 and color bit depth ([I1 62)
/ [B] CFexpress card (the one currently For RAW clips, the RAW mode (RAW/HQ/ST/LT)
selected appears in white) appears instead of the color sampling.
SD card 17 Clip’s start time code
8 Slow & fast motion recording (11 120) 18 Clip’s end time code
9 Clip number / Total number of clips 19 Clip duration

10 Recording date and time

1 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.
2 XF-AVC clips only.

Displaying Additional Information (XF-AVC Clips Only)

From the [Clip Info] screen of an XF-AVC clip, you can push the joystick up/down or turn the SELECT dial to
display additional information screens.

[Lens & [HEM] screen: Details about the lens used to record the clip. If a user memo was recorded with the clip’s
metadata, this screen will show also the user memo details.

[[€@ Data 1/3] to [[Md Data 3/3] screens: If a custom picture file was embedded with the clip, these screens show
the custom picture settings used.

Push the joystick down repeatedly or turn the SELECT dial right to check the information screens in
the following order: [[@@ Data 1/3] to [[@@d Data 3/3] screens = [Lens & ] screen = [Clip Info] screen.

149
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Clip/Photo Operations

Adding [l Marks or [4 Marks

You can add an OK mark () or check mark () to XF-AVC primary clips to help you identify particular clips.
Since clips with an [l mark cannot be deleted with the camera, you can use this mark also to protect important
clips.

Adding an [l Mark or M Mark During Playback
To add an [ mark or [ mark to a clip during playback or playback pause, you must set an assignable button
to [Add [ Mark] or [Add M Mark] in advance.
1 Set an assignable button to [Add [l Mark] or [Add [ Mark] (11 129).
2 Select the desired clip in the [XF-AVC] index screen and press the B/l button.
3 During playback or playback pause, press the assignable button to add the clip mark.
o [[MAMark] or [MMark] will appear briefly and the selected clip mark will be added to the clip.
e Adding a clip mark to a clip during playback will pause the playback.
o [l or 4 appears at the top right of the clip playback screen.

Adding an [l Mark or M Mark from the Index Screen
1 Select the desired clip in the [XF-AVC] index screen.

2 Press SET (clip menu) and select [Add [ Mark] or [Add [ Mark] > [OK].
¢ The selected clip mark is added to the clip and [l or [ appears next to the clip’s thumbnail.

(i) notes

¢ A clip cannot have both an [l mark and [ mark at the same time. When you add a [ mark to a clip with an
[ mark, the [ mark will be deleted. Similarly, when you add an [l mark to a clip with a [ mark, the
mark will be deleted.

Deleting [l Marks or [4 Marks
1 Select the desired clip in the [XF-AVC] index screen.

2 Press SET (clip menu) and select [Delete M Mark] or [Delete M Mark] > [OK].
® The selected mark is deleted.

Adding Shot Marks

During the playback of a primary clip recorded in XF-AVC format, you can add shot marks (H) to particular
frames in the clip that you want to single out. To add a shot mark to a clip during playback or playback pause,
you must set an assignable button to [Add Shot Mark] in advance.

1 Set an assignable button to [Add Shot Mark] ([1] 129).

2 Select the desired clip in the [XF-AVC] index screen and press the /1l button.

3 During playback or playback pause, press the assignable button at the point in the clip where you
want to add the shot mark.
e [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.
e Adding a shot mark to a clip during playback will pause the playback.



Clip/Photo Operations

Deleting All the Shot Marks from a Clip
1 Select the desired clip in the [XF-AVC] index screen.

2 Press SET (clip menu) and select [Del. All Shot Marks] > [OK].
¢ All shot marks in the selected clip are deleted. 151

Deleting Clips and Photos

You can delete clips and photos you are not interested in keeping, except for XF-AVC clips with an [l mark. To
delete such clips, delete the i mark beforehand (11 150).

1 Select the desired clip or photo in the index screen.

2 Press SET (clip/photo menu) and select [Delete Clip] (clips) or [Delete] (photos) > [OK].
¢ The clip or photo is deleted.
® The operation cannot be canceled.

3 When the confirmation message appears, press SET.

@ vPorTANT
¢ Be careful when deleting recordings. Once deleted, they cannot be recovered.

Deleting the User Memo and GPS Information from a Clip
1 Select the desired clip in the [XF-AVC] or [XF-AVC Proxy] index screen.

2 Press SET (clip menu) and select [Delete User Memo] > [OK].
e The user memo and GPS information that were recorded in the selected clip’s metadata are deleted.



Clip/Photo Operations
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Video Output Configuration

The video signal output from the SDI OUT terminal, MON. terminal and HDMI™ OUT terminal, depends on the
clip’s video configuration and on various menu settings. The camera does not output signals to the MON.
terminal and HDMI OUT terminal simultaneously and will select the active output terminal automatically. However,
simultaneous output from the MON. terminal and the HDMI OUT terminal can be activated if necessary

(00 158).

SDI OUT Terminal Video 12G-SDI Output Configuration (Recording/Playback)

Main recording video configuration / Video output configuration

Configuration of the clip played back UREUE A (YChCr 4:2:2, 10 bit signal)®
Video format’ Frame rate? Resolution Scan mode® SDI OUT resolution* SDI OUT terminal
5952x3140), - 4096x2160 / 3840x2160 4096x2160
4192x3140 (4:3), 2048x1080 / 1920x1080 20481080
RAW 50.94P 3768x3140 (6:5)
50.00P [(C500 Mk II)]
€500 Mk | 29.97P PsF - 1920x1080°
RAW HQ 25.00P 4096x2160
RAW ST 24.00P 4096x2160 / 3840x2160
RAW LT 23.98P p 2048x1080
2048x1080 2048x1080 / 1920x1080
PsF - 1920x1080°
4096x2160
P 4096x2160 / 3840x2160 284042160
4096x2160,
3840x2160 2048x1080 / 1920x1080 2048x1080
1920x1080
59.94P 5
50.00P PsF - 1920x1080
29.97P 4096x2160 / 3840x2160
25.00P P 2048x1080
24,00 2048x1080 2048x1080 / 1920x1080
23.98P PsF - 192010808
XF-RVC 4096x2160 / 3840x2160
P 1920x1080
1920x1080 2048x1080 / 1920x1080
PsF - 1920x1080°
4096x2160 / 3840x2160
59.94P P 1280x720
1280x720 2048x1080 / 1920x1080
50.00P
PSF - 1920x1080°
50.94i
20,001 1920x1080 - - 1920x1080

T MENU > [£8 Recording/Media Setup] > [Main Rec Format] setting.

2 The output signal’s frame rate will be the same as that used for recording (except when slow & fast motion recording is activated).

S MENU > [& System Setup] > [SDI OUT Scan Mode] setting during slow & fast motion recording, it can only be set when using
a resolution of 3840x2160 or 1920x1080.

4 MENU > [¥ System Setup] > [SDI OUT Output (Max Res.)] setting.

5 The video signal’s effective bit depth will be output.

6 The output signal’s frame rate will be changed as follows: 59.94P / 23.98P - 59.94i, 29.97P - 29.97PsF,
50.00P - 50.00i, 25.00P - 25.00PsF and 24.00P - 60.00i. During slow & fast motion recording (only with a resolution of either
3840x2160 or 1920x1080) it will be changed as follows: 59.94P / 29.97P / 23.98P - 59.94i, 50.00P / 25.00P - 50.00i, 24.00P
- 60.00i.
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Video Output Configuration

(i) NoTES

¢ \When the resolution in the recording video configuration is 4096x2160 or 2048x1080 and slow & fast motion
recording is activated, video in 1920x1080 cannot be output.

. When the resolution in the recording video configuration is 4192x3140 (4:3) or 3768x3140 (6:5),
when shooting, the area of the screen that is not being recorded will appear transparent. When playing those
clips in MEDIA mode, black bars will appear on the sides of the picture.

MON. Terminal / HDMI OUT Terminal Video Output Configuration

(Recording/Playback)
Main recording video configuration / Outout settings Video output configuration
Configuration of the clip played back p 9 (YCbCr 4:2:2, 10 bit signal)®
. ) MON. HDMI OUT ) HDMI OUT
1 2 3
Video format Frame rate Resolution Scan mode resolution® resolution® MON. terminal terminal
5952x3140, 210;;8‘1 10(?50/ 4;’:468‘221 1650/ 2048x1080 | 4096x2160
4192x3140 (4:3), X X
37683140 (6:5) P 1920x1080 | 1920x1080 1920x1080
€500 Wk I
RAW 59.94P ( ) 1280x720 1280720 1280x720°
50.00P
€500 M|l 29.97p 4096x2160 PsF - - 1920x10807 | 1920x10808
RAW HQ 25.00P 2048x1080/ | 4096x2160 /
E/;vv\\/l ir 24.00P 19201080 3840x2160 2048x1080 1920x1080
23.98P p
204841080 1920x1080 | 1920x1080 1920x1080
1280720 1280x720 12807205
PsF - - 1920x10807 | 1920x10808
2048x1080/ | 4096x2160/ | 2048x1080, | 4096x2160,
1920x1080 | 3840x2160 | 1920x1080 | 3840x2160
4096x2160, P 1920x1080 | 1920x1080 1920x1080
3840x2160
59.94P 1280x720 1280720 1280x720°
50.00P ; ;
29,97 PsF - - 1920x10807 | 1920x1080
25.00P
20481080/ | 4096x2160/ | 2048x1080, | o0 oo
24.00P 1920x1080 | 3840x2160 | 1920x1080
23.98P
XF-AVC 2048x1080, P 1920x1080 | 1920x1080 1920x1080
1920x1080 5
1280720 1280x720 1280x720
PsF - - 1920x10807 | 1920x10808
50.94p P - - 1280720
1280x720
50.00P PsF - - 1920x10807
59.94i
20,001 1920x1080 - - - 1920x1080

T MENU > [£2 Recording/Media Setup] > [Main Rec Format] setting.
In most cases (orange cells in the table), the output signal’s frame rate will be the same as that used for recording (except when
slow & fast motion recording is activated).

3 MENU > [¥ System Setup] > [MON./HDMI Scan Mode] setting.

4 MENU > [ System Setup] > [MON. Output Resolution] or [HDMI Max Res.] setting.

5 The video signal’s effective bit depth will be output.



Video Output Configuration

6 The output signal’s frame rate is fixed and determined by the system frequency: 59.94P (59.94 Hz recordings), 50.00P (50.00 Hz
recordings) or 60.00P (24.00 Hz recordings).

" The output signal’s frame rate will be changed as follows: 59.94P or 23.98P - 59.94i, 29.97P - 29.97PsF,
50.00P - 50.00i, 25.00P - 25.00PsF and 24.00P — 60.00i.

8 The output signal’s frame rate is fixed and determined by the system frequency: 59.94i (69.94 Hz recordings), 50.00i (50.00 Hz
recordings) or 60.00i (24.00 Hz recordings).

(i) NoTES

. When the resolution in the video configuration is set to 4096x2160 or 3840x2160, and the recording
frame rate during slow & fast motion recording is 61 or higher, the video output from the HDMI OUT terminal
will be a 1920x1080 image.

¢ When MENU > [ System Setup] > [MON&HDMI Simuit. Output] is set to [On] the output resolution will be
1920x1080P when [MON./HDMI Scan Mode] is set to [P], and 1920x1080i when set to [PsF (Forced 1080i)].
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Connecting to an External Monitor or Recorder

Connecting to an External Monitor or Recorder

When you connect the camera to an external device, be it a monitor (to monitor the recording or for playback) or
an external video recorder (for recording), use the terminal on the camera that matches the one you wish to use
on the external device. Then, select the video signal output configuration (1] 153).

Connection diagram
The camera does not output signals to the MON. terminal and HDMI OUT terminal simultaneously. However,
simultaneous output from the MON. terminal and the HDMI OUT terminal can be activated if necessary

(0 158).

MON. terminal External
monitor/
digital video
recorder
]
SDI inputs
x
o
» %— HDMI inputs
= HDMI OUT terminal
SDI inputs

SDI OUT terminal

BNC cable (commercially available)

HDMI cable (commercially available)

(i) NoTES

e Powering the camera from a power outlet using an AC adapter is recommended.

Using the SDI OUT Terminal

The digital signal that is output from the SDI OUT terminal includes the video signal, audio signal, time code
signal and the recording command signal. You can connect an external video recorder to the SDI OUT terminal
to record 4K or 2K video. For details about configuring and using external recorders, refer to the instruction
manual of the external device used.

1 Select MENU > [¥ System Setup] > [SDI OUT Output (Max Res.)] > Desired option.

2 To change the 3G-SDI mapping level, select MENU > [¥ System Setup] > [3G-SDI Mapping] >
[Level A] or [Level B].

e You can select a video output signal compliant with Level A or Level B of the SMPTE ST 425-1 standard.

(i) notes

¢ Depending on the external recorder, you may not be able to record at the desired video configuration.

e After you connect the camera to the external recorder, make a test recording first to check that audio and
video are recorded correctly on the external recorder.

¢ You can set MENU > [ 2% Recording/Media Setup] > [Rec Command(EXT REC)] to [On] to use the camera’s
REC button to control also the recording operation of an external recorder connected to the SDI OUT terminal.
However, this function cannot be used when slow & fast motion recording is activated.



Connecting to an External Monitor or Recorder

Using the MON. Terminal

The digital signal that is output from the MON. terminal includes the video signal, audio signal, time code signal,
recording command, metadata and clip file name information. You can also output various assistance displays
(onscreen displays, markers, etc.) in order to check them also on an external monitor.

1 To output signals from the MON. terminal, make sure the HDMI OUT terminal does not have a cable
connected to it.

2 Select MENU > [¥ System Setup] > [MON. Output Resolution] > Desired option.
3 To change the 3G-SDI mapping level, select MENU > [¥ System Setup] > [3G-SDI Mapping] >
[Level A] or [Level B].
e You can select a video output signal compliant with Level A or Level B of the SMPTE ST 425-1 standard.
Options

[2048x1080 / 1920x1080]:
Outputs video with a resolution of 2048x1080 or 1920x1080.

[1920x1080]:  Outputs 1920x1080 (Full HD) video. When the horizontal resolution of the main recording video
configuration is 4096 or 2048, the image will be displayed letterboxed.

[1280x720]: Outputs 1280x720 (standard HD) video.

(i) NoTES

e You can set MENU > [ £% Recording/Media Setup] > [Rec Command(EXT REC)] to [On] to use the camera’s
REC button to control also the recording operation of an external recorder connected to the MON. terminal.
However, this function cannot be used when slow & fast motion recording is activated.

Using the HDMI OUT Terminal

The digital signal that is output from the HDMI'™ OUT terminal includes the video signal and audio signal. You
can output also the time code signal, recording command and various assistance displays (onscreen displays,
markers, etc.) in order to check them also on an external monitor.

[T™M

1 Connect the HDMI cable to the HDMI OUT terminal.
o MOy will appear on the right of the screen and the HDMI OUT terminal will become the active output terminal.

2 Select MENU > [¥ System Setup] > [HDMI Max Res.] > Desired option.

3 CAMERA mode only: To output the time code signal, select MENU > [£% Recording/Media Setup] >
[HDMI Time Code] > [On].

(i) NoTES

* You can set MENU > [ System Setup] > [Linked to HDMI Monitor] to [On] to automatically change the HDMI
OUT terminal’s output resolution according to the capabilities of the connected monitor. When this setting is
set to [Off], the output resolution is set according to the menu settings and if the connected monitor is not
compatible with the signal output from the camera, HDMI output will stop.

e The HDMI OUT terminal is for output only. Do not connect the camera to another device’s output terminal
using the HDMI OUT terminal as this will cause a malfunction.

e Correct operation cannot be guaranteed when connecting the camera to DVI monitors.

¢ Video may not be output correctly depending on the connected external monitor/recorder or the HDMI cable
used. In such case, use another terminal.

* You can set both MENU > [£% Recording/Media Setup] > [Rec Command(EXT REC)] and [HDMI Time Code]
to [On] to use the camera’s REC button to control also the recording operation of an external recorder
connected to the HDMI OUT terminal. The camera’s time code signal will be output as well.
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¢ The time code will not be output from the HDMI OUT terminal in the following cases.
- In MEDIA mode.
- When the video output signal is 720x480 / 59.94P or 720x576 / 50.00P.

Enabling simultaneous output from the MON. terminal and the HDMI OUT terminal
You can simultaneously output the same video signal from the MON. terminal and the HDMI OUT terminal.

Select MENU > [ System Setup] > [MON&HDMI Simult. Output] > [On].

e The output resolution will be 1920x1080P when [MON./HDMI Scan Mode] is set to [P], and 1920x1080i when
set to [PsF (Forced 1080i)].

(i) NoTES

¢ The following functions cannot be used when [MON&HDMI Simult. Output] is set to [On].
MENU > [¢ System Setup] > [HDMI Max Res.], [Linked to HDMI Monitor] or [MON. Output Resolution].

Selecting the Video Output’s Scan Mode

When using external devices that support only interlaced scanning, you can change the scan mode of the video
signal output from the various terminals.

MON. Terminal / HDMI OUT Terminal

Select MENU > [¥ System Setup] > [MON./HDMI Scan Mode] > [P] or [PsF (Forced 1080i)].

SDI OUT Terminal

Select MENU > [ System Setup] > [SDI OUT Scan Mode] > [P] or [PsF (Forced 1080i)].

(i) noTes

e During slow & fast motion recording, [SDI OUT Scan Mode] cannot be used.

Superimposing Onscreen Displays on Video Outputs

You can output the camera's onscreen displays along with the video output from the MON. terminal or HDMI
OUT terminal to check the onscreen displays on an external monitor. This setting will not affect your recordings.

Select MENU > [[=) Monitoring Setup] > [OSD Output: MON./HDMI] or [OSD Output: SDI OUT] > [On].

° appears on the right of the screen (In CAMERA mode, only if MENU > [[E]) Monitoring Setup] >
[Custom Display 2] > [OSD Output] is set to [On]).

(i) notes

¢ \When the HDMI OUT terminal’s output resolution is 720x480 or 720x576, the camera’s onscreen displays will
not be output from the HDMI OUT terminal.

e For video output from the SDI OUT terminal, only onscreen displays can be superimposed. Assistance
functions that affect the image (such as false color and magnification) will not be superimposed.
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e |f you set an assignable button to [OSD Output: All], [OSD Output: MON./HDMI] or [OSD Output: SDI OUT]
(I 129), you can press the button to turn the camera’s onscreen displays on and off on external monitors
connected to the respective terminals.

Changing the Opacity Level of Onscreen Displays
You can make onscreen displays more visible or less conspicuous by changing their opacity level.

1 To change the visibility of onscreen displays on individual video outputs, select MENU >
[(ZD Monitoring Setup] > [OSD Opacity: VIDEO Term.] (LCD screen), [OSD Opacity: EVF-V50]
(optional viewfinder), [OSD Opacity: MON./HDMI] or [OSD Opacity: SDI OUT] (external monitors) >
[On].

2 Select MENU > [[=) Monitoring Setup] > [OSD Opacity Level] > Desired option.
¢ The smaller the percentage the more transparent the onscreen displays.

3 Select MENU > [[Z) Monitoring Setup] > [OSD Opacity: Appl. Screens] > [All] or [Only Rec/Playback
Screens].

e You can apply the selected opacity level to all onscreen displays (including menus, etc.) or only to onscreen
displays on the shooting and playback screens.

(1) NoTES

e AF frames and assistance functions will not be superimposed on video output from the SDI OUT terminal.

e |f you set an assignable button to [OSD Opacity: All], [OSD Opacity: VIDEO Term.], [OSD Opacity: EVF-V50],
[OSD Opacity: MON./HDMI] or [OSD Opacity: SDI OUT] ([ 129), you can press the button to change the
opacity level of onscreen displays on all monitoring devices, the supplied LCD screen, an optional viewfinder or
external monitors, respectively.

Selecting the Output Range

You can select the output range of video signals output from the various terminals to determine how the image
levels are mapped to code values. Moreover, you can select the setting independently for Canon Log output and
for HDR output.

Applied output range settings

Custom picture file Applied range settings
[Gamma] [Look File] [Gamma/Color Space] MENU > [{Z) Monitoring Setup] > [Range: HDMI]
after the Look File is applied Al 2
[0ff] -
[Canon Log 2] "
[On] [Conform to Custom Picture] )
[off [During Canon Log Output]
[Canon Log 3] -
[On] [Conform to Custom Picture]
[Off] -
[PQl
[On] [Conform to Custom Picture]
[During HDR OQutput]
[Off] -
[HLG]
[On] [Conform to Custom Picture]
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Custom picture file Applied range settings
[Gamma] [Look File] (I AR MENU > [[) Monitoring Setup] > [Range: HOMI]
after the Look File is applied 9 2 ge:
0 -
160 [BT.709 Wide DR] o
— [On] [Conform to Custom Picture]
0 -
[BT.709 Normal] o
[On] [Conform to Custom Picture]
[Off] - -
[BT.709 Standard] - )
[on] [Conform to Custom Picture] (Fixed narrow range)
[Off] -
[Canon 709]
[On] [Conform to Custom Picture]
[SDR BT.709]
[SDR BT.2020]
- [On]
[HDR PQ(BT.2100)]
[During HDR Output]
[HDR HLG(BT.2100)]

1 Select MENU > [(Z) Monitoring Setup] > [Range: SDI OUT], [Range: MON.] or [Range: HDMI].

2 Select [During Canon Log Output] or [During HDR Output] > Desired option.
® Repeat the procedure as necessary to select the output range for other terminals or output signals.

Options for [Range: SDI OUT], [Range: MON.]
[Full Range]:  The signal output will use full range coding.
[Narrow Rangel:
The signal output will use narrow range (video range) coding.

Options for [Range: HDMI]

[Full Range Priority]:
The signal output will use full range coding whenever possible but will change the range
automatically according to the capabilities of the connected monitor.

[Narrow Range]:
The signal output will use narrow range (video range) coding.
(i) NoTES

e Settings will change depending on the gamma curve component of the [Gamma/Color Space] setting in the
custom picture file. When a LUT is applied, settings will change also depending on the gamma curve selected
for the output signal. If a user LUT is applied, the output range will be determined by the user LUT’s [Range
(Qutput)] setting.
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Applying a LUT to Video Outputs

While recording using special gamma curves, you can apply a LUT to the image displayed on external monitors
(SDI OUT terminal, MON. terminal, HDMI OUT terminal), the supplied LCD screen (VIDEO terminal) or an optional
viewfinder. When a LUT is applied, the displayed image will look as if a standard gamma curve were used,
making it easier to check the image on the display device used. To check the image on an external monitor, you
will need a monitor that is compatible with the video’s color space.

You can also load and apply LUT files created with Blackmagic Design’s DaVinci Resolve ([11 163).

Available LUTs
The available LUTs depend on the [Gamma/Color Space] and [Look File] settings in the custom picture file
(11 136). If these settings are changed, LUT will be turned off.

Custom picture file Available LUTs
[Look [Gamma/Color Space] 1 1 [PQ]1 / 1 [HDR Assist.  [HDR Assist
File] after the Lok File is applied ©/00)  [BT20201 - IDCIT py 1 TACESprowl™ [CMT 709 ©gh002 (agg0ey2

1o - : A (See the following table.)
[Conform to Custom Picture]
[SDR BT.709] - - - - - - _ _
[On] | [SDR BT.2020] [ ) - - - - _ _ _
[HDR PQ (BT.2100)] [ J - - - - - o )
[HDR HLG (BT.2100)] [ J - - - - - _ ™Y

SDR stands for Standard Dynamic Range.

Selectable LUTs (when A)

Custom picture file Available LUTs
[HDR [HDR
[Gamma/Color Space] [BT.709] [BT2020]' [DC'  [PQ]'  [HLG]' [ACESproxy]' [CMT709]  Assist.  Assist.
(1600%)12  (400%)]2

[Canon Log 2 / C.Gamut] [ J o o [ J o [ J ([ ([ J ([
[Canon Log 3 / C.Gamut] [ J o o [ J o [ J ([ [ J ([
[Canon Log 3 / BT.2020] ° ) - ° o - - o )
[Canon Log 3/ BT.709] [ ) - - - - - — — _
[PQ/ BT.2020] ° _ - _ _ _ _ ° °
[HLG / BT.2020] ° _ - _ _ _ _ _ °
[BT.709 Wide DR / BT.2020] ° - - - - - _ _ _
[BT.709 Wide DR / BT.709] - - - _ - _ _ _ _
[BT.709 Normal / BT.2020] - - - _ - - _ _ _
[BT.709 Normal / BT.709] - - - - - _ _ _ _
[BT.709 Standard / BT.709] - - - - - - _ _ _
[Canon 709 / BT.709] - - - - - - - - _

1 Not available for the VIDEO terminal (supplied LCD monitor/optional LV-M1 LCD Monitor/optional EVF-V70 OLED Electronic
Viewfinder).

2 Available only for the VIDEO terminal (supplied LCD monitor/optional LV-M1 LCD Monitor/optional EVF-V70 OLED Electronic
Viewfinder).

1 To apply the LUT to the supplied LCD screen, select MENU > [[Z) Monitoring Setup] > [LUT: VIDEO
Term.] > [On].

2 Select MENU > [[=) Monitoring Setup] > [LUT Selection: VIDEO Term.] > Desired LUT.
* The gamma curve and color space of the video output will change.
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e Repeat steps 1 and 2 as necessary to apply LUTs to other video outputs with the following settings:
[LUT: SDI OUT] and [LUT Selection: SDI OUT]: video output from the SDI OUT terminal,
[LUT: MON.] and [LUT Selection: MON.]: external monitor connected to the MON. terminal,
[LUT: HDMI] and [LUT Selection: HDMI]: external monitor connected to the HDMI OUT terminal,
[LUT: EVF-V50] and [LUT Selection: EVF-V50]: optional viewfinder.

List of LUTs
Output Settings
Applied LUT with LUT applied Description
Gamma curve  Color space
[BT709] BT.709 BT709 LUT fqr wgwmg on the LCD screen and external monitors compatible with BT.709
Wide DR specifications.
[BT.2020] BT.709 BT 2020 LU'!' for wgwmg on external monltor§ comp.at.lt.)le with I.T.U-R BT.2020 standards,
Wide DR which define parameters for ultra-high-definition television (4K/8K).
[DCI oel DCI-P3 LUT for viewing on external monitors that support color spaces and gamma
curves that follow the guidelines established by DCI (Digital Cinema Initiatives).
LUT for viewing HDR (high dynamic range) images on external monitors
[PQ] PQ BT.2020 compatible with the PQ standard defined by ITU-R BT.2100. The signal output will
use narrow range (video range) coding.
LUT for viewing HDR (high dynamic range) images on external monitors
[HLG] HLG BT.2020 compatible with the HLG standard defined by ITU-R BT.2100. The signal output
will use narrow range (video range) coding.
LUT for viewing on external monitors compatible with the ACESproxy standard
[ACESproxy] ACESproxy ACESproxy | established by ACES (Academy Color Encoding System). The signal output will use
narrow range (video range) coding.
LUT for viewing on the LCD screen and external monitors compatible with BT.709
[CMT 709] CMT 709 BT. 709 specifications. It produces a look suitable for a cinema production, keeping a wide
dynamic range without clipping when log recording.
[HDR Assist. (1600%)] LUT for viewing HDR (high dynamic range) images on LCD screens and optional
Original viewfinders connected to the VIDEO terminal or to an optional viewfinder attached
g BT.709 to the system expansion terminal. The LUT follows the ITU-R BT.2100 transfer
gamma curve

[HDR Assist. (400%)]

function to convert a brightness range of 1600% or 400% respectively into a
linear brightness scale.

(i) NoTES

¢ \When you apply the [ACESproxy] LUT to the SDI OUT terminal, MON. terminal or HDMI OUT terminal, the
terminal will output ACESproxy video data. Using a compatible monitor, you can perform on-set color grading
and check the image after color correction as you continue shooting ([11 23).

e |f you set an assignable button to [LUT: All], [LUT: VIDEO Term.], [LUT: EVF-V50], [LUT: SDI OUT], [LUT: MON.]
or [LUT: HDMI] (Q1 129), you can press the button to turn the selected LUT on and off on all monitoring
devices, the supplied LCD screen, an optional viewfinder or external monitors, respectively.

Adjusting the Color Quality for HLG Output

You can change the quality of the color reproduction when the [HLG] LUT is used.

Select MENU > [[=) Monitoring Setup] > [HLG Color] > Desired option.

Options
[BT.2100]:

Color reproduction according to ITU-R BT.2100 specifications.
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[Vivid]: More saturated color reproduction according to the "Traditional Colour' approach in ITU-R
BT.2390.

163
Adjusting the Gain Difference between HDR and SDR —

You can adjust the SDR gain difference relative to HDR within a range of + 7.5 dB (in 0.5 dB increments) in the
following cases:
¢ \When the main clip is set to HDR* and a LUT that changes the color space to BT.709 is applied to the output.

¢ \When the main clip is set to HDR* and [Sub Rec Color Conversion] of the proxy clip is set to [BT.709 (Wide
DR)] or [BT.709 (CMT 709)].

* When the [Gamma/Color Space] setting in the custom picture file is set to [PQ / BT.2020] or [HLG / BT.2020], or when a Look
File is activated and the [Gamma/Color space] setting after applying the Look File is set to [HDR PQ (BT.2100)] or [HDR HLG
(BT.2100)], and the [LUT] setting is set to [BT.709] or [CMT 709].

Select MENU > [[Z) Monitoring Setup] > [Gain for HDR—->SDR Conv.] > Desired option.

User LUTs

You can register in the camera up to four LUT files created with Blackmagic Design’s DaVinci Resolve as user
LUTs and apply them to video outputs/screens. User LUTs can be applied when the gamma in the custom
picture file is a log gamma curve. You can adjust the output color space and range of user LUTs.

Use an SD card to copy LUT files to the camera.

Registering a User LUT

1 Insert the SD card with the desired LUT file (.cube format) into the camera’s SD card slot.
2 Select MENU > [[E) Monitoring Setup] > [User LUT 1] to [User LUT 4] > [Register].

3 Select the LUT file on the SD card.

4 Select [BT.709 Gamut] or [BT.2020 Gamut] to change the color space for the output signal ((Color Space
(Output))).

¢ To leave the color space unchanged, select [Do Not Convert] instead.
5 Select [Narrow Range] or [Full Range] to change the output range ([Range (Output)]).
6 Select [OK].

e The selected LUT file will be registered in the camera.
7 When the confirmation message appears, press SET.

o After registering a user LUT, it will appear as one of the options ([USERLUT1 %] to [USERLUT4 % ]) when
you select the desired LUT (step 2, [] 161).

¢ Only registered user LUTs are listed in the options.

Deleting a User LUT

1 Select MENU > [[E) Monitoring Setup] > [User LUT 1] to [User LUT 4] > [Delete] > [OK].
® The selected user LUT will be deleted.
2 When the confirmation message appears, press SET.

Resetting All the User LUTs

1 Select MENU > [(Z) Monitoring Setup] > [Reset All User LUTs] > [OK].
e All user LUTs will be deleted.
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2 When the confirmation message appears, press SET.

Renaming a User LUT
You can rename each of the four user LUTs in the camera.

Select MENU > [[=) Monitoring Setup] > [User LUT 1] to [User LUT 4] > [Rename].
¢ Enter the desired LUT name (up to 8 characters) using the keyboard screen ([1] 36).

Checking a User LUT’s Settings

Select MENU > [[=) Monitoring Setup] > [User LUT Info].

e Use the joystick or SELECT dial to review all the information and press the CANCEL button to return to the
menu.

(i) NoTES

About LUT files
- The camera supports LUT files (3D LUT/.cube format) in 17 grid or 33 grid format created with Blackmagic
Design’s DaVinci Resolve.
- LUT files with input ranges outside the 0 to 1 range in the header (“LUT_3D_INPUT_RANGE”) are not
supported.
- LUT files which include values outside of the 0 to 1 range in the data area are not supported.
- LUT files 2 MB and larger, as well as files with a name containing over 65 characters are not supported.
- Only the following characters can be used in the file name:
Numbers O to 9, upper/lower case letters a to z, underscore (_), hyphen (-), period (.) and a single byte
space.
e Save a LUT file to the root directory of the SD card.
e [f the correct color space for the output signal ((Color Space (Output)]) is not selected, video will not be output
correctly.
e User LUT files in the camera cannot be overwritten. If necessary, delete a user LUT file in the camera before
registering a different LUT file.
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Audio Output

The camera can output audio from the SDI OUT terminal, MON. terminal, HDMI OUT terminal, () (headphone)
terminal or speaker*. When recording or playing back clips recorded with 4-channel audio, you can select which
audio channels are output from the HDMI OUT terminal, headphones and speaker.

* Only monaural output is available for the speaker.

Audio output configuration

Recorded audio configuration Audio output during recording/playback
Audio format Audio bit depth SDI OUT terminal/ HDMI OUT terminal*
MON. terminal
4-channel 4-channel 2-channel
linear PCM 24 hit linear PCM linear PCM
24 bit 16 bit

* You can select the audio channels that are output.

To select the audio channels for headphone or speaker output

Select MENU > [ M) Audio Setup] > [Monitor Channels] > Desired audio output option (L/R).

e Options like [CH1+2] indicate that two audio channels (CH1 and CH2 in this example) are mixed and output
from the same side.

To select the audio channels for HDMI output
Select MENU > [ ) Audio Setup] > [HDMI OUT Channels] > [CH1/CH2] or [CH3/CH4].

(i) NoTES

e |f you set an assignable button to [Monitor Channels] (11 129), you can press the button to toggle between
the audio channel output options.
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Working with Clips on a Computer

Canon offers software applications as free downloads that allow you to save on a computer XF-AVC clips
recorded with the camera, develop RAW clips, and more.

Saving XF-AVC Clips

Use Canon XF Utility to save and organize XF-AVC clips on a computer. You can use the Canon XF plugins to
easily use clips directly from Avid non-linear editing (NLE) software. The software and plugins are available as free
downloads from your local Canon website. Check the download page for the system requirements and latest
information.

You will find detailed instructions about installing and uninstalling the software in the "Read This First" file
(Install-XF Utility.pdf) included in the compressed file you will download from the website. For details about using
the software, refer to the instruction manual (PDF file) that is installed with the software.

Canon XF Utility (for Windows/macOS): Software application that allows you to save clips on a computer,
check, play back and organize clips and grab still frames from clips.

Canon XF Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import clips
from a card or a local folder in the computer to the compatible version of Avid Media Composer (an NLE
application compatible with Avid Media Access), directly from within the application.

Developing RAW Clips

Use Cinema RAW Development to develop RAW clips shot/recorded with the camera. After you develop the
clips and export them to a full-quality standard file type such as DPX, they will be ready for color grading.
Alternatively, you can use the Canon RAW Plugin to easily use RAW clips unaltered (in RAW format) directly from
major non-linear editing (NLE) applications. The software and plugin are available as free downloads from your
local Canon website. Check the download page for the system requirements and the latest information.

You will find detailed instructions about installing and uninstalling the software in the “Read This First” file
(Install-Cinema RAW Development.pdf) included in the compressed file you will download from the website. For
details about using the software, refer to the instruction manual (PDF file) that is installed with the software.

Cinema RAW Development (for Windows/macOS): Software application that allows you to develop, play back
and export RAW clips.

Canon RAW Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import RAW
clips to the compatible version of Avid Media Composer (an NLE application compatible with Avid Media
Access), directly from within the application.

Canon RAW Plugin for Final Cut Pro (macOS): Plugin that allows you to easily import RAW clips to Apple’s
Final Cut Pro, directly from the application.
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About the Network Functions

To be able to use the following network functions, you will need to attach an optional WFT-E9Q Wireless File
Transmitter to the system expansion terminal ([J] 14) and connect to a Wi-Fi network, or attach an expansion
unit to the camera and use the =% (Ethernet) terminal on the expansion unit to connect to a wired (Ethernet)
network. For details about the accessories and how to attach them, refer to the Cinema EOS System Expansion
User Guide.

Network functions and connection types

Wi-Fi
Wired network
Network function Description
P (Ethernet) infrastructure! e A§ e |
Point

Transfer clips recorded with the camera to

FTP File Transfer another device connected to the network o 184
using the FTP protocol.
Stream the camera’s live video and audio over

IP Streaming IP to a compatible IP video decoder connected - 185
to the network. o Y

Browser Remote Control the camera remotely from the Web Y 187
browser of a connected device.
Control the camera remotely using a

XC Protocol controller or application compatible with the o 194
XC Protocol via an IP connection.

1 Connection to a Wi-Fi network via an external access point (wireless router, etc.)
Direct connection to one Wi-Fi-enabled device where the camera serves as the Wi-Fi access point.

Before using the network functions

e The instructions in this chapter assume you already have a correctly configured and working network and
correctly configured network device(s). If necessary, refer to the documentation provided with the network
devices you plan to use.

e Configuring the network settings requires adequate knowledge about configuring and using wired (Ethernet)
and/or wireless (Wi-Fi) networks. Canon cannot provide support regarding network configurations.

@ vPorRTANT

e Canon shall not be liable for any loss of data or damage resulting from incorrect network configuration or
settings. Additionally, Canon shall not be liable for any loss or damage caused by the use of network functions.

¢ Avoid using open networks or networks without sufficiently strong security settings. Using an unprotected
network can expose your data to monitoring by unauthorized third parties.

(1) NoTES

¢ Do not open the card compartment cover while using network functions.

¢ Do not place cables connected to the camera’s terminals near the optional WFT-EQ Wireless File Transmitter.
Doing so may negatively affect the wireless communication over Wi-Fi.
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Using Networks
Using a Wi-Fi Network

To use a Wi-Fi network, attach an optional WFT-E9 Wireless File Transmitter to the camera. To learn how to
attach the accessory, refer to the Cinema EOS System Expansion User Guide.

% (attach directly)

WFT-E9 Wireless File

) ) Transmitter (optional)
System expansion terminal

You can connect the camera in Infrastructure mode, using an access point (wireless router etc.), or in Camera
Access Point mode, directly to a network device. The type of connection you can use, depends on the network
function you wish to use (11 167).

For an Infrastructure connection, the camera offers 4 ways to configure an access point and the method you use
will depend on the type and specifications of the access point and network you plan to use.

Camera Access Point: When shooting in a location where there are no access points available, the camera can
serve as a wireless access point*. Wi-Fi enabled devices will be able to connect to the camera directly.

* Limited only to the connection between the camera and supported Wi-Fi enabled devices. The functionality is not the same as
that of commercially available access points.

Infrastructure connection:

WPS (button): If your wireless router supports Wi-Fi Protected Setup (WPS), setup will be @ pp—

SETUP

easy and require minimal configuring and no passwords. To check if your wireless router
has a WPS button and for details about how to activate the Wi-Fi protected setup, refer to
the instruction manual of your wireless router.

WPS (PIN code): Even if your wireless router does not have a dedicated WPS button, it may support WPS using
a PIN code instead. For setup using a PIN code, you will need to know in advance how to activate the wireless
router’s WPS function. For details refer to the instruction manual of your wireless router.

Searching for Access Points: If your access point does not support the WPS function or you cannot activate it,
you can have the camera search for access points in the area.

Entering the SSID and authentication method: Manually enter the SSID and other information about the access
point.

@ PoRTANT

e Depending on the country/region of use, some restrictions on outdoor use or Camera Access Point
connections may apply when using the IEEE 802.11b/g/a/n/ac wireless standard. Check in advance the
version of WFT-EQ transmitter used and its applicable areas of use and restrictions.
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Using a Wired (Ethernet) Network

Connect a commercially available Ethernet cable to the == (Ethernet) terminal on an expansion unit and to the
Ethernet port on a network device. Use Category 5e, shielded twisted pair (STP) Ethernet cables compatible
with Gigabit Ethernet (1000BASE-T) and with good shielding capability. 169

EU-V1 Expansion Unit 1 (optional)

=5 (Ethernet) terminal and
connection indicator

Ethernet port on a
network device

0O 0O0ODODODOOO

Ethernet cable
AL N (commercially available)

1 Turn off the camera.
2 Connect an Ethernet cable to the camera’s == (Ethernet) terminal and the desired network device.
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Configuring Connection Settings

To connect to a network you will need to define in advance a connection setting (SET), which is a combination of
one or two communication settings (networks, NW) and one or two network function settings (MODE). You can
save in the camera up to 25 individual communication settings and function settings, and up to 20 combinations
of connection settings (SET1 to SET20).

To configure a connection setting for the first time, you will follow the setup wizard ([J] 171). Using the wizard,
you can set up only one network and one function per connection setting. After having configured multiple
connection settings, you can change them (for example to add a secondary network or second function) and
you can create new ones combining existing communication and function settings ([11 178).

Configure the necessary connection settings for the networks and network functions you wish
to use.

Connection setting (SET)

Communication Communication Function Function
Setting 1* (NW) Setting 2 Setting 1* (MODE) Setting 2**
* Configured using the wizard.
S ** Only in CAMERA mode.

Wi-Fi —— FTP transfer
—E Camera Access Point IP streaming

Infrastructure Browser Remote

WPS (pUSh bUtton) XC Protocol

WPS (PIN code)
Detected access points
SSID/authentication mode input

—— Ethernet

Select a connection setting appropriate for the network function you wish to use and start using
the function.

FTP transfer (11 184)

IP streaming ([1] 185)

Browser Remote ([1] 187)

XC Protocol ([J] 194)
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Adding a New Connection Setting Using the Wizard

This section uses a connection to a Wi-Fi network using the WPS push button method as an example. Refer to
the instruction manual of the access point for details about the location and operation of the WPS button.

1 Select MENU > [#W# Network Settings] > [Network] > [Enable] to enable the network functions.

2 Select MENU > [#W Network Settings] > [New Conn. Setting (Wizard)] > Desired network function >
[OK].

3 Select [Create New Comm. Setting].
e Once you have added multiple communication settings, you can select [Select Existing Setting] to reuse the

settings for a network that you saved previously.

4 Select [Wi-Fi 7).
¢ To configure a wired (Ethernet) network, refer to Ethernet Settings (11 175).

5 Select [Connect with WPS] > [WPS (Push Button)].

¢ To use a different configuration method, complete the corresponding procedure.
Camera Access Point ([J] 175)
WPS using a PIN code ([11 176)
Detected access points ([I] 176)
SSID/authentication mode input ([ 177)
Manual setup without connecting to the network (1 177)

6 Press and hold the WPS button on the wireless router and then, on the camera, select [OK].

7 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] >
[Disable].
¢ To configure IPv4 settings manually, continue with that procedure instead ([11 179).
e To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6

settings as necessary (1] 181).

8 When the confirmation message appears, press SET to continue to configure the function settings.

e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (11 172), IP streaming ([ 173), Browser Remote ([ 174), XC Protocol ([I] 174)

(i) NoTES

e The [WPS (Push Button)] method may not work correctly if there are several active access points in the area. In
such case try using [WPS (PIN Code)] (11 176) or selecting one of the detected networks (1] 176).
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Function Settings
Function Settings: FTP Transfer

This section continues the connection settings wizard ([J] 171). In the function settings you will configure the
FTP server settings and other settings related to the handling of folders and files. If necessary, consult the
network administrator in charge of the FTP server.

1 Select [Create New Func. Setting].

e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse the
settings for an FTP server that you saved previously.

2 Select the desired transfer mode.

e Select [FTPS] for a secure FTP transfer using a root certificate. For details about the required root certificate,
refer to Readling a root certificate for FTPS transfer (11 181).

e Select [SFTP] for a secure FTP transfer using an SSH secure channel.
3 Configure the destination FTP server. Select [Server] and [Port No.] > [OK].

e Enter the FTP server’s IP address or host name using the keyboard screen ([11 36). Enter the port number
using the data entry screen ([ 60).

e Usually, the port number used is 21 (FTP or FTPS transfers) or 22 (SFTP transfers).

* Depending on the FTP mode selected in step 2, perform either step 4 or steps 5-7 and then continue to
step 8.

SFETP transfers

4 Enter the user name and password for the SSH protocol’s authentication. Select [User Name] and [Password]
> [OK].
e Enter the desired user name and password using the keyboard screen ([11 36).

FTP/FTPS transfers
5 Select [Enable] to use passive mode or [Disable] to use active mode.
* |In most cases, select [Disable].
6 Enter the user name for the FTP server and then select [OK].
e Press SET and enter the desired user name using the keyboard screen ([1] 36).

7 Enter the password for the FTP server and then select [OK].
¢ Press SET and enter the desired password using the keyboard screen (1] 36).

All transfer modes
8 Select the destination folder on the server.
9 Select [OK]
e The function settings are saved to a [MODE] file.
10 Select the connection setting (SET1 to SET20) where to save the settings.
11 When the confirmation message appears, press SET.
¢ The camera will connect to the network and will be ready to use the FTP transfer function (11 184).

Options for [Destination Folder]

[Root Directory]:
Files are saved on the root directory of the destination FTP server.

[Select Folder]: Press SET and enter the desired path using the keyboard screen (11 36). If the folder does not
exist on the destination FTP server, it will be created automatically.
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Function Settings: IP Streaming

This section continues the connection settings wizard ([J1 171). In the function settings you will configure the
streaming video bit rate and resolution, the protocol used and the receiver’s settings.

1 Select [Create New Func. Setting].

¢ Once you have added multiple function settings, you can select [Select Existing Setting] to reuse IP
streaming settings that you saved previously.

2 Select the desired protocol.
3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].

¢ Enter the receiver’s IP address using the keyboard screen ([11 36). Enter the port number using the data
entry screen ([ 60).

e Using the default port number is recommended.

¢ Depending on the streaming protocol selected in step 2, perform step 4 if necessary and then continue to
step 5.

[RTP+FEC] streaming

4 Configure the settings used to send FEC packets. Select [FEC Port No.] and [FEC Interval] > [OK].
¢ Enter the port number using the data entry screen ([1] 60).
e Using the default settings is recommended.

[RTSP+RTP] streaming

4 Enter the user name and password of the RTSP client. Select [RTSP: User Name] and [RTSP: Password] >
[OK].

¢ Enter the desired user name and password using the keyboard screen (11 36).

All streaming protocols

5 Select the video streaming configuration.
6 Select the audio channels.
* The function settings are processed and saved.

7 Depending on the resolution and frame rate, a screen may prompt you to change other settings. Change the
settings as necessary.

8 Select [OK].
e The function settings are saved to a [MODE] file.
9 Select the connection setting (SET1 to SET20) where to save the settings.
10 When the confirmation message appears, press SET.
e The camera will connect to the network and will be ready to start streaming.

11 Connect the decoder to the network and complete any necessary configurations on the receiving side so the
decoder is ready to receive video over IP.

e For details refer to the instruction manual of the decoder device or software you will use.
¢ To start streaming, refer to /P Streaming (11 185).

Options for [Protocol]

[UDPI: This protocol prioritizes transfer speeds but does not guarantee the reliability/integrity of the
data. Lost or delayed IP packets are ignored.

[RTP]: Standard protocol for video/audio broadcasts over the Internet. Lost or delayed IP packets are
ignored.

[RTP+FEC]: This setting uses the RTP protocol and adds a layer of FEC error correction so the receiving
side* can recover lost or delayed IP packets. This combination is more common for broadcasts
over Wi-Fi networks.
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[RTSP+RTP]:  This setting uses the RTSP (real time streaming) protocol to control the streaming server
(camera) in real time and the RTP protocol for the broadcast over IP. With the RTSP protocol,
the receiver can control when to start and stop the broadcast.

* A decoder compatible with FEC error correction is required.

Function Settings: Browser Remote

This section continues the connection settings wizard ([J1] 171). A user name and password are required to log
in to the Browser Remote application. In the function settings you will configure up to three different users for
single-user or two-user operation.

1 Select [Create New Func. Setting].

e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse Browser
Remote settings that you saved previously.

2 Select the number of users.
3 Enter the user names and passwords as necessary.
e For a single user, select [Full: User Name] and [Full: Password] > [OK].
For two users, select [Camera: User Name], [Camera: Password], [Meta: User Name] and [Meta: Password]
> [OK.
e Enter the desired user name and password using the keyboard screen (1] 36).
4 Select [OK]
e The function settings are saved to a [MODE] file.
5 Select the connection setting (SET1 to SET20) where to save the settings.
6 When the confirmation message appears, press SET.

e The camera will connect to the network and will be ready to accept commands from the Browser Remote
application ([ 187).

Options for [User Setting]
[One User (Full)]:
A single user who can access all Browser Remote screens.

[Two Users (Camera/Meta)]:
You will set up two user names and passwords, one who can access the main Browser Remote
screen to control the camera ([Camera]) and one who can access the metadata screen to
update the user memo and GPS information ([Meta]).

(i) NoTES

e The user names for the [Camera] and [Meta] users cannot be the same.

Function Settings: XC Protocol
Set a user name and password to connect to an XC Protocol compatible device connected to a network.
1 Select [Create New Func. Setting].
2 Set the authentication method used by the XC Protocol (HTTP) server.
e After selecting [Basic Authentication] or [Digest Authentication], set the user name and password.
User name: 5 to 15 alphanumeric characters or symbols.
Password: 8 to 32 alphanumeric characters or symbols (use at least 2 types from each).
® Enter the desired user name and password using the keyboard screen (11 36).
3 Select [OK].
e The function settings are saved to a [MODE] file.
4 Select the connection setting (SET1 to SET20) where to save the settings.
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5 When the confirmation message appears, press SET.

e The camera will connect to the network and will be ready to accept commands from the remote controller or
application ([T] 194).

Other Connection Methods
Ethernet Settings
1 In the [Network Type] screen, select [Ethernet =i5].

2 Make sure the Ethernet cable is correctly connected ([11 169) and select [Setup with Network Connection].

e Select [Setup without Network Connection] to only configure the settings, without connecting to the
network.

3 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] > [Disable].
¢ To configure IPv4 settings manually, continue with that procedure instead (1] 179).

¢ To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6
settings as necessary (11 181).

4 When the confirmation message appears, press SET to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (11 172), IP streaming ([ 173), Browser Remote ([11] 174), XC Protocol ([11 174)

Camera Access Point
1 In the [Select a network] screen, select [Camera Access Point Mode].

2 Select the configuration method.
¢ Depending on the selected method, perform either step 3 or steps 4-9 and then continue to step 10.

Easy Connection

3 The camera will assign the network name (SSID) and password automatically. Review the settings for the
camera’s Wi-Fi access point and select [OK].

* These settings are necessary to connect a network device to the camera.

[Manual Connection]

4 Enter the SSID (network name) for the Camera Access Point and then select [OK].
¢ Press SET and enter the desired network name using the keyboard screen ([] 36).
5 Select the Wi-Fi channel.

e Select [Automatic Setting] to have the camera select the channel automatically, or select [Manual Setting] >
Desired channel.

6 Select the encryption settings.

e Select [AES] to use AES encryption, or [Disable] to use no encryption.

e |f you selected [Disable], skip to step 8.
7 Enter the password for the Camera Access Point and then select [OK].

¢ Press SET and enter the desired password using the keyboard screen ([1] 36).
8 To configure the IP settings automatically, select [Automatic Setting].

¢ To configure IP settings manually, continue with that procedure instead (1] 179).
9 Review the settings for the camera’s Wi-Fi access point and select [OK].

* These settings are necessary to connect a network device to the camera.

e The password set by the user will not be shown on the screen.
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Both configuration methods
10 When the confirmation message appears, select [OK] to continue to configure the function settings.
e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer ([J] 172), Browser Remote ([] 174), XC Protocol ([J1 174)
11 Before you can save the connection setting, connect the network device to the camera.

e Activate the device’s Wi-Fi function, select the camera’s SSID (network name) from the list and enter the
password to connect to the camera.
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WPS using a PIN Code
1 In the [Select a network] screen, select [Connect with WPS] > [WPS (PIN Code)].
e The camera will generate and display an 8-digit PIN code.
2 Enter the PIN code into the wireless router’s WPS (PIN code) setup screen and then, on the camera, select
[OK].
e For most wireless routers, you must use a Web browser to access the setup screen. For details about how
to access your wireless router’s settings, refer to its instruction manual.

3 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] > [Disable].
¢ To configure IPv4 settings manually, continue with that procedure instead (1] 179).
¢ To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6
settings as necessary (11 181).
4 When the confirmation message appears, press SET to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer ([J1 172), IP streaming ([11 173), Browser Remote ([ 174), XC Protocol ([J] 174)

Detected Access Points

The camera will automatically detect access points in the vicinity. After you select the desired access point, you
only need to enter the selected network’s password to connect the camera. For details about the access point’s
network name (SSID) and password refer to the wireless router’s instruction manual or consult the network
administrator in charge of the access point.

A list of active networks detected in the vicinity
will appear after the menu settings

it Mode

Network name Encrypted access point
(SSID, only ASCII characters)

1 In the [Select a network] screen, scroll through the list of detected networks and select the desired network.
e |f the access point is encrypted, press SET and enter the password of the access point using the keyboard
screen ([ 36).
2 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] > [Disable].
¢ To configure IPv4 settings manually, continue with that procedure instead ((11 179).

¢ To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6
settings as necessary ([11 181).
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3 When the confirmation message appears, press SET to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (11 172), IP streaming ([ 173), Browser Remote ([J1] 174), XC Protocol ([I] 174)

SSID/Authentication Mode Input
1 In the [Select a network] screen, select [Enter SSID/Authentication Methodl].
2 Enter the SSID (network name) of the desired network and then select [OK].
¢ Press SET and enter the desired network name using the keyboard screen ([] 36).
3 Select the network’s authentication method.

e |f you select [Open System], select [Disable] (no encryption) and skip to step 6, or select [WEP] and continue
the procedure.

4 Only if you selected [Shared Key] or [Open System] > [WEP] in the previous step, select the key index.

5 Enter the password of the desired network and then select [OK].
¢ Press SET and enter the desired password using the keyboard screen ([1] 36).

6 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] > [Disable].
¢ To configure IPv4 settings manually, continue with that procedure instead (1] 179).

¢ To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6
settings as necessary (11 181).

7 When the confirmation message appears, press SET to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (11 172), IP streaming ([Z1 173), Browser Remote ([11 174), XC Protocol ([11 174)

Offline Configuration without Connecting to a Network
1 In the [Select a network] screen, select [Configure Offling].

2 Select the network type.

e |f you select [Infrastructure], continue with the procedure to enter the SSID and authentication mode, from
step 2 (1] 177).
If you select [Camera Access Point Mode], continue from that procedure, from step 2 (11 175).

Checking and Changing Connection Settings

You can check and, if necessary, change the settings of connection settings registered in the camera. In addition
to deleting and renaming connection settings, you can also add to a connection setting a secondary network or
second function.

Checking the Content of a Connection Setting

Select MENU > [V Network Settings] > [Connection Setting] > Desired connection setting ((SET1] to [SET20])
> [Check Settings].

¢ The detailed content of the connection setting is displayed.

e Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to
return to the menu.
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Changing Settings using the Wizard
1 Select MENU > [V Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to
[SET20]) > [Change with Wizard].

2 Select the desired network function and then follow the wizard as described in the previous procedure (from
step 3, [11 171) and make any changes as necessary.

Changing Connection Settings using Existing Settings

You can use previously registered communication settings ([NW] files) or function settings ((MODE] files) to easily
replace the content of a connection setting or to add a second network or network function in addition to those
registered using the wizard.

1 Select MENU > [ Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to
[SET20]) > [Select Existing Setting].

To add/replace a communication or function setting
2 Select the setting you want to change > [Select Existing Setting] > Desired NW or MODE file.

¢ |n the list of communication settings and function settings registered in the camera, only those that can be
selected will be displayed in white and others will be grayed out.

3 Select [Set].

e |f necessary, select [Check Comm. Settings] or [Check Function Settings] to check the content of the
selected file before making the change.

To delete a communication or function setting
2 Select the setting you want to change > [Clear Selected] > [OK].

(i) NOTES

¢ A connection setting can have two communication settings (primary/secondary network) and up to two
function settings (only for [IP Streaming] and [Browser Remote]).

e |f both function settings are deleted, the connection setting itself will be reset and will appear as [Unspecified].

Renaming Connection Settings
You can rename connection setting files to make them easier to identify from the list.

Select MENU > [#W Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20])
> [Settings Name].

¢ Enter the desired name (up to 12 characters) using the keyboard screen ([11 36).

Deleting Connection Settings

Select MENU > [#W Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20])
> [Delete Settings] > [OK].
e The connection setting will be deleted.

(i) NoTES

e Even if you delete a connection setting, the individual communication/function settings stored in it are not
deleted. You can reuse these settings to configure other connection settings.
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Configuring the Camera’s IP Address Manually

You can configure the camera’s IP address manually. If necessary, consult the network administrator to obtain
the relevant information. The settings displayed will change depending on the network function selected.

1 In the [IP Address Settings (IPv4)] screen, select [Manual Setting].

2 Select [IP Address] and [Subnet Mask] and enter the desired addresses using the data entry screen
(1 60).
e To use a default gateway, select [Use Gateway] > [Enable] and then select [Gateway] and enter the address.
e To use a DNS address, select [Use DNS Address] > [Manual Setting] and enter the address.

3 Select [OK].

4 Select whether to use IPv6 settings or not.
e If you select [Enable], change the IPv6 settings as necessary after completing the wizard ([1] 181).

5 When the confirmation message appears, press SET to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (11 172), IP streaming ([ 173), Browser Remote ([ 174), XC Protocol ([I1 174)

Checking and Changing Communication Settings/Function Settings

You can check the content of communication settings ([NW] files) and function settings ((MODE] files) saved in
the camera and change or delete them as necessary.

Checking the Content of a Communication Setting/Function Setting
1 Select MENU > [V Network Settings] > [Advanced Settings] > [Communication Settings] or [Function
Settings].
2 Select the desired communication setting ((NW1] to [NW25]) or function setting ((MODE1] to [MODEZ25]).
3 Select [Check Settings].
e The detailed content of the selected setting is displayed.

e Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to
return to the menu.

Changing Communication Settings/Function Settings

With the first procedure you can only change IP streaming and FTP transfer settings.

1 Select MENU > [ Network Settings] > [Advanced Settings] > [Communication Settings] or [Function
Settings].

2 Select the desired communication setting ((NW1] to [NW25]) or function setting ((MODE1] to [MODEZ25]).

3 Select [Change Settings] and change the various settings as necessary.
e |fin step 2 you selected an [Unspecified] settings file, the only option available is [Create New with Wizard]

(@171).

To change Browser Remote settings

e Browser Remote settings are common to all function settings that use this function so they must be changed
globally.

1 Select MENU > [V Network Settings] > [Advanced Settings] > [Browser Remote Settings].
2 Change the various settings as necessary.
e User settings and the HTTP port number are the same as those set using the wizard ([1] 174).
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e You can select [Port No. (HTTP)] or [Port No. (HTTPS)] to change the port numbers used for each
connection. Using the default port numbers (HTTP: 80, HTTPS: 443) is recommended.

e To use an HTTPS connection, select [HTTPS] > [Enable].
To use a secure HTTPS connection, use a Camera Access Point connection setting and connect the
180 network device to the camera using a normal HTTP connection ([1] 187) and download the necessary
- certificate from the Browser Remote’s settings tab ([1] 192). After you import the certificate you
downloaded to your Web browser, you will be able to use a secure HTTPS connection.

To change XC Protocol settings

1 Select MENU > [V Network Settings] > [Advanced Settings] > [XC Protocol Settings].
2 Change the various settings as necessary.

Individual settings available for manual change (communication settings)

Menu item Setting options and additional information
[Wi-Fi]
[TCP/IPv4]
[IP Address Settings]* [Automatic Setting], [Manual Setting]
[DNS Server] [Disable], [Auto Assign], [Manual Setting]

[DNS Address]*, [IP Address]*,
[Subnet Mask]*, [Gateway]*

[TCP/IPv6)
[TCP/IPv6 Settings]* [Disable], [Enable]
[Manual Setting] [Disable], [Enable]
[DNS Server] [Disable], [Auto Assign], [Manual Setting]
[DNS Address],
[Manual Address], Enter the desired address using the data entry screen (1] 60).
[Prefix Length], [Gateway]

Individual settings available for manual change (function settings)

Menu item Setting options and additional information
[FTP Transfer]

[Destination Server]

[Server]*, [Port No.]*

[User Name/Password]

[User Name]*,
[Password]*

[SSH Setup]

[User Name]*,
[Password]*

[Destination Folder]*
[Dest. Folder Structure] [Default], [Camera]

[Overwrite Files] [Skip], [Save As (New Name)], [Overwrite]

Determines how to deal with files to be transferred when files with the same name already exists in the
destination folder.

[Skip]: The file will not be transferred.

[Save As (New Name)]: The file will be transferred and “_1” will be added to the end of the file name.
[Overwrite]: The file will be transferred, overwriting any file with the same name on the FTP server.
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Menu item Setting options and additional information

[Passive Mode]* [Disable], [Enable]

[New Folder by Date] [Enable], [Disable]
[Enable]: A new subfolder under the transfer destination folder “YYYYMMDD\HHMMSS” will be created for every 181
transfer operation. -
[Disable]: All the files will be transferred to the folder specified for the [Destination Folder] setting.

[IP Streaming]
[Protocol]* [UDP], [RTP], [RTP+FEC], [RTSP+RTP]

[Destination Server]*,
[Dest. Port No.J*,
[FEC Port No.J*

[FEC Interval] 10 to 100 (intervals of 5)

[RTSP: User Name]*,
[RTSP: Password]*

[Video Output Conf.]* [9Mbps/1920x1080 59.94P], [4Mbps/1920x1080 59.94P], [9Mbps/1920x1080 50.00P],
[4Mbps/1920x1080 50.00P], [9Mbps/1920x1080 59.94i], [4Mbps/1920x1080 59.94i],
[9Mbps/1920x1080 50.00i], [4Mbps/1920x1080 50.00i],

[Audio Out Channels]* [CH1/CH2], [CH3/CH4]

* Change these settings as explained in the wizard (] 171).

Deleting Communication Settings/Function Settings
1 Select MENU > [ Network Settings] > [Advanced Settings] > [Communication Settings] or [Function
Settings].
2 Select the desired communication setting ((NW1] to [NW25]) or function setting ((MODE1] to [MODEZ25]).
3 Select [Delete Settings] > [OK].
¢ The communication setting/function setting will be deleted.

Configuring IPv6 Settings

1 Select MENU > [#\* Network Settings] > [Advanced Settings] > [Communication Settings] >
Desired communication setting ((NW1] to [NW25]) > [Change Settings] > [TCP/IPv6].
e Select the communication setting of a network in which you want to use IPv6 settings.

2 Select [TCP/IPv6 Settings] > [Enable].

3 Select [Manual Setting] > [Enable].

e [DNS Server] changes to [Manual Setting] and you will be able to set the DNS server’s address, prefix length
and gateway address.

e [f you are not using a DNS server, select [DNS Server] > [Disable].
4 Select [DNS Address], [Manual Address] (manually entered IPv6 address), [Prefix Length] (bits

available for the network address) and [Gateway] (gateway’s IP address) and enter the necessary
information.

¢ Enter the IP addresses and prefix length using the data entry screen (11 60).

Reading a Root Certificate for FTPS Transfer

When you select the [FTPS] transfer mode, you will need to read onto the camera the same root certificate saved
on the FTP server.
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(i) NoTES

¢ Only root certificates with the following file names can be read by the camera: “ROOT.CER”, “ROOT.CRT” and
“ROOT.PEM”.

¢ Only one root certificate can be read onto the camera at a time. Save the root certificate file on the card in
advance.

e |f you transfer files using FTPS transfer with a self-signed certificate, you may not be able to trust the
destination server.

1 Set the camera to MEDIA mode.

2 Select MENU > [#V Network Settings] > [Advanced Settings] > [FTP Transfer Settings] > [Read
Root Certificate] > [OK].
e The root certificate saved on the card is read by the camera.

e After reading a root certificate file, select [Delete Root Certificate] to delete the root certificate in the camera.
Select [Root Certificate Details] to check the certificate’s issuer and expiration date.

802.1X Authentication

The camera is compatible with the following protocols.
EAP-TLS: X.509 supported
EAP-TTLS, PEAP: MS-CHAP v.2 supported

Select MENU > [ Network Settings] > [Advanced Settings] > [802.1X Authentication] > [Setup

Wizard].

¢ Follow the wizard to complete the authentication settings.
When you select the [EAP-TLS] protocol, the root certificate, client certificate and private key will be read from
the card.
When you select the [EAP-TTLS] or [PEAP] protocol, select [User Name] and [Password] and enter the
information using the keyboard screen ([11 36). Then, read the root certificate from the card.

¢ After reading the authentication files, select [Check Settings] to check their content. Select [Delete Settings] to
delete the authentication files in the camera.

Giving a Nickname to the Camera

You can give the camera a nickname that is used on network connections and network devices to make it easier
to identify.

Select MENU > [\ Network Settings] > [Nickname].
¢ Enter the desired nickname using the keyboard screen ([ 36).
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Checking the Network’s Status

Unless you selected to configure a connection setting offline (without connecting to the network), immediately
after configuring a new connection setting, the camera will connect to the network automatically and the
selected function settings will be activated. The icons displayed on the screen will indicate the type of network
selected and the connection status. When you disable the network functions or disconnect from the network,
the icons will disappear.

To connect to a network manually

1 Select MENU > [V Network Settings] > [Network] > [Enable].

2 Select MENU > [V Network Settings] > [Connect] > Desired connection setting ([SET1] to [SET20]) > [OK].
¢ To end the network connection, set [Connect] to [Disconnect] instead.

80 min

83 min [N

% Wi-Fi (Infrastructure):
In yellow — the camera is connecting to or disconnecting from the network. In white — the
network function can be used.

Wi-Fi (Camera Access Point):
In yellow — starting the camera’s access point. In white — the camera’s access point is ready.
Connect the Wi-Fi enabled device to the camera.

Ethernet:  In yellow — the camera is connecting to or disconnecting from the network. In white — the
network function can be used.
The indicator next to == (Ethernet) terminal on the optional EU-V1 or EU-V2 Expansion Unit will
flash or illuminate as follows™*:
Browser Remote, FTP transfer and XC Protocol: Flashing in green — processing the connection;
illuminated in green — function active (transferring data).
IP streaming: Flashing in green — processing the connection or function active.
All functions: Flashing in red — network error.

FTPE FTP file transfer ([11] 184)
. IP: IP streaming ([ 185)
Remote B Browser Remote ([ 187)

* You can also set MENU > [§ System Setup] > [=%5 (Ethernet) LED] to [Off] to disable the indicator.
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FTP File Transfer

FTP File Transfer

In MEDIA mode, you can transfer XF-AVC clips from the camera to another device connected to the network,
using the FTP protocal.
The following explanations assume that the FTP server is on, ready and correctly configured.

Transferring a Single Clip

1 Connect the camera to the desired network and activate the network functions ([11 183).
e Select a connection setting with the [FTP Transfer] function setting.

2 Select the desired clip in the [XF-AVC] or [XF-AVC Proxy] index screen ([11 143).

3 Press SET to open the clip menu and select [FTP Transfer] > [OK].
e The camera will connect to the FTP server and the file will be transferred.

Transferring All Clips

1 Connect the camera to the desired network and activate the network functions ([11 183).
e Select a connection setting with the [FTP Transfer] function setting.

2 Open the index screen with the clips you want to transfer (11 143).

3 Select MENU > [#V Network Settings] > [FTP Transfer All Clips] > [OK].
® The camera will connect to the FTP server and all the files will be transferred.

@ vPoRTANT

e Observe the following precautions when transferring files. Failing to do so may interrupt the transfer and
incomplete files may remain at the transfer destination.
- Do not open the card compartment cover.
- Do not remove the power source or turn off the camera.

e |f incomplete files remain at the transfer destination, check the content and make sure they are safe to delete
before deleting them.

(i) NoTES

¢ Depending on the access point’s settings and capabilities, it may take some time to transfer files.
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IP Streaming

In CAMERA mode, only when the main recording format is set to XF-AVC, you can stream the camera’s live

video and audio* over IP to a compatible IP video decoder*™ connected to the network. You can use IP

streaming for live broadcasts or to send video reports from a location with poor network connectivity. 185

* Only 2 channels. You can select which two channels to stream over IP. —

** This can be a dedicated video transfer device or decoder software on a computer. For details about compatible decoders,
please visit your local Canon website.

Configuration of video streamed over IP

Video
. . Audio
Bit rate Resolution Frame rate
59.94P, 50.00P, MPEG-2 AAC,
9 Mbps or 4 Mbps 1920x1080 59.94i, 50.00i 2 channels, 256 Kbps

1 Connect the decoder to the network and complete any necessary configurations on the receiving
side so the decoder is ready to receive video over IP.

¢ For details refer to the instruction manual of the decoder device or software you will use.

2 Connect the camera to the desired network and activate the network functions ([11 183).
e Select a connection setting with the [IP Streaming] function setting.

3 Select MENU > [V Network Settings] > [Activate IP Streaming] > [Enable].
® The camera will start streaming video over the selected network.
e You can press the REC button to simultaneously record the same image in the camera as XF-AVC clips.
¢ \When the streaming protocol is [RTSP+RSP] only: On the receiver’s side, access the following URL and log
in using the RTSP user name and password that were set on the camera ([J1 173) to control the streaming
sessions.
rtsp://<camera’s IP address>/stream

4 To end the streaming of video, select MENU > [\ Network Settings] > [Activate IP Streaming] >
[Disable].

@ vPorTANT
e Streamed data is not encrypted.

(i) NoTES

¢ The available frame rates for the streamed video depend on the frame rate of the main recording (XF-AVC), as
follows.
- When the main recording’s frame rate is 59.94P: 59.94P or 59.94i
- When the main recording’s frame rate is 59.94i:  59.94i only
- When the main recording’s frame rate is 50.00P: 50.00P or 50.00i
- When the main recording’s frame rate is 50.00i:  50.00i only

e Except when the streaming protocol is [RTSP+RTP], once IP streaming is activated, the camera will continue
to broadcast video and audio data over the network, regardless of the status of the receiver. The streamed
data is not encoded. Be careful to set up the correct IP address and test in advance that the receiving decoder
can indeed receive the signals.

¢ Depending on the network used and the connection conditions, you may experience lost or delayed IP
packets.

e After streaming video continuously for 24 hours, the camera will stop the IP streaming momentarily and then
restart it automatically.



IP Streaming

¢ \When using IP streaming together with the Browser Remote function, you may experience stuttering issues in
the streamed video or audio. When the two functions are used simultaneously, it is not recommended to log
out from and then reconnect to Browser Remote.

e Opening the card compartment cover and removing a card while IP streaming is activated may cause brief

186 stops in the streamed video and audio.

¢ |P streaming cannot be used in the following cases:
- When the main clip is in RAW format.
- When slow & fast motion recording, pre-recording, relay recording or double slot recording is activated.
- When the system frequency is set to 24.00 Hz.
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Browser Remote: Controlling the Camera from a Network Device

In CAMERA mode, you can operate the camera remotely using Browser Remote, an application that can be
accesses on a connected network device*. Using Browser Remote you can check the camera’s live image and
control various recording settings**. You can also set and change metadata (only for XF-AVC clips) and check
other important indications, such as remaining recording time on the card, remaining battery charge/power
source details, time code, etc.

* For details about compatible devices, operating systems, Web browsers, etc., please visit your local Canon website.
** White balance, ISO speed/gain, shutter speed, ND filter, aperture, focus and zoom.

Starting Browser Remote

After connecting the camera to the network In CAMERA mode, you can start the Browser Remote application
on the Web browser* of any network device** connected to the same network.

* A Web browser that supports JavaScript and is enabled to accept cookies is required.
** For details about compatible devices, operating systems, Web browsers, etc., please visit your local Canon website.

Preparations on the Camera

1 Connect the camera to the desired network and activate the network functions ([I] 183).
e Select a connection setting with the [Browser Remote] function setting.

2 Check the Browser Remote’s URL in the [#N\* Network Settings] status screen ([11219).
¢ When using IPv6 settings, check the camera’s IP address instead (1] 218).
¢ Write down the URL or IP address if necessary.

On the Network Device
1 Connect the network device to the same access point as the camera.
2 Start the Web browser on the network device.

3 Enter Browser Remote’s URL.

e Enter the URL / IP address you checked previously into the Web browser’s
address bar.

¢ \When using IPv6 settings, enter the URL as follows.
http:// <camera’s IPv6 IP address> (default port no.)
http:// <camera’s IPv6 IP address>:<port no.> (specified port no.)
You can change “http” to “https” to use an https connection.

http://192.168.0.5

4 Enter the user name and password.
Authentication Required

e Be sure to log in with the user name and password of one of the 192.168.0.5
users that were set on the camera ([J1 174). If necessary, consult
the administrator who configured the camera’s settings.
* The Browser Remote screen will appear. The screen displayed may
be different depending on the user information used to log in. . , .
¢ While Browser Remote is correctly connected to the camera, the 5;;?5&2}2}253;”;33535 L?gng;?i”ng” Y
network connection indicator’s @ @ « « will keep turning on and off ~ version used.
in a loop.

Cancel Log In
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Camera’s nickname
and lens information

‘oom

Manual

188

Angle

Network connection
indicator a » B 80min
[ 83min

@& 113 min O ide ONE-SHOT AF

00:00:39.14

SELECT STBY ¢-AvC) Cal King PUSH AUTO IRIS

5 To change the application’s language, select [ ¢ ] > [Language &3] >

Desired language. s
e Most buttons and controls emulate physical controls on the camera v Englsh | Deusch  Francas laliano
and are labeled in English only, regardless of the language selected. Eeparol Pyt MfEX @30l
6 Use the Browser Remote controls to operate the camera. CE2 Vipaiwa

e Descriptions of the controls are given in the following pages.

7 When you have finished using Browser Remote, select [ ¢ ] > [Log Out] on the Browser Remote screen to end
the application.

(i) notes

* Depending on the network used and the connection performance, you may notice delays in the refreshing of
the live view image and other settings. If the delay is too long, changing the resolution of the live view image is
recommended ([] 192).

¢ |f Browser Remote is set to a language other than the language set on the network device, the application may
not be displayed correctly.
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Using Browser Remote

The Browser Remote application has two screens: ["™] the main screen for controlling the camera remotely in
recording mode and [¥] the metadata screen. The screen displayed will be different depending on the user
information used to log in. 189

(i) NoTES

e Browser Remote does not support multi-touch gestures.

The Main Remote Operation Screen ["™] ([Full]/[Camera] user only)

4 5 6 7 8 9 10™11 12 13

C500MKkII
CN-E18-80mm T4.4 L IS KAS S

Zoom

30 31 32 33 34  35"36*37* 38 39 40™

*Onscreen display/indication only. The content or value cannot be changed using Browser Remote.
** Only available with compatible lenses ([ 247).

1 [Zoom] button**
Touch to use the manual controls to zoom.

2 Manual controls for focus/zoom

When [Focus] is active, touch [~ ], [2A] or [ 2] to focus closer or [ v ], [ ¥ ] or [ ¥ ] to focus farther. There are
three levels of adjustment - [ ~ /[ v ] is the smallest and [ 2 ]/[ ¥ ] the largest. Keep touching the button (long
press) for a continuous operation.

When [Zoom] is active, drag the slider up to zoom in (T) and down to zoom out (W).
¢ Make the necessary adjustments on the lens to allow focus (11 85) or zoom ([ 95) operation.
¢ \When using a slow zoom speed, it may take some time until the lens starts moving.
3 [Focus] button**
Touch to use the manual controls to focus.

4 Camera’s nickname (11 182)
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Lens information

Live view screen
Shows the camera’s live view image.

~

Browser Remote screen selection ([Full] user only)
Touch ["™] to open the main remote recording screen, or [R] to open the metadata screen (11 192).

8 [AWB Lock] button / x4 (register white balance) button

When the white balance mode is set to [}, touch to lock the current white balance settings. Touch again to

resume the automatic white balance (AWB).
When the white balance mode is set to A or 4B, touch to register a custom white balance.

9 White balance mode

10 Aperture mode button**
Touch to select the aperture mode (automatic/manual).

11 Detailed camera settings ([11 191)

12 Key lock button

Touch the icon to lock the Browser Remote screens in order to prevent settings from being changed
inadvertently. Controls on the camera are not locked.

13 Browser Remote settings (11 192)

14 ND filter

15 Aperture

16 Shutter speed

17 1SO speed/gain value

18 AE shift

19 Color temperature and color compensation (CC) value
20 Face AF function

21 AF speed

22 [LIVE VIEW] button
Touch the button to display the camera’s live view image on the Browser Remote screen.

23 [m Touch Focus] button
Touch the button to unlock (enable) the touch focus mode.

24 Add a shot mark
25 |P streaming

Available only when using a connection setting with both the [Browser Remote] and [IP Streaming] function

settings.

26 Card selection and approximate remaining recording time
The currently selected CFexpress card is indicated with a » mark next to the icon.

Remaining recording times are approximate and calculated based on the current video configuration used.

27 Status indicators

‘- Qe (! Network connection indicator. While Browser Remote is correctly connected to the camera, the
dots will keep turning on and off in a loop.

ny: Appears during double slot recording (11 47).

qvam], etc. : Remaining battery charge / Power supply level (11 55)

28 [Focus Guide] button
Touch to display the focus guide ([11 86).
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29 [ONE-SHOT AF] button / [AF Lock] button

When the focus mode (1] 191) is set to [One-Shot], touch to focus automatically once.
When the focus mode is set to [Continuous] or [AF-Boosted MF], touch to lock the current focus. Touch
again to resume the previous focus mode.

30 Add an [ mark
31 Add a [ mark

32 [REC] button
Touch the button to start recording. While recording, the center of the button turns red.
Touch the button again to stop recording.

33 [SLOT SELECT] button
Touch to select the other CFexpress card when both card slots contain a card.

34 Recording operation ([] 55) and recording command ([J] 200) (same as on the camera)
35 Main recording format ([]] 62)

36 Time code (same as on the camera)

37 [Tracking] button ([J] 93)

38 Cancel the tracking function

39 [PUSH AUTO IRIS] button
Touch to have the camera adjust the aperture automatically once.

40 [Face Detection] button** (1] 92)

[Z] Detailed Camera Settings Tab
1 ND extended range
2 Aperture increment

3 Fine aperture adjustment

Fine adjustment lets you use the smallest aperture increment allowed by
the lens. (The aperture value displayed will be the closest value in the
selected increment scale.)

Shutter speed increment 1/3

ISO speed/gain increment off

One Shot

ISO speed/gain extended range

Selectable

AF mode selection

. ** Only available with
AF frame position button compatiole lenses (LT 247).

Touch the button to select the position of the AF frame. Select [Center
Frame] for a fixed AF frame at the center of the live view screen, or
[Selectable] to be able to touch the live view screen to select where to
focus.

0 N o 0o s
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¢ Browser Remote Settings Tab

1 Language selection
Changes the language used for controls in the [ ] (metadata input) screen

192 and for error messages. Still, most of the application’s controls emulate Setings
- physical buttons on the camera and appear in English only, regardless of Language (59
the language selected. Display Theme
2 Display style Secire Transter
Touch to select the background color of the Browser Remote screens. B e

Log Out

3 Secured connection

Touch to download the certificate required to use a secure HTTPS
connection.

4 Live view resolution
Select [Large] (higher resolution) or [Small] (lower resolution) depending on the quality of the connection.

5 Log out
Touch to log out from the Browser Remote application.

The Metadata Screen [®] ([Full]/[Meta] user only)

Using Browser Remote you can create, edit and transfer to the camera a metadata profile that can be
embedded with the recorded clips. This metadata profile includes the user memo information (clip title, creator,
location and description), as well as GPS information. For details, refer to Using Metadata (11 117).

To open the metadata screen, touch the [®] icon at the top of the Browser Remote screen.
¢ This step is not necessary when logging in with the user name and password of the [Meta] user.

CN-EWl-80mm T4.4 LISHAS S

Clip Title Creator

Location Description

GPS Info

Altitude Latitude

- - -.

Longitude

East

User memo information
2 GPS information
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[® Activate] button

Touch the button to give priority to the metadata entered in this screen when recording clips. This overrides
the metadata read from a file saved on the SD card.

[Overwrite Previous] button

After recording a clip: Touch [Overwrite Previous] to send the metadata entered in this screen to the camera,
replacing any metadata embedded in the last clip recorded.

[Apply from Next] button

Touch the button to send the metadata entered in this screen to the camera so it is embedded only with clips
that are recorded after the transfer. This option does not overwrite the metadata of clips already recorded or
being recorded.

[Overwrite] button

While recording: Touch [Overwrite] to send the metadata entered in this screen to the camera, replacing any
metadata that the clip being recorded might have.

[Clear All] button

Touch to delete all the data entered.

(i) NoTES

e The metadata sent to the camera from Browser Remote will be lost in the following cases.

- The camera is turned off.

- The MENU > [ Recording/Media Setup] > [Metadata] > [Setting] setting was changed.

e Using Browser Remote ((@ Activate] button) you can give priority to metadata sent from the application.
However, you cannot return the priority back to the SD card. To use a user memo file saved on a card you will
need to set MENU > [} Recording/Media Setup] > [Metadata] > [Setting] to [SD Card] on the camera itself.
e |f you use Browser Remote to transfer user memo information to a relay clip after the switch, the user memo
will not be saved to the clip recorded before the camera switched cards.
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Recording remotely using an XC Protocol compatible controller/application

Recording remotely using an XC Protocol compatible controller/
application

Set the IP address of the camera on the optional XC Protocol compatible Remote Camera Controller RC-IP100/
RC-IP1000 or Remote Camera Control Applioa’rion1 to control the camera remotely. You can also control the
camera remotely using Multi-Camera Control? on a smartphone connected to the same network as the camera.

1 Available from your local Canon website.
2 Available from the App Store.

1 In CAMERA mode, activate the network functions ([J] 183)
e Select a connection setting with the [XC Protocol] function setting.

Recording remotely using the RC-IP100/RC-IP1000 Remote Camera Controller

You can remotely control camera settings like the aperture and shutter speed, or change picture related settings
like the knee and sharpness. For more details on the connection, settings and the RC-IP100/RC-IP1000 refer to
the RC-IP100/RC-IP1000 instruction manual.

(i) notes

¢ \When connected to the camera, the following functions of the RC-IP100 cannot be used.

- F1/F2 knob: PT Speed, AGC Limit, R Gain, B Gain, Noise Reduction.

- USER1/USER2 button: Shooting Mode, ISO/Gain, Preset Color Settings, Noise Reduction, Knee-
Automatic.

- Control lever: pan/tilt operations.

- TRACE tab.

- FUNC tab: Digital Zoom, D.Tele-Converter, Soft Zoom Control, PT Acceleration, Image Stabilizer, Face
Detection AE, Eye Detection, Focus limit, Auto Slow Shutter, Gain Boost, Flicker Reduction, ND Filter Mode,
Infrared, Wiper, Washer, AUX1 to 4, Enhanced ND Filter.

The following RC-IP1000 buttons/lever/dials cannot be used when connected to the camera.

- Camera settings area: ABB button, AGC button, FULL AUTO button.

- Pan/tilt operation area: PAN/TILT lever, pan/tilt SPEED dial.

You cannot use functions that are not supported by the camera. If you assign an unsupported function to the

menu operation area, USER buttons area, F1/F2/F3/F4/F5 dials, or USER 1 to USER 10 buttons in the

SYSTEM menu, it will be displayed in gray on the RC-IP1000’s LCD panel.

The zoom can only be operated when a compatible EF Cinema/broadcast lens ([ 247) is attached to the

camera.

¢ [PRESET] camera settings can only be used when a compatible EF Cinema lens is attached to the camera

(CN-E70-200mm T4.4 L IS KAS S or CN-E18-80mm T4.4 L IS KAS S).

Even if the camera’s controls are locked (key lock), you can use the RC-IP100/RC-IP1000 to operate the

camera ([11 12).

(i) NoTES

e About changing custom picture related settings

- If a protected custom picture file is selected on the camera, custom picture related settings cannot be
changed using the remote camera controller or Remote Camera Control Application.

- Adjusting custom picture related settings using the remote camera controller or Remote Camera Control
Application will change the settings registered under the currently selected custom picture file. If you want to
keep an important custom picture file, backup it or select in advance a custom picture file you do not mind
changing.
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Recording remotely using the Remote Camera Control Application

During recording, you can check the angle of view using Live View and adjust various picture related settings.
For details about connection/setup and the Remote Camera Control Application, refer to the Remote Camera
Control Application manual.

(i) NoTES

¢ The following functions are not available when operating the camera from the Remote Camera Control
Application.
- Menu
[Camera Power]
[Operational Settings]:
[Keyboard Shortcuts] > [Pan Left]. [Pan Right], [Tilt Up], [Tilt Down], [Pan/Tilt Left and Up],
[Pan/Tilt Right and Up], [Pan/Tilt Left and Down], [Pan/Tilt Right and Down],
[Pan/Tilt Speed +], [Pan/Tilt Speed -], [Prepare Trace], [Execute Trace],
[PTZ Direction Settings]

[Preset/Trace Settings]:
[Preset] > [Preset List] > [Preset Name], [Camera Settings]
[Trace]
[Camera Settings Page]
[Register] > Camera Setup

- Camera controls

[Basic] tab:
[PTZ/Focus] > [Pan/Tilt Speed], [Pan/Tilt]
[Preset] > [Speed Levell
[Exposure] > All shooting modes
[Exposure] > [ISO)/[Gain] > [Auto]
[Exposure] > [ND filter] > [Auto]
[White Balance] > [R Gain], [B Gain]
[Trace]

[Details] tab:
[Image Quality] > [Knee: Automatic]
[Exposure] > [Infrared] and [Enhanced ND Filter]
[Other Functions] > [Wiper]

e Even when camera operation is disabled by key lock, operation is possible using the Remote Camera Control
Application (11 12).
¢ When adjusting custom picture related settings, refer to About changing custom picture related settings

(01 194).
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Recording remotely using Multi-Camera Control

You can use a smartphone connected to the same network as the camera to remotely operate the camera and
record video. During recording, you can check the angle of view using Live View and adjust various picture
related settings.
1 Install Multi-Camera Control on your smartphone.

e Download and install Multi-Camera Control from the App Store.

e There is no need to repeat this step after the first time.
2 Connect the smartphone to the same network (access point) as the camera.

e [or details, refer to the smartphone’s instruction manual.
3 Activate the desired network connection ([1] 183).

e Select a connection setting with the [XC Protocol] function setting.

4 Open Multi-Camera Control on the smartphone.

5 Operate the smartphone to connect to the camera.

6 Operate Multi-Camera Control on the smartphone to record remotely.

7 When you finish the procedure, set MENU > [#M Network Settings] > [Network] to [Disable].

e You can also set MENU > [#8W* Network Settings] > [Connect] to [Disconnect].

¢ \When you end the connection from the smartphone, MENU > [#W Network Settings] > [Network] will be
set to [Disable].

(i) notes

e Even when camera operation is disabled by key lock, operation is possible using Multi-Camera Control

(@12).
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Additional Information

For details about how to select an item, refer to Using the Menus ([J1 34). For details about each function, see
the reference page or the explanation accompanying the menu entry. Setting options in boldface indicate default

values.

Depending on the camera’s operating mode and the settings, some menu items may not be available. Such
menu items do not appear or appear grayed out in menu screens.

To skip directly to the page of a specific menu:

("™ Camera Setup] menu 197 (%4 Assistance Functions] menu 1204
[[@d Custom Picture] menu 11198 [swv Network Settings] menu 11206
[£¥ Recording/Media Setup] menu 1199 [@ Assignable Buttons] menu [ 207
[ Audio Setup] menu 13 201 [§ System Setup] menu [ 207
(=) Monitoring Setup] menu 11 201 [ My Menu] customized menu 210

["™ Camera Setup] menu (CAMERA mode only)

Menu item Setting options and additional information
[Iris Mode] [Automatic], [Manual] (m77)
This setting is available only when a compatible lens ([ 247) is attached to the camera.
[Iris Increment] [1/2 stop], [1/3 stop] (@77
[Fine Increment] [On], [0ff] (@7
[Zoom-Iris Correction] [On], [Off]

If you are using a compatible lens, when this setting is set to [On], the camera will adjust the aperture as
needed to keep the selected aperture value while zooming. Because of this adjustment, the brightness of
the image might flicker slightly or you may hear the operation sound.

[Extended ND Range] [On], [Off] (@m7e)
[Shutter Mode] [Speed], [Angle], [Clear Scan], [Slow], [Off] (@72
[Shutter Increment] [1/3 stop], [1/4 stop] (@73
[1S0/Gain] [1S0], [Gain] (@74
[ISO/Gain Extended Range] [On], [Off] (@M74
[1SO Increment] [1 stop], [1/3 stop] (74
[Gain Increment] [Normal], [Fine] (@74
[Light Metering] [Backlight], [Standard], [Spotlight] (T2 80)
[AE Shift] —2.0to +2.0 in 0.25 point intervals (+0) (T3 80)
[AE Response] [High], [Normal], [Low] (@79
Determines how quickly the exposure (aperture, shutter speed and gain) changes when using the
automatic adjustment mode.
[Shockless WB] [On], [Off] (RAE:))
[AWB Response] [High], [Normal], [Low] (T 83)
[C. Temp. Increment] [Mired], [Kelvin] (@ma1
[AF Mode] [One Shot], [AF-Boosted MF], [Continuous] (T 84)
[AF Frame Position] [Selectable], [Center Frame] (9
[AF Frame Size] [Large], [Small] (o)

[Apply AF Speed Limit]

[Always], [Only While Recording] (@90
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Menu item
[AF Speed]
[AF Response]
[Focus Control]

—710 +2 (0)
-3t0+3(0)
[Camera], [Lens]

Determines the signal path used to adjust the focus.
[Camera]: Use the default setting for most cases.

Setting options and additional information

[Lens]: You can adjust the focus using an accessory connected to the lens but you will not be able to use
the camera’s autofocus functions or an optional RC-V100 Remote Controller or RC-IP100/RC-IP1000

Remote Camera Controller connected to the camera to adjust the focus.

[Mount Adapter]

[MO-4E], [Off]

When an optional MO-4E B4 Mount Adapter is attached to the camera, this setting optimizes optical
settings for the adapter. After replacing the camera’s lens mount with a PL mount using the optional

PM-V1 PL Mount Kit, the options will change to [MO-4P] or [Off].

[Face Detection] [On], [Off] (92
[Face AF] [Face Priority], [Face Only] (@92
[Camera Grip Zoom] [On], [Off] (2 95)
[Camera Grip Zoom Speed] 11016 (8) (1195
[Tele-converter] [x3.0], [x2.5], [x2.0], [x1.5], [Off] (95)
[ABB] - (M 49)
[Color Bars] [On], [Off] (@m113)
[Color Bar Type] [SMPTE], [EBU]*, [ARIB] (D 113)
[Periph. lilum. Corr] [On], [Off] (139
[Chromatic Aberr. Corr] [On], [Off] (39
[Diffraction Correction] [On], [Off] (A 39)
[Digital Image Stabilization] [On], [Off] (@94
[Lens Focal Length] 1 to 1000 (50) (@94
[Anamorphic Corr.] [Lens Squeeze Factor], [x2.0], [x1.8], [x1.3], [Off] (394
* The default value depends on the country/region of purchase.
[[@@ Custom Picture] menu (CAMERA mode only)
Menu item Setting options and additional information
[Select File] [C1:BT.709 Wide DR], [C2:Canon Log 2], [C3:Canon Log 3], [C4: PQ], [C5: HLG], (11133
[C6:BT.709 Standard], [C7:EQS Standard], [C8:EQS Neutral], [C9:Canon 709], [C10:User10] to
[C20:User20]
[Edit [&d File]
[Rename] - (d1134)
[Protect] [Unprotect], [Protect] (134
[Reset] [BT.709 Wide DR], [Canon Log 2], [Canon Log 3], [PQ], [HLG], [EOS Standard], [EOS Neutral], ([ 135)
[BT.709 Standard], [Canon 709], [User (BT.709 Wide DR)]
Detailed custom picture Refer to the tables in the Available Custom Picture Settings section
settings (@m137).
[Save [€3 File]
[Save to SD Card], - (11135)

[Load from SD Card]
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[£% Recording/Media Setup] menu

Menu item
[Initialize Media]

Setting options and additional information

[CFexpress A], [CFexpress B],  [Cancel], [OK] (T2 46)
[SD Card]
[Sensor Mode] [Super 35mm], [Super 16mm (Cropped)] (62
[Full Frame], [Super 35mm (Cropped)], [Super 16mm (Cropped)]
[Main Rec Format] [RAW], [XF-AVC] (T162)
[RAW], [RAW HQ], [RAW ST], [RAW LT], [XF-AVC]
[System Frequency] [59.94 Hz], [50.00 Hz]‘, [24.00 Hz] (162
[Recording Mode] [Normal Recording], [Slow & Fast Motion], [Pre-Recording] (120
[Slow & Fast Frame Rate] 110120 (@ 120)

Available options and default value vary depending on other settings. See the tables on the reference
page.

[Sub Rec Format] [XF-AVC (SD Card)], [0ff] (1 69)
[Sub Rec Color Conversion] [Conform to Custom Picture], [BT.709 (Wide DR)], [BT.709 (CMT 709)] (2 69)
[Resolution/Color Sampling] When [Main Rec Format] is set to [XF-AVC]: (62

[4096x2160 YCC422 10 bit], [3840x2160 YCCA422 10 bit], [2048x1080 YCC422 10 bit],
[1920x1080 YCC422 10 bit], [1280x720 YCC422 10 bif]

When [Main Rec Format] is set to [RAW] / [RAW HQ] / [RAW ST] / [RAW LT]:
[4096x2160], [2048x1080]
[5952x3140], [4192x3140 (4:3)], [3768x3140 (6:5)], [4096x2160],
[2048x1080]

When [Main Rec Format] is set to [RAW], [RAW HQ], [RAW ST] or [RAW LT], the color bit depth is
determined by the frame rate used.

[Frame Rate]

[Bit Rate]

When [System Frequency] is set to [59.94 Hz]: (T 63)
[59.94i]*, [59.94P]1, [29.97P], [23.98P]

When [System Frequency] is set to [50.00 Hz]:
[50.00i]*, [50.00P]", [25.00P]

When [System Frequency] is set to [24.00 Hz]:
[24.00P]

* XF-AVC clips only. Not available when slow & fast motion recording is activated.

Available options vary depending on the [Main Rec Format] and [Resolution/Color Sampling] settings.

When [Resolution/Color Sampling] is set to [4096x2160 YCC422 10 hit] or (T 63)
[3840x2160 YCC422 10 bit]:

[810 Mbps Intra-frame], [410 Mbps Intra-frame], [260 Mbps Long GOP],

[160 Mbps Long GOP]
When [Resolution/Color Sampling] is set to [2048x1080 YCC422 10 bit] or
[1920x1080 YCC422 10 bit]:

[310 Mbps Intra-frame], [160 Mbps Intra-frame], [50 Mbps Long GOP]
Available options vary depending on the [Frame Rate] setting. Additionally, when [Main Rec Format] is set
to an option other than [XF-AVC], or when set to [XF-AVC] with [Resolution/Color Sampling] set to
[1280x720 YCC422 10 bit], the bit rate is set automatically.

[Pre-Recording Time] [3 sec], [5 sec] (@122
[Relay Recording] [On], [Off] (@47
[Double Slot Recording] [On (Same File Name)], [On (Different File Names)], [Off] (T 47)
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Menu item Setting options and additional information
[Metadata]
[Camera Index] [A] to [Z] (1 59)
[Reel Number], [Clip Number] ~ [001] to [999] (M 59)
[User Defined)] User defined string up to 5 characters ([(CANON]) (12 60)
[Stream Number/Proxy] [01_Proxy], [_01P] (12 60)
[Scene], [Take] Scene description up to 16 characters / Take description up to 8 characters (O 118)
[Lens Squeeze] [x2.0], [x1.8], [x1.3], [Off] (T 124)
[Setting] [Remote], [SD Card] (4 117,192)
[User Memo] [Off], list of user memo files available on the SD card (Mm117)

[Country Code], [Organization],
[User Code]

Identifiers up to 4 characters ([00__] default for [Organization] only)

[Country Code]: This identifier is the country code defined by ISO-3166-1 and is to be entered starting
from the left.

[Organization]: This identifier represents the organization that owns or operates the camera and can be
obtained by registering with the SMPTE Registration Authority. If the organization is not registered,
enter [0000].

[User Code]: This identifier designates the user. Leave this blank if [Organization] is set to [0000].

[Add (@3 File] [On], [Off] (1139)
[Clip Numbering] [Reset], [Continuous] (@60
[Rec Command(EXT REC)] [On], [Off]

When this setting is [On] and you connect the camera to an external recorder, if you start or stop recording
with the camera, the external recorder will also start or stop recording. To output the recording command
from the HDMI OUT terminal, you will need to set also [HDMI Time Code] to [On].

[HDMI Time Code]

(On], [Off] ((157)

[Photo Numbering]

[Reset], [Continuous]

Photos are saved as files in folders. You can select the numbering method for those files. File numbers
appear on screens in playback mode in a format such as "101-0107". The first 3 digits indicate the folder
number and the last 4 digits are different for each file in a folder.

[Reset]: File numbers will restart from 100-0001 every time you insert a new (or initialized) card. If the
card already contains previous recordings, numbers will continue from the number following that of
the last photo on the card.

[Continuous]: File numbers will continue from the number following that of the last photo recorded with
the camera. This setting is the most convenient for managing files on a computer. We recommend
using the [Continuous] setting.

Folder names

e An example folder name is “101_1103". The first 3 digits indicate the folder number (from 100 to 999)

and the last 4 digits indicate the month and day when the folder was created. In the example, the folder
numbered 101 was created on November 3.

e Each folder can contain up to 500 files. When that number is exceeded, a new folder is created

automatically.

File names

e File names follow the pattern “IMG_xxxx.jpg” (photos) where xxxx represents the photo number (0001

t0 9999).

[Volume Label]

[Canon], [Canon + Metadata] (59

" The default value depends on the country/region of purchase.
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[P Audio Setup] menu

Menu item Setting options and additional information
[Audio Input Selection] (2 109)
[CH1/CH2] [INPUT Terminals], [MIC Terminal], [Monaural Mic] 201

When an optional EU-V2 Expansion Unit 2 with a commercially available V-mount battery is
attached to the camera:
[INPUT Terminals (Camera)], [MIC Terminal], [Monaural Mic]
[CH3/CH4] [INPUT Terminals], [MIC Terminal], [Monaural Mic]
When an optional EU-V2 Expansion Unit 2 with a commercially available V-mount battery is
attached to the camera:
[INPUT Terminals (Camera)], [INPUT Terminals (Exp. Unit)], [MIC Terminal],
[Monaural Mic]

[CH2 Input] [INPUT 2], [INPUT 1] (@10
[CH1/CH2 ALC Link], [Linked], [Separated] (RARER))
[CH3/CH4 ALC Link]

[Audio Rec Level CH3], [Automatic], [Manual] (@)

[Audio Rec Level CH4],
[Audio Rec Level CH3/CH4]

[CH3 Level], [CH4 Level], 0to 100 (50) (@)
[CH3/CH4 Level]
[INPUT 1 Mic Trimming] to [+12 dB], [+6 dB], [0 dB], [-6 dB], [-12 dB] (@11
[INPUT 4 Mic Trimming]
[INPUT 1 Mic Att.] to [On], [Off] (@12
[INPUT 4 Mic Att.]
[INPUT Limiter] [On], [Off] (@)
[MIC Att] [On], [Off] (@112
[MIC Low Cut] [On], [Off] (Mm112)
[MIC Power] [On], [Off] (@2
[1 kHz Tone] [-12 dB], [-18 dB], [-20 dB], [Off] (M113)
[Headphone Volume] [0ff], 1t0 15 (8) (@147
[Speaker Volume] [Off], 1t0 15 (8)
In MEDIA mode only, this setting is an alternative way to adjust the built-in speaker's volume ([] 147).
[Monitor Channels] [CH1/CH2], [CH1/CH1], [CH2/CH2], [CH1+2/CH1+2], [CH3/CH4], [CH3/CH3], [CH4/CH4], (7 165)
[CH3+4/CH3+4], [CH1+3/CH2+4]
[HDMI OUT Channels] [CH1/CH2], [CH3/CH4] (11 165)

[(Z) Monitoring Setup] menu

Menu item Setting options and additional information
[LCD LM-V2 Brightness], -99 to 99 (x0)
[LCD LM-V2 Contrast]
[LCD LM-V2 Color] —20 to 20 (=0)
[LCD LM-V2 Sharpness] 1104 (2)
[LCD LM-V2 Luminance] [Normal], [+1], [+2]

[LCD LM-V2] settings are used to adjust, respectively, the brightness, contrast, color saturation,
sharpness and luminance of the supplied LCD monitor.

[EVF-V50 Brightness], —99 t0 99 (+0)
[EVF-V50 Contrast]

[EVF-V50 Color] —-20 to 20 (x0)
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Menu Options

Menu item
[EVF-V50 Sharpness]
[EVF-V50 Luminance]
[EVF-V50 Eye Sensor]

Setting options and additional information
1104 (2)
[High], [Normal]
[On], [Off]
[EVF-V50] settings are used to adjust, respectively, the brightness, contrast, color saturation, sharpness,
luminance and eye sensor of an optional EVF-V50 OLED Electronic Viewfinder connected to the camera.
[EVF-V50 Eye Sensor]: When this setting is set to [On], the viewfinder will be turned off automatically

when the sensor does not detect the user’s eye near the eyepiece for 30 seconds (or 10 seconds, in
playback mode).

[Run EVF at x2 Speed]

[On], [Off]
[Run EVF at x2 Speed] setting reduces the image shaking on the viewfinder (both EVF-V50 and EVF-V70).
e The [Run EVF at x2 Speed] setting cannot be used in the following cases.
- When the recording mode is set to an option other than normal recording or pre-recording.
- When the frame rate is set to an option other than 29.97P / 25.00P / 23.98P / 24.00P.
- In MEDIA mode.
¢ The [Run EVF at x2 Speed] setting cannot be changed while you are recording (while [ @ REC] appears
on the screen).

[LCD LM-V1 Brightness], —-99 to 99 (x0)
[LCD LM-V1 Contrast]

[LCD LM-V1 Color] —20 to 20 (x0)
[LCD LM-V1 Sharpness] 1104 (2)

[LCD LM-V1 Luminance]

[Normal], [+1], [+2]

[LCD LM-V1] settings are used to adjust, respectively, the brightness, contrast, color saturation,
sharpness and luminance of an optional LM-V1 LCD monitor.

[EVF-V70 Brightness], -99 to 99 (x0)
[EVF-V70 Contrast]

[EVF-V70 Color] —20 to 20 (x0)
[EVF-V70 Sharpness] 1104 (2)
[EVF-V70 Luminance] [High], [Normal]
[EVF-V70 Eye Sensor] [On], [Off]

[EVF-V70] settings are used to adjust, respectively, the brightness, contrast, color saturation, sharpness,

luminance and eye sensor of an optional EVF-V70 OLED Electronic Viewfinder connected to the camera.

[EVF-V70 Eye Sensor]: When this setting is set to [On], the viewfinder will be dimmed automatically when
the sensor does not detect the user’s eye near the eyepiece for 30 seconds (or 10 seconds, in playback
mode).

[Run EVF at x2 Speed] [On], [Off] (@ 202)
[Anamorphic: Video Term.], [on], [Off] (@124
[Anamorphic: EVF-V50],

[Anamorphic: MON./HDMI]

[Anamorphic Desqueeze] [Lens Squeeze Factor], [x2.0], [x1.8], [x1.3] (T 124)
[Desqueeze for S&F] [Reduced Display], [0ff] (T 124)

[B&W Image: Video Term.],

[B&W Image: EVF-V50],

[B&W Image: MON./HDMI]

[On], [Off]
These settings display the image captured by the camera in black & white on the LCD screen, an optional
viewfinder or external monitors, respectively.

[0SD Output: MON./HDMI] [On], [Off] (01 158)
[0SD Output: SDI OUT] [On], [Off]

[Tally OSD: VIDEO Term.], [EVF-V50], [On], [Off] (d126)
[MON./HDMI], [SDI OUT]

[Tally 0SD Settings] [REC/Tally In (PGM/PVW)], [REC], [Tally In (PGM/PVW)] (0 126)

[Tally OSD Position]

[Frame], [Top], [Bottom] (@ 120)




Menu item
[DISP Level 1]
[DISP Level 2]
[DISP Level 3]

Menu Options

Setting options and additional information
[All Displays], [All Displays (Periph. Border)] (M 57
[Main Recording Displays], [Only FUNC/MENU]
[Only REC/STBY], [No Displays]

[Apply Peripheral Border]

[DISP Level 1/2/3], [DISP Level 1/2], [DISP Level 1], [DISP Level 2], [DISP Level 3], [Off] (O 58)

[Custom Display 1]

[Light Metering],

[Custom Picture],

[Focal Length], [ND Filter],
[Focus Mode], [Key Lock],
[White Balance], [AE Shift],
[Exposure Bar], [Iris],
[ISO/Gain], [Shutter], [Peaking],
[Tele-converter],

[Digital Image Stabilization],
[Magnification], [LUT], [Lens],
[Mount Adapter]

[On], [Off]

[Custom Display 2]

((1153)

[Remaining Battery],
[Remaining Rec Time]

[Only Warnings], [Normal], [Off]

[Recording Mode], [Genlock], [On], [Off]

[Time Code],

[Reel/Clip Number]

[Photo] [Only Warnings], [Normal], [Off]
[Temperature/Fan], [On], [Off]

[Sensor Mode],
[Resolution/Color Sampling],
[Frame Rate],

[Output Terminals Status],
[OSD Output]*,

[Rec Command(EXT REC)],
[User Memo]*, [User Bit]*,
[Monitor Channels]*,

[Audio Level Indicator],
[Network Functions], [GPS]

[Date/Time]
[Custom Display]

[On], [Normal]: Show the icon/onscreen display always or whenever the necessary conditions are
triggered.

[Only Warnings]: Show the icon/onscreen display only when a critical level is reached.

o The default setting for items marked with an asterisk (*) is [Off].

[Date/Time], [Time], [Date], [Off]
(17 146)

These settings are available only in MEDIA mode and determine whether the following onscreen displays
will appear on the playback image.

[Audio Level Indicator]

[On], [Off]

[Date/Time], [Camera Data]

[Displayed Units]

[On], [Off]

[Audio Level Indicator]: The audio level meter (clips only).

[Date/Time]: The date and time when the clip/photo was recorded.

[Camera Data]: The aperture value, shutter speed and ISO speed/gain value used to record the clip (clips
only).

[Meters], [Feet]'

Changes the distance units used in camera displays between meters and feet.

[OSD Opacity: Video Term.],
[OSD Opacity: EVF-V50],
[OSD Opacity: MON./HDMI]
[OSD Opacity: SDI OUT]

[On], [Off] ([T 159)

[OSD Opacity Level]

[75%], [62.5%)], [50%)], [37.5%)], [25%)]
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Menu item
[OSD Opacity: Appl. Screens]

Setting options and additional information
[All], [Only Rec/Playback Screens]

[LUT: SDI OUT], [LUT: MON.], [On], [Off] (@161
[LUT: HDMI], [LUT: VIDEO Term.],
[LUT: EVF-V50]
[LUT Selection: SDI OUT], [BT.709], [BT.2020], [DCI], [HLG], [ACESproxy], [CMT 709], [USERLUT1]* to [USERLUT4]* (T 161)
[LUT Selection: MON.], Available options and default values vary depending on other settings. See the tables on the
[LUT Selection: HDMI] reference page.
* Available only when user LUTs have been registered in the camera ([ 163).
[LUT Selection: VIDEO Term.], [BT.709], [HDR Assist. (1600%]], [HDR Assist. (400%)], [CMT 709], [USERLUT1]* to
[LUT Selection: EVF-V50] [USERLUT4]*
Available options and default values vary depending on other settings. See the tables on the
reference page.
* Available only when user LUTs have been registered in the camera (1] 163).
[HLG Color] [BT.2100], [Vivid] (162)
[Gain for HDR—SDR Conv.] —7.5dB to +7.5 dB (3.0 dB) (T 163)
[User LUT 1] to [User LUT 4] (T 163)
[Register] -
[Color Space (Output)] [BT.709 Gamut], [BT.2020 Gamut], [Do Not Convert]
[Range (Output)] [Narrow Range], [Full Range]
[Delete], [Rename] -
[Reset All User LUTs] -
[User LUT Info] -
[Range: SDI OUT], [Range: MON.] (@ 159)
[During Canon Log Output] [Full Range], [Narrow Range]
[During HDR Qutput] [Full Range], [Narrow Range]
[Range: HDMI]
[During Canon Log Output] [Full Range Priority], [Narrow Range]
[During HDR OQutput] [Full Range Priority], [Narrow Range]
1 The default value depends on the country/region of purchase.
[ Assistance Functions] menu
Menu item Setting options and additional information
[Focus Guide] [On], [Off] (8)
[Focus Guide 2nd Frame] [On], [Off]
[Focus Position Guide] (2 88)
[Display] [On], [Off]
[Orientation] [Horizontal], [Vertical]
[Sensitivity] 1t05(3)

[Delete All Markers]

[Cancel], [OK]

[Marker 1 Color]

[Yellow], [Blue], [Green], [Red], [Purple], [White]

[Marker 2 Color]
[Marker 3 Color]

[Yellow], [Blue], [Green], [Red], [Purple], [White]
[Yellow], [Blue], [Green], [Red], [Purple], [White]




Menu Options

Menu item Setting options and additional information

[Peaking: Video Term.], [On], [Off] (T 87)
[Peaking: EVF-V50],
[Peaking: MON./HDMI],
[Peaking: SDI OUT]
[Peaking] [Peaking 1], [Peaking 2] (T 87)
[Peaking 1]

[Color] [White], [Red], [Yellow], [Blue]

[Gain] [0ff], 1 to 15 (8)

[Frequency] 1104 (2)
[Peaking 2] (2 88)

[Color] [White], [Red], [Yellow], [Blug]

[Gain] [0ff], 1 to 15 (15)

[Frequency] 1to4(1)
[Magnification] [On], [Off] (87)
[Magn. Output] [VIDEO Term.], [EVF-V50], [MON./HDMI]
[B&W during Magn.] [On], [Off] (T 87)
[False Color: Video Term.], [On], [Off] (12 98)
[False Color: EVF-V50],
[False Color: MON./HDMI]
[False Color Index] -
[Zebra: Video Term ], [On], [Off] (L1 98)
[Zebra: EVF-V50],
[Zebra: MON./HDMI]
[Zebra] [Zebra 1], [Zebra 2], [Zebra 1+2]
[Zebra 1 Level] [5 +5%] to [95 +5%)] in 5 percentage point intervals ([70 £5%)])
[Zebra 2 Level] 0% to 100% in 5 percentage point intervals (100%)
[WFM: Video Term.], [On], [Off] (@M 114)
[WFM: EVF-V50],
[WFM: MON./HDMI]
[WFM Opacity Level] [Linked to 0SD Opacity], [100%)], [80%], [60%)], [40%], [20%)] (T 114)

Select the WFM opacity level. If set to [Linked to OSD Opacity], it will be linked to the [0SD
Opacity Level] setting.

[WFM Function] [Waveform Monitor], [Vectorscope]
[Waveform Settings] (M 114)

[Size: VIDEO Term./EVF-V50]

[Normal], [2X]
Changes the size of the waveform displayed on the screen.

[Position] [Right], [Left]
[Type] [Line], [Line+Spot], [Select Line], [RGB], [YPbPr]
[Gain] [1x], [2x]

[Vertical Scale for HDR]

[IRE], [PO/HLG]

[Y Position]

[0%], [15%], [30%], [45%], [50%]

[Select Line]

0to 719 in 1-line increments (360), 0 to 1079 in 1-line increments (540),
0 to 2158 in 2-line increments (1080),
0 to 3138 in 2-line increments (1570)

Available options depend on the resolution and operating mode (CAMERA / MEDIA mode).
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Menu item Setting options and additional information
[Vectorsope Settings] (M 115)
[Position] [Right], [Left]
[Type] [Normal], [Spot]
[Gain] [1x], [2x]
[Markers: Video Term.], [On], [Off] (T 96)
[Markers: EVF-V50],
[Markers: MON./HDMI]
[Markers: SDI OUT] [On], [Off]
[Center Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (M97)
[Center Marker Type] [Cross 1], [Cross 2], [Dot 1], [Dot 2]
[Horizontal Marker], [Grid Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off]
[Aspect Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 100%], [Mask 75%)], (@9
[Mask 50%], [Mask 25%)], [Off]
[Marker Aspect Ratio] [4:3], [13:9], [14:9], [16:9], [1.375:1], [1.66:1], [1.75:1], [1.85:1], [1.90:1], [2.35:1], [2.39:1],
[9:16], [Custom]
[Marker Custom Asp. Ratio] 1.00:1 t0 9.99:1 (1.00:1)
[Safe Area Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (97)
[Basis for Marker Safe Area] [Whole Picture], [Selected Aspect Marker]
[Marker Safe Area %] [80% (Side Length)], [88% (Side Length)], [90% (Side Length)], [93% (Side Length)],
[95% (Side Length)], [80% (Area)], [90% (Area)], [92.5% (Area)], [95% (Area)]
[User Marker 1], [User Marker 2] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (M97)
[User Marker 1 Size], 2x2 to 2048x1080 only even numbers (100x100)
[User Marker 2 Size]
[User Marker 1 Position], (-1024, -540) to (1024, 540) (0, 0)
[User Marker 2 Position]
[im Network Settings] menu
Menu item Setting options and additional information
[Network] [Enable], [Disable] (171, 183)
[Connect] [Disconnect], [SET1] to [SET20] (183
[Connection Setting] [SET1] to [SET20]
[Create New with Wizard] - ((RARFa))
[Create with Existing Setting] - (I 178)
[Check Settings] - (M177)
[Change with Wizard] - (T1178)
[Select Existing Setting] - (X178)
[Settings Name] File name up to 12 characters (M 178)
[Delete Settings] - (M178)
[New Conn. Setting (Wizard)] [FTP Transfer], [IP Streaming], [Browser Remote], [XC Protocol] (@1
[Advanced Settings]
[Communication Settings] [NW1] to [NW25] (179
[Function Settings] [MODE1] to [MODE25]
[Browser Remote Settings] [User Setting], [User Name/Password], [Port No. (HTTP)], [Port No. (HTTPS)], [HTTPS] (179
[FTP Transfer Settings] [Read Root Certificate], [Root Certificate Details], [Delete Root Certificate] (I 181)
[XC Protocol Settings] [Authentication Method], [User Setting], [User Name/Password], [Port No. (HTTP)] (174
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Menu item Setting options and additional information
[802.1X Authentication] [Setup Wizard], [Check Settings], [Delete Settings] (1182
[Nickname] User defined string up to 16 characters ((€ERNITAD [C300MKk3], [C500MKII]) (182
[Activate IP Streaming] [Enable], [Disable] (11 185)
[FTP Transfer All Clips] - (T 184)

[@ Assignable Buttons] menu

Following are the default settings for each assignable button. For a complete list of the functions that can be
assigned, refer to the detailed table (11 130).

Menu item Setting options and additional information

[Camera] 1: [Magnification], 2: [Peaking: All], 3: [Zebra: All], 4: [WFM: All], 5: [LUT: All],
6: [1SO/Gain], 7: [Shutter], 8: [Slow & Fast Motion], 9: [Slow & Fast Frame Rate],
10: [White Balance], 11: [Set White Balance], 12: [FUNC], 13: [Audio Status],
14: [Push Auto Iris], 15: [One-Shot AF]

[Camera Grip] 1: [Focus Guide]

[LCD LM-VIN2] 1: [FUNC], 2: [DISP]

[REMOTE A/B / XC Protocol]

[Link to Camera]

[Enable], [Disable]

1: [Magnification], 2: [Peaking: All], 3: [Zebra: All], 4: [WFM: All]

[Exp. Unit EU-V2]

1: [FUNC]

[Exp. Unit EU-V3]
[EVF-V70]

1 to 3: (Unspecified), 4: FUNC
1: [FUNC], 2: [EVF-V70 Setup], 3: [Magnification], 4: [False Color: VIDEO Term.]

[Grip SG-1]

1: [One-Shot AF]

[ System Setup] menu

Menu item Setting options and additional information
[Reset] [All Settings], [Assignable Buttons]
These settings reset the following camera settings to default values/settings.
[All Settings]: All the camera’s settings except for the hour meter.
[Assignable Buttons]: Only the assignable buttons.
[Transfer Menu/ (€3] (@142
[Save] [To Camera], [To SD Card]
[Load] [From Camera], [From SD Card]
[Time Zone] List of world time zones. ([ 33)
[UTC-05:00 New York] or [UTC+01:00 Central Europe]1
[Date/Time] - (M3
[Date Format] [YMD], [YMD/24H], [MDY], [MDY/24H], [DMY], [DMY/24H]'
[Language &3 ] [Deutsch], [English], [Espafiol], [Francais], [Italiano], [Polski], [Portugués], (@33
[Pycckwin], [Ykpaikcbkal, [ kb 5], [81=04], [BAE]
[REMOTE Term.] [RC-V100 (REMOTE A)], [RC-V100 (REMOTE B)]?, [Standard], [Standard + RC-V100]? (7 125)
[MON&HDMI Simult. Output] [On], [Off] ([ 158)
[HDMI Max Res.] [4096x2160 / 3840x2160], [1920x1080], [1280x720] (M 157)
[Linked to HDMI Monitor] [On], [Off] (M 157)
[SDI OUT Output (Max Res.)] [4096x2160 / 3840x2160], [2048x1080 / 1920x1080], [Off] ([T 156)
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Menu item Setting options and additional information
[MON. Output Resolution] [2048x1080 / 1920x1080], [1920x1080], [1280x720] (157)
[3G-SDI Mapping] [Level A], [Level B] ([T 156, 157)
[MON./HDMI Scan Mode] [P], [PsF (Forced 1080i)] ([T 158)
[SDI OUT Scan Mode] [P], [PsF (Forced 1080i)] (T 158)
[G-LOCK/SYNC Term.]2 [HD Sync Output], [Genlock Input] (12103, 104)
[Genlock Adjustment]? -1023 to +1023 (000) (07 103)
The phase difference between the external Genlock signal and the camera is initially set to 0. This setting
allows you to adjust it within the range of approx. +0.4 H (1023 to 1023). To set a 4-digit adjustment
value, set the first field to 10 or —10.
[SYNC Scan Mode] [P1, [PsF] (2 104)
[RET Output: VIDEO Term.] [Enable], [Disable] (T 126)
[RET Output: MON.] [Enable], [Disable] (T 126)
[RET Output: HDMI] [Enable], [Disable] ([T 126)
[Time Code Mode] [Preset], [Regen.] (299)
[Time Code Run] [Rec Run], [Free Run] (2 99)
[Time Code DF/NDF] [DF], [NDF] (02 100)
[Set Time Code] [00:00:00:00] to [23:59:59:29] (59.94 Hz recordings), [23:59:59:24] (0299
(50.00 Hz recordings), or [23:59:59:23] (24.00 Hz recordings)
[TC In/Out] [In], [Out] (A 102, 103)
[User Bit Recording Mode] [Internal], [External] (102
[User Bit Type] [Setting], [Time], [Date] (ato1)
[Camera Ctrl Dial], [Iris], [ISO/Gain], [Off] (75, 78)

[Camera Grip Ctrl Dial]
[Camera Ctrl Dial Dir.],
[Camera Grip Ctrl Dial Dir.],
[Grip SG-1 Ctrl Dial Dir.]

[Camera SELECT Dial Dir.],
[EVF-V70 SELECT Dial Dir.]

[Reverse], [Normal]

Changes the direction of the adjustment when operating the control dial on the camera, camera grip, or
optional SG-1 Shoulder Style Grip. These settings are available only in CAMERA mode.

[Reverse], [Normal]

Changes the direction of the adjustment when operating the SELECT dial on the camera or optional
EVF-V70 OLED Electronic Viewfinder. These settings are available only in CAMERA mode.

[Key Lock] [All Buttons], [All Except REC Button] (M12)
[Camera REC Button], [Disable], [Enable]
[Camera Grip REC Button], Independently enables or disables the use of the REC buttons on the camera, camera grip, or optional

[Grip SG-1 REC Button]

SG-1 Shoulder Style Grip. These settings are available only in CAMERA mode.

[Tally Lamp (Front)],
[Tally Lamp (Rear)]

[On], [Off]
When this setting is set to [On], the tally lamp illuminates while recording.

[Tally Lamp Settings]

[Power/Media/Tally In (PGM)], [REC/Tally In (PGM)], [REC], [Tally In (PGM)] (151

When this setting is set to [Power/Media/Tally In (PGM)], the tally lamp illuminates/flashes according to
battery and recording warnings and the SD card recording status.

[DC OUT Term. Signal Setup]

[CFexpress Access LED],
[SD Card Access LED]

[=% (Ethernet) LED]

[REC/Tally In (PGM)], [REC], [Tally In (PGM)], [Disable]

This setting allows you to set the signal to output from the DC OUT terminal of EU-V3 Expansion Unit 3.

Refer also to the Cinema EOS System Expansion User Guide.

[On], [Off]

When this setting is set to [On], the CFexpress/SD card access indicator illuminates when the camera is
accessing the card.

[On], [Off]

When this setting is set to [On], the % (Ethernet) indicator on an optional expansion unit illuminates/

flashes when the camera is accessing a wired network.
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Menu item Setting options and additional information
[Fan Mode] [Automatic], [Always On] (@ 61)
[Fan Speed (STBY)] [Maximum], [High], [Middle], [Low]
[Fan Speed (REC)], [High], [Middle], [Low]
[Fan Speed (Always)]
[Fan Speed] [High], [Middle], [Low] (M e61)
[Touch Screen Response] [Normal], [Low] (31
[Review Recording] [Entire Clip], [Last 4 sec] (119

[GPS Auto Time]®

[On], [Off]

When this setting is set to [On], the camera automatically adjust its date and time settings according to

the information received from the GPS signal. The date and time will be updated automatically the first

time a correct GPS signal is acquired after turning on the camera. This setting is available only in CAMERA

mode.

» While the automatic date/time adjustment is activated, the MENU > [¥ System Setup] > [Date/
Time] setting will not be available.

e The time will not be updated while recording video.

[Button lllumination]

[On], [Off] (142

[DC IN Warning (V)]

11.5V1015.0 Vin 0.1 Vintervals (12.0 V) (@27

[Exp. Unit Batt. Warning (%)]*

1% to 10% (5%)

[Exp. Unit Batt. Warning (V)]*
[Power Saving Mode]

12.0V1t015.0 Vin 0.1 Vintervals (13.0 V)

[On], [Off]
When this setting is set to [On], the camera’s power consumption is reduced.

¢ The following functions cannot be used when this setting is set to [On]:
- MENU > [(Z) Monitoring Setup] > [LCD LM-V1 Luminance], [LCD LM-V2 Luminance] or
[EVF-V70 Luminance].
- MENU > [#\ Network Settings] > [Network].
- MENU > [[Z) Monitoring Setup] > [LUT Selection: VIDEO Terminal] > [HDR Assist. (400%)] or
[HDR Assist. (1600%)].

[Retract Lens]

[On], [Off]

When one of the following lenses is attached to the camera and the focus mode switch on the lens is set
to AF, if this setting is set to [On], the lens will retract fully when the camera is turned off. This setting is
available only in CAMERA mode.

e EF 40mm /2.8 STM e EF-S24mm /2.8 STM e EF 50mm /1.8 STM

[Reset Hour Meter] -
The camera has two “hour meters” — the first keeps track of total operation time and the second keeps
track of operation time since the last time the second hour meter was reset with this function. This setting
is available only in CAMERA mode.
[Firmware]
[Camera] -
Displays the current firmware version of the camera and is used to update the firmware. This setting is
available only in CAMERA mode but is usually grayed out.
[Lens] - (@ 39)

1 The default value depends on the country/region of purchase.

2 Only when an optional expansion unit is attached to the camera.

3 Only when the optional GP-E2 GPS Receiver is connected to the camera.

4 Only when the optional EU-V2 Expansion Unit 2 is attached to the camera with a commercially available V-mount battery

attached.
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Menu Options

[ My Menu] menu (CAMERA mode only)

Menu item Setting options and additional information
[CAMERA-1: Edit] to [Register], [Move], [Delete], [Reset All], [Rename] (1 35)

210 [CAMERA-5: Edit]



Displaying the Status Screens

Displaying the Status Screens

You can use the status screens to check the camera’s various settings. You can also output the status screens
to an external monitor.

211
1 Set an assignable button to [Status] ([I] 129). —

2 Press the assignable button to open the status screens.

e The status screen most recently displayed will appear unless you turned off the camera or changed the
operating mode.

3 Scroll through the status screens to check the desired settings.
¢ Navigate the status screens in the same way you do the setup menus.

4 Press the assignable button again or select [X CLOSE] to close the status screens.
® You can also press the MENU button to close the status screens and open the menu instead.

To skip directly to the page of a specific status screen:

[IA Gamma/Color Space/Range] (M211) [d) Audio Setup] (T 215)
[[€&@] (custom picture file in use) (M212) [§ System Setup] (M 216)
("™ Camera Setup] (1 213) [£¥ Recording/Media Setup] (M 217)
[@ Assignable Buttons] (M214) [swv Network Settings] (1 218)

[ Gamma/Color Space/Range] status screens (CAMERA mode only)

Gamma/Color Space/Range

Recording : Gamma : Color Space: Range:
CFexpress BT.709 Wide DR  BT.709 Narrow
SD Card

Gamma/Color Space/Range

Gamma : Color Space: Range:
Look File Conform to Custom Picture BT.709 Wide DR  BT.709 Narrow
Gain for HDR—>SDR Conv. .
HLG Color BT.709 Wide DR  BT.709 Narrow
BT.709 Wide DR  BT.709 -
BT.709 Wide DR  BT.709
IP Strm. (8 bit) BT.709 Wide DR  BT.709
Look File Conform to Custom Picture
Gain for HDR—SDR Conv.
HLG Color

1 Gamma curve, color space ([J] 137) and range 3 Look File applied
used for recording clips 4 Gain for HDR-to-SDR conversion ([11] 163)
[CFexpress]: Primary clips on the CFexpress card 5 HLG color quality ([J1 137, 162)
[SD Card]: Proxy clips on the SD card
2 Gamma curve, color space (E[] 137, 161) and * This information appears also on screen [1].
range (1 159) used for video outputs/monitoring
devices
[SDI OUT], [MON.], [HDMI]: Video output from the
respective terminal ((HDMI] indicates the HDMI
OUT terminal)
[VIDEQ]: LCD screen
[EVF-V50]: Optional viewfinder
[IP Strm. (8 bit)]: IP streaming signal (11 185)
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[[€d] status screens (CAMERA mode only)

212

C1:BT.709 Wide DR
Gamma BT.709 Wide DR
Color Space BT.709
Color Matrix Neutral
HLG Color
Look File On
With Look File Conform to Custom Picture

Black MP +0 R
Black Gamma Lvl +0 Range =0 Point
Low Key Satur. Off Lvl
Knee (o])] Slp +0 P
Sharpness Lvl +0 Frq +0 Coring Lvl =0
Lim +0
NR Spatial Filter Frame Correlation
Skin Detail Off
Y

3 C1:BT.709 Wide DREJ
Color Matrix Tuning Gain + +0
R-G + +0 B-R
R-B + +0 B-G
White Balance R Gain = =0 B Gain
Color Correction Off
Area A Setting P 0
Area A Revision Lvl
Area B Setting Pi 50
Area B Revision Lvl =0 +0
Other Functions Over 100%  Through

Cc
P
(g
p

1 Custom picture file name (11 133)
2 Custom picture settings ([1] 137)



["™ Camera Setup] status screens (CAMERA mode only)

w

ISO 1

ISO/Gain Extended Range  Off

I1SO Increment 1/3 stop

Gain Increment

Iris

Iris Increment 1/3 stop

Fine Increment Off

Zoom-Iris Correction On

1/4 stop

One Shot
AF Frame Position Selectable
AF Frame Size Large
Apply AF Speed Limit Always
AF Speed 0
AF Response 0

ISO speed/Gain (11 74)

Selected mode, extended range, I1SO increment
and gain increment

Aperture (11 77)

Iris increment, fine increment, aperture correction
while zooming

Shutter speed increment ([ 73)

Focus ([11 84)

AF mode, AF frame settings, AF speed and AF
response settings

Automatic exposure (AE)

AE shift ([11 80), AE response (11 79)

bd
Camera Setup

24 5
AE
AE Shift
AE Response
White Balance
Shockless WB
AWB Response
Periph. lllum. Corr.
Chromatic Aberr. Corr.

3@ 5
Anamorphic: VIDEO Term.
Anamorphic: EVF-V50
Anamorphic: MON./HDMI
Anamorphic Desqueeze
Desqueeze for S&F
Metadata
Lens Squeeze
Digital Image Stabilization
Lens Focal Length
Anamorphic Corr.

2 3 45

Lens Info
EF50mm /1.4 USM

Displaying the Status Screens
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Off
Off
Lens Squeeze Factor
Off

Off
Off

6  White balance ([11 81)
Shockless white balance, auto white balance

(AWB) response

7 In-camera lens correction ([J] 39)
Peripheral illumination, chromatic aberration
8 Anamorphic correction ([J1 124)
Video outputs, desqueeze ratio (for most clips/for
slow & fast motion clips), lens squeeze factor
saved in the metadata
9 Image stabilization ([11] 94)
Lens's focal length and anamorphic correction
10 Lens model name ([1] 37)
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[@ Assignable Buttons] status screens
G

Assignable Buttons

[

Magnification 3 Assignable Buttons
Peaking: All

| Camera Grip ]—
Zebra: All 1 Focus Guide 2

UUALR A LCD LM-VIN2
LUT: All

. 1 FUNC 3
ISO/Gain 2 DISP
Shutter
Slow & Fast Motion P ©

@E ¢ - 4 Assignable Buttons

Assignable |  REMOTE A/B / XC Protcol
Link to Camera Disable

i Magnification 4

Slow & Fast Frame Rate Peaking: Al

i 2
White Balance ]
Set White Balance i 65;3&::\‘?
FUNC 3

Status " @

Push Auto Iris 5 Assignable Buttons

One-Shot AF Exp. Unit EU-V2 ]— 5
1 FUNC

Exp. Unit EU-V3

1 (NONE)

2 (NONE) 6

E] (NONE)

4 FUNC

<€
6 Assignable Buttons

EVF-V70

1 FUNC

p) EVF-V70 Setup 7

E] Magnification

4 False Color: VIDEO Term.

Grip SG-1 ] 8
1 One-Shot AF

Current functions of the assignable buttons (11 129)

,
2
3

On the camera grip

On the camera’s body 5 On the optional EU-V2 Expansion Unit 2
6 On the optional EU-V3 Expansion Unit 3
On the LM-V2 (supplied) or LM-V1 (optional) LCD 7 On the optional EVF-V70 OLED Electronic

Monitor

Viewfinder

On the RC-V100 Remote Controller / XC Protocol 8 On the optional SG-1 Shoulder Style Grip Unit
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[P) Audio Setup] status screens
When you press the AUDIO STATUS button, the status screens displayed are the same except that you can
press the joystick to open the [§)) Audio Setup] menu.

w

CAMERA mode:

B o X
Audio Setup
INPUT1 MIC CH1 Audio Setup
1 INPUT2 MIC CH2 i it Output : Audio Format :

Monaural Mic CH3
Monaural Mic CH4
2 = \onitor Channels CH1/CH2 SD Card LPCM / 24 bit /4CH 5
Headphone Volume [91:]
4 e—\1|C Power -

CFexpress LPCM / 24 bit /4CH

SDI OUT/MON. LPCM / 24 bit /4CH

HDMI LPCM / 16 bit /2CH (CH1/CH2
Bl Audio Setup g 6
MEDIA mode:
Audio Setup
Output : Audio Format :
SDI OUT/MON. 4 bit /4CH
5 LPCM / 16 bit /2CH (CH1/CH2)
2 - . Monitor Channels CH1/CH2
3 Headphone Volume 08
Audio source input, audio level adjustment mode 5 Audio format and audio bit depth used for
and audio level indicator for each audio channel recording or output ([J] 105, 165)
(T3 105) [CFexpress]: Primary clips on the CFexpress card
Audio channels output from the headphones/ [SD Card]: Proxy clips on the SD card
speaker (11 165) [SDI OUT/MON.]: Audio output from the SDI OUT
Headphone volume ([11] 147) or MON. terminal,
MIC terminal’s plug-in power ([11 112) [HDMI]: Audio output from the HDMI OUT
terminal

6 Press SET to open the [ Audio Setup] menu.
(Only when the status screen was opened using
the AUDIO STATUS button.)
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[ System Setup] status screens

"2 3 System Setup
21 6 % —SD| OUT 3840x2160 YCC422 10 bit
! Off
- 3 HDMI 1920x1080 YCC422
59.94P 2CH/PCM
4 —|_[ off
5 0SD Output: MON./HDMI on
I 3G-SD| Mapping
(3} HDMI Time Code off 8
7 I — User Bit Type Setting

Battery Life e — 1 ()
Hour Meter 84h ===l 1 1

12 B System Setup
Latitude N35°39'30.9"

Longitude E139°44'43.5"
Elevation 32.8ft 13
uTC Nov.3,2019 9:20 AM

Satellite Reception 3D &5l

1 SDI OUT terminal status ([J] 156) Information about the Canon battery pack? (11 25)
2 MON. terminal status’ (00 157): Video outputon/ 8 Remaining recording time
off 9 Remaining charge level (visual bar)

3 HDMI OUT terminal status ([J] 157): Signal type 10 Battery life indicator
(HDMI/DVI), video output, frame rate, audio

output 11 Total operation time

4 Qutput of onscreen displays ([11 158) 12 Operation time since using [Reset Hour Meter]
to the MON. or HDMI OUT terminal, to the SDI (11 209)
OUT terminal 13 GPS information?3 (CAMERA mode only)

5 3G-SDI mapping Latitude, longitude, elevation, coordinated

6 Time code output from the HDMI OUT terminal® universal time (UTC), satellite signal strength
(157)

7 User bit? (0 101)

! The bit depth displayed is the video signal’s effective bit depth.
2 CAMERA mode only.
3 Only when the optional GP-E2 GPS Receiver is connected to the camera.
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5

Recording/Media Setup] status screens

A - é 5 d AA
2 3 4
CFexpress A Recorded
= Available

CFexpress B Recorded
L Available
Recorded
Available

21.6GB
30 min
2.51GB
31 min
308 MB
241 min
9999 Photos

SD Card

File Name TANZO1
Title
Fantastic Trips
Creator
E. Lubeski
Location
Tanzania
Description

Recording media information (CFexpress card A,
CFexpress card B, SD card)

Visual bar, total capacity, used (recorded) space,
approximate available recording time

SD card’s SD/UHS speed class and number of
remaining photos

User memo (11 117)

User memo file name, clip title, creator, location
and description

Clip name information ([J1 59)

Camera index, reel number/clip number, stream
number/proxy, user-defined field

Scene and take information ([J1] 118)

(i) NoTES

¢ Depending on the card, the total space displayed on the screen may differ from the nominal capacity printed
on the card itself.

X

Recording/Media Setup

Displaying the Status Screens

2 Bl 4
Camera Index
Reel/Clip Number 001C001 4
Stream Number/Proxy _01P
User Defined CANON
Scene (NONE) 5
Take (NONE)
Country Code
Organization 00 ]— 6
User Code
Add [€ File —ee——— 7
nAa X

3 @ Recording/Media Setup r 8
Main Rec Format XF-AVC
Resolution/Color Sampling 3840x2160 YCC422 ‘IDbit ?0
Bit Rate 810 Mbps Intra-frame et
Relay Recording Off 1 1
Recording Mode Normal Recording e -I 2
Photo Numbering Cont\'nuous
Clip Numbering Cont\‘nuous 1 3

14

8
9
10
11
12

13
14

Unigue material identifier (UMID) code ([1] 200):
country, organization, user

Custom picture file embedded with XF-AVC clips
(1139

Main recording format ([1] 62)
Resolution and color sampling (11 62)

Bit rate ([11 62)

Relay recording ([ 47)

Normal recording / Special recording mode
(120)

Photo numbering (11 200)

Clip numbering (11 60)
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[i,m# Network Settings] status screens

B @ = & » ¢ 2 N X

2 3456 7 8 91011121314 Network Settings
Network Enable
Connection Setting SET2
Settings Name CANONet
Comm. Settings 1 Wi-Fi T

Comm. Settings 2 -
Function Settings 1 Browser Remote
Function Settings 2

3 456 7 8 91011121314 Network 41 2 181 4 5 7 8 91011121314 Network Settings
Comm. Settings 1 Wi-Fi T Comm. Settings 2
Connection Method Infrastructure Connection Method

SSID SsSID

| -A4CBB7-G ===

Channel - Channel
Authentication Method WPA/WPA2-PSK Authentication Method
Encryption Method TKIP/AES Encryption Method
Key Index - Key Index

Network connection used ([J] 183)

1 Network functions activated/deactivated 4 Communication settings of the secondary

2 Connection setting in use network
Connection setting (SET) number, name, Network type, connection method, SSID (network
communication settings (primary network and name), Wi-Fi channel, authentication, encryption
secondary network) and function settings and key index

3 Communication settings of the primary network
Network type, connection method, SSID (network
name), Wi-Fi channel, authentication, encryption
and key index

Network Settings

Automatic Setting
192.168.0.5
255.255.255.0
Enable
192.168.0.1

Use DNS Address Enable

DNS Address 192.168.0.1

MAC Address
MAC Address (Ethernet)

9 10111213 14 Network Settings

TCP/IPv6 Settings Disable TCP/IPv6 Settings
Manual Setting Disable Gateway
Link-Local Address -

- DNS Server Auto Assign
Stateless Address DNS Address

DHCPv6 Address

IP Address

TCP/IP settings of the current network connection ([1] 179)

1 IP address assignment method 5 DNS server

2 |P address 6 Camera’s MAC address (wireless and Ethernet)
3 Subnet mask 7 IPv6 settings (11 181)

4 Default gateway



1 2 3 45 6§48

802.1X Authentication
Authentication Protocol
User Name

2 3 45 7 18 9 10111213 14 91

802.1X Authentication
Root Certificate Type
Issued by
Issued to

Expiration date

802.1X authentication ([11] 182)

9 10111213 14

Displaying the Status Screens

Network Settings

23456
802.1X Auth

Client Certificate Type
Issued by

Network Settings

Issued to

Expiration date

Protocol, user name, root certificate details and client certificate details

2 34567 8 9811121314

IP Streaming
Disable

IP streaming settings (CAMERA mode only, [T]173)
1 IP streaming activated/deactivated (1] 185)

2 Streaming protocol and receiver settings

3 Error correction settings

3456 7 8

Browser Remote
i I———rort No. (HTTP) 80

9 1011 4213 14

2 Disable

3 E—ttp://192.168.0.5/

Network Settings

2 3456 7 8 910 121314 Network Settings

IP Streaming
RTSP: User Name

Video Output Conf.
Audio Out Channels

4 RTSP user name required to control streaming
sessions

5 Streaming video configuration and audio
channels

4 56 7 8
Browser Remote
One User (Full)
CANONchief

Two Users (Camera) 4

9 1011 1218 14 Network Settings

Two Users (Meta)

Settings for Browser Remote (CAMERA mode only, [T]174)

1 Port number (HTTP)
2 HTTPS connection ([J1 179)
Port number, HTTPS activated/deactivated

3 Camera’s URL
4 Users
User names for single-user and two-user modes
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3456 7 8 91011121304 Network Settings

Authentication Method Basic Authentication

220 -I User Name

80

XC Protocol (CAMERA mode only, [T] 194)

1 Authentication Method, User name,
Port number (HTTP)

34567 89f@ Network Settings

FTP Transfer
| TP Mode
User Name

2 Destination Server

FTP server settings (MEDIA mode only, [1]172)

1 FTP mode
2 FTP server
User name and FTP server (or host) name



Troubleshooting

Troubleshooting

If you have a problem with your camera, refer to this section. Consult your dealer or a Canon Service Center if
the problem persists.

Power source

The camera will not turn on or it turns off by itself.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Shortly after turning it on, the camera turns off on its own.
- You are using a battery pack that is not compatible for use with this camera. Use a recommended battery pack
(11 238).
Cannot charge the battery pack.
- The temperature of the battery pack is outside the charging range. If the battery pack’s temperature is below 0 °C
(82 °F), warm it before charging it; if it is above 40 °C (104 °F), let the battery pack cool down before charging it.
- Charge the battery pack in temperatures between 0 °C and 40 °C (32 °F and 104 °F).
- The battery pack is faulty. Replace the battery pack.

The battery pack is depleted extremely quickly even at normal temperatures.

- Check the [i' System Setup] status screen ([1] 216) to check if the battery pack has reached the end of its battery
life. If so, buy a new battery pack.

Recording

The camera’s controls are not responsive/disabled.

- The camera grip’s plug may not be correctly connected to the camera’s GRIP terminal. Disconnect the camera grip’s
cable and then connect it again, firmly (11 41). If you changed the angle of the camera grip, make sure you did not
partially disconnect the plug by mistake.

- When the G switch is set to &, all buttons (or all buttons with the exception of some REC buttons) are locked
and cannot be operated. Set the [MED switch to CAMERA. You can change which controls are locked with the
MENU > [¥ System Setup] > [Key Lock] setting.

Pressing the REC button will not start recording.

- The card is full or it already contains the maximum number of clips (999 clips). Delete some clips ([J1 151) or save your
recordings and initialize the card (1] 46) to free some space. Alternatively, replace the card.

- The REC button that was used may be disabled. Change the current settings in the MENU > [§ System Setup] >
[Camera REC Button] or [Camera Grip REC Button] setting to enable the use of the desired REC buttons.

- Power supply to the camera or the optional expansion unit has reached the level set for the power level warning
([T 209). Check the power source.

- The camera cannot record while the [Color Correction] settings in the custom picture file (1] 140) are being adjusted
(except for the [Revision Level]/[Revision Phase] settings).

The point where the REC button was pressed does not match the beginning/end of the recording.
- There may be a slight interval between pressing the REC button and the actual start/end of recording. This is not a
malfunction.

The camera will not focus.

- The camera may not be able to focus on certain subjects using autofocus. Focus manually ([1] 85).

- When the AF mode is set to AF-boosted MF, start focusing manually until the AF frame changes to white (automatic
adjustment range).

- The lens is dirty. Clean the lens with a soft lens-cleaning cloth.
When a subject flits across in front of the lens, the image appears slightly bent.

- This is a phenomenon typical of CMOS image sensors. When a subject crosses very quickly in front of the camera, the
image may seem slightly warped. This is not a malfunction.
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Troubleshooting

Bright red, green or blue dots appear on the screen.

- Try adjusting the black balance ([T 49). The camera’s CMOS sensor is a delicate piece of precision engineering. Direct
exposure of the sensor to ion rays or other types of cosmic radiation may affect it and this may rarely appear as bright colored
dots on the screen. This is the nature of CMOS image sensors and does not represent a malfunction.

- The effects of the damage may be more noticeable when the camera is used in places subject to high temperatures,
when a high ISO speed or gain level is used and when slow shutter speeds are used.

Abnormal images appear on the screen and the camera cannot record properly.
- While recording using an almost empty battery pack together with an AC adapter, the AC adapter was inadvertently
disconnected or the power supply was suddenly interrupted. Reconnect the AC adapter and turn the camera off and
then on again or replace the battery pack with a fully charged one.

Changing between recording (@ REC) and record standby (STBY) takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings
and initialize the card ([I1 46). Alternatively, replace the card.

Clips or photos cannot be recorded properly.
- This may occur as clips and photos are recorded/deleted over time. Save your recordings and initialize the card
([ 46).
After using the camera for a long time, it becomes hot.
- The camera may become hot after using it continuously for long periods of time; this is not a malfunction. If the
camera becomes unusually hot or it becomes hot after using it only for a short while, it may indicate a problem with
the camera. Consult a Canon Service Center.

Playback

Cannot delete clips/photos
- XF-AVC clips with an il mark cannot be deleted with the camera. Remove the [ mark (11 150).
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- Photos that were protected using other devices cannot be deleted with this camera.

Deleting clips takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings
and initialize the card (11 46).

Indicators and Onscreen Displays

appears in red on the screen.
- Battery pack is depleted. Replace or charge the battery pack.

appears on the screen.
- The camera cannot communicate with the battery pack attached so the remaining battery time cannot be displayed.

The tally lamp does not illuminate.
- Set MENU > [¥ System Setup] > [Tally Lamp (Front)] or [Tally Lamp (Rear)] to [On].

The tally lamp flashes quickly. <] (4 flashes per second)
- The battery pack is depleted. Replace or charge the battery pack.
- There is not enough available space on the CFexpress cards. Delete recordings (11 151) to free some space or
replace the CFexpress card.
- A system error has occurred. Turn the camera off and then on again. If this does not solve the problem, consult a
Canon Service Center.

The tally lamp flashes slowly. 6 o (1 flash per second)
- The combined available space on the CFexpress cards is low. Replace the CFexpress card that is not being used for
recording.

(s8d appears in red on the screen.
- An SD card error occurred. Remove and reinsert the SD card. If the display does not change back to normal, save your
recordings and initialize the SD card ([] 46).
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/(B])/ appears in red on the screen followed by [END].
- The indicated card is full. Delete recordings ([11 151) to free some space or replace the card.

Even after stopping recording, the access indicator stays illuminated in red.
- The clip is being recorded on the card. This is not a malfunction.

E3 appears in yellow on the screen.
- The camera’s internal temperature has reached a predetermined level. You can continue using the camera.

E3 appears in red on the screen.

- The camera’s internal temperature has risen further while B8 appeared in yellow on the screen.

- If the icon appears in red in CAMERA mode while MENU > [ System Setup] > [Fan Mode] is set to [Always On] or in
MEDIA mode while MENU > [¥ System Setup] > [Fan Speed] is set to [High], turn off the camera and wait until the
temperature has decreased.

- In CAMERA mode, if the fan mode is set to [Automatic] and the fan was turned off while recording, the fan will turn on
automatically (in that case, will appear on the screen).

appears in red on the screen.
- The cooling fan may not be working properly. The camera will automatically turn off after a few minutes. Consult a
Canon Service Center.

14N appears on the screen.
- The camera and lens cannot communicate normally. Clean the lens’s contacts and reattach the lens.

The aperture value (F or T) appears in gray on the screen.

- When using a compatible EF Cinema lens ([] 247) or broadcast lens, the aperture value will appear in gray when the
camera detects that the aperture may be close to fully closed. As you continue to close down the aperture further, the
display will change to [closed].

The ND filter indicator appears in red or as [- -] on the screen.
- The ND filter mechanism may not be working properly. Consult a Canon Service Center.

Picture and Sound

The screen of the monitoring device connected to the VIDEO terminal does not turn on.
- Make sure the unit cable connecting the camera’s VIDEO terminal and the monitoring device’s VIDEO terminal is
correctly connected on both sides.

There is no picture from an external monitor.
- Make sure the cable connecting the camera to the monitor is correctly connected on both sides.
- Check that the correct video input is selected on the external monitor.
There is no picture or sound from an external monitor connected to the MON. terminal
- If an HDMI cable is connected to the HDMI OUT terminal, disconnect it.
- Check that the external monitor’s settings match the configuration of the output signal selected on the camera
(01 153).
There is no picture or sound from an external monitor/recorder connected to the HDMI OUT terminal
- Disconnect the HDMI cable and then restore the connection or turn the camera off and then on again.
- Check that the settings of the external monitor/recorder match the configuration of the output signal selected on the
camera ([] 153).

An assistance display (peaking/zebra pattern/video scope/onscreen markers/magnification/B&W image/anamorphic
desqueeze/LUT) does not appear or is not applied on the screen.

- These assistance displays have separate settings that allow you to turn the display on/off on individual monitoring
devices/video outputs. Check the settings to see that the desired function is enabled on the desired monitor/video
output.

- Onscreen displays output has not been enabled. Activate the output of the camera’s onscreen displays ([J] 158).

Screen displays turn on and off repeatedly.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.
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Abnormal characters appear on the screen and the camera does not operate properly.
- Remove all the cards and disconnect the power source. After a moment, reconnect the power and reinsert the cards.
If the problem still persists, use the MENU > [¥ System Setup] > [Reset] > [All Settings] function. This resets all the
camera’s settings to default values, except for the hour meter.

Video noise appears on screen.
- Keep a distance between the camera and devices that emit strong electromagnetic fields such as near powerful
magnets and motors, MRI machines or high-voltage power lines.

Horizontal bands appear on the screen.

- This is a phenomenon typical of CMOS image sensors when recording under some types of fluorescent, mercury or
sodium lamps. This is not a malfunction. You may be able to reduce the symptoms by setting the shutter speed mode
to [Speed] and the shutter speed to a value matching the frequency of the local electrical system: 1/50* or 1/100 for
50 Hz systems, 1/60 or 1/120 for 60 Hz systems.

*May not be available depending on the frame rate.
Audio cannot be recorded.

- The INPUT switch (audio source selection) is set to AES/EBU but an analog audio source is connected, or it is set to
one of the other positions and a digital audio source is connected. Set the audio related switches correctly according
to the audio source you wish to use ([J1 109).

- When using the INPUT 1/INPUT 2 terminals, make sure you are using an XLR connector. When using the MIC terminal,
make sure you are using a condenser microphone with a & 3.5 mm stereo mini plug.

- The external microphone connected to the INPUT 1/INPUT 2 terminal requires phantom power. Set the corresponding
INPUT 1/INPUT 2 audio input selection switch to MIC+48V ([1] 109).

- The external microphone connected to the MIC terminal is not turned on or its battery is depleted. Alternatively, an
external microphone compatible with plug-in power is connected to the MIC terminal but MENU > [)) Audio Setup]
> [MIC Power] is set to [Off].

Audio is recorded at an extremely low level.
- When using the INPUT 1/INPUT 2 terminals or MIC terminal: The audio level switch for CH1 or CH2 is set to M, and
the recording level is set too low. Check the audio level meter on the screen and adjust the audio level correctly
(M 110).

- The microphone attenuator is on. Turn off the microphone attenuator (11 112).

Sound is distorted or is recorded at lower levels.
- When recording near loud sounds (such as fireworks, shows or concerts), sound may become distorted or it may not
be recorded at the actual levels. Activate the microphone attenuator ([1] 112), or adjust the audio recording level
manually.

Cards and Accessories

Cannot insert the card.
- The card you are trying to insert is not facing the correct direction. Turn it over and insert it.

Cannot record on the CFexpress card.
- A compatible card must be used ([] 43).
- Initialize the card ([11 46) when you use it with the camera for the first time.
- The card is full or it already contains the maximum number of clips (999 clips). Delete recordings ([11 151) to free some
space or replace the card.
- The clip number has reached its maximum value. Save your recordings and initialize the card ([I] 46) or delete all the
clips (11 151).
Cannot record on the SD card.
- A compatible card must be used ([] 43).
- Initialize the card ([11 46) when you use it with the camera for the first time.
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- The card is full or it already contains the maximum number of clips (999 clips). Delete recordings ([11 151) to free some
space or replace the card.
- The folder and file numbers for photos have reached their maximum value. Set MENU > [£% Recording/Media Setup]
> [Photo Numbering] to [Reset] and insert a new card.
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Recording to and playing back from a CFexpress or SD card is slow.

- This may occur as recordings are made and deleted repeatedly over time. Save your recordings and initialize the card
(T 46).

The optional RC-V100 Remote Controller or commercially available remote control does not work.

- Make sure that MENU > [§ System Setup] > [REMOTE Term.] is set to [RC-V100 (REMOTE A)] or [RC-V100
(REMOTE B)]* when using the optional RC-V100 Remote Controller, [Standard] when using a commercially available
remote control, or [Standard + RC-V100]* to use both simultaneously ([11 125).

: Only when the optional expansion unit is attached to the camera.

- Turn off the camera, reconnect the remote controller and then turn the camera back on again.

- When the currently selected custom picture file is protected, detailed custom picture settings cannot be adjusted
using the RC-V100. Unprotect the file ([I1 134).

Cannot adjust the custom picture settings using the RC-IP100/RC-IP1000 Remote Camera Controller.
- When the currently selected custom picture file is protected, detailed custom picture settings cannot be adjusted
using the RC-1P100/RC-IP1000. Unprotect the file (11 134).

Connections with External Devices

Video noise appears on a nearby TV screen.
- When using the camera in a room where a TV is located, keep a distance between the AC adapter and the power or
antenna cables of the TV.

Network Functions

Check This First

¢ Are the camera, computer or other network devices all turned on?
e |s the network working and correctly configured?
¢ Are all network devices correctly connected to the same network as the camera?

¢ \When using a Wi-Fi network, are there any obstructions between the camera and the access point or
between the network device used and the access point?

Cannot connect with an access point.
- If the network function icon does not turn white, turn off the camera, remove the optional WFT-E9 Wireless File
Transmitter and attach it again.
- Check that the settings on the network device the camera is trying to connect with are correct.
- The wireless signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal.
Refer to Precautions Regarding Wi-Fi Networks ([J] 226).
Cannot establish a Camera Access Point connection with a network device.
- If the network function icon does not turn white, turn off the camera, remove the optional WFT-E9 Wireless File
Transmitter and attach it again.
- When you reset all the camera settings, all network settings are lost as well. Set up the Camera Access Point settings
again ([11 175).
- The wireless signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal.
Refer to Precautions Regarding Wi-Fi Networks ([I] 226).
Cannot connect with a wired (Ethernet) network.
- Use a category 5e or better shielded twisted pair (STP) Ethernet cable.
- Try replacing the Ethernet cable.
- When you reset all the camera settings, all network settings are lost as well.
- Check that the network device to which the camera is connected is on and functioning properly. To use 1000BASE-T
connection speeds, make sure to use network devices compatible with Gigabit Ethernet (1000BASE-T).

The % (Ethernet) indicator on the optional EU-V1 Expansion Unit 1 or EU-V2 Expansion Unit 2 is illuminated or
flashing in red or is turned off.
- The Ethernet cable was disconnected or the camera cannot connect to the network device. Check the cable
connection and the network device.
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The Browser Remote application will not start on the Web browser.
- Make sure to use a connection setting with the [Browser Remote] function setting.
- The URL entered into the Web browser’s address bar is incorrect. Select MENU > [#N# Network Settings] >
[Connection Setting] > Connection setting in use > [Check Settings] and check the camera’s IP address. Use this IP
address as the URL ([] 187).

The Browser Remote screen is not displayed correctly on the Web browser.
- The device, operating system or Web browser used may not be supported. For the latest information about supported
systems, visit your local Canon website.
- Enable JavaScript and cookies in your Web browser’s settings. For details, refer to the help modules or online
documentation of the Web browser used.
- Delete the cache and cookies for Browser Remote's URL in your Web browser and restart Browser Remote.

Cannot start IP streaming.

- Verify that MENU > [#\¥ Network Settings] > [Activate IP Streaming] is set to [Enable] (1] 185).

- If the IP streaming protocol is set to an option other than [RTSP+RTP], make sure the [Dest. IP Address] is set correctly
(T 173).

- IP streaming cannot be used in the following cases. Check the settings.
® When the main clip is in RAW format.
* When slow & fast motion recording, pre-recording, relay recording or double slot recording is activated.
* When the system frequency is set to 24.00 Hz.

Cannot connect the optional XC Protocol compatible Remote Camera Controller.
- Make sure to use a connection setting with the [XC Protocol] function setting.
- Check that the settings on the Remote Camera Controller the camera is trying to connect with are correct.

Precautions Regarding Wi-Fi Networks

When using a Wi-Fi network, try the following corrective actions if the transmission rate drops, the connection is
lost, or other problems occur.

Positioning a network device (access point, mobile device, etc.)
- When using a Wi-Fi network indoors, place the network device in the same room as the camera.
- Place the network device in an open, unobstructed location, where people or objects do not come between it and the
camera.
- Place the network device as close as possible to the camera. Change the height or facing of the network device, as
necessary.

Nearby electronic devices

- If the transmission rate over a Wi-Fi network drops because of interference from the following electronic devices,
switching to the 5 GHz band or to a different channel may solve the problem.

- Wi-Fi networks using the IEEE 802.11b/g/n protocol operate in the 2.4 GHz band. For this reason, the transmission
rate may drop if there are nearby microwave ovens, cordless telephones, wireless microphones and Bluetooth or
similar devices operating on the same frequency band.

- If another access point operating on the same frequency band as the optional WFT-E9 Wireless File Transmitter
connected to the camera is used nearby, the transmission rate may drop.

Using multiple cameras/wireless transmitters/access points

- Check that there are no IP address conflicts among the devices connected to the same network.

- If multiple cameras are connected to a single access point, connection speeds may be reduced.

- To reduce radio wave interference when there are multiple access points using IEEE 802.11b/g or IEEE 802.11n (in the
2.4 GHz band), leave a gap of four channels between each wireless access point. For example, use channels 1, 6, and
11, channels 2, 7, and 12, or channels 3, 8, and 13.

If you can use IEEE 802.11a/n/ac (in the 5 GHz band), switch to IEEE 802.11a/n/ac and specify a different channel,
leaving an appropriate gap between channels according to the wireless standard and frequency band used. For
example, when using IEEE 802.11ac (VHT80), leave a gap of 8 channels between access points.
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List of Messages

Refer to this section if a message appears on the screen. The messages in this section appear in alphabetical
order. Note that for some messages, an indication of the recording media involved ([CFexpress A], [CFexpress
B], [SD Card] or a combination thereof) may appear above the message itself.

Activate power saving mode to continue recording?
- The camera will turn off after approximately one minute. By enabling power saving mode it is possible to continue
recording.

Battery communication error. Does this battery display the Canon logo?
- You attached a battery pack that is not recommended by Canon for use with this camera.
- If you are using a battery pack recommended by Canon for use with this camera, there may be a problem with the
battery pack or camera. Consult a Canon Service Center.

Buffer overflow. Recording was stopped.
- The data transfer rate was too high for the card in use and the recording was stopped. Use a recommended card
(T 43).

- Save your recordings and initialize the card ([11 46).

Camera ® Lens communication error. Clean the lens’s contacts and reattach the lens.
- The camera cannot correctly communicate with the lens due to dirty lens contacts. After the message disappears, the
(13 icon appears on the screen. Clean the lens contacts with a soft cloth and reattach the lens.

Cannot be used due to power saving mode.
- The following functions cannot be used during power saving mode.
* MENU > [V Network Settings] > [Network].
¢ MENU > [[E) Monitoring Setup] > [LCD LM-V1 Luminance], [LCD LM-V2 Luminance] or [EVF-V70 Luminance].
Cannot play back
- The XF-AVC clip’s file control information is corrupted or there was a decoder error. Turn the camera off and then on
again. If this does not solve the problem, consult a Canon Service Center.

* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information
cannot be read by the software (Canon XF Utility or plugins for NLE applications).

Cannot switch CFexpress card slots

- The SLOT SELECT button was pressed while the camera is recording. Wait until recording is finished to change the
selected CFexpress card slot.

CFexpress A/CFexpress B/SD Card: Check the data.

- Cannot access the card. Check the card and make sure it is inserted correctly.

- A card error occurred and recording/playback is not possible. Try removing and reinserting the card or replace it.

- You inserted a MultiMedia Card (MMC) into the camera. Use a recommended SD card ([] 43).

- If after the message disappears, (A9, (B or (58 appears in red, perform the following: Turn off the camera and
remove and reinsert the card. If [A], or turns back to green you can resume recording/playback. If the problem
persists, save your recordings and initialize the card ([ 46).

CFexpress A/CFexpress B/SD Card: Recommend checking the data and initializing

- The card cannot be used for any of the following reasons. Save your recordings and initialize the card ([] 46).
* A problem has occurred with the card.
® The camera cannot read the data on the card.

* The card was initialized using a computer.
® The card is partitioned.
CFexpress A—>CFexpress B / CFexpress B->CFexpress A Will switch in a moment
- The card is almost full so recording will continue on the other card in approximately 1 minute.
CFexpress A~>CFexpress B / CFexpress B->CFexpress A Switched

- This message appears when you use the SLOT SELECT button to switch the CFexpress card slot in use or recording

continued from one card to the other.

Check the connection of the camera grip
- The camera grip may not be attached correctly. Check the connection.
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Check the following settings
[Network Functions], [LCD/EVF-V70 Luminance]
- Power saving mode cannot be used in the following cases:
e When MENU > [#\* Network Settings] is set to [Enable].
¢ When MENU > [[E) Monitoring Setup] > [LCD LM-V1 Luminance], [LCD LM-V2 Luminance] or [EVF-V70 Luminance]
is set to an option other than [Normal].
e When MENU > [[E) Monitoring Setup] > [LUT Selection: VIDEO Terminal] is set to [HDR Assist. (400%)] or [HDR
Assist. (1600%)] and [LUT: VIDEO Term.] is set to [On].

Check the remaining battery charge
- Low power warning. If you set [Power Saving Mode] to [Off], the camera will turn off

Cover is open
- The card compartment cover was open when the camera was turned on or switched to CAMERA mode. Insert a card
and close the card compartment cover.

Fan error
- The cooling fan may not be working properly. The camera will turn off automatically after a few minutes. Consult a
Canon Service Center.

File name error

- The clip number has reached its maximum value. Save your recordings and initialize the card ([1] 46) or delete all the
clips (11 151).

- Photo numbers have reached their maximum value. Set MENU > [£% Recording/Media Setup] > [Photo Numbering] to
[Reset] and initialize the SD card ([J] 46) or delete all the photos ([ 151).

[Gamma/Color Space] ([HLG Color] or [Over 100%])
Look File not available because these settings are different from those registered with the Look File.

- A Look File is disabled if the [Gamma/Color Space], [HLG Color] or [Over 100%] settings are changed after registering
it. Restore the setting or register the Look file again.

If you change this setting, you will not be able to use the current Look File.

- The Look File’s adjustments to the image quality cannot be applied because the [Gamma/Color Space], [HLG Color],
[Over 100%)] settings in the custom picture file are different from those registered with the Look File. Change these
settings or register a different Look File.

Invalid operation

- The following are not valid operations and cannot be performed.
¢ In MEDIA mode, during playback, trying to add a shot mark to a frame that has one already.
¢ Trying to add an [l mark and a [ mark to the same clip.

e Pressing the REC button when no cards are inserted in the camera.
Lens error Turn the camera off, then on again.
- There was a communication error between the camera and the lens. Turn the camera off and then on again.
Lens firmware update Firmware update failed. Try updating again.
- The lens’s firmware could not be correctly updated. Try updating the lens’s firmware again.
Low Power Warning Check the power supply.

- The input power supplied to the camera (V-mount battery or DC IN 12V terminal) has reached the level set for the
power level warning ([J1 209). Check the power source.

- The message appears every time you press the REC button when the power supply is too low (as described above).

Management file error

- Cannot record because the camera cannot write to the file control information. This may occur if the files on the card

were accessed using another device. Save your recordings and initialize the card ([1] 46).
May not be possible to record clips on this media

- You may not be able to record clips on an SD card without a Speed Class rating or rated Class 2 or 4. Use a

recommended card ([T1] 43).
Media full
- The card is full. Replace the card or delete recordings ([1] 151) to free s